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Notice

© 1990-1997 NetManage, Inc. All rights reserved.

© 1986 Carnegie Mellon.

Portions of this software are © 1984-1985 Massachusetts Institute of Technology.

No part of this publication shall be reproduced or transmitted in any form or by any
means, electronic or mechanical, for any purpose, without prior written permission from
NetManage, Inc. The information in this publication and the product it describes are
subject to change without notice. The software program described in this publication is
provided to its users pursuant to a license agreement or nondisclosure agreement. Such
software program may only be used, copied or reproduced pursuant to the terms of such
agreement. This publication does not contain or represent any commitment of any kind on
the part of NetManage, Inc.

Disclaimer

NetManage makes no representation or warranties other than the standard warranty with
regard to the contents of this manual or the suitability of this software product for any
particular purpose. Therefore, NetManage assumes no liability for damages incurred
directly or indirectly from errors, omissions or discrepancies between the software and
this manual.

Important : You should carefully read the license terms and conditions included in this
package before you open or use the product. If you do not agree with the terms and
conditions, you should promptly return the product unopened.

Disclosure: Permission to use, copy modify, and distribute portions of this program are
granted by M.I.T. and Carnegie Mellon. Such rights are granted provided that the names
M.I.T. and Carnegie Mellon are not used in any advertising or publicity pertaining to the
distribution of this program or portions thereof. M.I.T. and Carnegie Mellon make no
representations about the suitability of this software, or portions thereof for any purpose.
It is provided "AS IS" without expressed or implied warranty.

Trademarks

NETMANAGE, the NETMANAGE LOGO, WEBSPIDER, ECCO, and SHOOTER are
registered trademarks of NetManage, Inc. in the United States and other countries.
AUTOMATIC INTERNET, CHAMELEON, INTRACHANGE, NEWT, Z-MAIL, Z-
MAIL PRO, and ECCO PRO are trademarks of NetManage Inc..
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Corporation.
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Chapter 1.  Introduction

ECCO Pro 4.01 is an Information Manager that provides all the tools you need to
simplify your life — an easy-to-use PhoneBook and Calendar for keeping track of the
appointments and people you deal with daily, and Notepads that let you organize
information in ways to best suit your needs.

Rather than forcing you to accept predefined categories, ECCO gives you the tools to
create your own organizational structure:

• Record and view information in the three ECCO views — PhoneBook, Calendar, and
Notepad.

• Use ECCO Pro to cross-reference, collect, and associate values with items of
information.

• Share information and schedule group meetings with other users by using ECCO’s
networking features.

Increase Your Productivity with ECCO
Even if you have never before used a computer to manage your daily information, you’ll
be surprised at how quickly ECCO can save you time and help you work more effectively.
ECCO provides you with three primary tools — the PhoneBook, the Calendar, and
Notepads.

The PhoneBook

Need a phone number fast?  Can you remember only the person’s first name and the fact
that you met at the Dallas convention?  Don’t bother fumbling through a pile of business
cards with notes scrawled on the back.  ECCO’s PhoneBook gives you instant access to
names, phone numbers, and personal notes for the people important to you.

You can also create customized PhoneBook forms, add new fields, and add outlines notes
to include contact histories.  If you are using a modem, you can have ECCO dial your
PhoneBook entry and automatically log the call.  Filters and queries add the power a
paper address book simply can’t match.
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The PhoneBook

The PhoneBook provides you with a customizable PhoneBook entry form for entering
new names and a phone list for viewing them:

• Quickly find the information you need by searching by first name, last name, or
company.

• Keep a full record of your conversations by adding outline notes to your PhoneBook
entries.

• Display, in spreadsheet-like columns, information such as phone numbers, addresses,
records, and phone conversations.

• Dial and log phone calls automatically.

• Customize the PhoneBook entry form to display only those fields into which you
customarily enter information.

For more information, see the chapter or online help on “The PhoneBook.”
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The Calendar

With ECCO’s Calendar, you’ll always have an answer to the question “What do I have to
do next?”  All your scheduled appointments and events are displayed for quick reference.
A Busybar shows you at a glance when you are busy and when you have a free time slot.
“Tickler” reminder notes and customizable alarms for your appointments take the
pressure off your memory skills.  Recurring events such as monthly progress reports, a
weekly lunch, or an annual physical are automatically scheduled for you with a simple
menu selection.  And because no one’s schedule is immune to changes, ECCO makes it
easy to rearrange your appointments by using the mouse to drag them to a new time or
date.

The Calendar

The Calendar provides day, week, month, and year views for recording and viewing
appointments and a tickler section for recording and viewing to-do’s and reminders:

• Include outline notes for any appointment or to-do item.

• Set alarms that notify you of appointments and events.  You can create multiple
alarms for each appointment or to-do.

• Create recurring appointments and to-do’s automatically, at the time intervals you
specify.
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For more information, see the chapter or online help on “The Calendar.”

You can also use the ECCO Calendar to schedule group meetings with other people on
your network. For more information, see the chapter or online help on “Group
Scheduling.”

The Notepad

If you think back on a typical day, you’ll likely realize that most information you deal
with doesn’t easily fall into neat categories.  ECCO’s Notepads are outlining tools that
give you the opportunity to record information in a way that best suits your needs.  Use a
Notepad to keep lists of major and minor points, track a new business plan, or record the
highlights of a recent seminar that you want to remember.

A Notepad

Note: Outlining isn’t limited to the Notepad — it is a basic feature available in all ECCO
views (Calendar, PhoneBook, and Notepads).

For more information, see the chapter or online help on “The Notepad and Outlining.”
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Other ECCO Features

In addition to ECCO views, other features help you find, organize, and view the
information you use every day:

• Click the right mouse button to display a pop-up menu that lets you execute
commands for the current view as well as common Edit-menu operations.

• Use the ECCO Shooter® to copy information between ECCO and other programs.

• Search any ECCO view or file for a group of text items and place them in a separate
Notepad.

• Customize the toolbar for instant access to any ECCO command.

• Customize the Tools menu for instant access to other programs and files.

• Format text using outline styles, character formatting, and text touch-ups.

• Share files and schedule group meetings with other users on your network.

• Place the same item in multiple ECCO folders simultaneously, the Folder window.
You can then view those items with other related items, from many perspectives.

• Add additional information (such as dates or numbers) to items in a view, using
columns in the column pane.

• Limit and order the display of items in a view, using filters and sorting.

• Add items and their associated values to multiple folders at one time, using forms.

• Export phone numbers, appointments, and to-do’s to a Timex Data Link watch.

• Synchronize data between the U.S. Robotics Pilot and your ECCO file.

Documentation Roadmap
You are provided with a variety of learning tools to ensure that you can learn ECCO in a
way that best suits your needs:

• ECCO Getting Starting Guide:  A hands-on approach to learning that walks you
step-by-step through ECCO basics and some intermediate features such as group
scheduling and file synchronization.  This printed guide is included with ECCO and
also available in Adobe Portable Document Format (PDF) on the ECCO CD-ROM.

• ECCO User’s Guide:  Your comprehensive guide for working with ECCO.  The
User’s Guide is available in Adobe Portable Document Format (PDF) on the ECCO
CD-ROM, which allows viewing and printing of any part of the User’s Guide.  The
content of the User’s Guide is also contained in the online ECCO Help system.
Printed User’s Guides are available for a nominal charge.  Please contact NetManage
ECCO Customer Service for ordering information (see the following section).

• Online Help:  An online version of this User’s Guide.  To access online help, choose
one of the commands from the ECCO Help menu or press F1.
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• TECHINFO.ECO:  This ECCO file contains troubleshooting information and other
technical reference information for using ECCO.

• README.WRI file:   This file contains helpful information that was not available
when this manual was printed.  This file can be opened with either Microsoft Write
or Microsoft WordPad, included with Microsoft Windows 3.x and 95, respectively.

Note: The documentation set for ECCO Pro 4.01 includes information on all platforms
(Windows 3.1, Windows NT, and Windows 95).  Any differences in ECCO
features on a specific platform are noted in the text.  Though all pictures in the
printed and online documentation were created with the 32-bit version of ECCO
Pro, the same features and commands described in the pictures are available in the
16-bit version.

ECCO Technical Support and Customer Service
If you need additional information or cannot find the answer you need in the printed or
online documentation, call NetManage ECCO Customer Support at (206) 885-0559.
Telephone support is available Monday through Friday, 7 a.m. to 5 p.m. Pacific time,
excluding holidays.

If you have questions about your product registration, need pre-sale information, or want
to purchase additional copies of ECCO, call NetManage ECCO Customer Service at
(206) 885-4272.  Representatives are available weekdays 6 a.m. to 6 p.m. Pacific time,
excluding holidays.

ECCO Online
The following online options provide 24-hour access as well as file libraries for
downloading technical notes, additional templates, and maintenance releases. Suggestions
and comments are also welcome.

Service Access

News Server forum.netmanage.com

Newsgroups:
netmanage.products.ecco.discussion
netmanage.products.ecco.misc
netmanage.products.ecco.network
netmanage.products.ecco.sales
netmanage.products.ecco.support
netmanage.products.feature-request

Internet eccosupport@netmanage.com  [technical support]

eccoservice@netmanage.com  [customer service]

FTP Server ftp.netmanage.com

Page 17



7 ECCO User’s Guide

Other NetManage Products
NetManage is committed to expanding network capabilities in line with existing products,
such as ChameleonNFS/X™ for all Windows platforms.  We will maintain our high
standards for ease of use and integration with Windows.

Our current set of products includes:

• ChameleonNFS/X™: TCP/IP applications suite for Windows systems, including NFS
client and server for Windows systems, plus Xoftware for X-Windows.

• Chameleon HostLink™: comprehensive TCP/IP application suite including IBM
mainframe, AS/400, and UNIX/VMS host access for SNA, TCP/IP, and
asynchronous connections.

• IntraNet Forum Server: A high-end IntraNet discussion server, based on the Network
News Transport Protocol (NNTP).

• Internet Chameleon™: Internet dialup access

• NEWTWatch: SNMP-based desktop management

• NEWT-SDK: Development kit for TCP/IP DLL, FTP DLL, SMTP DLL, SNMP
DLL, and ONC RPC/XDR.

• NEWT IntraNet ActiveX: Development kit for ActiveX Controls.

• ECCO Pro™:  Personal information management and workgroup communications
application.

• Z-Mail Pro™: Set of e-mail related applications that let you send and retrieve
electronic mail.

We also have native-language versions of some of our products in:

• Chinese

• Dutch

• French

• German

• Italian

• Japanese

• Korean

• Portuguese

• Spanish
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Chapter 2.  Setup and Installation

ECCO Pro 4.01 System Requirements
Before installing ECCO, be sure your computer meets the minimum system requirements:

• IBM PC, PS/2, or 100% compatible computer

• Mouse or other pointing device

• Microsoft Windows 95 or Windows NT 3.51 or later operating systems (Windows
3.1 or higher for ECCO Pro 16-bit version)

• 8 megabytes (MB) of RAM (12 MB or more recommended)

• 12 MB of free hard disk space for minimum install; 16 MB for full install

• CD-ROM drive

• Hayes-compatible modem is required to use the Phone Dialer feature and fax
modem for Correspondence Manager faxing features

Installing ECCO
When you insert the ECCO Pro 4.01 CD into your CD drive, the setup program
automatically launches if your system has CD autoload enabled (which is the default in
Windows 95 and Windows NT 4.0).

Before installing ECCO, exit any virus checking or screen saver programs

To install ECCO Pro for Windows 95 or Windows NT 4.0

1. Insert the ECCO Pro CD into the CD drive.

2. An autostart program will automatically initiate the installation process.

3. When the installation wizard prompts you, specify the folder into which you would
like the ECCO Pro 4.01 files to be installed.

4. When the installation wizard prompts you, specify the files you want to be installed
by checking the appropriate checkboxes.  All files are selected by default.

5. When the installation wizard prompts you, specify a program group in which to place
the icons for ECCO Pro.

 You can cancel the installation at any time by choosing the Cancel button.  To
proceed to the next panel of the wizard, choose Next.  If you want to change
information you have previously entered, choose the Back button.
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 The last panel of the wizard has a Finish button.  Choose the Finish button to begin
the installation.  When the installation is complete, a dialog is displayed confirming a
successful installation of ECCO Pro.

Note: For upgrade installation information, see the README.WRI file in the installation
directory of the ECCO Pro CD.

To install ECCO Pro for Windows 3.1x and Windows NT 3.51

1. Insert the ECCO Pro CD into the CD drive.

2. In Program Manager, choose the Run command from the File menu.

3. When the installation wizard prompts you, specify the directory into which you
would like the ECCO Pro 4.01 files to be installed.

4. When the installation wizard prompts you, specify the files you want to be installed
by checking the appropriate checkboxes.  All files are selected by default.

5. When the installation wizard prompts you, specify a program group in which to place
the icons for ECCO Pro.

 You can cancel the installation at any time by choosing the Cancel button.  To
proceed to the next panel of the wizard, choose Next.  If you want to change
information you have previously entered, choose the Back button.

 The last panel of the wizard has a Finish button.  Choose the Finish button to begin
the installation.  When the installation is complete, a dialog is displayed confirming a
successful installation of ECCO Pro.

Note: For upgrade installation information, see the README.WRI file in the installation
directory of the ECCO Pro CD.  You may also access the README.WRI file by
choosing the ECCO Pro README button on the first panel of the installation
wizard.

Starting ECCO
After you have installed ECCO, you are ready to start the program.

To start ECCO

1. Start Microsoft Windows 95, Windows NT, or Windows 3.1x.

 For more information about running Microsoft Windows 95, Windows NT, or
Windows 3.1x, see your Microsoft Windows documentation.

2. Choose the Start button on the Windows taskbar, select Programs on the Start menu,
then NetManage ECCO Pro, then NetManage ECCO 4.0.

 Or if using Windows NT 3.51 or Windows 3.1x:
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 Open the ECCO program group, if it is not already open and double-click the ECCO
icon.

 The ECCO program window appears. It remains empty until you create a new file or
open an existing file.

To Create a New File

From the File menu, choose New.  ECCO opens a new, untitled file based on the template
DEFAULT.ECT.

To Open an Existing File

1. From the File menu, choose Open.  The File Open dialog box appears..

2. In the File Name box, type or select the name of the file you want to open.

3. If the file you want to open is not listed, specify the location in which you saved the
file with the appropriate dialog box options.

4. Select the name of the file you want to open, and then choose the OK or Open button.
ECCO opens the file.

Note: ECCO lists the last four files you closed at the bottom of the File menu.  To open a
recently closed file, choose it from the menu.

Using Templates
An ECCO template is a file (with the extension .ECT) that you can use as a model to
create other files of the same type.  Because templates contain views with predefined
folders and columns tailored to specific professions, they can help you become productive
quickly.  For example, the Sales template (SALES.ECT) is specifically designed to meet
the needs of sales professionals.

Each ECCO template includes a view titled “How to Use This File” that describes how to
get the most out of each template.

To Create a New File Based on a Template

1. From the File menu, choose Open.

 The File Open dialog box appears.

2. In the List Files Of Type box, select the ECCO Templates (*.ECT) option.

3. Select the TEMPLATE folder.

 A list of all available templates appears.

4. Select a template.

5. Choose the OK or Open button.
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 ECCO opens a new, untitled file based on the template you selected.

To Create a New Template

You can create a template based on any ECCO file.

1. Open the file on which you want to base the new template.

2. From the File menu, choose Save As.

 The Save As dialog box appears.

3. In the File Name box, type a name for the template.

4. Specify the location in which you want to save the file.

5. In the Save File Type As box, select the ECCO Templates (*.ECT) format.

6. Choose the OK or Save button. ECCO saves the file as a template.

Note: Once you’re familiar with ECCO, you might want to create a custom file that has
no predefined template information.  To do so, press the CTRL or SHIFT key while
you choose New.  ECCO will create a file that contains only a PhoneBook and a
Calendar.  You will have to explicitly create any desired Notepads.

Navigating in ECCO
In this section, you’ll learn the features of the ECCO program window and the basics of
ECCO navigation.  Familiarity with the Microsoft Windows 95, Windows NT, or
Windows 3.1x graphical environment is assumed.  If you need more information, refer to
your Microsoft Windows documentation.
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The following illustration (which displays a Notepad for demonstration purposes) shows
the key features of the ECCO program window:

The following table describes the key features of the ECCO program window:

Feature Description

Menu bar Contains main ECCO menu names.  Choose a menu name to
display a drop-down list of commands.

Toolbar You can speed up your work by using command buttons located
on the toolbar.  You can customize the toolbar to contain the
ECCO command buttons you use most often.

Repeat box Choose the Repeat box to repeat the command last chosen or to
customize the toolbar (by using the right mouse button to drag
the button that appears in the box).

Column pane An area of each view in which you can display columns to enter
and display values such as dates, numbers, and check marks.

Tabs You can move from one ECCO view to another by clicking a
tab.
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Feature Description

Tab scrolling buttons Appear when there are more tabs than can be displayed at one
time.  Choose the button on the far left to display the first tab;
choose the second button from the left to display the previous
tab; choose the second button from the right to display the next
tab; choose the button on the far right to display the last tab.

Status bar Displays the current date and time as well as information about
the selected command, and it indicates whether a filter has been
applied to the active view.  It also contains the Show/Hide
Toolbar button and context-sensitive help messages.

Files menu Appears whenever multiple ECCO files are open.  Use the Files
menu to switch from one open file to another.

Folder window You create and organize folders in the Folder window.  You also
use the Folder window to edit existing folders, view folder types,
change folder preferences, add items to folders, and remove
items from folders.

ECCO Views
An ECCO file has three main views — the Calendar, the PhoneBook, and the Notepad.

Each ECCO view is a window.  Each ECCO window can display three additional views at
one time.  For example, if you are in the Calendar, you can “add” a Notepad to the
Calendar so that the Notepad and the Calendar are displayed side by side.

To Switch between ECCO Views Using the Menu Bar

From the View menu, do one of the following:

• To switch to the Calendar, choose Calendar.

• To switch to the PhoneBook, choose PhoneBook.

• To switch to a Notepad, choose Notepads, and then choose a notepad name from the
submenu.

To Switch between ECCO Views Using Tabs

Choose the tab for the view you want to see.

Note: You can also switch between views by using the keyboard or the toolbar.  For
more information about customizing the toolbar, see the online help or chapter on
“Using the Toolbar.”
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ECCO Files
In ECCO, you can have multiple files open at one time and move between them as you
work.  You switch to another open file using the Files menu.  The Files menu is displayed
in the lower-right corner of the ECCO Program window whenever multiple files are open.

To Switch between ECCO Files

From the Files menu in the lower-right corner of the ECCO program window, choose the
file you want.

Saving an ECCO File
When you select Save from the File menu, you save all changes made in any view in the
active file.  You can set save options for all your ECCO files such as autosave every x
minutes and autosave on file close or file-specific backup options, such as keeping
multiple rotating backups and daily backups to a network.

To Save an ECCO File

1. From the File menu, choose Save.

• If you are saving an existing (previously saved) file, ECCO simply saves the file
under the existing name to the location specified when you last saved the file.

• If you are saving a new, unnamed file, ECCO displays the Save As dialog box.
Follow steps 2 through 4 to complete the process.

2. In the File Name box, type a name for your file.

3. Specify the location in which you want to save the file.

4. Choose the OK or Save button.

To Set Save Options

To customize the saving process, use the save options in the ECCO Options property
sheet.

1. From the Tools menu, choose Options.  The ECCO Options property sheet appears.

2. On the Files tab, select one or more of the following:

• To save your file automatically at a regular interval, select the Autosave All Files
Every option, and then select a time interval from the list.

• To save automatically on closing without a prompt, select the Autosave on File
Close option.

3. Choose the OK button.
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To Set File Specific Save Options

1. From the File menu, choose Properties.  The File Properties property sheet appears.

2. On the Backups tab, select one or more of the following:

• To save backup copies, in the Local Backup section check Keep Backup Copies
of This File and enter number of backup copies you want ECCO to save.  Each
time you exit, ECCO creates a new backup copy with the extension .BK1 (the
most recent backup), .BK2, and so forth, up to the number specified.

• To save a copy of your file to a network directory automatically on closing,
select Save a Daily Backup to the Network in the Network Backup section, and
then specify the network location in which you want to save the file.

Closing Files and Exiting ECCO
When you are finished working with an ECCO file, you have two options — you can
close it and remain in ECCO, or you can close it (along with all other open files) and exit
ECCO.

To Close the Active File and Remain in ECCO

From the File menu, choose Close.  If you have not saved changes, ECCO asks whether
you want to save them.

To Close All Open Files and Exit ECCO

From the File menu, choose Exit.  If you have not saved changes, ECCO asks whether
you want to save them.
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Chapter 3.  The Calendar

About the Calendar
Use the Calendar to record appointments on your computer just as you use a paper
organizer or other paper calendar.  Once you’ve recorded your appointments, ECCO
gives you a number of ways to save yourself time and keep your schedule on track—ways
that a paper calendar doesn’t provide, such as:

• View your schedule a day, a week, a month, or a year at a time.

• Schedule an appointment by clicking in the Appointment section, or by dragging a
name from your PhoneBook or from any Notepad to the Calendar.

• Remind yourself of to-do’s and upcoming appointments with a list of tickler
items. Just click in the Tickler section to add a reminder.

• Set alarms that notify you of appointments and events.

• Create recurring appointments and events automatically, at the time interval you
choose.

• Store important information  about your appointments and tickler items with outline
notes.

• Use columns to give priority or other values to your appointments and tickler
items.

• Schedule group meetings with anyone connected to your ECCO Workgroup
Directory.  For more information, see the chapter or online help on “Group
Scheduling.”

The Date Settings dialog box is a compact tool for specifying settings for your
appointments, tickler items, alarms, recurring events, and Busybar block colors.

The Calendar Window

The Calendar window appears inside the ECCO program window.  To switch to the
Calendar, choose Calendar from the View menu or click the Calendar tab.
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• Day/Week/Month/Year buttons:  Switches between daily, weekly, monthly and
yearly views of your calendar.

• Navigator:  Lets you travel backward and forward through your calendar. ECCO
immediately displays the appointments and tickler items for the dates you specify.

• Go to Today button:  Instantly returns you to the current date.

• Calendar/PhoneBook button:  Displays the Calendar and PhoneBook side by side.
You can drag names from the PhoneBook to the Calendar to schedule an
appointment in the Appointment section.

• Sidebar:  Displays “thumbnail” calendars of the current, previous, and next month,
or it displays a Busybar that shows your appointments in timeline form.

• Appointment section:  Create and modify your appointments here.  You can also
add information in outline form for each appointment item you schedule.

• Status icons:  Show you at a glance the items with associated alarms and items that
are recurring events.
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• Tickler section:  Displays reminders that “tickle” your memory about things you
need to do or upcoming appointments you need to prepare for.

• Add Tickler button:  Displays the Add Tickler Item dialog box.

Viewing Your Schedule
As you plan and create your appointments and to-do’s, you might want to look at one
day’s events in detail or get an overview of the weeks, months, and year to come.  There
are five ways in which to view your schedule:

• Move through the Calendar a month, day, or year at a time.

• Move to today’s date by choosing the Go To Today button.

• View a particular day, or a week, month, or year at a time, using the Day, Week,
Month, and Year buttons.

• Display weeks and months in detail, or in a summary “planner” format.

• Use the sidebar to display three months at a glance, and move to any date by clicking
it.  Or, display busybars showing your scheduled appointments in timeline form.

Moving To A Date

ECCO offers you four ways to move to any date in your Calendar:

• Select a date using the Navigator.

• Use the keyboard shortcuts listed below.

• Click a date in the sidebar.

• Choose the Go to Today button to return to today’s date.

The Navigator displays the currently selected date of the active Calendar and lets you
select any date:

• Click the text of the Navigator buttons to display drop-down lists of months, days,
and years, and choose the one to which you want to move.

• Click the arrow buttons to move forward and backward by month, day, or year. These
buttons will either move you directly to a different date or will display a set of days,
months, or years from which to choose.

For example, to go from April 28, 1997 to May 1, 1998, you would make selections that
result in the following screen display:
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Use the Navigator’s drop-down lists to move to a specific month, day, or
year.

You can also move quickly between dates by using the following keyboard shortcuts:

To Press

Go to today ALT + G

Go to date—specify date or number
of week

F4

Go to previous year F5

Go to next year F6

Go to previous month F7

Go to next month F8

Go to previous day F9

Go to next day F10

Viewing Your Schedule by Day, Week, Month, or Year

Click the Day, Week, Month and Year buttons (at the far left of the Calendar window) to
view your schedule for the day, week, month, or year of the date displayed in the
Navigator.  The Tickler section also changes to reflect the reminders you have created for
the selected day, week, month, or year.
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Displaying Weeks and Months in Summary or Detail

The ECCO Calendar can display the selected week or month in detail (as a scrolling list
of your appointments) or in summary (a graphical display of squares that resembles a
“planner” paper calendar, showing your appointments and, optionally, your tickler items).
A black bullet appears below the number of the currently-selected date.

Note: When you display your appointments by week or by month in detail, you can
expand or collapse the appointments for a day by double-clicking the folder icon
to the left of the day, or jump to a particular day by clicking that day in the
sidebar.

To customize the font size of text in the week and month summary displays, press the
Font button (between the Navigator and the Go to Today button).

To switch between detail and summary displays

Do any of the following:

• In either summary or detail display, click the Detail/Summary button on the Calendar
toolbar.

• In either summary or detail display, press SHIFT + F10.

• In a summary display, click a date and, from the pop-up menu, choose Go to Day.

• In a summary display, double-click anywhere in a date.

 ECCO displays in detail the day display of the date you selected.

ECCO remembers your display choice the next time you view the Calendar by week or
month.

To select a date in a summary display

Do any of the following:

• Use the Navigator

• Click in the sidebar

• Click anywhere in a date square

When you click a date, a pop-up menu opens, including commands for:

• Adding, deleting, or modifying an appointment, multi-day appointment, or tickler
item

• Adding a group meeting

• Displaying the selected day in detail

Choose a command, or press ESC to close the pop-up menu.

Page 32



ECCO User’s Guide22

Note: You can also change an appointment or tickler item by dragging it to any other
date in the current week or month.

To display or hide tickler items in summary displays

1. From the Calendar menu, choose Options.

 ECCO displays the Calendar Options property sheet.

2. Choose the Ticklers tab.

3. Select or deselect the Week and Month options under Show Ticklers in Summary
Views for.

4. Choose OK.

To display day details in summary displays

1. Click the date and, from the pop-up menu, choose Show Day Details.

 ECCO displays the Day Details dialog box. The text box displays the full text of any
items associated with this date.

2. Choose the Go to Day button to view the Calendar by day, or choose the Done
button.

Using the Sidebar and Busybars

The vertical sidebar at the left-most side of the Calendar displays either:

• Three-month “thumbnail” calendars.

• A Busybar, which shows your appointments and recurring events in timeline form by
day, week, or month.  Each appointment or event appears as a colored Busybar
block.

• No Busybar.

The three-month calendar displays the month selected in the Navigator and the months
immediately before and after it.  The Busybars display the day, week, or month of the date
currently selected in the Navigator.  These Busybars are independent of the way your
schedule is displayed (using the Day, Week, Month, and Year buttons).  For example, you
can display today’s appointments, and have the Busybar show your busy periods for the
entire month.

You can specify a different busybar for each calendar display.

To change the sidebar display

1. From the Calendar menu, choose Sidebar Shows.

2. From the submenu, choose one of the following:
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To hide the sidebar, choose No Sidebar.
To display “thumbnail” calendars of the next, previous, and current

months, choose Three Months.
To display a Busybar, choose Day Busybar, Week Busybar, or Month

Busybar.

Note: Click the right mouse button in the sidebar to open a pop-up menu containing
these same commands.

To change an appointment’s time, drag the middle of its Busybar block to a new position
in the Busybar.

To change appointment’s duration, drag either end of its day or week Busybar block to
make it longer or shorter.  As you drag, ECCO displays the duration in 15-minute
increments.

Each appointment’s Busybar block can have any color you specify in the Date Settings
dialog box or the Edit Appointment or Tickler Item dialog box.

Customizing the Calendar’s Appearance

ECCO offers you a number of ways to customize the Calendar’s appearance.  You can set
default options, specify international date and time formats, and display the Tickler
section above or beside the Appointment section.

To set calendar options

1. From the Calendar menu, choose Calendar Options.

 ECCO displays the Calendar Options property sheet.

2. Choose the Appointments tab to:

• Start the week on Monday instead of Sunday.

• Change the start and end times of your day.

• Change the default appointment duration (for example, from one hour to a half
hour).

• Change the default appointment time slot that appears in the Calendar.

• Change standard settings for appointment items.

3. Choose the Ticklers tab to:

• Show or hide tickler items in the week and month summary views.

• Show the Tickler section to the right or on top of the Appointments section.

• Change standard tickler item options.

4. Choose the Time Zone tab to:
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• Set the primary time zone for group scheduling.

• Set time zone adjustments.

5. Choose the Holidays tab to:

• Select the country for which you want to view national holidays.  Select none
for no holidays.

• Create, edit, and custom holidays.

6. Choose the OK button.

 The Calendar changes to reflect the options you specified.

ECCO automatically uses the country and language set in the Regional Settings option on
the Control Panel (in the Windows NT 3.51 Control Panel use the International option) to
determine time, date, number, and currency formats.  For example, if you specify the
country as Sweden, the Navigator and all dates change to year/month/day order, and times
are displayed using the 24-hour clock.

You can resize the Tickler section and Appointment section by dragging the bar in
between them (the pointer becomes a double-headed arrow).  If a section disappears,
press F12 to reopen it.

By default, ECCO displays the Appointment section and Tickler section side by side;
however, you can choose to arrange them vertically.

To rearrange the Appointment and Tickler sections

1. From the Calendar menu, choose Options.  ECCO displays the Calendar Options
property sheet.

2. Select the Ticklers tab.

3. Under Tickler Section Position, select either On Right Side of Appointments or On
Top of Appointments.

 You can also change the Tickler section position when in the a Calendar detail view
by selected Show Tickler Section on Top from the Calendar menu.

Note: ECCO is sensitive to state of your computer screen, so this command may be
unavailable if the active ECCO window is crowded or if your monitor display is at
a low resolution.

To add a customized holiday

1. From the Calendar menu, choose Options.

 ECCO displays the Calendar Options property sheet.

2. Choose the Holidays tab.
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3. Choose the Custom Holiday button.

 The Manage Custom Holidays dialog box appears.

4. Choose the New button.

 The Custom Holiday dialog box appears.

5. Specify the date and type a description of the holiday in the Title text box.

6. Choose OK, and then choose the OK button in the Manage Custom Holidays dialog
box.

7. Choose OK on the Calendar Options property sheet.

Note: ECCO can display national holidays for many different countries.  From the
Calendar menu, choose Options, then the Holidays tab.  Select a country from the
drop-down list next to Show Holidays for.  To display no holidays, choose None
from the list.

Creating and Managing Appointments
An appointment is an item that has a time associated with it.  While you can create items
with time values in any ECCO view, the Calendar lets you schedule and manage your
appointments at a glance.  Display your Calendar by day, week, or month, in detail or in
summary, and click in any day to add an appointment, or click any existing appointment
to change it.

You can also schedule appointments by dragging any name or item from the PhoneBook
or any Notepad into the Calendar.  Outline notes for appointments can provide important
additional information, such as meeting agenda items or directions to a location.  Remind
yourself of upcoming appointments with tickler items, or by setting alarms.  If an
appointment occurs regularly, you don’t need to enter it over and over—just make it a
recurring event.

The Date Settings Dialog Box

The Date Settings dialog box is a compact tool for changing the settings for a selected
appointment.  You can use it to change an appointment’s date and times, add a tickler
item for the appointment, set alarms, make the appointment a recurring event, and change
the color of the appointment’s Busybar block.  When a tickler item, alarm, or recurring
event is set for the appointment, a red triangle appears in the upper-left corner of the
respective button.

You can open the Date Settings dialog box by:

• Clicking the time next to an existing appointment or the date next to a Tickler item.

• Selecting an appointment or item and choosing Time, Date, Alarm, etc. from the
Calendar menu.
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In summary displays of the Calendar, the Date Settings dialog box is not available;
however, the Edit Appointment or Tickler item dialog box contains similar options.
Select the appointment, right mouse click, and select Modify.

• Mini-Navigator:  Moves the date grid forward or backward by month or year.

• Cancel:  Cancels any changes made and closes the dialog box.

• OK:  Enters any options selected and closes the dialog box.

• Date grid:  Changes the date for the selected appointment. The appointment date
appears in black, and the current date is shown in blue. If the appointment date is
today’s date, then it appears in red.

• Tickler:  Sets tickler item options, such as beginning and ending dates.

• Alarms:  Creates new custom alarms and edits existing ones.

• Recur:  Makes the selected item recur at the time interval you specify.

• Color:  Changes the color of the Busybar block for the selected appointment.

• Group:  Displays the group scheduling menu from which you can choose to make a
group meeting or keep the selected time available for other appointments or
meetings. For more information, see the chapter or online help on “Group
Scheduling.”

• Hours and minutes buttons:  Changes the beginning or end time of the selected
appointment.

• A or P button:  Toggles the selected appointment between AM and PM.

• Help button:  Displays help information about the Date Settings dialog box.

Note: If you select an item not associated with a time (for example, in the Tickler
section) and display the Date Settings dialog box , the Group, Hours, Minutes, A,
P, and Help buttons are replaced by a Time button.  Click the Time button to
display the hidden buttons.
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Scheduling Appointments

When you first open the Calendar, by default you see the detail display of the current day.
Time slots appear at the left side of the Appointment section in one-hour increments.  The
simplest way to create an appointment is to select a time and type an appointment
description.  If a Busybar is visible, the appointment’s Busybar block appears in it.  To
schedule an appointment on a date that is not displayed, move to the date you want, and
then create the appointment; or schedule the appointment, and then change its date.

To schedule an appointment in day display

1. From the Calendar menu, choose Add Appt. Item, or either click to the right of the
time at which you want the appointment to begin or use the UP ARROW and DOWN

ARROW keys to select a time slot.

2. Type a description for the appointment.

To schedule an appointment in detail display of a week or
month

1. From the Calendar menu, choose Add Appt. Item.

2. Type a description for the appointment.

Note: To change the default duration of  ECCO appointment time slots (for example, to
30 minutes or two hours), choose the Options command from the Calendar menu
and select the Appointments tab.  Select a Default Appointment Duration from the
list box.

To schedule an appointment in summary display of a week or
month

1. From the Calendar menu, choose Add Appt. Item, or click a date and, from the pop-
up menu, choose Add Appt. Item.

 The Add Appointment dialog box appears, displaying the selected date.

2. If appropriate, take any of the following actions:

• Change the time or date of the appointment.

• Create a tickler item reminder for the appointment.

• Create an alarm for the appointment.

• Make the appointment a recurring event.

• Change the appointment’s busybar block color.

3. Under Enter Appointment, type a description for the appointment.
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4. Choose OK to return to the summary display, or choose the Jump to Notes button to
add an outline note for the appointment and view the Calendar by day.  Outline notes
do not appear in summary displays.

Note: In any display of the Calendar, the Add Appt. Item command is also available
from a pop-up menu when you click the right mouse button.

Scheduling Appointments Using the PhoneBook

You can schedule an appointment with anyone in your PhoneBook by viewing the
PhoneBook and the Calendar side by side and dragging a name into the Calendar.

To schedule an appointment using the PhoneBook

1. From the Calendar menu, choose Use with PhoneBook.

Or

 Choose the Calendar/PhoneBook button.  The Calendar and PhoneBook appear side
by side, in the PhoneBook window tab, and the Calendar is displayed by day.  You
can use the Navigator or the Week and Month buttons to move to another date, or use
the Detail/Summary button to display the Calendar by week or day in summary.

2. In the PhoneBook list, point to the item bullet next to the name you want and hold
down the left mouse button.  The pointer changes to the item move icon.

3. Drag the name to the time slot or day of the Calendar on which you want to schedule
the appointment.  If the Calendar is displayed by day, the appointment is scheduled in
the time slot you selected.  In detail display of a week or month, the appointment is
scheduled in the earliest available time slot.  If the Calendar is displayed by week or
month in summary, the Make Appointment or Tickler dialog box appears, containing
options similar to the Add Appointment dialog box.

4. Take any actions you want, and then choose the OK button.  The appointment is
scheduled in the Calendar, and also appears as an outline note under the name in the
PhoneBook.  Any changes you make to the appointment are reflected in both places.

Scheduling Multi-Day Appointments

Create a multi-day appointment for any appointment or event that spans more than one
day, such as a three-day seminar or a two-week vacation.  Multi-day appointments appear
in the Tickler section, and in solid red at the top of any Busybars.  In summary displays,
they appear on the dates you specify, preceded by a double asterisk.

To schedule a multi-day appointment

1. From the Calendar menu, choose Add Multi-Day Appt.

 ECCO displays the Add Multi-Day Appointment dialog box.
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2. In the Beginning list box, select the date on which the appointment or event will
begin.

3. In the Ending list box, select the date on which the appointment or event will end.

4. Type a description for the appointment in the Appointment Text box.

5. Deselect Keep time available for meetings to block out days for group scheduling.

6. Choose the OK button to return to the summary display or, if the Calendar is
displayed in summary, choose the Jump to Notes button to add an outline note for the
multi-day appointment, and view the Calendar by day.  Outline notes do not appear in
summary displays.

Note: In any display of the Calendar, the Add Multi-Day command is also available from
a pop-up menu when you click the right mouse button.

Changing an Appointment

As your schedule changes, you will probably want to change the text or
settings of an appointment.

• To change an appointment’s description when the Calendar is displayed by day or in
detail, just select the description and edit the text.

• To reschedule an appointment quickly, drag it to a new time or date.  If the Calendar
is displayed in summary, the Change Time? dialog box appears.  Specify a new time,
or keep the same time, and choose OK

• If a Busybar is displayed, you can also reschedule an appointment by clicking the
middle of its Busybar block and dragging it to a new position in the Busybar.

• To change an appointment’s duration quickly, drag either end of its Busybar block to
make it longer or shorter.  As you drag, ECCO displays the duration in 15-minute
increments.

• If the Calendar is displayed by day or in detail, you can also select the appointment,
press F2 to select new times or a new date.  The date you enter need not be visible in
the Calendar.

• Or, to change any of an appointment’s settings, you can use the Date Settings dialog
box or the Edit Appointment or Tickler dialog box.

To change any of an appointment’s settings

1. If the Calendar is displayed by day or in detail, click the time to the left of the
appointment, or select the item and choose Time, Date, Alarm, etc., from the
Calendar menu, to open the Date Settings dialog box.  However, if the Calendar is
displayed in summary, click the appointment and, from the pop-up menu, choose
Modify to open the Edit Appointment or Tickler dialog box.

2. Take one or more of the following actions:
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• Select a new date in the date grid.  The appointment’s current date is bold and
underlined and the date currently selected in the Calendar’s Navigator is
highlighted in black.  To change the month or year, use the Mini-Navigator
above the date grid.

• Change the appointment’s beginning or end times, or both, using the hours and
minutes buttons.

• Create a tickler item for the appointment.

• Create an alarm for the appointment.

• Make the appointment a recurring event.

• Change the color of the appointment’s Busybar block.  Choose the Color button
and, from the pop-up menu, select a color.

• Create a group meeting.

• Edit the appointment’s description (in the Edit Appointment or Tickler dialog
box only).

3. Choose the OK button, or in the Edit Appointment or Tickler dialog box only, choose
the Jump to Notes button to add an outline note for appointment, and view the
Calendar by day.  Outline notes do not appear in summary displays.

Deleting Appointments

ECCO preserves appointments indefinitely unless you delete or archive them.  You can
delete an appointment from the Calendar only, or delete all occurrences of the item in all
ECCO views (for example, if you have dragged a name from the PhoneBook to the
Calendar).

To delete an appointment

1. Select the appointment you want to delete.

• If the Calendar is displayed by day, or by week or month in detail, from the Edit
menu, choose Delete Items.

• If the Calendar is displayed in summary, from the pop-up menu, choose Delete.

• If the appointment appears only in the Calendar, it is deleted.

• If the appointment appears in any other ECCO views, the Delete Items dialog
box appears (if the Calendar is displayed by day or in detail), or the Delete
Appointment or Tickler dialog box appears (if the Calendar is displayed in
summary).

2. If a dialog box appears, take one of the following actions:

• To delete the appointment from the Calendar only, select the Delete From
Calendar and Date Folder option, or the Delete From Calendar Only option.
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• To delete the appointment from all ECCO views, select the Delete entirely from
file (all Views) option.

3. Choose the OK button.

Ticklers:  To-Do’s and What’s Ahead
For many people, a simple list of calendar appointments isn’t enough of a memory aid.
You might also want to create a list of tasks to do each day.  Or you might want to keep
track of upcoming events so you can prepare for them.  To-do’s and reminders of
upcoming appointments or events appear as tickler items in the Tickler section of the
Calendar, when the Calendar is displayed by day or by week or month in detail.

The Tickler section can display the column pane.  Use columns such as “Priority” or “Hot
Issues” to prioritize your reminders efficiently.  Tickler items in the Tickler section can be
sorted by their text or column values, just like other items.  For more information, see the
chapter or online help on “Working with Items and Formatting.”  When the Calendar is
displayed by week or month in summary, tickler items appear above each day’s
appointments.

You can create and view two types of tickler items:

• Tickler items without specific times (to-do’s):  Type reminders directly into the
Tickler section, or add them to a date in a summary display.  For example, put a
shopping reminders or a phone call you want to make onto your daily to-do list
without assigning a time to them.

• Tickler items for appointments:  Create a tickler item for a scheduled appointment
(with a specific time) to remind you of it in advance.  For example, you could remind
yourself to prepare a project report several days before the meeting at which you’re
scheduled to present it.

If you have a large number of tickler items or appointments, you might want to expand or
collapse the folders in the Tickler section that contain tickler items by double-clicking the
folder icons.  You can also resize or rearrange the Tickler section and Appointment
section or show or hide tickler items from summary displays.  Just like appointments,
tickler items can have outline notes.

Creating a To-Do List

On any day, you might want to create a list of to-do tasks that do not have specific times,
such as calling a colleague or sending a birthday card.  You can create tickler items for
these tasks by entering them in the Tickler section or by adding them to any date
displayed in summary.

Note: Any item in the PhoneBook or in any Notepad can also appear in the Calendar as a
tickler item.  Select the item and, from the Tools menu, choose Ticklers.
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To add a tickler item to the Tickler section

The Tickler section appears when the Calendar is displayed by day, or by week or month
in detail.  If necessary, move to the date on which you want to add the to-do item before
you create it.

1. From the Calendar menu, choose Add Tickler, or click the Add button in the Tickler
section.

 The Add Tickler Item dialog box appears, with the event date shown as the date
selected in the Navigator.

2. In the Tickler Text list box, type a description for the tickler item.

3. In the Advance Warning list box, specify the number of days or weeks before the
event you want to begin showing the item in the Tickler section.

4. In the Carry Forward box, specify the number of days or weeks after the event you
want to show the item in the Tickler section.  By default, the tickler item will appear
until you mark it as done.

5. If you want, select a different folder in which to include the tickler item from the
Type of Tickler list box.  By default, the To-Do’s folder appears in the Tickler
section. If you add a tickler item to a different folder, such as Birthday or Start Dates,
that folder will appear in the Tickler section for as long as you specify that the item
appears.  If you select a different folder, the default beginning and ending settings
may change.

6. Choose the OK button.

Note: In any display of the Calendar, the Add Tickler command is also available from a
pop-up menu when you click the right mouse button.
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To add a tickler item in summary display of a week or month

1. Select a date and, from the Calendar menu, choose Add Tickler, or click on the date
and, from the pop-up menu, choose Add Tickler.

 The Add Tickler dialog box appears, with the event date shown as the date selected
in the Navigator.

2. In the Enter Reminder or To-Do text box, type a description for the tickler item.

3. If you want, take one or more of the following actions:

• Use the date grid or the Mini-Navigator to select a different event date.

• Select a different folder in which to include the tickler item.

• Choose the Tickler button to select beginning and ending settings for the item.

• Choose the Alarms button to create an alarm for the tickler item.

• Choose the Recur button to make the tickler item a recurring event.

4. Either choose the OK button to return to the summary display (the tickler item
appears on the date you specified, preceded by the name of its folder), or choose the
Jump to Notes button to add an outline note for the tickler item and view the
Calendar by day.  Outline notes do not appear in summary displays.

Note: To hide or show tickler items in summary displays, choose the Options command
from the Calendar menu, then choose the Ticklers tab and select Week and/or
Month under Show Ticklers in Summary Views for.

Creating Advance Warning for Your Appointments

Suppose you have an important meeting or presentation coming up.  It’s not enough to
have the event itself on your schedule; you might need reminders for a few days in
advance so you can prepare for the event.  Tickler items for appointments give you
advance warning as many days ahead of time as you need.

Tickler items for appointments (that have specific times) appear by default in the
Appointments folder in the Tickler section, when the Calendar is displayed by day, or by
week or month in detail.  Appointment ticklers do not appear in summary displays.

To create an appointment tickler item

The Calendar must be displayed by day, or by week or month in detail.

1. Click the time to the left of the appointment, or select the item and, from the
Calendar menu, choose Time, Date, Alarm, etc.

 The Date Settings dialog box appears.

2. Choose the Tickler button.

 The Item’s Calendar Tickler Options dialog box appears.
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3. Select the Show in Tickler Section option.

4. If you want, specify how many days or weeks before the event you want to begin
showing the item in the Tickler section and when to end showing the item.  By
default, the item will appear for the day of the event.  Selecting Until Marked Done
from the Carry Forward list box will keep the item in the Tickler until you mark it as
done.

5. Choose OK, and then choose the OK button in the Date Settings dialog box.

Note: Appointment tickler items do not appear in the Tickler section when the day of the
appointment is selected in the Navigator and the Calendar is displayed by day;
however, they do appear in the Tickler section when the Calendar is displayed by
week or month, in detail.

Changing a Tickler Item

As your schedule changes, you will probably want to change the text or settings of a
tickler item.  To change the description of a tickler item when the Calendar is displayed
by day or in detail, simply select the description and edit the text.

To change any settings for a tickler item

1. If the Calendar is displayed by day or in detail, click the date to the left of the tickler
item, or select the item and choose Time, Date, Alarm, etc., from the Calendar menu,
to open the Date Settings dialog box.  However, if the Calendar is displayed in
summary, click the tickler item and, from the pop-up menu, choose Modify to open
the Edit Appointment or Tickler dialog box.

2. Make the desired changes to the tickler item’s settings or description.  To change the
tickler item’s beginning and ending settings or its folder, choose the Tickler button to
display the Item’s Calendar Tickler Options dialog box.

3. Either choose the OK button, or in the Edit Appointment or Tickler dialog box only,
choose the Jump to Notes button to add an outline note for appointment, and view the
Calendar by day.  Outline notes do not appear in summary displays.

Marking Tickler Items as Done

Sometimes you need to be reminded of a task until you get around to doing it.  When you
create any tickler item, you can specify that it will be shown in the Calendar until you
mark it as done.  When you mark a tickler item as done, ECCO assigns it the current date
as the Done date.  ECCO removes the tickler item from the Tickler section; however, the
item is not deleted from the file.  The tickler item remains in any other folder or view to
which you may have added it.  For example, if you created the tickler item in the
PhoneBook or in a Notepad, it will still appear there after it is marked as done.

Marking items as done helps you keep track of what you have accomplished and lets you
use the item again in the future.  You can mark as done not only any tickler item but any
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item or outline note in any ECCO view.  By default, if your ECCO file was created using
any of the ECCO templates:

• All items you have marked as done appear in the Completed Work notepad in the
Done folder.

• The Done column appears in the column pane of the Calendar and in all Notepads.

You can also use the Folder window to add the Done folder (or insert the Done column)
in any ECCO view.  For more information about folders and columns, see the chapter or
online help on “Folders” and “Columns and Values.”

To mark an item as done

If the Calendar is the active view, it must be displayed by day or in detail.  If you want to
display the column pane, choose the Show Columns command from the Column menu.

1. Select the item.

2. From the Item menu, choose Mark as Done or, in the column pane, click the item’s
cell in the Done column.  The item is marked as done on today’s date.  When you
select the item, a checkmark appears next to the Mark as Done command on the Item
menu.

Note: To change an item’s Done date, in any ECCO view, click its cell in the Done
column and edit the date in the appointment edit box.

To remove a tickler item from the Calendar by changing its
settings

1. If the Calendar is displayed by day or in detail, click the date to the left of the tickler
item, or select the item and choose Time, Date, Alarm, etc., from the Calendar menu,
to open the Date Settings dialog box.  However, if the Calendar is displayed in
summary, click the tickler item and, from the pop-up menu, choose Modify to open
the Edit Appointment or Tickler dialog box.

2. Choose the Tickler button.

 The Item’s Calendar Tickler Options dialog box appears.

3. Select the Don’t Show option.

4. Choose the OK button, and then choose the OK button in the Date Settings dialog
box or the Edit Appointment or Tickler dialog box.
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Using Alarms
Alarms are reminders that occur at a specified time.  They either appear as a message on
your computer screen, play a sound, or launch a file.  Alarms can occur at the time of an
event (such as a meeting), or minutes, hours, days, even weeks before or afterwards.
Attach alarms to any item or appointment, or create them without attaching them to an
item in any ECCO view.

ECCO has two types of alarms:

• A simple alarm goes off once, at the time you specify, and displays a text message.

• A custom alarm can go off at the time of the event and at multiple times before and
after the event.  It can display a message, play a sound, or launch a document,
application, or batch file.  For example, you could set a custom alarm to launch your
presentation program every morning for a week before the presentation is due, and
set follow-up alarms after the event to remind you to finish a follow-up report or
mark an item as done.  You can also rename a custom alarm, add it to the Alarms
menu, and use it repeatedly.

When you set an alarm for a tickler item in the Tickler section of the Calendar, an alarm
icon appears to the right of the item’s text, in the status area.  If ECCO is running when
the alarm is scheduled to occur, ECCO displays the alarm message, plays the sound, or
launches the application, even if you are currently working in another application.  If
ECCO is not running when an alarm is scheduled to occur, the Alarms Occurred dialog
box appears when you restart ECCO.  When any alarm occurs, you can make it occur
again later by specifying the next alarm time for the event.

Setting Simple Alarms in the PhoneBook or a Notepad

A simple alarm can display the text of the selected item (including appointments and
tickler items).  You can also set a simple alarm that is not associated with any item, but
displays a message of your choice.  For example, if you need to remind yourself to pick
up your dry cleaning on your way home, you can set an alarm and type a reminder
message for that task.

To set a simple alarm

1. If you want the alarm to display the text of an item, select the item.

2. From the Tools menu, choose Alarms, and then choose Create New Alarm.

 ECCO displays the Create An Alarm dialog box.
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3. In the Date list box, select a date.

4. To set a time for the alarm, use the Hours and Minutes buttons.  If you do not set a
time, the alarm will occur at the start of the day of the event.  You can specify the
start of your day using the Calendar Options command on the Calendar menu.

5. If you want the alarm to display the text of the item you selected, either select the
Attach Alarm To Selected Item option or, in the Alarm Text box, type the message
you want the alarm to display and make sure that the Attach Alarm To Selected Item
option is not checked.

6. In the Type list box, select Simple Alarm if it is not already selected.

7. Choose the OK button.

 When the alarm occurs, ECCO displays a dialog box with the message or item text
you specified.

Note: You can also set alarms from the Date Settings dialog box or, when the Calendar is
displayed in summary, from any of the dialog boxes you use to create or modify
appointments or tickler items.

Setting Custom Alarms in the PhoneBook or a Notepad

You can set custom multiple alarms for any event and before and after the event.  You can
also rename any custom alarm and use it again later.

Note: Named alarms that you create in your shared files are also available to anyone who
has the proper access privileges for your ECCO view.

To set a custom alarm

1. If you want the alarm to display the text of an item, select the item.

2. From the Tools menu, choose Alarms, and then choose Create New Alarm.

 ECCO displays the Create an Alarm dialog box.

3. In the Date list box, select a date.

4. To set a time for the alarm, use the Hours and Minutes buttons.  If you do not set a
time, the alarm will occur at the start of the day of the event.  You can specify the
start of your day using the Calendar Options property sheet by selecting Options from
the Tools menu, then choosing the Appointments tab.
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5. If you want the alarm to display the text of the item you selected, either select the
Attach Alarm to Selected Item option or, in the Alarm Text box, type the text you
want the alarm to display and make sure that the Attach Alarm to Selected Item
option is not checked.

6. In the Type list box, select Custom.

 ECCO displays Custom Alarm dialog box.

7. Take one or more of the following actions:

• Select the Invoke Alarm at Time of Event option if you want the alarm to go off
at the time of the event.

• If you want, choose additional alarms before and after the event by clicking or
dragging in the drop-down number menu.  Selecting multiple numbers will cause
alarms to occur at multiple times before or after the event.  You can select any
number of minutes, hours, days, or weeks (up to six weeks).

• To reuse the same alarm settings in the future, select the Add to Menu option,
and then type in the Rename box a new name for your alarm.

• Your named alarm will appear in the Type list in the Create an Alarm dialog
box, as well as at the bottom of the Alarms menu (displayed from the Date
Settings dialog box or the Edit Appointment or Tickler dialog box).

• To specify other alarm actions, choose the Options button.

8. Choose the OK button, and then choose the OK button in the Create an Alarm dialog
box.

Note: You can also set alarms from the Date Settings dialog box or, when the Calendar is
displayed in summary, from any of the dialog boxes you use to create or modify
appointments or tickler items.

Specifying Alarm Actions

In addition to displaying a message with the text of the item, custom alarms can also:
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• Play any sound (.WAV file) in your computer.

• Display any dialog message you type.

• Launch files, programs, or batch files.  For example, an alarm can launch your word-
processing program to remind you that you need to send a memo to your staff, or
launch a batch file that backs up your files at a certain time every day.

To specify alarm actions

1. From the Tools menu, choose Alarms, and then choose Create New Alarm.  In the
Type box, select Custom.

 The Custom Alarm dialog box appears.

2. Choose the Options button.

 The dialog box expands, displaying options for setting alarm actions.

3. Take one or more of the following actions:

• To display a custom message instead of the item’s text, select the Dialog
Message option and then type your message.

• To play a sound, either select the Play Sound option, and then choose the
Browse button to search for the .WAV file you want, or type the path, including
the filename, of the sound you want to play.

• To launch a document or a batch file, either select the Launch Document/.BAT
File option, and then choose the Browse button to search for the file you want, or
type the path, including the filename, of the file you want to launch.

• To display a dialog box that lets you confirm before launching, select the
Confirm Before Launch option.

4. Choose the OK button.
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Note: You can also set alarms and specify their actions from the Date Settings dialog box
or, when the Calendar is displayed in summary, from any of the dialog boxes you
use to create or modify appointments or tickler items.

Before ECCO can launch a document file, you must use Windows Explorer or File
Manager to associate its file extension with a program.  For more information, see the
chapter or online help on “Using ECCO with Other Programs.”

Setting Alarms in the Calendar

In the Calendar, you can use the Date Settings dialog box to set simple or
custom alarms quickly for any existing appointment or tickler item.

To set alarms in the Calendar

1. If the Calendar is displayed by day or in detail, click the time to the left of the
appointment or tickler item, or select the item and choose Time, Date, Alarm, etc.,
from the Calendar menu, to open the Date Settings dialog box.  However, if the
Calendar is displayed in summary, click the appointment or tickler item and, from the
pop-up menu, choose Modify to open the Edit Appointment or Tickler dialog box.

2. Choose the Alarms button to display the Alarms menu.

3. Take one or more of the following actions:

• To create a custom alarm, choose Custom, and specify the event times and,
optionally, alarm actions.

• To set a simple alarm that will occur only at the event time and will display the
text of the appointment or tickler item, choose Simple Alarm.  If you selected a
tickler item, the alarm will occur at the start of the day of the event.  You can
specify the start of your day using the Calendar Options command.

• To set a previously-named alarm, select it from the Alarms menu.

• To cancel existing alarms for the selected item, choose None.

4. Choose the OK button in the Date Settings dialog box or the Edit Appointment or
Tickler dialog box or, in the Edit Appointment or Tickler dialog box only, choose the
Jump to Notes button to add an outline note for appointment or tickler item, and view
the Calendar by day.  Outline notes do not appear in summary displays.

Note: When the Calendar is displayed in summary, you can also set alarms from any of
the dialog boxes you use to create appointments or tickler items.

Canceling an Alarm

When you no longer need an alarm, you can:
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• Cancel the alarm in the Calendar by opening either the Date Settings dialog box, the
Edit Appointment, or the Tickler dialog box, choosing the Alarms button, and by
then choosing None.

• Delete the item with which the alarm is associated.

• Delete the alarm from the Review Alarms dialog box, from the Manage Named
Alarms dialog box, from the PhoneBook, or from a Notepad.

Reviewing Alarms

To see all alarms you have set in all ECCO views, or to delete an alarm you no longer
need, use the Review Alarms command in any ECCO view.

To review alarms

1. From the Tools menu, choose Alarms, and then choose Review Alarms.  The Review
Alarms dialog box appears, displaying all alarms set for the current week.

2. Take one or more of the following actions:

• To see alarms occurring in a week other than the current week, choose the down
arrow next to Alarms Occurring The Week Of and select a different date.

• To delete an alarm, select the alarm you want to delete and then choose the
Delete button.

3. When you are finished, choose the OK button.

Managing Named Alarms

Named alarms are custom alarms that you have created, named, and added to the Alarms
menu (displayed from the Alarms button in the Date Settings dialog box or the Edit
Appointment or Tickler dialog box).  Named alarms also appear in the Type list in the
Create An Alarm dialog list box.  If your ECCO file was created from a template, it may
contain additional default named alarms, such as 5 Minutes Before, 30 Minutes Before,
etc.  ECCO lets you edit or rename existing named alarms, delete named alarms, or
reorder named alarms on the Alarms menu.

To manage named alarms

You can manage named alarms in any ECCO view.

1. From the Tools menu, choose Alarms, and then choose Manage Named Alarms.  The
Manage Names Alarms dialog appears.

2. Take one or more of the following actions:

• To rename an alarm, select the alarm you want to rename, and then type in the
Rename box the new name you want to give the alarm.

• To create a new named alarm, choose the New button.
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• To edit a named alarm, select the alarm you want to edit, and then choose the
Edit button.

• To delete a named alarm, select the alarm you want to delete, and then choose
the Delete button.

• To reorder named alarms on the Alarms menu, select the alarm you want to
move, and then choose either the Up or Dn reorder button.  The New Named
Alarm dialog box and the Edit Named Alarm dialog box are similar to the
Custom Alarm dialog box.

3. When you are finished, choose the OK button.

Using Recurring Events
Recurring events are activities that happen at regular intervals—events such as weekly
appointments or bimonthly conference calls.  When you specify an event as recurring,
ECCO automatically displays the event at the dates and times of your choice in your
Calendar.

By using recurring events, you can:

• Save time.

• Be certain that you’ll remember events that happen regularly.

• Avoid scheduling conflicts.  If you schedule another appointment that coincides with
the recurring event, a red-and-white striped pattern in the Busybar block alerts you to
the conflict.  Or, if you schedule a recurring event that conflicts with holidays or
weekends, ECCO displays a dialog box listing the conflicts.

You can create events recurring as frequently as every day or as far apart as every 20
years. For example:

• Weekly status reports (due the same day every week)

• Payroll (1st and 15th  of every month)

• Board meetings (first Tuesday of every month)

• Estimated taxes (four times a year)

• Annual reports (yearly)

Creating Recurring Events

ECCO offers you two types of recurring events:
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• Standard recurring events are based on the current date selected in the Calendar’s
Navigator.  For example, if the current date is Friday, September 5, 1997, ECCO
gives you the following choices:  every day, every Mon thru Fri, every Friday, the 5th

of every month, the first Friday of every month, and every September 5th.

• Custom recurring events can be set for almost any time period, such as the 11th,
12th, and 13th of each month.

Once you’ve created a recurring event, a recurring event icon appears in the status area to
the right of the item with which it’s associated, in the Calendar’s Tickler section or
Appointment section.

Note: When a date column is visible in any ECCO view, you can also make an item a
recurring event by clicking its cell in the column and selecting the down arrow in
the appointment edit box to open the Date Settings dialog box.

To create a recurring event

1. If the Calendar is displayed by day or in detail, click the time to the left of the
appointment or tickler item, or select the item and choose Time, Date, Alarm, etc.,
from the Calendar menu, to open the Date Settings dialog box.  However, if the
Calendar is displayed in summary, click the appointment or tickler item and, from the
pop-up menu, choose Modify to open the Edit Appointment or Tickler dialog box.

2. Choose the Recur button to display the Recur menu.  The commands on this menu
change depending on the date selected in the Calendar’s Navigator.

3. To create a standard recurring event, choose an interval of recurrence from the Recur
menu.

4. To change an existing selected recurring event so that it does not recur, choose Non-
Recurring.

5. To create a custom recurring event, choose Custom, and take one or more of the
following actions in the Recurring Event dialog box before choosing the OK button:

• In the Type list box, select the time increment you want for the recurring event
(daily, weekly, monthly, or yearly).

• In the On list box, select as many options as you want.

• In the Repeating list box, select the frequency with which you want the event to
recur.  For example, if you selected Weekly in the Type list box, you could
choose the Every 2 Weeks option in the Repeating list box to have the recurring
event scheduled at two-week intervals.  If you selected the Monthly option in the
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Type list box, a Specific Months option is available.  This option lets you select
multiple months, such as January, April, July, and September.

• In the Until list box, select the date on which you want the event to stop
recurring.

6. Choose the OK button in the Date Settings box or the Edit Appointment or Tickler
dialog box or, in the Edit Appointment or Tickler dialog box only, choose the Jump
to Notes button to add an outline note for the recurring event and to view the
Calendar by day.  Outline notes do not appear in summary displays.

Note: ECCO lets you combine recurring events with alarms in powerful ways.  For
example, to help yourself reduce eye and muscle strain from sitting too long at
your computer, make a tickler item that recurs every weekday, and has a custom
alarm with an “ergonomic” dialog message such as “Get up and stretch now.”  Set
an event time for the alarm an hour after your day begins, and follow-up alarms
every hour for the next six hours (or at any times you specify).  If you choose not
to show the item in the Tickler section, you won’t clutter your Calendar with the
recurrences, and ECCO will still remind you to stretch several times every day.

Changing Recurring Events

You can change a recurring event by changing its recurrence options or by changing its
other options in the same way that you change any appointment.

If you change the time or duration of a recurring event by using the Date Settings dialog
box, the Edit Appointment dialog box, or the Tickler dialog box, the Change Recurring
Event dialog box appears. You can change the time of:

• All recurrences

• The selected recurrence

• Future recurrences

For example, if your weekly staff meeting changed from 10 a.m. to 11 a.m. for one week
only, you would change the selected recurrence only (which is the default option).
However, if the meeting permanently changed to 11 a.m., you would change future
occurrences only.  The Calendar would still reflect all past occurrences at the time they
occurred.

If you change a recurring event’s time or duration by dragging the Busybar block or its
ends or by dragging the appointment item to a new time slot, ECCO changes the selected
occurrence only.

To change the date of the selected occurrence only, select another date with the date grid
or Mini-Navigator in the Date Settings dialog box or Edit Appointment or Tickler dialog
box.

To change the date for all occurrences, or to change the event so it does not recur, use the
Recur menu to select another recurrence interval or select Non-Recurring.
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Any changes to the recurring event’s description, Tickler options, alarms, or Busybar
block color are reflected in all occurrences of the event.

You can create different outline notes for each occurrence of a recurring event.  For
example, a weekly class can have unique lecture notes for each week.  To see all notes for
all occurrences of a selected recurring event, from the Calendar menu, choose See All
Recurring Notes.  Choose the command again (so that its name is unchecked on the menu)
to see only the notes for the selected occurrence.

Canceling Recurring Events

You can cancel a recurring event in three ways:

• Delete the item with which a recurring event is associated.  In the dialog box that
appears, select to delete the selected recurrence(s) only, future recurrences only, all
recurrences, or delete the item entirely from the file in all views (if the item appears
in more than one ECCO view).  You delete a recurring event in the same way that
you delete any appointment.

• Specify an earlier expiration date for the event in the Recurring Event dialog box.

• Cancel the recurring event without deleting the item by changing the event to non-
recurring.

Adding Outline Notes
For some appointments or tickler item reminders, you might want to include additional
background information, directions to a location, or a list of points to be discussed at a
meeting.  With ECCO, you can include a detailed outline as part of the description of any
item.  For more information, see the chapter or online help on “The Notepad and
Outlining.”

If your appointment or tickler item is a recurring event, your outline notes can be
displayed for every occurrence or be specific to one occurrence.  For example, you can
set up a recurring event for a weekly staff meeting and use outline notes to write new
agenda notes each week.

Use outline notes to describe an appointment or item

Note: Outline notes do not appear in summary displays of the Calendar.
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To make your outline notes distinctive, you can apply outline styles, outline labels, or
other formatting.  For more information, see the chapter or online help on “Working with
Items and Formatting.”

To add an outline note in day display, or in detail display of a
week or month

1. Select the appointment or tickler item.

2. From the Calendar menu, choose Add Outline Note.  ECCO inserts an outline note or
subitem to the right of the appointment or tickler item.

3. Type descriptive information in the outline note.  Each time you press Enter another
subitem is added at the same heading level.

Note: In day or detail display, you can also add outline notes by pressing CTRL+R. Or,
when an appointment is selected, you can simply press ENTER.

To add an outline note from summary display of a week or
month

1. Click an existing appointment or tickler item and, from the pop-up menu, choose
Modify.

 The Edit Appointment or Tickler dialog box appears.

2. Choose the Jump to Notes button.

 ECCO displays the Calendar by day, for the selected date, and adds an outline note to
the selected appointment or tickler item.

3. Type descriptive information in the outline note.

Note: You can also create outline notes while you create appointments or tickler items in
summary displays by using the Jump to Notes button in the respective dialog
boxes.

To display or hide all outline notes for a recurring event

The Calendar must be displayed by day, or by week or month in detail.

1. Select the recurring appointment or tickler item.

2. From the Calendar menu, choose See All Recurring Notes.

 While this command is chosen and while its name is checked on the menu, ECCO
displays all outline notes from all occurrences of the selected recurring event.  When
the command is not chosen, ECCO displays only the outline notes for the selected
occurrence.
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Using Columns in the Calendar
When the Calendar is displayed by day, or by week or month in detail, you can display
the column pane in the Tickler and Appointment sections by choosing the Show Columns
command on the Column menu.  To close the column pane, choose the Show Columns
command again.

By default, most ECCO files created from a template contain:

• The Priority, Hot Issues, and Done columns in the Tickler section

• The Done folder in the Completed Work notepad

Organize your tasks more efficiently by assigning priority to your tickler items.  The
Priority column is a pop-up list column; use its default values (Low, Medium, and High)
or add your own values.

To add a new value to a pop-up list column

1. Click a cell in the pop-up list column, or select a cell and press ENTER.

2. Choose <Edit Values> from the pop-up list.

 The Pop-up List Column Values dialog box appears.

3. Choose the New Pop-Up Value button.

4. Type over Value 1 as it appears in the Edit Pop-up Value box.

5. Choose the OK button.

 The new value appears in the column’s pop-up list.

To sort items by their column value, go to the column, click the right
mouse button, and choose the Sort, Sort Up, or Sort Down command.
For more information, see the chapter or online help on “Working with
Items and Formatting.”

Using the Done column to mark items as done also adds them to Done folder in the
Completed Work notepad.  Similarly, if a folder appears in one view and also appears as
a column in another view, any value you give it will appear in both locations.

For example, if your file contains the Hot Issues folder in a Hot Issues notepad, when you
check the Hot Issues column for a tickler item in the Calendar, the item also appears in
the Hot Issues notepad.  If you assign a date value to any item in the PhoneBook or any
Notepad using any date column or folder, ECCO displays the item in the Calendar as well
as in the original view.

When the Tickler section is displayed beside the Appointment section (rather than above
it), you can display a different column pane for each section.
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You can also:

• Add other columns to a column pane.  For more information, see the chapter or
online help on “Columns and Values.”

• Add the Appointments folder or To-Do folder as a folder column to the PhoneBook
or to any Notepad.  For more information, see the chapter or online help on
“Folders.”

• Use filters to see only the appointments or ticklers that have specific column values.
For more information, see the chapter or online help on “Other ECCO Features.”

• Use a form to add an appointment or tickler item and to specify multiple column
values at once.  For more information, see the chapter or online help on “Forms.”

Printing Your Schedule
ECCO gives you a variety of options for printing your Calendar.  You can print:

• A specified day, week, month, or range of dates

• All items, or only selected items and their subitems

• Appointments, tickler items, or both

• Detail or summary displays

• Outline notes

• Columns

You can also use special calendar formats and page sizes, such as Day Timer™.  When
you select a set of print options, you can save them as a print catalog to reuse them
without having to specify them all again.  For more information, see the chapter or online
help on “Printing.”

Working with Related Dates
Related dates help you track appointments and ticklers that relate to the same project or
activity.  They are a group of items in the Calendar whose dates can change depending on
the outcome of some other date.  These dates can have a single anchor date or be linked
to each other in a chain.

Anchor Dates

Suppose an attorney has a court date on Monday, April 28.  Almost every task for this
case is related to the actual court date.  If the court date changes, it is essential that all
tasks related to the court date change with it.  The court date is the anchor date because
all other tasks are dependent on it.
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Chained Dates

Consider a construction project.  The masons must pour the foundation to allow the
framers to build the house, which will allow the roofers to build the roof, so that the
painters can paint, and so on.

If the framers are a week late building the house, the roofers’ schedule will get pushed out
a week, which in turn will push out the painters’ schedule a week.  Dates such as these, in
which each is dependent on the date item that precedes it, are called chained dates.

Creating Related Dates

There are two ways to create related dates:

• You can base a group of dates on a single anchor date.  If you change the anchor
date, all dates change in relation to it.

• You can link dates in a chain.  If you change one date, all related dates following it
change.

To create related dates based on an anchor date

1. In the Calendar, select the date item that you want to use as the anchor date.

2. From the Calendar menu, choose Add Related Dates.

 ECCO displays the Add Related Dates dialog box.

3. Choose the Options button.

 The Related Date Options dialog box appears.

4. Choose Single Anchor Date to make the currently selected appointment item the
anchor date.  Single Anchor Date is the default.

5. Choose OK.

6. In the New Appointment Date section, do one of the following:
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• Enter a date before or after the anchor date.

• Use the Date Interval field to quickly navigate x number of days in the future or
past.  To navigate thirty days before the anchor date, type -30.

Note: Entering a value in either of these fields automatically updates the other.  For
example, if you enter a date in the Choose a Date field, the Specify Date Interval
field automatically displays the number of days to the anchor date.

7. In the Date Interval Calculation section, specify how the date interval is calculated:

• Counting business days only:  Subtracts weekends from the total number of
days from the anchor date.

• Falling on first available business day:  Calculates the interval based on the
first available business day.

8. In the New Appointment Time section, change the appointment time or check No
Time to display the item in the Calendar Tickler section.

9. Choose the Add button.

10. Repeat the process for all new dates related to the anchor date.

To create related dates that are chained

1. In the Calendar, select a date item.

2. From the Calendar menu, choose Add Related Dates.

 ECCO displays the Add Related Dates dialog box.

3. Choose the Options button.

 The Related Date Options dialog box appears.

4. Choose No Anchor Date, and then choose OK.

5. In the New Appointment Description box, enter the text for the new appointment.

6. In the New Appointment Date section, do one of the following:

• Enter a date before or after the previously entered related date.

• Use the Date Interval field to quickly navigate x number of days in the future or
past.  To navigate thirty days before the previously entered date, type -30.

7. In the New Appointment Time section, change the appointment time or check No
Time to display the item in the Calendar Tickler section.

8. Choose the Add button.

9. Repeat the process for all new dates related to this group.

Note: You can select any of these related dates and add additional dates to the group.
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Viewing Groups of Related Dates

By viewing all of your related appointments, you can deal with all dates in the group at
one time, print a report of those appointments, and make any changes and updates.

To show related dates

1. Select a date from the group of related dates you want to view.

2. From the Calendar menu, select Show Related Dates.

 The dates will be displayed in the Search Results notepad.

Note: You cannot view related dates when Calendar is displayed by year.

Modifying Related Dates

Once you have created a set of related dates, they can be modified like any other date.  If
the date you want to modify is the group’s anchor date, or if you have created related
dates without an anchor, ECCO displays the following options:

• Adjust all dates on or after today’s date:  Adjusts all the dates that fall on today’s
date or later.

• Adjust all dates on or after the currently selected calendar date:  Moves all
related appointments that occur after the current appointment’s date and time.

• Don’t adjust any other dates in the group:  Modifies only the selected date.

Page 62



ECCO User’s Guide52

Page 63



53 ECCO User’s Guide

Chapter 4.  The PhoneBook
To display the PhoneBook, choose PhoneBook from the View menu, or choose the
PhoneBook tab.

• PhoneBook toolbar:  Using the PhoneBook toolbar buttons, you can perform the
same functions that you can using the PhoneBook menu, such as search for and
collect PhoneBook entries, find the next instance of specified search text, query the
PhoneBook by form, dial and log phone calls, and make an appointment in your
calendar.

• PhoneBook menu:  The PhoneBook menu commands let you perform basic
PhoneBook actions, such as entering new and editing existing PhoneBook entries.
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• PhoneBook list:  The PhoneBook list displays PhoneBook items.  When you enter a
name in the PhoneBook, ECCO converts it into an item.  Each item has an item bullet
to its left.

• Entry form:   You enter names, numbers, addresses, and other information into the
fields in the entry form.  You also use this form to view or make changes to existing
entries.  The PhoneBook entry form is customizable.

• Column pane:  The column pane provides an alternate display of the information,
other than the name, that you entered using the entry form.

• Search button:  Search for any text in the PhoneBook (names, outline notes,
companies, or any field information) by typing text in the Search For field and then
choosing the Search button.  Choose the Search button with the search edit box
empty to collect all names in the PhoneBook.

• Next button:  Choose this button to highlight the next instance of the search text in
the displayed PhoneBook items.  You need to enter text in the Search For field for
this function to work correctly.

Introduction to the PhoneBook
You can use the PhoneBook to record names, numbers, and addresses in your ECCO files
just as you would in any address book.  However, the ECCO PhoneBook offers you much
more than a paper address book does.

In the PhoneBook you can:

• Enter information into the PhoneBook using the straightforward, customizable
entry form.

• Add outline notes using the ECCO outlining features. Enter any number of outline
notes for each name in the PhoneBook.

• Search for an entry that matches a specified single character, multiple characters, a
word, or a phrase.  You can search for a person's name, a company's name, outline
notes, or any other information you enter in the PhoneBook form.

• Create and track any number of Calendar appointments for any name in your
PhoneBook.

• Dial any number saved in the PhoneBook.  Let ECCO search for it and do the
dialing for you.

• Automatically log the time, date, and duration of every call you make.

• Import from another software program the file that you currently use as your on-
line phone or address book.  You can import any file that can be saved as a CSV
(comma-separated value) or as a tab-separated text file.

• Organize names in the PhoneBook by collecting them in ECCO folders.

• Display columns of custom information about the names in the PhoneBook.
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• Apply filters  to the PhoneBook to display only those names that meet search criteria,
based on any field or column.

• Customize the PhoneBook entry form to display only those fields into which you
customarily enter information.

Introduction to Entering Information
To enter and update PhoneBook information, you use an entry form similar to a paper
form.  To enter new information, simply fill in the blanks.  You can use the entry form to:

• Add new entries

• Edit or update existing entries

When you add information to the PhoneBook, the name (or item) is displayed in the
PhoneBook list, and the rest of the information is displayed in the column pane.  The
name plus its associated information (address, phone number, and so on) is called an
entry.

Adding New PhoneBook Entries
Use the New PhoneBook Name dialog box to add new entries to the PhoneBook.

To add a new entry

1. From the PhoneBook menu, choose New Name.

 Or

 Choose the New Name button on the toolbar.  The New PhoneBook Name form
appears.

2. In the Name field, type the name you want to add, last name first.
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3. Press the TAB key to move to the next field.

4. Type information in all applicable fields.

5. To indicate which address you'd like ECCO to use when printing, select either
Business or Home next to Address to use when printing.

6. When you have finished filling in the fields, choose the Add button.

7. To add another entry to the PhoneBook, repeat steps 2 through 6.

8. When you have finished adding entries to the PhoneBook, choose the Close button.

 The name (or item) is displayed in the PhoneBook list, and the name plus the
remainder of the information is displayed in the entry form.  You can use the entry
form to edit or add information to the entry.

You can display the column pane and add more columns to the PhoneBook.  Use columns
to display additional information about your PhoneBook entries or use them to filter the
entries displayed in the view.

Editing Entries
Use the PhoneBook entry form to edit PhoneBook information.

To edit an existing entry

1. In the PhoneBook list, select a name.  All information associated with the name
appears in the form.

2. If the entry form is not displayed, from the PhoneBook menu, deselect Hide Form or
press CTRL+ALT+H.

3. Type new information as desired.  Press the TAB key or SHIFT+TAB to move forward
or backward through the fields.  The entry is modified to include your changes.

Adding Outline Notes to an Entry
For some entries, a name, an address, and a phone number might be adequate. With
ECCO, you can also include a detailed outline as part of the description of any entry.
Your outline could include any or all of the following:

• A log of all conversations.

• A log of all appointments and outline notes for those appointments.

• Additional information about the person or company, such as directions to a home or
business or a list of topics to discuss the next time you talk on the phone.

• Any letters or faxes sent using the Correspondence Manager.
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To add outline notes to an entry

1. Select the entry to which you want to add outline notes.

2. Press the ENTER key.

 Or

 From the PhoneBook menu, choose Add Outline Note.  ECCO inserts a blank line for
a subitem below and to the right of the entry item.

3. Type information in the subitem line.  Each time you press ENTER, an additional
blank line and subitem is added at the same heading level.

4. To move an item up or down in the outline or to promote or demote an item in the
outline, drag the item bullet (located at the left of the item) to the desired location.

 Or

 Select the item and then press ALT+LEFT ARROW or ALT+RIGHT ARROW.

5. You can expand or hide the outline levels by double-clicking the item bullet.

Deleting Entries
To delete a PhoneBook entry, you select the entry's item bullet and then delete it.  The
associated information is deleted along with it.

To delete an entry

1. Select the item you want to delete.

2. From the PhoneBook menu, choose Delete Name.

 Or

 Press CTRL+D.

Creating Custom PhoneBook Entry Forms
In addition to using the standard PhoneBook entry form, you can also create custom
PhoneBook forms to accommodate your special needs.

To create a custom PhoneBook entry form

1. From the PhoneBook menu, choose Change PhoneBook Form, and then choose New.
The Create Phone Form dialog box appears.

2. In the Rename box, type a name for your custom PhoneBook entry form.  This name
will appear in the Change PhoneBook Form submenu.

Page 68



ECCO User’s Guide58

3. In the Choose Fields list, select all the fields you want to add to your form.  To select
multiple fields, hold down the CTRL key or the right mouse button while clicking each
field you want to select.

4. Choose the Add button.

 The fields you selected appear in the Fields Chosen list.

5. Take one or more of the following actions:

• To remove a field from the Fields Chosen list, select the field, and then choose
the Remove button.

• To change the order in which a chosen field appears on the form, select the field,
and then choose either the Up or Dn Reorder button.

• To create a new entry field, choose the New Field button. In the New Field &
Column dialog box, enter a name for the new field and select its type.

6. Choose the OK button.

 The new entry form appears.

7. Choose the OK button again to return to the PhoneBook window.

Displaying and Hiding PhoneBook Entry Forms
Use the Change PhoneBook Form submenu to switch between entry forms.  Use the Hide
Form command on the PhoneBook menu to show or hide the PhoneBook entry form.

To display a different PhoneBook entry form

1. From the PhoneBook menu, choose Change PhoneBook Form.

2. From the Change PhoneBook Form submenu, choose a PhoneBook entry form.

To show or hide the PhoneBook entry form

From the PhoneBook menu, choose Hide Form to display or hide the PhoneBook entry
form. The form is either displayed or hidden.  You can also use CTRL+ALT+H to display or
hide the PhoneBook form.

Managing Multiple PhoneBook Entry Forms
ECCO lets you edit or rename existing PhoneBook entry forms, delete forms, reorder
forms on the Change PhoneBook Form submenu, or make forms public.  You perform all
these tasks from the Manage Phone Forms dialog box.

To manage PhoneBook entry forms

1. From the PhoneBook menu, choose Change PhoneBook Form, and then choose
Manage.
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 The Manage Phone Forms dialog box appears.

2. Take one or more of the following actions:

• To rename a form, select it, and then type the new name in the Rename field.

• To create a new form, choose the New button.

• To edit a form, select it, and then choose the Edit button.

• To delete forms, select them, and then choose the Delete button.

• To reorder forms on the menu, select them, and then choose either the Up button
or the Dn button.

• To make forms public (they must be made private first), select them, and then
select the Make Public checkbox in the lower-right corner of the dialog box.

3. When you have finished, choose the OK button.

Introduction to Finding PhoneBook Information
You can find and display PhoneBook entries in three ways:

• Click a letter tab to display all entries whose first name, last name, company, or any
other field begins with that letter.  The letter tabs are located along the left side of the
PhoneBook window.

• Search for entries that contain certain text.

• Query the PhoneBook to perform a more sophisticated search.

Specifying Search Options
Before clicking a letter tab or searching for a string of text, you can specify whether you
want to search by last name only or by last name and:

• first name

• notes

• company name and all other PhoneBook fields

You specify these options in the Search Options dialog box.

To specify search options

1. From the PhoneBook menu, choose Search Options.

 The Search Options dialog box appears.

2. By default, ECCO always searches by last name.  In the Search Options dialog box,
do one or more of the following:

• To search by last name only, deselect all checkboxes.
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• To search by first and last name, select the First Name checkbox.

• To search by last name and outline notes, choose Notes.

• To search by last name and company, or last name and all other PhoneBook
fields, choose Company or Fields.

3. Choose the OK button.

4. Search for PhoneBook entries by clicking a letter tab or searching for specific text.

Searching Using the PhoneBook Letter Tabs
You can quickly find the name you want by clicking the letter tab associated with the first
letter of the name.

To search using the letter tabs

1. To specify search options, from the PhoneBook menu, choose Search Options.

 The Search Options dialog appears.

2. Click a letter tab to display all entries beginning with that letter.  If you selected
Company or Fields in the Search Options dialog box, a pop-up menu appears.

3. From the pop-up menu, choose one of the following:

• To display all entries with names beginning with that letter, choose Name.

• To display all entries with company names beginning with that letter, choose
Company.

• To display all entries that have any field beginning with that letter, choose
Fields.

ECCO searches for, and collects in the PhoneBook list, all entries that match the specified
letter.

Searching for Specific Text
You can search for entries in the PhoneBook using multiple letters, a word, or a phrase.
You search for specific text using the Search For field, located on the PhoneBook toolbar.

To search for specific text

1. To specify search options, from the PhoneBook menu, choose Search Options.

 The Search Options dialog appears.

2. In the Search For field, type the text you want to search for.

3. Choose the Search button.  If you selected Company or Fields in the Search Options
dialog box, a pop-up menu appears.
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4. From the pop-up menu, choose one of the following:

• To display all entries whose name or notes contain the specified text, choose
Name & Notes.

• To display all entries whose company names contain the specified text, choose
Company.

• To display all entries that have any field containing the specified text, choose
Fields.  ECCO searches for, and collects in the PhoneBook list, all entries that
match the specified text.

5. Choose the Next button in the PhoneBook toolbar to highlight the first instance of the
search text in the entries collected in the PhoneBook list.

6. Continue choosing the Next button to move to each subsequent instance of the search
text.

Querying the PhoneBook
Use the Query By Form dialog box to search for entries matching specific criteria.  To
display the Query By Form dialog box, choose the Query button.

For example, you may want to search for all clients who live in the Seattle area and who
have a 98111 ZIP Code.  Or, if you have international clients, you could easily search for
all clients from a particular country using the Query By Form dialog box.

When querying, you can specify that ECCO match:

• all fields containing the search text

• any field containing the search text

• text beginning with the specified search text

• text containing the specified search text

You can use a filter to limit your search even further, using columns not displayed in the
Query By Form dialog box.  For more information on filters, see the chapter or online
help “Other ECCO Features.”

To query the PhoneBook

1. Choose the Query button on the toolbar.

 The Query By Form dialog box appears.

2. Type search text into one or more PhoneBook fields.

3. Under Must Match, do one of the following:

• Select the Every Field option to search for entries that match all sets of search
text.
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• Select the Any One Field option to search for entries that match any of the sets
of search text.

4. Under Text, do one of the following:

• Select the Begins With option to search for entries that begin with the text.

• Select the Contains option to search for entries that contain the search text.

5. If you want to add a filter to your query, choose the Advanced button.

6. Select the column and item (such as Text contains), enter the correct item in the
Value field, then choose the Add button.  The search filter is added to the Find
entries that match text box in the Advanced Query Filter dialog box.

7. Choose the Close button to close the Add to filter dialog box.

8. Choose the OK button to return to the PhoneBook window.  If there are already
entries in the search filter, the Advanced Query Filter dialog box appears.

9. Choose the Add Line button to add a new entry to the search filter.

10. Choose the Modify button to change an existing entry in the search filter.

11. Choose the Delete button to remove an entry in the search filter.

12. Choose the OK button when you are done defining additional search criteria.

13. Choose the Search button. ECCO searches for, and collects in the PhoneBook list, all
entries that match your query.

About Displaying PhoneBook Information
If the PhoneBook contains more information than ECCO can display at one time, you can
scroll through the PhoneBook, hide parts of the PhoneBook, or resize sections of the
PhoneBook so you can see more information.

When displaying and viewing PhoneBook information, you can select an entry and view
all its information in the entry form.
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• Sort the entries in the PhoneBook list.  For example, you could sort the list by
company name.

• Apply filters to your PhoneBook.  For example, you might create a filter to display
all entries that have the same ZIP Code.

• Display all entries in the entire PhoneBook in the PhoneBook list.

Displaying All PhoneBook Entries
When you search for entries in the PhoneBook using the letter tabs, the Search box, or the
Query By Form dialog box, ECCO displays only the entries that match your search text.
Using the following procedure, you can display your entire PhoneBook.

To view all PhoneBook entries
• From the PhoneBook menu, choose Show All Names.  ECCO displays all names in

your PhoneBook.

 Or

• Choose the Search button with the Search for entry field blank.

Introduction to Dialing and Logging Calls
ECCO lets you keep track of the date, time, and duration of any call.  And if you have a
modem on the same line as your telephone, ECCO can dial phone numbers for you.

Dialing and logging is performed through the Dialer/Call Logger dialog box.  To display
the Dialer/Call Logger dialog box, choose the Telephone button on the PhoneBook
toolbar, or choose the Dial Phone command from the PhoneBook menu.

Setting Up Your Modem
By default, ECCO uses the Ports setting in the Control Panel.  ECCO also uses basic
Hayes prefix and suffix settings.  You should only need to verify that the correct COM
port for your modem is selected.

To set phone dialer settings

1. From the PhoneBook menu, choose Dial Phone.

 Or

 Choose the Telephone button. The Dialer/Call Logger dialog box appears.
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2. Choose the Setup button. The Phone Dialer Setup dialog box appears.

3. In the Prefix box, enter your modem's prefix or accept the default.

4. In the Modem Suffix box, enter your modem's suffix or accept the default.

5. In the Modem Port box, select the communications port to which your modem is
connected.

6. Choose the OK button.

Troubleshooting

If you experience problems when dialing from ECCO, consult the TECHINFO.ECO file
for troubleshooting techniques, access the NetManage News Server at
forum.netmanage.com, or call NetManage ECCO Technical Support at (206) 885-0559.

Dialing
If you have a modem, you can use ECCO to dial your phone numbers.

To have ECCO dial a phone number

1. Select the name of the person you want to call.

2. From the PhoneBook menu, choose Dial Phone.

 Or

 Using the right mouse button, select the name, and choose Dial Phone from the
menu.  The Dialer/Call Logger dialog box appears.

3. In the Prefix box, enter a dialing prefix (for example, 9 for an outside line).
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4. In the Suffix box, enter any additional numbers to be dialed (for example, an
extension or a calling card number).  For a 5-second delay before the suffix is dialed,
precede the suffix with a comma.

5. In the Phone # Choice box, select the type of phone number you want to dial (for
example, Work #, Home #, or Fax #).

6. The phone number appears in the Number to Dial field.  In the Select text for dialing
field, you can select only part of the number you want to dial.  The highlighted text
will appear in the Number to Dial field.

7. If you want ECCO to omit the local area code when dialing, select the Don't dial
local area code; local code is checkbox, and then type your area code in this field.

8. Choose the Dial button.

 ECCO dials the number for you.

9. When the connection begins ringing, pick up the phone receiver, and then choose the
Talk button to begin your conversation.

Note: If your phone is plugged into the “Phone” jack on your modem, you may not be
able to hear or use the handset until the Talk button is chosen.  Many modems
disable the phone jack while the modem is in use.

10. When the call is complete, hang up the phone, and then choose the Close button.

Logging Calls
ECCO can track the time, date, and duration of every call you make. All you need to
provide is a description of the call.  ECCO logs the duration of a call in five-minute
increments.

To log a call

1. Select the name of the person you want to call.

2. From the PhoneBook menu, choose Dial Phone.

 The Dialer/Call Logger dialog box appears.

3. Choose the Log >> button.

 The Dialer/Call Logger dialog box expands to display the Call Logging button.
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4. Dial the number manually, and then choose the Begin Logging button.

 ECCO begins logging the duration of your call and inserts a "Logged Call" subitem
under the contact's name

5. Choose the Close button to stop logging your call.

To view time, date, and duration of a logged call

1. Scroll through the column pane to find the Phone Log column.  If the column pane is
not displayed, choose Show Columns from the Column menu.

2. In the Phone Log column, click the cell associated with the call for which you want
information.  A date value edit box displaying the date, time, and duration of the call
appears.  Logging durations are kept in five minute increments.  When you have
finished viewing the information, choose the ENT (Enter) button or the ESC button.

Logging Time
There are times when you may want to log the duration of activities that are not phone
related.  For example, you may want a record of the time spent writing a contract or
researching a topic for a client.  ECCO provides a time logging feature for tracking these
tasks.

To log the duration of a task

1. From the Tools menu, choose Time Logger.

 The Time Logger dialog box appears.

2. Select one of the following options:

• Below Selected Item:  Adds a blank subitem and begins logging.

• To Time & Expenses View:  Adds to the Time & Expenses view if it exists; if it
doesn't exist, it creates one.

• To Both:  Adds the logged item below the selected item and to the Time &
Expenses view.

3. To start timing the activity, choose the Begin button.

 The Elapsed Time dialog appears.
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4. Add notes about the task to the "Time Logged" item.

5. When you are finished, choose the Done button.

 ECCO logs the duration of the task in five-minute increments.

Importing, Exporting, and Mail Merge
You can import into the PhoneBook an existing database or text file of names, addresses,
and numbers.  Or, you can import phone book information from another personal
information manager into your ECCO PhoneBook.  You can import these files in two
formats: .TXT (text) or .CSV (comma-separated values).

You can also export PhoneBook information to other programs.  For example, you can
export PhoneBook entries to a word-processing program and use the program's mail-
merge feature to print form letters.  For more information see the chapter or online help
on “Importing and Exporting.”

Using the PhoneBook with the Calendar
You can display the PhoneBook and Calendar side by side by choosing the
Calendar/PhoneBook button or by choosing the Use with Calendar command from the
PhoneBook menu.  You can then schedule an appointment with anyone in your
PhoneBook list by dragging a name from the PhoneBook to a time slot in the Calendar.

To schedule an appointment using the PhoneBook

1. From the PhoneBook menu, choose Use with Calendar.

 Or

 Choose the Calendar/PhoneBook button.

2. In the PhoneBook list, point to the item bullet next to the name you want and hold
down the mouse button.  The pointer changes to a plus sign.

3. Drag the name to the time slot you want.

4. The appointment is scheduled in the Calendar.  ECCO creates a subitem for the
appointment in the PhoneBook.  If you have an Appointments column in the
PhoneBook, ECCO also displays the appointment date there.
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Chapter 5.  The Notepad and
Outlining
In this chapter, you will learn about:

• About Notepads and Outlining

• Using Notepads

• Using Outline Notes

• Elements of an Outline

• Creating Notepads and Outline Notes

• Working with Notepads and Outlines

• Viewing Outline Items

• Managing Notepads

• Using Columns in a Notepad

The following outline elements are common to both the Calendar and PhoneBook:
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• Item bullets:  Blue bullets that appear next to each outline item.  Yellow bullets
indicate shared or public items.

• Folder:  The container that holds items displayed in the outline.  Notepad outlines
can contain multiple folders.

• • Parent item:  An item that has one or more subitems.  A black triangle next to the
item bullet indicates the presence of hidden subitems.

• Subitem:  An item that is subordinate to another item; in other words, an item below
and to the right of another item.

About Notepads and Outlining
Outlining is a fundamental part of information management in ECCO.  Notepads are
outline structures that let you create and organize information in ways that best suit your
needs.  In the Calendar and PhoneBook, outlines are called outline notes; you use them to
enhance Calendar and PhoneBook entries by adding detailed information specific to
appointments or individuals.

Using Notepads
Unlike the PhoneBook (with its alphabetical organization) and the Calendar (with its
chronological organization), the Notepad has no predefined structure.  Information in a
Notepad can be arranged in any way that best suits your needs.  For example, a reporter
doing a three-part series on American film might have one Notepad structured by genre,
another structured by director name, and a third organized by studio name.  Each of these
Notepads would be an individual folder and, when open, would be accessible from the
tabs at the bottom of the ECCO program window.

Note: To move a parent item independently of its subitems, first promote the subitems to
the level of the parent.

Using Outline Notes
Outline notes are pieces of information that enhance information in the Calendar or
PhoneBook.  For example, to help remember specific tips for dealing with particular
subcontractors, created detailed outline notes for each subcontractor's PhoneBook entry.

Creating Notepads and Outline Notes
It's easy to create Notepads and outline notes.

To create a new Notepad

1. From the View menu, choose Notepads, and then choose New Notepad.

 The Create Notepad dialog box appears.
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2. In the Name Notepad box, type a descriptive name.

3. Choose the OK button.

 ECCO displays a new Notepad.  The name you provided appears as the folder name
at the top of the Notepad as well as in the title bar.  The next time you choose
Notepads from the View menu, the name will appear on the submenu.

Adding Outline Items
You can quickly add outline items to the Calendar, PhoneBook, or Notepad.

To add outline items

1. Press the ENTER key.  The new item will appear below the selection and will be at the
same level as the selection.  If the selection has expanded subitems, the new item will
be subordinate to the selection.

 If you're adding outline notes to a Calendar or PhoneBook entry, the new item will be
subordinate to the selection.

You can also add outline items below the selection by using the following keyboard
shortcuts or Item menu commands:

Result Menu Command Key Command

Adds item at same level
as selected item

Add Item CTRL+ENTER

Adds subitem one level
to the right of the
selected item

Add Item Right CTRL+R

Adds item one level to
the left of the selected
item

Add Item Left CTRL+L

To insert carriage returns or tabs within the selected item, use the following keyboard
shortcuts and Edit menu commands:

Result Menu Command Key Command

Adds carriage return at the
insertion point

Insert New Line SHIFT+ENTER

Adds tab at the insertion
point

Insert Tab CTRL+T
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Selecting Outline Items
Before you can promote, demote, move, or delete an outline item, you must select it.
Selected items have a black bar to the left of the item bullet and are highlighted.

To select a single item

• Click the item bullet or any of the item text.

To select multiple sequential items
• Drag to select the desired items (they will be highlighted).

Or

• Click one item, hold down the SHIFT key, and click the final item in the group.

To select multiple non-sequential items

• Hold down the CTRL key and click each item you want to select.

Promoting, Demoting, and Moving Outline Items
You can promote or demote any outline item (or group of items) from one level to
another. You can also move outline items. And, if you're working in a Notepad outline
that contains multiple folders, you can even move items between the folders.

The following rules regulate promotion, demotion, and movement of items:

• Subitems are relocated with their parent item.

• An item can be no more than one level below the item that precedes it.

• An item can be no more than one level above the item that follows it.

To promote, demote, or move outline items

Use the following techniques to promote, demote, or move selected outline items.  You
can also move items using the Cut and Paste commands on the Edit menu.

Result Item Menu
Command

Mouse Technique Key Command

Moves selection up
one item

Move: Up Drag item bullet up ALT+UP ARROW

Moves selection
down one item

Move: Down Drag item bullet
down

ALT+DOWN ARROW

Promotes selection
(moves it left) one
level

Move: Left Drag item bullet
left

SHIFT+TAB or
ALT+LEFT ARROW
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Demotes selection
(moves it right) one
level

Move: Right Drag item bullet
right

TAB or ALT+RIGHT
ARROW

Deleting Outline Items
You can delete one or more outline items from the Calendar, PhoneBook, or Notepad.

To delete outline items

1. Select the item(s) you want to delete.

2. From the Edit menu, choose either the Cut command or the Delete Items command.

 Or

3. Press CTRL+D or the DELETE key.

Viewing Outline Items
You have control over the amount of outline information that appears on your screen.
You can

• Use the Show Levels dialog box to specify the number of outline levels you wish to
see.

• Expand and hide outline items individually.

To use the Show Levels dialog box

1. From the Item menu, choose the Show Levels command.

 Or

 Press CTRL+W.  The Show Levels dialog box appears.

2. Select one of the following options in the Show Levels dialog box:

• All:   Displays the entire outline at the level you specify.

• Selected:  Displays the selected parts of the outline at the level you specify.

• Unselected Only:  Displays the unselected parts of the outline at the level you
specify.
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3. Choose a numbered button.

 The outline immediately displays the number of levels you specified.

To expand and hide outline items individually

Use any of the techniques in the following list to expand and hide subitems of the
selection:

Result Item Menu
Command

Mouse
Technique

Key
Command

Hides all
subitems

Show
Subitems:
Hide

Double-click
item bullet of
expanded item

CTRL+H

Displays
specified
number of
levels

Show Levels None CTRL+1....9

Returns the
display to its
previous state

Show
Subitems:
Expand

Double-click
bullet of the
item with
hidden
subitems

CTRL+E

Displays a
specific number
of levels for the
selected item

Show levels None SHIFT + CTRL
+ 1....9

Expands all
subitems

Show
Subitems: All
Subs

ALT+double-
click

CTRL+G

Shows one level
below the
selected item

Show
Subitems: 1
Level Only

CTRL+double-
click

CTRL+J

Managing Notepads
To edit, rename, or delete Notepads, or to reorder the Notepads submenu, use the Manage
Named Notepads dialog box.

To manage Notepads

1. From the View menu, choose Notepads, and then choose Manage.  The Manage
Named Notepads dialog box appears.
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2. Take one or more of the following actions:

• To rename a Notepad: Select it, and then type a new name in the Rename box.

• To delete Notepads: Select them, and then choose the Delete button.

• To reorder Notepads on the menu select them, and then choose either the Up or
Dn reorder button.

3. When you have finished, choose the OK button (or choose Cancel to exit the dialog
box without saving changes).

Entering Information in Columns
To display the column pane, choose the Show Columns command from the Column
menu.  The column pane appears to the right of your Notepad.

You can use the column pane to associate dates, pop-up list values, numbers, and text
with items in your Notepad.  For example, you can assign a date to an item using the To-
Do's column or assign an item a priority using the Priority pop-up list column.

To enter information in a column

The columns displayed when you choose the Show Columns command will vary
depending on the template you are using.

1. From the Columns menu, choose Show Columns.  The column pane appears at the
right side of the window.

2. To enter additional information about an item in the outline, click a column cell on
the same line as the item.

 Or

 Press the F11 key to move the selection to the column pane, and then press the ENTER

key.  ECCO displays a value edit box in which you can enter information.

3. Enter information in the value edit box.  ECCO might display a value edit box
requiring a specific type of information, such as a date or number.  If you type more
characters than will fit in the box, the text scrolls up so you can continue to enter
information.

4. When you have finished entering information, press the ENTER key or choose the ENT

(Enter) button.  The value edit box disappears, and ECCO displays only the amount
of text that fits into the visible column cell.

Resizing the Column Pane
You can quickly adjust the column pane border to display the information you need.

To adjust the width of the column pane, use the mouse to drag the left border of the pane.
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You can adjust the display of the individual columns as described in the following table:

Adjustment Column Menu
Command

Mouse Procedure

Resize a column Width Drag border of
column heading

Minimize or restore
a column

Width (Minimize
checkbox in the
Column Width
dialog box)

Double-click
column heading

Move a column Move Column Drag column
heading

Showing More Columns
You can have up to 100 columns in the column pane of each view.  If you have more
columns than can be displayed at one time, use the column scrolling buttons to view more
columns.  The column scrolling buttons are located on each side of the column headings.

• To show columns to the left, click the left column scrolling button.

• To show columns to the right, click the right column scrolling button.
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Chapter 6.  Working with Items and
Formatting

About Working with Items and Formatting
In all ECCO views, you can work with your items to make information more easily
accessible. You can:

• Format text and create styles or change labels for your outline levels.

• Search for specific information.

• Sort items.

• Drag and drop items between views to quickly copy information, schedule
appointments, and add items to folders.

About Formatting
You can format item text and column values in every ECCO view.  Formatting attributes
such as bold, underline, color, or italics add emphasis or call attention to special points.
Changes in font and point size can enhance readability or create special effects.  Outline
styles and outline labels help you differentiate levels of outline items.

Four types of formatting are available:

• Character formatting  lets you emphasize items, words, or column values.

• Text touch-ups are a group of character-formatting attributes that you define once
and use repeatedly.

• Outline styles are distinctive formatting attributes that you can associate with outline
levels.

• Outline labels are letters or numerals you can use to label outline levels and clarify
the structure of your outline.

Note: To increase efficiency, customize the toolbar so that it contains the formatting
commands you use most frequently.  For more information, the chapter or online
help on “Using the Toolbar.”

Character Formatting
Use character formatting to change the font, point size, style, and color of your text.  You
can apply one or more attributes at a time to items, text within an item, or to all values in
a column.
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Note: Character formatting overrides, but does not change, outline styles.

Use character formatting to change selected text

To format characters

1. Highlight the item(s) or text within an item you want to format.

 Or

 Click a cell in the column you want to format. Column formatting will apply to all
values in the selected column.

2. From the Format menu, choose Character.

 Either the Character dialog box or the Column Character Format dialog box appears.
These dialog boxes contain identical options.

3. Select the desired formatting attributes.

4. Choose the Apply button.

Note: To apply a single format, simply highlight the text you want to format and choose
the desired attributes from the Format menu.  The Character command is also
available if you click the right mouse button in the Column pane or a Notepad
view.

Page 89



79 ECCO User’s Guide

Text Touch-Ups
A text touch-up is a group of character-formatting attributes that you name and store. You
can apply text touch-ups in any ECCO view.

Suppose, for example, that you want to make particular items in your file stand out.  You
could create a text touch-up to apply bold and italic formatting simultaneously.  Because
you name text touch-ups and add them to the Text Touch-Ups menu, you can use them
repeatedly.  ECCO saves text touch-ups whenever you save a file.

Text touch-ups override, but do not change, outline styles.

Creating Text Touch-Ups

You create a new text touch-up by specifying formatting attributes in the New Named
Text Touch-Up dialog box.

To create a text touch-up

1. From the Format menu, choose Text Touch-Ups, and then choose New.

 The New Named Text Touch-Up dialog box appears.

2. In the Name box, type the name you want to give the text touch-up.

3. Select the desired formatting attributes.

4. Choose the Apply Button.

Applying Text Touch-Ups

Once you create a text touch-up, you can apply it to text anywhere in ECCO.

To apply a text touch-up

1. Highlight the item text or column to which you want to apply a text touch-up.
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2. From the Format menu, choose Text Touch-Ups, and then choose the text touch-up
you want to apply.

Managing Text Touch-Ups

You can edit, rename, or delete existing text touch-ups or reorder text touch-ups on the
Text Touch-Ups menu.

To manage named text touch-ups

1. From the Format menu, choose Text Touch-Ups, and then choose Manage.

 The Manage Text Touch-Ups dialog box appears.

2. Take one or more of the following actions:

• To rename a text touch-up, select the touch-up, and then type the desired name in
the Rename box.

• To create a new text touch-up, choose the New button.

• To edit a text touch-up, select the touch-up, and then choose the Edit button.

• To delete text touch-ups, select one or more touch-ups, and then choose the
Delete button.

• To reorder text touch-ups on the menu, select one or more touch-ups, and then
choose either the Up or Dn Reorder button.

3. When you have finished using the Manage Text Touch-Ups dialog box, choose the
OK button.

Outline Styles
An outline style is a set of character-formatting attributes associated with a particular
outline level.  Using different outline styles for each level makes it easier to distinguish
visually between outline levels.  For instance, you could format every first-level item as
10-point, bold, and Helvetica; and every second-level item as 10-point, italic, and Times
New Roman.
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Note: Although you can create outline items and subitems in any ECCO view, the outline
styles you create apply only to the active view.

You can use different outline styles for each level of your outline.

To format using outline styles

1. Select item(s) that represent the outline level(s) you want to format.

2. From the Format menu, choose Outline Styles.  The Outline Styles dialog box
appears.

3. the desired formatting attributes.

4. Choose the Apply button.

Note: You can also create outline styles by selecting one or more items that represent the
appropriate level(s), holding down the CTRL key, and choosing the desired
attributes from the Format menu.

To reapply an outline style

You can reapply an outline style to an item or word that has already been formatted with a
character format.

1. Highlight the text or click a cell in the column to which you want to reapply the
outline style.

2. From the Format menu, choose Character.

 The Character dialog box appears.

3. Choose the Reapply button.
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Labeling an Outline
By default, each outline item is labeled with a numeral.  But you can define a set of
custom outline labels to identify the levels of any outline items.  For example, you could
use uppercase letters for level 1 items, lowercase letters for level 2 items, and so on.
Once you name and save a set of labels, you can apply it to any outline.

Default outline labels

Custom outline labels

Note: Folders in the Folder window can also be labeled. By default, outline labels for
folders are not displayed.

Creating Outline Labels

When you create a set of outline labels, you can:

• Use Roman or Arabic numerals and uppercase or lowercase letters.

• Add prefix or suffix characters (such as brackets, periods, or any characters you want
to use).

• Make labels cumulative, so that each item includes the labels of all the levels above
it.  For example, the second third-level item in an outline might be labeled 1.1.2.

• Name a set of labels so that you can reapply it to any view.

• Base a new set of labels on an existing set.

Page 93



83 ECCO User’s Guide

To create a set of outline labels

1. From the Format menu, choose Outline Labels, and then choose New.

 The Outline Labels dialog box appears.

2. In the Rename box, type a name for the set of labels.

 ECCO adds this name to the Outline Labels menu.

3. Select one or more outline levels.

4. Make any of the following changes:

• Select a label from the Label box.

• Select or type a prefix or suffix in the Prefix or Suffix box.

• Select the Cumulative checkbox to make each item in the selected levels include
the labels of all levels above it.

• Choose the Based On button to use an existing set of labels as the basis for part
or all of the new set.

5. When you have finished specifying your outline labels, choose the OK button.

Managing Outline Labels

You can edit, rename, or delete existing named outline labels, and reorder outline labels
on the Outline Labels menu.

To manage named outline labels

1. From the Format menu, choose Outline Labels, and then choose Manage.

 ECCO displays the Manage Outline Labels dialog box.

2. Take one or more of the following actions:

• To rename a named outline label, select the label and type the desired name in
the Rename box.

• To create a new outline label, choose the New button.
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• To edit an outline label, select the label, and then choose the Edit button.

• To delete outline labels, select one or more labels, and then choose the Delete
button.

• To reorder outline labels on the menu, select one or more labels, and then choose
either the Up or Dn Reorder button.

3. When you have finished using the Manage Outline Labels dialog box, choose the OK
button.

Displaying Outline Labels

In some situations you might want to change how outline labels are displayed.  For
example, in a simple one-level outline, you might find labels distracting.  You might want
to include unlabeled, blank items in your outline to create space between sections.  Or,
you might want to restart the numbering sequence in the middle of the outline.

Choose Outline Labels from the Format menu, and then use the following commands to
change how labels are displayed:

Use To

Show Labels Display or hide all outline labels.

Skip Label & Icon Hide or display the label(s) and item
bullet(s) for the selected item(s).

Restart Sequence Restart the alphabetical or numerical
label sequence beginning with the
selected item.

Finding Items
Use the Find, Find Next, and Find/Replace commands when you need to find item text or
column values anywhere in your ECCO file.

To quickly find a specific word or string of text, use the Find command.  To replace all
instances of a specific word or string of text with other text, use the Find/Replace
command.

Using the Find and Find/Replace commands, you can:

• Find a specified string of text in order to reformat, edit, delete, promote, or demote it.

• Update all instances of the specified string of text with a different string of text.

• Add to the Search Results view all items in the file that contain the text.

• Apply a filter to find only those items that match specified criteria.
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In the Folder window, you can find text in folder names by choosing the Find command
from the Edit menu, or by choosing the Find Folder command from the Folder menu.  For
more information, see the chapter or online help on “Folders.”

Note: You can continue to promote and demote items, apply formats, edit text, and
perform other tasks using menu commands while the Find dialog box is open.

Finding Text Quickly

Use the Find command to quickly highlight the next instance of the specified text in the
active view.

To highlight the next instance of the specified text

1. From the Edit menu, choose Find.  The Find dialog box appears.

2. In the Find box, type the text you want to find.

 Or

 Click the down arrow and select from the list of previous searches.

3. Choose the Find button to highlight the next occurrence of the specified text.

4. Continue choosing the Find button to highlight subsequent occurrences.

5. When you have finished using the Find dialog box, press ESC.

To repeat the most recent search

From the Edit menu, choose Find Next.

Specifying Further Search Options

Using the Find command, you can:

• Search the active view or the entire file.

• Search within item text, column values, or both.

• Apply a filter to find only those items that match the specified criteria.  You can
use a filter to find items whether you specify search text or not.

• Collect the results of your search into the Search Results view.

The Search Results view allows you to collect and work with similar items all in one
place.  For example, you could collect all items concerning an employee so that you could
review them, edit them, or copy them to a Notepad view to preserve the results of the
search.  You can also find “lost” items, which do not currently appear in any view, by
searching the entire file and using the Search Results view.
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The Search Results view is a Notepad, so you can add items to it or view it again later by
choosing it from the Notepad menu.  When your search results include subitems, they are
displayed along with their context parents—green-shaded parent items that do not match
the search criteria but appear in the Search Results view to provide context.  For more
information about context parents, see the chapter or online help on “Folders.”

Context parents appear as shaded items

To specify further search options

1. From the Edit menu, choose Find.  The Find dialog box appears.

2. In the Find box, type the text you want to find.

 Or

 Click the down arrow and select from the list of previous searches.

3. Choose the Unfold  (>>) button to expand the Find dialog box.  The Find dialog box
expands, displaying additional options.

4. Beside Scope, specify whether you want to search the current view or the entire file.

 If you are in the Calendar, you can search all future dates or the entire file.

 Depending upon the option you select, other options in the dialog box may change
slightly.

5. Beside Match, specify whether you want to search only item text, only column
values, or both.
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6. Beside Find Items Matching Filter, you can select an existing filter or select the
Custom option and create a filter.  For more information, see the chapter or online
help on “Filters.”

7. Beside Actions, specify how you want to display the text you find:

• To highlight the next occurrence of the specified text in the active view, select
the Find Next option.

• To highlight all items in the active view that contain the specified text, select the
Select All In View option.

• To copy all occurrences of the specified text to the Search Results view, select
the Copy To “Search Results” View option.  Then select either Replace (to
replace the contents of the Search Results view with the results of your search)
or Append (to append the results of your search to the contents of the view).

8. Choose either the Find button or the Collect All button.

9. When you have finished using the Find dialog box, press ESC.

Finding and Replacing

When you need to change specific text, you can search for and replace it all at once or
replace it selectively on a case-by-case basis.

To replace text

1. From the Edit menu, choose Find/Replace.

 The Find and Replace dialog box appears.

2. In the Find box, type the text you want to find.

 Or

 Click the down arrow and select from the list of previous searches.

3. In the Replace box, type the replacement text.

 Or

 Click the down arrow to select from the list of previous replacements.
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4. Beside Match, specify whether you want to search only item text, only column
values, or both.

5. Choose the Find button.  ECCO highlights the first occurrence of the text.

6. Choose one or more of the following buttons:

• To leave the text unchanged and search for the next occurrence, choose the Find
button.

• To  replace the text, choose the Replace button.

• To replace all occurrences of the text without confirmation (rather than replacing
occurrences one at a time), choose the Replace All button.

7. When you have finished using the Find And Replace dialog box, press ESC.

Note: In the Calendar, this procedure searches only the active pane.

Sorting Items
Sorting is the process that rearranges items in the order most meaningful to you.

A simple sort might arrange items alphabetically by their text.  A more powerful sort
might arrange items by alphanumeric value, using the values displayed in columns. ECCO
gives you two sorting criteria, or keys.  Choose the more significant criterion for the first
sort key and the less significant for the second sort key.

For example, suppose you wanted to sort items in a project outline by priority.  You could
use the Priority column to sort items in order of High, Medium, or Low priority (or any
other priority value you created) and then select the “<item text>” option to sort items
with the same priority in alphabetical order.

In the Calendar, you can sort Tickler items by their event date, as well as by their item
text and column values.  You might want to use the event date and the Priority column to
organize your reminders first by date and then by order of importance.  Whenever you
display a different day, week, or month, your Tickler items are sorted in the order you last
specified.

You can sort all top-level items or the subitems of any selected items or folders.  If you
choose to sort subitems, only the items one level subordinate to the selected items or
folders are sorted:
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• If you select a folder, only first-level items are sorted.

• If you select a first-level item, only second-level items are sorted.

• If you select first and second-level items, only second- and third-level items are
sorted.

To sort items

1. Select one or more folders or items.

 To sort subitems, select a folder or item that has subitems.

2. From the Tools menu, choose Sort.  The Sort Items dialog box appears.

3. To sort all top-level items or Tickler items, select the Entire View option or the
Tickler sections option.

 Or

 To sort subitems of selected items or folders, select the Subitems of Selected Items
Or Folders option.

4. In the Sort Key 1 drop-down list, select your primary sort criterion:

• To sort by item text, select <item text>.

• To sort Tickler items by event date, select <event date>.

• To sort by a value, select the name of the column or folder by which you want to
sort.  For more information about columns, see the chapter or online help on
“Columns and Values.”

5. Specify whether you want to sort in ascending or descending order.

6. Optionally, select a second sort criterion and specify ascending or descending order.

7. Choose the OK button.

Note: To sort quickly by a column value, click the right mouse button in the desired
column, and then choose Sort Up or Sort Down.
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Drag and Drop
ECCO’s drag and drop feature makes it easy for you to work with items and manage
information:

• Drag items to promote, demote, or copy them.

• Schedule appointments in the Calendar by dragging names from the PhoneBook or
by dragging items from any Notepad.

• Add items to folders by dragging them into a folder in the Folder window.
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Chapter 7.  Using the Toolbar

About the Toolbar
Using a mouse, you can perform tasks quickly and easily by choosing buttons on the
ECCO toolbar.  The toolbar can have up to six rows of buttons—three rows are
associated with the ECCO program window, and three rows are associated with the active
view.  You get to determine how many rows (if any) are visible at any time.

Note: You can also display a toolbar in the Shooter.  For more information, see the
chapter or online help on "Using ECCO with Other Programs."

Toolbar Features
The customizable ECCO toolbar provides the following advantages:

• Convenient access to any ECCO command.

• Instant access to cascading submenus.

• Access to user-defined menu items (such as outlines, outline labels, and text touch-
ups).

• Instant access to the last-accessed command (with the Repeat box).

Showing or Hiding the Toolbar

The ECCO toolbar can be made visible or invisible at the touch of a button.
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To show or hide the toolbar

1. Click the Show/Hide Toolbar button in the status line.

 The toolbar will appear (or will disappear if it was previously visible).

Customizing the Toolbar
The default toolbar buttons in the ECCO program window are some of those most
commonly used for file management and editing.  But you can customize the toolbar to
best suit your needs:

Change the number of rows in the toolbar.
Add buttons to the toolbar.
Copy buttons.  Use the right mouse button to drag a copy from one

section of the toolbar to another.
Delete buttons.  Use the right mouse button to drag them down to the

view area.
Change the size of the buttons.

To change the number of toolbar rows

1. From the Tools menu, choose Toolbar.

 The Toolbar dialog box appears.

2. In the Rows box, select the number of rows you want displayed in each section of the
toolbar.

3. Choose the OK button.

To add a button to the toolbar

Note: For a complete guide to all ECCO buttons, see the chapter or online help on
"Command Reference."

1. Choose a command from any ECCO menu.  And to prevent the command from
actually being carried out, be sure to drag the mouse off the menu before releasing
the mouse button.

 The button corresponding to this command appears in the Repeat box at the top right
of the toolbar.

2. Press the right mouse button and drag the command button from the Repeat box to
the desired position on the toolbar.
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Note: From the Tools menu, choose Toolbar, and then choose Add/Arrange Icons to
display icons in the Repeat box without invoking the action.

To change toolbar button size

You have a choice of large toolbar buttons with captions (the default) or small toolbar
buttons without captions.

1. From the Tools menu, choose Toolbar.

 The Toolbar dialog box appears.

2. Check or uncheck the Show Large Buttons with Captions checkbox.

3. Choose OK.

Reorganizing the Toolbar

After placing the desired command buttons on the toolbar, you can reorganize it at any
time:

• Rearrange command buttons by dragging them.  Use the right mouse button.

• Add or delete spaces between command buttons.  Position the mouse cursor between
the buttons, and press SHIFT+ the right mouse button.

• Arrange command buttons into groups (that is, delete the spaces between them), and
then move these groups as single objects . Drag them while pressing CTRL+ the right
mouse button.

Note: From the Tools menu, choose Toolbar, and then choose Add/Del Spaces or
Arrange Groups.  Then follow the instructions in the Description box.

Adding Submenus to the Toolbar

For added convenience, any submenu (or hierarchical menu) can be added to the toolbar.
(It will appear as a drop-down menu when you click its command button.)  This gives you
simplified access to commands.  For example, the conventional method for changing a
font would require that you choose the Format menu, the Font menu, and then a font
name; by adding the Font submenu as a button on the toolbar, you can choose a font
directly from the drop-down menu.

To add a submenu to the toolbar

1. Choose a menu command that brings up a submenu.

 The button for the first item in the submenu appears in the Repeat box.

2. Click outside the menus to dismiss them.

3. Click the up arrow attached to the Repeat box.
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 The button for the submenu appears in the Repeat box.  Buttons for submenus have a
white triangle in their lower-right corner.

4. Use the right mouse button to drag the menu button from the Repeat box onto the
toolbar.
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Chapter 8.  Printing
It's easy to print from each ECCO view.  In this chapter you'll learn about:

• Printing a Calendar

• Printing a Notepad

• Printing a PhoneBook

• Printing columns

• Printing a Calendar

• Printing catalogs

When printing a Calendar you have the following options:

• Print summary pages (summary pages do not include subitems of appointments and
ticklers).

• Print detail pages.  When you print detail pages you can print all items, exclude
hidden subitems, and specify the levels of subitems to include.  You can also print
any columns associated with your Calendar.

• Print the Appointment section, Tickler section, or both.

• Print items in a desired font.

A user name prints in the upper-left corner of the Calendar, and the time period prints in
the upper-right corner.  You can change the user name in the ECCO Options property
sheet.  Select the Options command on the Tools menu, select the Files tab, and then enter
the name to be printed in the text field to the right of User name for report headings.

To print a Calendar

1. To print specific items, select them.

2. From the File menu, choose Print.
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 The Print Calendar View dialog box appears.

3. In the Catalog of Print Settings list, select one of the following:

• A predefined Calendar Print Catalog Setting, such as Default Settings for Day or
Default Settings for Month.

• A user-defined Print Catalog that you've created.

4. In the Page Setup list, select the desired page size.

Note:   To add custom page sizes, select the Setup option.  You can choose from page
sizes that fit common organizer-style notebooks, including The Priority
Manager™, DayTimer™, Franklin™, and most other popular day planners, as
well as A4, A5, Legal, and Executive paper sizes.

5. Under Format, select the desired option.

6. Under Date Range, specify a start and end date for the information you want to print.

7. Under Sections, select Appointments, Ticklers, or both for printing.

8. Under Ordering, type the number of copies you want to print and, as desired, select
2-sided printing, reverse-order printing, or multiple copies on a page.

9. If you want to specify additional printing options, choose the Notes/Columns button.

 The Appointment Notes and Columns dialog box appears.
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10. In the Outline Notes And Columns dialog box, take one or more of the following
actions:

• Select either Summary Pages: No Appointment Notes or Columns or Details
Pages with Notes and Columns (Skip Empty Slots).

•  In the Notes section, select the options you want.  You can do this only if you
specified Details Pages in the Format section.

• In the Columns section, select the options you want.  You can do this only if you
specified Details Pages in the Format section.

11. Choose OK.

12. As desired, choose the Font button to customize printout fonts.  Choose OK to exit
the Item Text Font dialog box.

13. Choose the OK button to print.

PhoneBook Entries
When you print PhoneBook entries you have the following options:

• Print the entire PhoneBook.

• Print items currently in the view.

• Print selected items.

You may also specify what kind of information is printed for each item.

To print PhoneBook information

1. If you want to print specific items, select the items you want to print.

2. From the File menu, choose Print.

 The Print PhoneBook View dialog box appears.
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Note:   To print Calendar columns, you must select Details Pages in the Format
section of the Outline Notes and Columns dialog box.

3. Choose the desired Catalog of Print Settings.

4. Choose the desired Page Setup.

Note:   If you are printing name and address only, you can choose standard page
sizes, or you can choose Avery® label sizes.  In the Range section, choose an
option to specify what you want to print.

5. In the Format section, select the kind of information you want to print for each item,
and specify a sort order.

 If you select a PhoneBook format option that includes columns, a Column button
appears.  Choose the Column button to display the PhoneBook Columns dialog box
in which you can specify which columns to print, the width for the Name section, and
the order and maximum width for each column.

 If you select a PhoneBook format option that includes forms, an option
appears that lists the PhoneBook forms that have been created.  You can
select the PhoneBook form you want to print and how fields will be divided
across the page.

6. Under ordering, enter the number of copies you want to print.  And, as desired,
specify 2-sided printing, reverse-order printing or multiple copies on a page.

7. If you want to set additional printing options, choose the Options button.

 The PhoneBook Options dialog box appears.

8. In the PhoneBook Options dialog box, take one or more of the following actions:

• To insert a page break between entries beginning with a different letter, select
the New Page at Start of Each Letter checkbox.

• To switch the print order of names, select the Switch Lastname, Firstname to
Firstname Lastname checkbox.  This will cause titles such as Dr. or Ms. to
appear in the entries as well.

• Select whether you want both the home and business addressed to be printed.

• In the Outline Notes section, select the desired options.  You can do this only if
you specified one of the Outline Note options in the Format section.

9. Choose the OK to close the PhoneBook Options dialog box.

10. Choose OK to print.

Printing Notepad Items
When you print Notepad items, you have the following options:
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• Print all items in the Notepad.

• Print selected items in the Notepad.

• Print items to a specific outline level.

• Omit or print hidden subitems.

• Omit or print item bullets.

• Omit or print specific columns.

• Add headers and footers.

To print Notepad information

1. If you want to print specific items only, select the items.

2. If you want to omit subitems, hide them (by double-clicking the item they're
subordinate to).

3. From the File menu, choose Print.

Note:   If you are printing name and address only, you can choose standard page
sizes, or you can choose Avery® label sizes.  The Print Notepad dialog box
appears, displaying the Default Notepad Settings.

4. In the Catalog of Print Settings list box, select a user-defined Notepad Print Catalog.

 Or

 Make any changes to the Default Notepad Settings.  These changes are temporary.

5. In the Page Setup list box, select the page setup you want, or choose the Setup  dialog
box and specify your own page setup.

6. Under Range, select the Print All Items checkbox or the Print Selected Items Only
checkbox.
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7. Under Item Options, select the Print Items Only to Level, Skip Hidden Sub Items,
and Print Item Icons checkboxes.

8. Under Columns, change the settings as necessary.

9. If you want to print a header or footer, choose the Header/Footer button and provide
information as appropriate.

 Headers and footers are automatically centered on the page.  If selected, the date
appears in the lower-right corner of each page, and the page number appears in the
lower-left corner.

10. Under Ordering, specify the number of copies to print and, as desired, check the
boxes for 2-sided printing, reverse-order printing, or multiple copies on a page.

11. Choose the OK button.

Specifying the Page Setup
With the Page Setup feature, you can specify the following options:

• Page size:  Dimension of the paper, height/width, orientation (portrait or Page
margins  Top, bottom, left, and right margins for the paper.

• Print areas:  Number of forms (days, weeks, months, pages) to be printed across and
down the page, space between rows and columns, and whether pages will be cut
sheets.

• Internal margins:   Top, bottom, left, and right margins for this page setup.

• Envelope address positions:  (if printing envelopes) Print location for the return
address and addressee.

To specify Page Setup

1. In the Page Setup section of the Print dialog box, choose the Setup button.

 The Page Setup dialog box appears.

2. In the Edit Settings For section, select the option for the characteristic you want to
modify.  The Paper section will change based on your selection.

3. In the Paper section, provide the requested information.

4. When you have finished making your selections, choose the OK button.

Note:   You can rename, delete, and reorder page setups using the Manage Page
Setups dialog box.
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Printing Options
A variety of options are available when you print ECCO views.  The following sections
describe these options in detail.

To preview your printing

To see a representation of how your printed page will look, use the Print Preview option.

1. From the File menu, choose Print.

 The Print dialog box for the view appears.

2. Choose the Preview button.

 The Print Preview screen, containing a representation of the page, appears.  From this
screen, you can move between sample pages by using the Next and Previous buttons.
To leave the Print Preview screen and begin printing, press the Print button.

To specify two-sided printing

With ECCO you can have information printed on two sides of the page.

1. From the File menu, choose Print.

 The Print dialog box for the view appears.

2. When specifying your printing preferences, click the 2 Sided Printing checkbox.

 A series of dialog boxes will walk you through the two-sided printing process.

To specify reverse printing

With reverse printing, the last page of the document is printed first.  This is useful for
printers such as those in the HP DeskJet series that output pages in a “face-up” manner.

1. From the File menu, choose Print.

 The Print dialog box for the view appears.

2. When specifying your printing preferences, click the Reverse Order checkbox.

To specify multiple copies on a page

With multiple copies on a page, a form feed command is not sent to the printer between
each copy.

1. From the File menu, choose Print.

 The Print dialog box for the view appears.

2. When specifying your printing preferences, click the Multiple Copies on a Page
checkbox.
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Catalog of Print Settings
A print catalog is a set of predefined print options.  You can use the default print catalog
settings or define your own print catalogs.  A print catalog specifies the following:

• Section:  You define settings for an ECCO view (PhoneBook, Calendar, or
Notepad).

• Format:  Select from a list of formats applicable to the section.

• Page Setup:  Define the page size, area, margins, and orientation.

• Range:  Select a range of items applicable to the section (for example, a date range
for the Calendar).

• Printer:   Select the printer to be used.

• Header/Footer:  Specify the text and formatting to be used on headers and footers.

• Font type and size:   Select the font and size used for printing.

• Two-side, Reverse order, Multiple Copies on a Page:  Select options for print
methods.

You can name and save any print catalog you define.  To print using a predefined print
catalog, select the name from the Catalog of Print Settings list box in the Print dialog box.
You can also modify and rename existing print catalogs.

To print a catalog

1. From the File menu, choose Print Catalog.

2. From the submenu, choose the catalog you want to print.

 Printing begins immediately, using the attributes previously defined for the selected
catalog.  If you're printing a Notepad catalog, you must choose which notepad you
want to print.

Printing Column Values
When printing Notepad or Calendar information, you can choose to print information
from columns. You can

• Print all columns.

• Print selected columns.

• Omit printing (skip) minimized columns.

• Specify the number of columns to print on the page.

• Specify the maximum width of the columns that print.
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To specify column-printing options

1. Display the Columns section of a dialog box.  The Columns section for Notepads
appears in the Print Notepad dialog box; the Columns section for Calendar appears if
you choose the Notes/Columns button in the Print Calendar dialog box.

2. Choose Print Columns.

3. Select the Skip Minimized Columns option to prevent minimized columns from being
printed.

4. Select the Custom Columns option to specify which columns should print, and then
choose the Columns button.  The Custom Columns dialog box appears.  You can add
any column to the printed view, even if the column doesn't normally appear in this
view.

5. Select columns from the Choose Columns List, and then choose the Add button to
add them to the Columns Chosen List.

6. Choose the OK button to close the Custom Columns dialog box.

7. Specify the number of columns you want printed on the first page and the maximum
item text width.

8. Choose OK.
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Chapter 9.  Importing and Exporting

Introduction to Importing and Exporting
By importing and exporting, you can move database, spreadsheet, or text information
between ECCO and other files.

• You can import phone book information from a personal information manager into
your ECCO PhoneBook.

• You can export selected records from ECCO in a mail-merge format to your word-
processing program.

• You can import or export spreadsheet information in a columnar format.

• You can combine information from two or more ECCO files by exporting
information from one file and importing it into another.

• You can reduce the size of your ECCO file by archiving your old appointment and
tickler items.

• You can export selected records from ECCO to a Timex Data Link™ watch.

• You can synchronize records to and from a U.S. Robotics® Pilot™ PDA

You can import files in two formats: tab-delimited text or comma-separated values
(CSV).  A tab-delimited text file contains fields or categories of information separated by
tabs.  A CSV file contains fields enclosed in quotation marks and separated by commas.
Most personal information manager, database, and spreadsheet programs allow you to
save files in these formats.

You can export ECCO information to other programs by using the Export command on
the File menu.  The information can be in any of several formats—ECCO to ECCO, tab-
indented, CSV, tab-delimited, and mail-merge.  Mail merge information can be exported
to major word-processing programs that use standard mail-merge formats.

Importing to the PhoneBook
When you import a file into the PhoneBook, you can specify the fields you want to
include as well as their ultimate location.  Names and other identifying information
normally appear as items in the PhoneBook; addresses, phone numbers, and most other
typical information will appear in the PhoneBook entry form.  New fields will appear as
PhoneBook columns.

To import a file into the PhoneBook

1. Switch to the PhoneBook.

Page 116



ECCO User’s Guide106

2. From the File menu, choose Database, then choose Import.

 The File Import dialog box appears.

3. In the List Files Of Type box, select the file type you want to import.

4. In the File Name box, type or select the name of the file you want to import.

5. Choose the OK button.

The Choose Fields For Import Into PhoneBook dialog box appears, which displays
the field names located in the file you want to import.  Use this dialog box to select
the fields you want to import into the ECCO PhoneBook.

6. In the Field Name box, select a field you want to import into the ECCO PhoneBook.

7. In the Choose A Destination box, select a destination for the field:

• If you do not want to import the information in the selected field, select
<Ignore>.
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• If you want the information in the selected field to appear as part of the item for
this PhoneBook name, select Full Name, Last Name, First Name, or Middle
Name.

Note: Use First Name and Last Name if the source file has separate fields for the first
and last names.  Use Full Name if the names are in a single field.  Use Name As
Entered if the source file is an ECCO file.

• If you want information in the selected field to appear as a particular field in the
PhoneBook form, or if you want the information in the selected field to appear in
an existing PhoneBook column or in another existing ECCO text column, select
a field name without angle brackets.

• If you want to create a new column in the PhoneBook to import the selected
import field to, select a field name with angle brackets and, then type a name in
the Rename New Field box.  For example, to create a new text column, select
<New Text Field> and then type a name for the text field in the box.

8. Repeat steps 7 and 8 for each additional field you want to import.

9. To check your field mapping, click the Sample buttons to move through the file one
record at a time.

10. When you have specified a destination for each field you want to import, choose OK.

 ECCO imports the information in the view to the file you specified.

Importing to a Notepad
You can import both item text and column information into a Notepad. ECCO lets you
specify which columns in the view you want to import to.  If the file you are importing has
a mail-merge header (if the first row of the file contains field names), you can use the
header to create new columns to import to.  If the file does not have a mail-merge header
and if you’d like to import information into columns, choose the fields you want to import
and the columns you want to import them to.

Note: Although you can’t import directly into the Calendar, you can import date column
information into an ECCO Notepad.  And, by default, any information you import
into a date column will appear in the Calendar.  Be sure to insert the date folders
(usually all the folders under scheduling in the Folder window) into the Notepad
before importing.

To import a file into a Notepad

1. Switch to a Notepad.

2. From the File menu, choose Database, then choose Import.

 The File Import dialog box appears.

3. In the List Files of Type list box, select the file type you want to import.
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4. In the File Name box, type or select the file you want to import.

5. Choose the OK button.

 The Import into Current View dialog box appears.

6. Under Insert Imported Items, select an option:

• To place the imported information at the bottom of the outline, select the At
Bottom of Outline option.

• To place the imported information after and at the same level as the currently
selected item first select the After Currently Selected Item option, and then select
the Same As Selected Item option.

• To place the imported information after and subordinate to the currently selected
item, first select the After Currently Selected Item option, and then select the
Subordinate to Selected Item option.

7. If you are importing information into columns, select the Import File Has Columnar
Data option.

8. If the file you are importing has a mail-merge header that you want to use to create
new columns, select the Create New Columns Using Mail Merge Header option.

 If you want to use existing ECCO columns if they match the fields in the file, select
the Use Existing Columns If Matching Names Found option.

9. To choose the columns you want to import to, select the Choose Column For Each
Field option, and then choose the Choose button.

 The Choose Columns For Import Fields dialog box appears, which displays the field
names in the file you want to import.  Use this dialog box to select the fields you
want to import into the ECCO Notepad.
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10. In the Import Field list, select an import field you want to import into the ECCO
Notepad.

11. In the Choose a Column box, select a destination for the import field (the first import
field is automatically designated as item text).

• If you do not want to import the information in the selected import field, select
Ignore.

• If you want the information in the selected import field to appear in a particular
column in the Notepad, select that column.

• If you want to create a new column in the Notepad to import the selected import
field to, select a column type with angle brackets and then type a name in the
Rename Column box.  For example, to create a new text column, select <New
Text Field> and then type a name for the text field in the box.  For more
information about column types, see chapter or online help, “Columns and
Values.”

12. Repeat steps 11 and 12 for each additional field you want to import.

13. To check your field mapping, click the Sample buttons to move through the file one
record at a time.

14. When you have specified a destination for each field you want to import, choose the
Continue button.

15. Choose the OK button.

 ECCO imports the information into the Notepad.
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Exporting from the PhoneBook
Use the Export command on the File menu to export PhoneBook entries to another
program.  For example, you might export your PhoneBook to a database, or you might
export PhoneBook entries to a mail-merge file for a word-processing program and use the
program’s mail-merge feature to print form letters.

To export from the PhoneBook

1. Switch to the PhoneBook.

2. From the File menu, choose Database, then choose Export.

 The Export PhoneBook dialog box appears.

3. Under Items To Export, select an option:

• To export all entries in your PhoneBook, select the Entire PhoneBook option.

• To export only those entries collected in the PhoneBook list, select the Items
Currently In View option.

• To export only selected items, select the Selected Items Only option.

4. Select one of the format options:

• To export information to a word-processing program in a mail-merge format,
select one of the mail-merge options.

• To export the PhoneBook to a spreadsheet or database, select the CSV (Comma
Separated) format.

• To export only names and outline notes to a word-processing program, select the
Outline Only (Tab Indented) format.

• To export names, column information, and outline notes, select CSV (+ Tab
Indented Notes).

• To export to another ECCO file, select the ECCO to ECCO format.

Note: Check the DOS Text option if you want to restrict the export file to ASCII
characters.
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5. If you are doing a mail merge or if you plan to import your PhoneBook information
back into ECCO at a later time, select the Mail Merge Header option (if it is not
already selected).

6. In the Export to File box, type a name for the file you want to export.

 Or

 Choose the Browse button and then select a file to export to (*.TXT or *.CSV).  The
file will be overwritten.

7. Choose the Choose Fields button.

The Choose Field Set dialog box appears.  Use this dialog box to select the
PhoneBook fields you want to export.

8. In the Choose Fields list, select a field you want to export.

Note: The < > fields are the default fields chosen in ECCO.  For example, if home
address is the default for an entry, that default information would be used for the
export.  If you are uncertain, ignore the < > fields and include the Address -
Business and Address - Home fields in the export.

9. Choose the Add button.

 The field appears in the Fields Chosen list.

10. Repeat steps 8 and 9 for each additional field you want to export.

11. When you have finished specifying fields, choose the OK button.

12. Choose the OK button.

 The PhoneBook is exported to the file you specified.

Note: To add the field set to the menu, in the Choose Field Set dialog box, select the
Add Field Set to Menu option, and then type a name in the Name box.  The field
set will appear under Choose Field Set in the Export PhoneBook dialog box.
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Exporting from a Notepad
When exporting from a Notepad, you can export all items in the view, selected items, or
items plus information in columns.

To export from a Notepad

1. Switch to the Notepad you want to export.

2. From the File menu, choose Database, then choose Export.

 The Export Notepad dialog box appears.

3. Under Items To Export, select an option:

• To export all items in your Notepad, select the All Items In View option.

• To export selected items, select the Selected Items option.

• To export selected items plus their subitems, select the Selected Items & Subs
option.

4. Select one of the format options:

• To do a mail merge, select one of the mail-merge options.

• To export the Notepad (including information in columns) to a spreadsheet or
database, select the CSV (Comma Separated) format.

• To export only outline items to a word-processing program, select the Outline
Only (Tab Indented) format.

• To export to another ECCO file, select the ECCO To ECCO format.

Note: Check the DOS Text option if you want to restrict the export file to ASCII
characters.

5. In the Export To File box, type a name for the file you want to export.

 Or

 Choose the Browse button and select a file to export to (*.TXT or *.CSV).  The file
will be overwritten.

6. Choose the OK button to export your outline.
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 Or

 To export information in columns, follow the instructions described in the following
procedure.

To export a Notepad with columns

Before beginning this procedure, follow the steps described in the preceding procedure.

1. In the Export Notepad dialog box, choose the Columns button.

 The Export Notepad and Columns dialog box appears.

2. Choose the Choose Columns button.

 The Choose Column Set dialog box appears.  Use this dialog box to choose the
columns you want to export.

3. In the Choose Columns list, select one or more columns you want to export.

4. Choose the Add button.

 The column(s) appear in the Columns Chosen list.

5. Repeat steps 3 and 4 for any additional columns you want to export.

6. When you have finished selecting columns, choose the OK button.

7. Choose OK again.

 The Confirm Export dialog box appears.

8. Choose OK to confirm the export.
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 Or

Choose Cancel to cancel the export.

If you chose OK, the Notepad is exported to the file you specified.

Note: To add the column set to the menu, in the Choose Column Set dialog box, select
the Add Column Set to Menu option, and then type a name in the Name box.  The
column set name appears under Choose Column Set in the Export Outline and
Columns dialog box.

Exporting from the Calendar View
To export Calendar information, place the Appointments folder or a date folder into a
Notepad, and then export the Notepad and its columns.

For more information about placing folders in Notepads, see the chapter
or online help, “Folders.”

Follow the instructions for exporting from a Notepad earlier in this
chapter.

Combining ECCO Files
If you need to combine multiple ECCO files, simply export the
information from one or more ECCO files and then import it into the
destination ECCO file.

Combining ECCO Notepads
To combine two files, you can transfer data from one ECCO file to another using the
Search Results notepad:

• Collect in the Search Results notepad of the first file all the data you want to transfer.

• Add any columns you want to export to the Search Results notepad.

• Export the Search Results notepad to a text file.

• Import the text file into the Search Results notepad of the destination file.

Use the following procedure to collect all data you want to export in the
Search Results notepad.  This procedure can be used with any named
filter.

To collect all data in the Search Results notepad

1. Open the ECCO file from which you want to transfer data.

2. From the Edit menu, choose Find.

 The Find dialog box appears.
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3. To display the entire Find dialog box, click the Unfold button (>>).

4. In the Find box, select and delete any text.

5. Under Scope, select the Entire File option.

6. In the Find Items Matching Filter box, select None or choose any named filter in the
list.

7. Under Actions, select the Copy To “Search Results” View option, and then select
Replace.

8. Choose Collect All.  ECCO places a copy of all items in your ECCO file in the
Search Results notepad.

9. Close the Find dialog box.

To add columns to the Search Results notepad

If you want to export item values, you must add columns for all folders that contains items
before you export.

1. From the Column menu, choose Show Columns.

2. From the Column menu, choose Insert Column, and then choose Existing Folder.

 The Insert Folder Columns dialog box is displayed.

3. Select all the columns whose values you want to export.  For more information about
columns and values, see the chapter or online help on “Columns and Values.”  You
can insert a maximum of 100 folders.

4. Choose the OK button.

To export from the Search Results notepad

1. From the File menu, choose Database, then choose Export.

 The Export Notepad dialog box appears.

2. In the Export Notepad dialog box, choose the Columns button.

 The Export Notepad And Columns dialog box appears.

3. Under Items To Export, select All Items In View.

4. Under Format, select ECCO To ECCO.

5. Select the Mail Merge Header option, if it is not already selected.

6. Select the DOS Text option, if it is not already selected.

7. Choose the Choose Columns button.
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 The Choose Column Set dialog box appears.

8. Select all the columns in the Choose Columns list.

9. Choose the Add button.

 The column(s) appear in the Columns Chosen list.

10. Choose the OK button.

11. Choose OK again.

 The Confirm Export dialog box appears.

12. Choose OK to confirm the export.

The Notepad is exported to the file NOTEPAD.TXT.

To import a file into the Search Results notepad

Now that you have exported the data from your first file, you can import it into the Search
Results notepad of a new or existing ECCO file.

1. Open the ECCO file into which you want to transfer data.

2. Again, use the Find dialog box to collect everything in the file and display the Search
Results notepad.

3. From the File menu, choose Database, then Import.

 The File Import dialog box appears.

4. In the File Name box, select NOTEPAD.TXT.  This is the file into which you
exported data in the previous procedure.

5. Choose the OK button.

 The Import Into Current View dialog box appears.

6. Select the Import File Has Columnar Data option.

7. Select the Create New Columns Using Mail Merge Header option.

8. Select the Use Existing Columns If Matching Names Found option.

9. Choose the OK button.

 The Confirm Import dialog box appears.

10. Choose the OK button.

ECCO imports the data into the Search Results notepad.
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Combining ECCO PhoneBooks
To combine two ECCO PhoneBooks, you export the PhoneBook of the first ECCO file to
a text file and then import that text file into the PhoneBook of the second file.

To export from the PhoneBook

1. Switch to the PhoneBook.

2. From the File menu, choose Database, then choose Export.

 The Export PhoneBook dialog box appears.

3. Under Items To Export, select the Entire PhoneBook option.

4. Under Format, select the ECCO to ECCO format.

5. Select the Mail Merge Header option, if it is not already selected.

6. Clear the DOS Text option unless you want to restrict the export file to ASCII
characters.

7. Choose the Choose Fields button.

 The Choose Field Set dialog box appears.

8. In the Choose Fields list, select Name As Entered.

9. Choose the Add button.

 The field appears in the Fields Chosen list.

10. In the Choose Fields list, select all fields from “Mr./Ms.” to the end of the list,
skipping fields surround by angle brackets (< >).

11. Choose the Add button.

 The fields all appear in the Fields Chosen list.

12. Choose the OK button.

13. In the Export PhoneBook dialog, choose the OK button.

The PhoneBook is exported to the file PHONE.TXT.

To import a file into the PhoneBook

1. Switch to the PhoneBook of the file into which you want to import.

2. From the File menu, choose Database, then Import.

 The File Import dialog box appears.

3. In the File Name box, select PHONE.TXT.
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This is the file into which you exported PhoneBook data in the previous procedure.

4. Choose the OK button.

The Choose Fields For Import Into PhoneBook dialog box appears, which displays
the field names located in the file you want to import.  You use this dialog box to
select the fields you want to import into the ECCO PhoneBook.

5. In the Field Name box, select Name As Entered.

6. In the Choose a Destination box, select Full Name.

The Name As Entered field is mapped to the Full Name field. Now you must map
the remainder of the fields you want to import.

7. In the Field Name box, select a field you want to import into the ECCO PhoneBook.

8. In the Choose a Destination box, select a destination for the field:

• If you do not want to import the information in the selected field, select Ignore.

• If you want the information in the selected field to appear as a particular field in
the PhoneBook form, or if you want the information in the selected field to
appear in an existing PhoneBook column or in another existing ECCO text
column, select a field name without angle brackets.

• If you want to create a new column in the PhoneBook to import the selected
import field to, select a field name with angle brackets, and then type a name in
the Rename New Field box.  For example, to create a new text column, select
<New Text Field>, and then type a name for the text field in the box.

9. Repeat steps 7 and 8 for each additional field you want to import.

10. When you have specified a destination for each field you want to import, choose OK.

ECCO imports the information in the file to the destinations you specified.

Archiving Appointments and Ticklers
Over time, many appointments and tickler items can accumulate in your ECCO file.
Archiving allows you to store appointment and tickler items so that you can

• Pass the information on to others.

• Create a library of your past activities either for security or future reference.

• Reduce the size of your ECCO file by removing old appointments and tasks.

To archive old appointments and ticklers

1. Open the file you want to archive information from.

2. From the File menu, choose Database, then choose Archive.
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 The Archive Appointments And Ticklers dialog box appears.

3. In the Archive Items Before field, select a cut-off date before which items will be
archived.

4. In the To File box, enter a filename for the archived information or accept the default
filename.

The default filename is based on the current date.  For example, if you are archiving
information on April 25, 1997, the default filename would be 042597.ECO.

5. To remove the archived information from the active file, select the Delete After
Archiving option.

Recurring events are not deleted if their final recursion date falls after the archive
date.

6. Choose OK to finish archiving.

Note: Each time you archive information, ECCO saves the information to a new ECCO
file. You cannot add the information to an existing file.

Exporting Data to a Timex ® Data Link ™ Watch
ECCO allows you to export data to the Timex Data Link watch.  This is an export-only
feature.  The Timex Data Link watch is a receive-only device.

Note: To transfer data you must use a CRT (cathode ray tube) monitor or the Data Link
adapter.  The Data Link software will not work with laptop or any LCD screen
display.

To select PhoneBook items to transmit
ECCO uses a checkmark column called “Timex” to select PhoneBook items to be
transmitted to the Data Link watch.  You can use a different name by specifying it in
the ECCO Timex Data Link Options dialog box, described later.

1. Create and add the column “Timex” in the PhoneBook view.  For more information
on adding a column, see the chapter or online help on “Columns and Values.”

 Or

2. Select the Timex Data Link command from the Tools menu.  Choosing the OK
button on the selection of information to transmit dialog box will prompt you to
create the Timex column.  Choose the Yes button.

 This creates the Timex folder and adds it as a column to the PhoneBook view.

3. Close the Times Data Link dialog box and switch to the PhoneBook view.

4. Place a checkmark in the Timex column for each PhoneBook item to be exported.
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To export from ECCO

1. Choose the Timex Data Link command from the Tools menu.

 The ECCO Timex Data Link dialog box appears.

2. Select the type of items you want to transmit.  You can select one or any combination
of the following:

• Appointments

• To-Do’s and Ticklers

• Anniversaries

• Alarms

• Phone numbers

3. Choose the Options button.

 The ECCO Timex Data Link Options dialog box appears.

4. Select the watch model from the list box.

5. Select the type of transmission—monitor or laptop adapter.

Note: The first time you run the Timex Data Link export, or when you change the Watch
model or Transmit using option, the ECCO Timex Link Calibrate dialog box will
appear.  It is also recommended that anytime you make changes to your monitor
that you choose the Calibrate button.

Page 131



121 ECCO User’s Guide

6. Enter the number of days of appointments, to-do’s and ticklers, anniversaries, and
alarms data to transmit.  The maximum setting is 30 days.

7. Enter the checkmark column name that you have used to select the ECCO
PhoneBook items to be transmitted.  The default is Timex.

8. Choose the OK button.

 The ECCO Timex Data Link dialog box appears.

9. Choose the OK button.

 The Preparing to Transit dialog box appears.

10. Choose the OK button.

11. Hold the watch in front of the screen until the receive completion tone sounds.

For more information on using the watch, see the Timex Data Link User’s Guide provided
with your Timex Data Link watch.

Using ECCO with the U.S. Robotics ® Pilot ™ PDA
Note: This feature is available only in the 32-bit version of ECCO Pro. The Pilot

HotSync Options command on the Tools menu is displayed, but disabled, in the
16-bit version of ECCO Pro.

With ECCO you can synchronize your PhoneBook, to-do’s, appointments, and selected
notes with your Pilot PDA.

Step-by-step instructions are provided in this document for a variety of scenarios while
using ECCO with your Pilot.  It is highly recommended that you read through the
document to become familiar with the Pilot synchronization process, any limitations that
may pertain to your situation, and to learn about the options available for data
synchronization.

Setting Pilot synchronization options

1. From the Tools menu in ECCO, select Pilot HotSync Options.

 The Pilot Synchronization Options dialog box appears and contains the following
fields:
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General

Field Meaning

PhoneBook Synchronize data in ECCO’s PhoneBook and Pilot’s Address
Book.

Calendar Synchronize data in ECCO’s Calendar and Pilot’s Date Book.

To-Do’s Synchronize data in ECCO’s To-Do’s section and Pilot’s To
Do List.

Memos Synchronize data in ECCO’s Notepads and Pilot’s Memo Pad.

HotSync button Launches Pilot HotSync Manager or maximizes if minimized.

Calendar, PhoneBook, To-Do’s, and Memos

Field Meaning

No Subs Do not synchronize subitems for the selected module.

Delete As Archive Any data deleted on the Pilot should be assigned to ECCO’s
archive folder.

Normal Sync Synchronize data that is new or has been modified for the
selected module.

Full Sync Synchronize all data regardless of status for the selected module.

Clear Pilot Data First Erase the data in the selected Pilot module before resending
ECCO data.

Note: The Memos tab does not have an option for No Subs.
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Synchronizing your data for the first time

Transferring your data between ECCO and the Pilot is as easy as pressing the HotSync
button.

Note: If you have previously used the Pilot Desktop you should synchronize so the Pilot
contains the most recent data.  Once you begin using ECCO with the Pilot, do not
continue use of the Pilot Desktop.  Using the Pilot Desktop in combination with
ECCO may result in irrecoverable data loss.

1. From the Tools menu in ECCO, select Pilot HotSync Options.

 The Pilot Synchronization Options dialog box appears.

 

1. Choose the HotSync button.

 The Hot Sync Manager window appears.

Note:   Choosing the HotSync button launches the HotSync Manager.  If the HotSync
Manager is already running or minimized the window is maximized and
brought to the forefront.

1. With the Pilot in its transfer cradle, press the HotSync button.

 The Users dialog box appears.
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Note:   These steps assume that you are using a Pilot that has been hard reset or never
synchronized with any other program.  If you have synchronized with the
Pilot, you will not see the Users dialog box, the The HotSync Progress dialog
box appears followed by the Choose ECCO File to Synchronize with Pilot
dialog box.  You may proceed to step 7.

1. Choose the New button.

 The New user dialog box appears.

1. Type a new user name and choose the OK button.

 The Users dialog box is displayed with the name you just entered.

1. Be sure the correct user name is selected if more than one name appears and choose
the OK button.
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 This user name is sent to and recorded in the Pilot.  The HotSync Progress dialog box
appears followed by the Choose ECCO File to Synchronize with Pilot dialog box.

1. Navigate to the correct folder and highlight the ECCO file you want to synchronize
with the Pilot.

2. Choose the Open button.

 The HotSync Progress dialog box appears as ECCO transfers data to the Pilot.

 The HotSync Progress dialog box will display a Status of HotSync Complete and the
Pilot will display “Hot Sync Complete” at the completion of the data transfer.

Synchronizing your data after the first time

Note: Once you begin using ECCO with the Pilot, do not continue use of the Pilot
Desktop.  Using the Pilot Desktop in combination with ECCO may result in
irrecoverable data loss.

1. With the Pilot in its transfer cradle, press the HotSync button.
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 The HotSync Progress dialog box appears as ECCO and the Pilot synchronize data.
The Pilot will display “Hot Sync Complete” at the completion of the data transfer.

You will not have to select the ECCO file again.  Data is synchronized between the Pilot
and ECCO.

Note: If the ECCO file on your computer is moved or deleted, you will be prompted with
the Choose ECCO File to Synchronize with Pilot dialog box.  Navigate to the
correct folder and highlight the ECCO file.  Choose the Open button.

Synchronizing selected modules only

ECCO gives you the ability to select which of the four modules to synchronize during a
HotSync.

1. From the Tools menu in ECCO, select Pilot HotSync Options.

 The Pilot Synchronization Options dialog box appears.

2. On the General tab check each module to be synchronized.

 You can select any combination, including all modules, to synchronize.

3. Select the General tab.

4. Choose the HotSync button.

 The Hot Sync Manager window appears.

5. With the Pilot in its transfer cradle, press the HotSync button.

 The HotSync Progress dialog box appears as ECCO and the Pilot synchronize data.
The Pilot will display “Hot Sync Complete” at the completion of the data transfer.

Restoring data on the Pilot and in ECCO

Situations may arise where you want to synchronize with a new ECCO file.  You may also
want to delete some or all of the data in the Pilot.  The following three sections will guide
you through the procedures to:

• Synchronizing Pilot data into a different ECCO file

• Synchronizing part or all of your ECCO data into the Pilot

• Synchronizing ECCO data with a completely erased (hard reset) Pilot

Synchronizing Pilot data into a different ECCO file

If you want to begin synchronizing with a different ECCO file and export the data from
your Pilot to this new file, do the following steps.  This assumes that you want to discard
the entire contents of your ECCO file.
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Note: If you do not want to discard the data in the ECCO file you are currently
synchronizing with, rename the ECCO file before proceeding.  You will no longer
be able to synchronize this file with the Pilot after you rename the file.

1. Create a new ECCO file and save it with the same filename in the same location as
the previous ECCO file you were synchronizing with.

Note:   You can also open an existing ECCO file that contains data, but you will need
to save the file (File, Save As) as the same filename and in the same location
as the ECCO file you are currently synchronizing with.

 The Pilot was programmed during the original synchronization to look for this ECCO
filename in the specified location on the hard drive.

2. From the Tools menu in ECCO, select Pilot HotSync Options.

 The Pilot Synchronization Options dialog box appears.

3. On the General tab check each module to be synchronized.

4. Switch to each Module tab (Calendar, PhoneBook, To-Do’s, and Memo) and select
Full Sync for the Synchronization Method.

1. Choose the OK button.

 Selecting the Full Sync option sends all data in the Pilot to the new ECCO file.

2. Place the Pilot in the HotSync cradle and press the HotSync button on the cradle.

3. In ECCO from the Tools menu select Pilot HotSync Options.

 The Pilot Synchronization Options dialog box appears.

4. Switch to each Module tab (Calendar, PhoneBook, To-Do’s, and Memo) and select
Normal Sync for the Synchronization Method.

5. Choose the OK button.

6. Save the ECCO file.

 The ECCO file and the Pilot are now synchronized.
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Synchronizing part or all of your ECCO data into the Pilot

The occasion may arise where you want to refresh (erase) the data in some or all of the
modules of the Pilot.  By doing these steps you can have all of the existing data in the
selected modules on the Pilot cleared before the data transfer from ECCO begins.

1. Open the ECCO file you have synchronized with the Pilot.

2. From the Tools menu in ECCO, select Pilot HotSync Options.

 The Pilot Synchronization Options dialog box appears.

3. Check the modules that you want to clear and reload from ECCO.

4. Click on the tab of each module you checked on the General tab.

5. Select the Full Sync option in the Synchronization Method section.

6. Check the Clear Pilot Data First option.

7. Repeat steps 4 - 6 for each module checked on the General tab.

8. Choose the Apply button.

9. Click on the General tab.

10. Choose the HotSync button.

Note:   Choosing the HotSync button launches the HotSync Manager.  If the HotSync
Manager is already running or minimized the window is maximized and
brought to the forefront.

11. With the Pilot in its transfer cradle, press the HotSync button.

 The HotSync Progress dialog box appears as ECCO and the Pilot synchronize data.
The Pilot will display “Hot Sync Complete” at the completion of the data transfer.

 For each module you chose to Clear Pilot Data First, the Pilot data was cleared then
synchronized with the data in ECCO.

Synchronizing ECCO data with a completely erased (hard reset) Pilot

If you want to completely erase the data in your Pilot and synchronize with ECCO (either
a new file or reload an existing ECCO file) into a blank Pilot, do the following steps.

1. Press and hold the green power button in on the Pilot, then insert a paper clip or
similar object in the reset hole on the back of the Pilot.  Remove the paper clip, then
release the green power button.

 The message Erase All Data? appears.

2. Press the up button on the Pilot to confirm the data erasure.
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Note:   This method erases all data in the Pilot, including any add-on applications
(.PRC files) you have uploaded into the Pilot.

 If you did not see the Erase All Data? prompt, the reset was not successful.  You
must see this message and respond Yes to properly reset the Pilot.

 For additional resetting information, see the Pilot User’s Guide that came with your
Pilot.

3. Create and save an ECCO file or open an existing ECCO file.

4. From the Tools menu, select Pilot HotSync Options.

 The Pilot Synchronization Options dialog box appears.

5. On the General tab be sure all four modules are checked.

6. Switch to each Module tab (Calendar, PhoneBook, To-Do’s, and Memo) and select
Full Sync for the Synchronization Method.

7. Choose the OK button.

 Selecting the Full Sync option sends all data in the ECCO file to the Pilot.

8. With the Pilot in its transfer cradle, press the HotSync button.

 The Users dialog box appears.

Note:   To remove user name list from the Users dialog box delete the USERS.DAT
file located in the \ECCO\PILOT folder on the hard drive.

9. Choose the New button.

 The New user dialog box appears.

10. Type a new user name and choose the OK button.

 This user name is sent to the Pilot.  The HotSync Progress dialog box appears
followed by the Choose ECCO File to Synchronize with Pilot dialog box.

11. Navigate to the correct folder and highlight the ECCO file.

12. Choose the Open button.

 The HotSync Progress dialog box appears as ECCO transfers data to the Pilot.  The
Pilot will display “Hot Sync Complete” at the completion of the data transfer.

13. In ECCO from the Tools menu select Pilot HotSync Options.

 The Pilot Synchronization Options dialog box appears.

14. Switch to each Module tab (Calendar, PhoneBook, To-Do’s, and Memo) and select
Normal Sync for the Synchronization Method.
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Note: If you forget to change the Synchronization Method back to Normal Sync do not
worry.  Synchronization will take longer as all items are being transferred, but data
integrity will be maintained.

15. Save the ECCO file.

 The Pilot now contains a synchronized copy of the data that is in the ECCO file.

Special Notes
ECCO allows for very powerful, flexible customization to items in your file.  The Pilot
synchronization feature does have some limitations.  You should carefully read this
section before you begin using ECCO with the Pilot.

Calendar Module

Excluding older Appointments from synchronization

By default, all calendar items are synchronized with the Pilot.  Most likely, there are older
items that you do not want to send to your Pilot.

To exclude these items, you can do the following in your ECCO file:

1. From the View menu, select Notepads, then New Notepad.

 The Create Notepad dialog box appears.

2. Choose the Options button.

 The Create Notepad Options dialog box appears.

3. Select Display The Items From Existing Folders In This Notepad.

4. Beneath Click On A Folder To Add To Notepad scroll to the Appointments folder
which is a subfolder of Scheduling.  If a + symbol appears to the left of the
Scheduling folder, click with the left mouse button on the + symbol to expand the
subfolders.

5. Click on the Appointments folder.

 A checkmark will appear to the left of the folder and the folder name will appear
beneath Folders In Notepad.

6. Choose the OK button.

 The Create Notepads dialog box appears.

7. Choose the OK button.

 A Notepad view containing items in the Appointments folder appears.

8. From the Tools menu, select Sort View.
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9. Select Entire View, Appointments in the listbox, and Ascending for Sort Key 1.

10. Choose the OK button.

11. From the Column menu, select Insert Column, Existing Column or Folder.

12. Scroll until you see Pilot Archive (check).

13. Click on Pilot Archive (check) to highlight the folder.

14. Choose the OK button.

 The Pilot Archive folder becomes a column in the Notepad.

15. Click in the Pilot Archive column to add a checkmark beside each Appointment item
you do not want to synchronize with the Pilot.

 When you synchronize, Appointments with the Pilot Archive column checked will
not be sent to the Pilot.

Date folders

ECCO transfers items only from the Appointments section.  Other date folders are not
transferred.  You can transfer items dated between January 1, 1970 and December 31,
2031.

Certain item recurrences cannot be transferred to the Pilot.  These include items recurring
more than one day in a month or year, recurring the fifth week of a month, or recurrences
designed for the first or last business day of the month.

Recurring items

All recurrences will have notes attached unless they are exceptions.  An exception could
be an item that was moved to a new time or date in ECCO.  The Pilot will create this item
as in independent item, while ECCO still maintains the link to the other recurring items.
If you then change the item on the Pilot, a new separate item will be introduced in ECCO
and the link to the other ECCO recurring items will be lost.

ECCO versus Pilot alarm settings

ECCO has 24 alarm settings.  The Pilot contains addition settings.  To avoid possible
duplication of items, when assigning an alarm to an item in Pilot use a an alarm setting
that is available in ECCO.  If an alarm setting is chosen on the Pilot that is not available
in ECCO, the alarm will be associated with the closest setting available.  The 24 alarm
settings in ECCO are as follows:

• 5, 10, 15, 30, 45, or 90 minutes

• 1, 2, 3, 4, 5, or 6 hours, days, or weeks
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Multiple alarms

If you have multiple alarms associated with an event, for example a reminder five, four,
and three days before an event, only the alarm nearest the event will be transferred.  This
is a limitation of the Pilot.  You should note that modifying the item in the Pilot will have
consequences when the item is synched with the ECCO file.  Changes made to the
multiple alarm attribute item in Pilot will cause the loss of special alarm attributes in
ECCO, such as playing a sound file or launching an application.  In addition, the multiple
alarms will be reduced to just the one alarm closest to the event.

PhoneBook Module

Special Pilot Address Book fields

There are several fields in the Pilot that are not in ECCO.  These include the Address
Book category, pager number, main number, and custom fields 1 - 4.  These fields will be
added to the ECCO file.

The Pilot uses one address per Address Book entry.  The address transferred to the Pilot
is determined by the ECCO “Address to use when printing” option on the New
PhoneBook name form.  You can also select PhoneBook item(s) and choose Address
Printing from the PhoneBook menu to designate this preference.

First name, last name order

The Pilot uses separate fields for Last Name and First name.  ECCO uses one name field.
As a result, this causes certain entries, such as single name entries or entries with
punctuation like business names to exhibit special behaviors.

An example of a single name entry is as follows:

If you create a PhoneBook record in ECCO and input only the name “Floyd” in the Name
(Last, First) field the name Floyd will appear in the Pilot with Floyd in the Last Name
field.

If you create an Address Book entry on the Pilot and enter a name only in the First name
field, the name will appear in the Name (Last, First) field in ECCO when synchronized.
Upon the second synchronization, the Pilot record will be modified to display the name
“Floyd” in the Last Name field.

All single name entries in ECCO will ultimately appear in the Last name field of the Pilot.

Address 1 and Address 2 field in ECCO

Using the “Address 1” and “Address 2” fields in ECCO will transfer the information to
the first two lines of the Pilot Address field.
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To-Do Module

Note: In the ECCO Tickler section only items in the To-Do’s folder are synchronized.
Items in any other folder displayed in the Tickler section are not transferred.

Excluding older To-Do’s from synchronization

By default, all To-do’s are synchronized with the Pilot.  Most likely, there are older items
that you do not want to send to your Pilot.

To exclude these items, you can do the following in your ECCO file:

1. From the View menu, select Notepads, then New Notepad.

 The Create Notepad dialog box appears.

2. Choose the Options button.

 The Create Notepad Options dialog box appears.

3. Select Display The Items From Existing Folders In This Notepad.

4. Beneath Click On A Folder To Add To Notepad scroll to the To-Do’s folder which is
a subfolder of Scheduling.  If a + symbol appears to the left of the Scheduling folder,
click with the left mouse button on the + symbol to expand the subfolders.

5. Click on the To-Do’s folder.

 A checkmark will appear to the left of the folder and the folder name will appear
beneath Folders In Notepad.

6. Choose the OK button.

 The Create Notepads dialog box appears.

7. Choose the OK button.

 A Notepad view containing items in the To-Do’s folder appears.

8. From the Tools menu, select Sort View.

9. Select Entire View, To-Do’s in the listbox, and Ascending for Sort Key 1.

10. Choose the OK button.

11. From the Column menu, select Insert Column, Existing Column or Folder.

12. Scroll until you see Pilot Archive (check).

13. Click on Pilot Archive (check) to highlight the folder.

14. Choose the OK button.

 The Pilot Archive folder becomes a column in the Notepad.
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15. Click in the Pilot Archive column to add a checkmark beside each item you do not
want to synchronize with the Pilot.

 When you synchronize, items with the Pilot Archive column checked will not be sent
to the Pilot.

To-Do dates

ECCO assigns all To-Do’s a date.  The Pilot does not automatically assign dates to To-
Do’s.  During synchronization ECCO will use the current date of the synchronization as
the date for To-Do’s created in the Pilot.  If you move or modify the date on the Pilot-
created To-Do in ECCO, the date assigned to the To-Do during synchronization will be
sent back to the Pilot and the Pilot’s blank To-Do date will now contain the date that
appears in ECCO.

In order for To-Do’s to be displayed in ECCO on other day views besides the
synchronization date, you may have to modify the properties of the To-Do’s folder in
ECCO.

1. From the Calendar menu in ECCO, select Options.

 The Calendar Options dialog box appears.

2. Select the Ticklers tab.

3. Choose the Tickler Item Options button.

 The Choose Tickler Type dialog box appears.

4. Select To-Do’s and choose the OK button.

 The Date Properties dialog box appears.

5. Select Until Marked Done from the Carry Forward listbox.

6. Choose the OK button to save and close the Date Properties dialog box.

7. Choose the OK button to close the Calendar Options dialog box.

 Now any To-Do item entered in the Pilot will appear in ECCO from the date of
synchronization until the item is marked done.

Items from the To-Do’s folder are synchronized with the Pilot.  If you want a ticker item
to be synchronized, it must be in the To-Do folder.

Two new folders are introduced in ECCO by the Pilot.  These two folders are the “ToDo
Category” and “Priority” number folder.  The latter folder uses numbers one through five
for priority coding.
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Marking To-Do’s “done”

When you mark an item completed in the Pilot, the “Done” date folder in ECCO will
display the date you synchronize with your ECCO file.

Recurring To-Do’s

Recurring To-Do’s will display in the Pilot as the next due date after the last done date.
This is identical to the behavior in ECCO.

Memo Module

Line spacing

A blank line will be inserted on the Pilot between items prefaced with a bullet in ECCO.
Lines created by soft returns or pressing CTRL+ENTER in an ECCO outline will not be
prefaced with a blank line.

For example, in ECCO you may have the following outline:
���&RQWDFW�FRQYHQWLRQ�FHQWHU�&RQWDFW�FRQYHQWLRQ�FHQWHU

���:KDW�GDWHV�DUH�DYDLODEOH"�:KDW�GDWHV�DUH�DYDLODEOH"

���:KDW�DUH�WKH�GHSRVLWV"�:KDW�DUH�WKH�GHSRVLWV"

���0DNH�EDQN�GHSRVLW�0DNH�EDQN�GHSRVLW

When synchronized, the information would appear in the Pilot as follows:

&RQWDFW�FRQYHQWLRQ�FHQWHU&RQWDFW�FRQYHQWLRQ�FHQWHU

:KDW�GDWHV�DUH�DYDLODEOH":KDW�GDWHV�DUH�DYDLODEOH"

:KDW�DUH�WKH�GHSRVLWV":KDW�DUH�WKH�GHSRVLWV"

0DNH�EDQN�GHSRVLW0DNH�EDQN�GHSRVLW

Likewise, to create items in the Pilot that will appear as bulleted top level items (TLIs) in
ECCO a blank line must be left between each line in the Pilot Memo Pad.

Changing subnotes on the Pilot doesn’t change ECCO subnotes

If you create a Memo on the Pilot and synchronize with ECCO, then modify the Memo on
the Pilot, the item modified will remain unchanged in ECCO and a new item will be
added that is identical to the changed Pilot item.  Thus, an additional item now appears in
ECCO.

For example, in the Pilot you create a Memo with three items:

7RP�VD\V�KH�FDQ�FRGH�QHZ�SURGXFW�LQ�WKUHH�ZHHNV7RP�VD\V�KH�FDQ�FRGH�QHZ�SURGXFW�LQ�WKUHH�ZHHNV

+5�VD\V�ZH�FDQ�RQO\�ZRUN�7RP����KRXUV�SHU�ZHHN+5�VD\V�ZH�FDQ�RQO\�ZRUN�7RP����KRXUV�SHU�ZHHN

3URGXFW�PXVW�VKLS�LQ�WKUHH�ZHHNV3URGXFW�PXVW�VKLS�LQ�WKUHH�ZHHNV

When synchronized with ECCO the above memo appears as follows:

���7RP�VD\V�KH�FDQ�FRGH�QHZ�SURGXFW�LQ�WKUHH�ZHHNV�7RP�VD\V�KH�FDQ�FRGH�QHZ�SURGXFW�LQ�WKUHH�ZHHNV
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���+5�VD\V�ZH�FDQ�RQO\�ZRUN�7RP����KRXUV�SHU�ZHHN�+5�VD\V�ZH�FDQ�RQO\�ZRUN�7RP����KRXUV�SHU�ZHHN

���3URGXFW�PXVW�VKLS�LQ�WKUHH�ZHHNV�3URGXFW�PXVW�VKLS�LQ�WKUHH�ZHHNV

If you now make a modification in the Pilot to one of the items, like the third item for this
example, watch the effect in ECCO:

���7RP�VD\V�KH�FDQ�FRGH�QHZ�SURGXFW�LQ�WKUHH�ZHHNV�7RP�VD\V�KH�FDQ�FRGH�QHZ�SURGXFW�LQ�WKUHH�ZHHNV

���+5�VD\V�ZH�FDQ�RQO\�ZRUN�7RP����KRXUV�SHU�ZHHN�+5�VD\V�ZH�FDQ�RQO\�ZRUN�7RP����KRXUV�SHU�ZHHN

���3URGXFW�PXVW�VKLS�LQ�IRXU�ZHHNV�3URGXFW�PXVW�VKLS�LQ�IRXU�ZHHNV

Upon the next synchronization the following appears in ECCO:

���7RP�VD\V�KH�FDQ�FRGH�QHZ�SURGXFW�LQ�WKUHH�ZHHNV�7RP�VD\V�KH�FDQ�FRGH�QHZ�SURGXFW�LQ�WKUHH�ZHHNV

���+5�VD\V�ZH�FDQ�RQO\�ZRUN�7RP����KRXUV�SHU�ZHHN�+5�VD\V�ZH�FDQ�RQO\�ZRUN�7RP����KRXUV�SHU�ZHHN

���3URGXFW�PXVW�VKLS�LQ�WKUHH�ZHHNV�3URGXFW�PXVW�VKLS�LQ�WKUHH�ZHHNV

���3URGXFW�PXVW�VKLS�LQ�IRXU�ZHHNV�3URGXFW�PXVW�VKLS�LQ�IRXU�ZHHNV

The original third item remains in ECCO and new fourth item appears.

Note: Changes made on the Pilot to a memo subnote will add new items to ECCO and
don’t delete the item that was modified on the Pilot.

A new popup folder called “Pilot Memos” will be created in your ECCO file.  This field
is used to designate items and their category that sync to pilot memos.

You can also insert the “Pilot Memos” folder as a column in any notepad new to
designate items to send to the Pilot and the appropriate category.

It is important to note that the order of items within a memo pad is not synchronized.

For more information on exporting data to a U.S. Robotics Pilot PDA, see the
TECHINFO.ECO file located in the folder where ECCO Pro was installed.

General Notes

Items exceeding 4 kilobytes (KB)

if an item in ECCO (the top level item and all of its subitems) exceeds 4 KB, then only
the top level item (TLI) is synchronized with the Pilot.  This is a size limitation of the
Pilot.
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When you attempt to synchronize an ECCO item that exceed the 4 KB limit, three actions
occur.

• ECCO checks the Pilot No Notes column for the TLI

• ECCO transmits only the TLI to the Pilot

• A notation is made in the HOTSYNC.LOG file stores in the subfolder of the
\ECCO\PILOT directory corresponding to the user’s name.  (i.e.
\ECCO\PILOT\FLOYD)

Order of notes is not synchronized

It is important to understand that the order of notes are not synchronized from the Pilot to
ECCO.  Arranging subnotes in a specific order will not alter the order displayed within
ECCO after synchronization.  Changes made in ECCO will change the order on the Pilot.

Must synchronize Pilot with a local ECCO file

If you are using a shared ECCO file in a network environment, you can only synchronize
the Pilot with a locally saved copy.  If you open the ECCO file directly from the network
(File, Open Shared) and do not maintain a local copy, you will be unable to synchronize
this ECCO file with your Pilot.  To do so, you must make a replica or local copy by
choosing Save As from the ECCO file menu.

Don’t check subitems for any ECCO/Pilot customization column

If you have one of the Pilot customization columns appearing in your view, it is important
to only check top level items (TLIs).  For example, if you have a PhoneBook entry that
contains subnotes that you do not want to transfer to the Pilot, place a checkmark in the
Pilot No Notes column adjacent to the PhoneBook item TLI.  Placing a checkmark in the
column adjacent to the subnotes can have adverse effects.

Other Pilot links stop working after synchronizing with ECCO

Verify that the other Pilot applications are compatible with HotSync Manager 1.1
(HSM11.EXE), which ECCO installs for use with the Pilot.  The is the latest version and
is required by ECCO.  If other programs you are using with the Pilot stop working after
you begin using ECCO with the Pilot, contact the manufacturer of the other application to
verify they are compatible with version 1.1.

ECCO columns created for synchronization with the Pilot

• Pilot Record ID (hidden):  This ID number is used to synchronize the ECCO item
with the Pilot entry.

• Pilot Archive:  When checked, the item is not synchronized with the Pilot.

• Pilot No Notes:  When a top level item (TLI) has the column checked no subnotes
are synchronized to the Pilot.  This column is also automatically checked during the
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synchronization process if more than 4 KB of data is detected for one TLI, including
subnotes.

• • Pilot Memos:  Items in ECCO with this column checked are sent to the Pilot as
memos.

• • PhoneBook Category:  Items in ECCO with this column checked are sent to the
Pilot as Address Book items.

• • Main #:  This is a Pilot field that is created as a folder in ECCO.

• • Pager #:  This is a Pilot field that is created as a folder in ECCO.

• • Display Phone (hidden):   Column used by synchronization process.

• • To Do Category:  This is a Pilot field that is created as pop-up list folder in ECCO.

• • Priority:  This is a Pilot field that is created an a numeric folder in ECCO.

• • PilotToDoDueDate (hidden):  Column used by synchronization process.

• • Custom 1:  This is a Pilot field that is created as a text folder in ECCO.

• • Custom 2:  This is a Pilot field that is created as a text folder in ECCO.

• • Custom 3:  This is a Pilot field that is created as a text folder in ECCO.

• Custom 4:  This is a Pilot field that is created as a text folder in ECCO.
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Chapter 10.  Using ECCO with Other
Programs
With ECCO you can create powerful connections to other programs and documents and
copy information between programs with ease.  You can even use other programs without
leaving ECCO, allowing ECCO to become the control center of your computer.

Copying Information between Programs
You can copy information between ECCO and other programs using a tool called the
Shooter.  The Shooter lets you copy items from another program directly into ECCO
views, copy information from ECCO into other programs, and copy information between
programs.  The Shooter provides a quick way to get information from electronic-mail,
word-processing, or spreadsheet programs into the right location in your ECCO file.

You can copy information directly into ECCO folders.

Using other programs from within ECCO

You can directly access other programs while you are using ECCO:

• Create ECCO items that refer to programs or document files, and use the items to
launch the programs or documents.

• Use commands from the ECCO Tools menu or toolbar to launch other programs and
files.

• Embed OLE objects (graphics, charts, spreadsheets, and so forth) within ECCO
items, or link objects to items.

You can add imported items to any number of folders and apply forms and filters to them.

Introduction to the Shooter
The Shooter is a tool that lets you place information from other programs into ECCO—or
from ECCO into other programs—in one easy step.  You can also use the Shooter to send
information between two other programs.  The arrow-shaped Shooter icon appears by
default to the left of the Minimize button of the active program window whenever ECCO
is running.

Using the Shooter, you can copy information between programs, create links between
ECCO and information in other programs, and embed objects from other programs into
ECCO.
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The Shooter is the most efficient means of copying.  It allows you to instantly copy
information from your current program into any ECCO view.  You don't have to choose
Copy and Paste, and you don't have to leave your program.

By linking information from another program with ECCO, you ensure that changes made
to the linked file are reflected in the ECCO copy.  For example, you might link a
spreadsheet file to ECCO so that when the spreadsheet changes you see the new
information in ECCO.

By embedding information from another program into ECCO, you can edit and format it
while you are working in ECCO.  When you double-click an object embedded in ECCO,
the program in which you created the object opens, and the object is ready for editing.
For example, if you double-click an embedded graphic in ECCO, the painting program in
which you created the graphic opens, and you can make changes to the graphic without
really leaving ECCO.

Displaying the Shooter
By default, the Shooter icon appears on your screen whenever ECCO is running.  You can
drag the icon to any location for convenience.

The Shooter has its own customizable toolbar that can give you fast access to the
commands you use most frequently.

You can display the folder window in the Shooter so that you can add information from
other programs to your ECCO folders.  You can display or hide the toolbar and the folder
window, resize the Shooter display, or move or hide the Shooter icon.

To change the Shooter display

1. Switch to any program while ECCO is running.  If the Shooter icon is not visible,
from the Tools menu in ECCO, choose Options, then the Files tab.  Select the
Display Shooter option.

2. Click the Shooter icon.

 The Shooter menu appears.

3. From the Shooter menu, choose Show.

4. Choose one of the following commands:

• To display only the Shooter icon, choose Icon.

• To display the Shooter toolbar, choose Tools.

• To display the Shooter toolbar and the ECCO folder window, choose the Tools
and Folders command.

Page 152



143 ECCO User’s Guide

To hide or display the Shooter icon

From the Tools menu in ECCO, choose Options, then the Files tab.  Select Display
Shooter and the Shooter icon appears (or disappears) from view.

Setting Shooter Preferences
You can change the settings of the Shooter using the Preferences command on the
Shooter menu.  Under Preferences, you can switch to or open another ECCO file to which
you want to send information.  You can specify how you want text and graphics sent and
indicate whether you want ECCO to confirm before sending.

To set Shooter preferences

1. In any other program, click the Shooter icon.

 The Shooter menu appears.

2. From the Shooter menu, choose Preferences, and then choose one of the following
commands from the Shooter menu:

• To switch to another open ECCO file, select Choose ECCO File, and then
choose the ECCO file to which you want to switch.  To open an ECCO file that
isn't currently open, choose Open Another.  The Choose ECCO File command is
unavailable if the ECCO program is the active window.

• To send all text as editable text, choose Send Text As, and then choose Editable
Text.

• To send all text as linked or embedded OLE objects, choose Send Text As, and
then choose the appropriate option.

• To send all graphics as linked or embedded OLE objects, choose Send Graphics
As, and then choose the appropriate option.

• To display or hide the Send Text Selection As dialog box when sending text,
choose Send Text As, and then choose Ask Before Sending.

Sending Information to ECCO
The Shooter, lets you copy information from other programs into ECCO without
switching to ECCO:

• You can send information to any ECCO file and to any ECCO view.

• You can send information relative to the last piece of information you sent to ECCO.
In other words, the new information can be to the left of, to the right of, or at the
same level as the last information sent.  This feature simplifies outlining.

• You can send information to any ECCO folder.  You can also send information to
several folders at one time, while associating numbers, other text, or dates with it, by
using ECCO forms.
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To send information to ECCO

1. If the Shooter icon is not visible, from the Tools menu in ECCO, choose Options,
then the Files tab.  Select the Display Shooter option.

2. In any other program, select the source information (text or a graphic) that you want
to send to ECCO.

3. Click the Shooter icon.

 The Shooter menu appears.

4. Choose one of the following commands from the Shooter menu:

• To send the selected information to the active view or the Calendar in ECCO,
choose the corresponding command.

• To send the selected information to ECCO relative to the last information you
sent, choose Relative to Last, and then choose the desired option.

• To send the selected information to a folder, choose Folders, and then click a
folder name in the folder window.

• To add the selected information by form, choose Add By Form, and then choose
the named form you want.

If you chose Ask Before Sending in the Shooter Preferences, ECCO displays either the
Send Text Selection As or the Send Graphics Selection As dialog box.

Sending Information from ECCO
You can use ECCO to copy information created in ECCO to other programs. For
example, you might create notes in a Notepad while talking to a client on the phone.  You
could then send those notes directly to your word-processing program to form the basis of
a letter addressing your client's concerns.

To send items from ECCO to another program

You can send one or more items to another program from any ECCO view.

1. Select the items you want to send.

2. Click the Shooter icon.

 The Shooter menu appears.

3. From the Shooter menu, choose Other Program. ECCO lists only those programs that
are currently active and that can have text or graphics pasted into them from the
Windows Clipboard.

4. Choose the name of the program to which you want ECCO to send the information.
ECCO inserts the information into the selected program's active file at the insertion
point.
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To send PhoneBook information from ECCO to another
program

From the PhoneBook, you can send names and addresses in letterhead format to another
program.

1. Switch to the PhoneBook.

2. Select the name of the person whose address you want to send.

3. Click the Shooter icon.

 The Shooter menu appears.

4. From the Shooter menu, choose Other Program.  ECCO lists only those programs
that are currently active and that can have text or graphics pasted into them from the
Windows Clipboard.

5. Choose the name of the program to which you want ECCO to send the information.
The Copy Name & Address dialog box appears.

6. Select one of the following options:

• To send the selected name and address select the Address check box.

• To send the selected name, address, and phone and fax number, select the
Address & Work & Fax check box.

• To send all fields on the current PhoneBook form, including customized fields,
select the All Fields check box.

• To send the selected name and address and current  Outline notes select the
Outline Notes check box.

7. Choose the OK button.  ECCO inserts the PhoneBook information into the selected
program's active file at the insertion point.

To retrieve PhoneBook information from ECCO to another
program

You can retrieve name and address information from the PhoneBook and copy it to
another program, such as a word processor.

1. If the Shooter icon is not visible, from the Tools menu in ECCO, choose Options,
then the Files tab.  Select the Display Shooter option.

2. In any other program, click the Shooter icon.

 The Shooter menu appears.
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3. Choose the Get Address command from the Shooter menu.

 The Get Address dialog box appears.

4. Type the first few characters of the name you want.  Any names in the PhoneBook
that match the text appear in the text box.

5. Choose the Search button.

6. Select the name you want and take any of the following actions:

• Specify whether you want to include work and fax phone numbers or all fields in
the address you get.

• Specify whether you want to get the home or business address.

7. Choose the OK button.  ECCO inserts the PhoneBook information into the program's
active file at the insertion point.

Sending Information Between Non-ECCO Programs
You can send text and graphics between virtually any two Windows applications that are
running while ECCO is running.  For example, you could send text created in your word-
processing program to your electronic-mail program to avoid retyping information.

Sending Text

Sending text from one program to another works like copying and pasting — but in one
easy step.  When you click the Shooter icon, the Shooter copies the selected text to the
Windows Clipboard, switches to the destination program, and pastes the copied text into
the active file.

Sending Graphics

Graphics are either embedded in the destination file (if the destination program supports
OLE objects or pasted into the destination file.  Embedded graphics can be edited and
formatted from the originating program; pasted graphics can be changed only from within
the destination program.
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To send information between non-ECCO programs

1. Select the text or graphic you want to send.

2. Click the Shooter icon.

 The Shooter menu appears.

3. From the Shooter menu, choose Other Program, and then choose the name of the
program to which you want ECCO to send the information.

 ECCO switches you to the destination program and inserts the selection at the
insertion point.

Shooter Compatibility
The Shooter automatically recognizes most Windows applications.  If the Shooter does
not work with an application, you may need to modify the Windows Registry (ECCO.INI
for the ECCO 16-bit version).

1. From the Start button on the Windows taskbar, choose Run.

2. Type REGEDIT, then choose the OK button.

3. Expand the HKEY_CURRENT_USER folder.

4. Expand the Software folder.

5. Expand the NetManage folder.

6. Expand the ECCO folder.

7. Open the ECCO folder.

8. From the Edit menu, select New, then String Value.

9. Type the name of the application’s executable file (i.e. GOCIS.EXE).

10. Double click on the String name

 The Edit String dialog box appears.

11. In the Value Data textbox, type the appropriate code from the following list:

• For applications that do not have keyboard shortcuts, type 101.

• For applications that use CTRL + C (Copy) and CTRL + V (Paste), type 202.

• For applications that use CTRL + INS (Copy) and Shift + INS (Paste), type 303.

12. Choose the OK button.

13. From the Registry menu, choose Exit.
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If you are using the 16-bit version of ECCO, add the following line to the [ECCO] section
of ECCO.INI located in the Windows directory:

For applications that do not have keyboard shortcuts, add <application name>=101.

For applications that use CTRL + C (Copy) and CTRL + V (Paste), add <application
name>=202.

For applications that use CTRL + INS (Copy) and Shift + INS (Paste), add <application
name>=303.

For example, GOCIS requires the use of the CTRL + INS and Shift + INS. The entry in
your ECCO.INI would look like this:

[ECCO]
GOCIS.EXE=303

About Running Other Programs
Once you have inserted a File and Directory Reference into your ECCO file, you can use
the Launch command from the Tools menu to open any file or executable program.
When you have inserted a directory reference, you can use the Launch command to open
the directory and then launch any file in that directory.

You can also add any PC program executable (*.EXE), batch program (*.BAT), or other
file (*.*) directly to the Get Disk Files menu.  You can add icons for these items to the
ECCO toolbar.  Then, you can launch other programs, open files, or run batch programs
with a click of the mouse.

Launching Other Programs from ECCO
Once you have inserted a File and Directory Reference  into an ECCO file, you can
launch it.  When you launch a document file, ECCO starts the program and then opens the
file.

To launch a file from an ECCO file

1. Double-click the filename.

 Or

 Select the reference to the file you want to launch, and then from the Tools menu,
choose Launch.

2. ECCO launches the file. If the file no longer exists, ECCO lets you search for an
existing file and update the reference with the new filename.

To launch a file within a directory

1. Select the reference to the directory that contains the file you want to launch.
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2. From the Tools menu, choose Launch.

 The Choose File To Run dialog box appears, open to the proper directory.

3. From the File Name box, select the name of the file you want to launch.

4. Choose the OK button.

 ECCO launches the file.

Working with Disk Files
Using the Get Disk Files command on the Tools menu, you can insert filenames,
executable programs, and even entire directories from your disk into your ECCO files.
You can then launch these files and their associated programs from within ECCO.  This
feature allows ECCO to function as a file and program manager.

An item that contains a File Reference can be added to other ECCO folders, making the
file available to you in many other contexts.

When you insert a file or program reference into an ECCO file using the Get Disk Files
command, you paste its path (including the name of the file or directory) into ECCO.
Each reference becomes an item with all the capabilities of any other ECCO item.

Inserting File and Directory References into ECCO
You can browse through your directory structure from within ECCO and select a file to
insert.

To insert a reference to a single file

1. Select the item below which you want to insert the file reference.

2. From the Tools menu, choose Get Disk Files, and then choose Browse, Add As Item.

 The Choose File Name to Paste dialog box appears.

3. Select the name of the file you want to reference, and then choose OK.  ECCO inserts
an item with a file reference below the selected item.

Adding Files or Programs to the Get Disk Files Menu
You can launch any PC program executable (*.EXE), batch program (*.BAT), or other
file (*.*) from the Get Disk Files menu.  For example, you may want to add programs you
use frequently, such as the Windows Explorer, to the Get Disk Files menu.

To add items to the Get Disk Files menu

1. From the Tools menu, choose Get Disk File, and then choose Browse, Add To Menu.

 The Add File Name or Program to Menu dialog box appears.
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2. Take one or more of the following actions to locate the program or file that you want
to run:

• If the program is on a different drive, select the proper drive from the Look In
drives list box.

• Choose the folder or directory where the program or other file is located.  ECCO
displays the names of all files in the selected directory.  To display only program
files, select Programs from the Files of Type list box.

3. From the list of files, select the program that you want to run.

4. In the Menu Text box, type the program name or description you want displayed on
the Get Disk Files submenu.  Use any standard ASCII characters, including spaces
and hyphens; ECCO adds the selected filename by default.

5. Use the arrow buttons to select a toolbar icon for your program.

6. Choose OK.

 The name you entered in the Menu Text box appears on the Get Disk Files submenu,
and the toolbar icon appears in the Repeat box.

7. Add the icon to the toolbar. Using the right mouse button, click and drag the icon
onto the toolbar.

You can then click the icon to launch your application, run your batch file, open another
program file, and so on.

Managing Disk Files
After you have added your other programs, you may want to customize your Get Disk
Files submenu.  You can rename, delete, or reorder items on the Get Disk Files submenu.

To manage disk files

1. From the Tools menu, choose Get Disk file, and then choose Manage Menu.

 The Manage Menu dialog box appears.

2. Take one or more of the following actions:

• To rename a program, select the name of the program in the list box, and then
change the name in the Rename text box.

• To delete a program from the menu, select the name of the program in the list
box, and then choose the Delete button.

• To reorder programs on the Get Disk Files submenu, select the name of the
program in the list, and then choose either the Up or Dn reorder button.

3. When you have finished, choose OK.
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 The changes you made will appear on the Get Disk Files submenu.

Introduction to Linking and Embedding
OLE is a Windows term that stands for object linking and embedding.  An OLE object is
a piece of information from one program that is used by another program.  OLE objects
can be text, spreadsheet figures, graphics, charts, or other types of information.

When you embed an object, you place information created in another program into
ECCO.  Embedding is similar to copying, but with an important distinction — it doesn't
require that you switch between programs to make changes to objects.  Simply double-
click the object you want to modify, and the originating program will open, allowing you
to change the information.

When you link an object, you make an association (a reference or link) between ECCO
and the source file that contains the object; no copy of the object is made.  Accordingly,
when you make changes to a linked object, you are making changes to the actual source
file.

Embedding an object into your ECCO file or linking an object to your file has many
benefits.  By using OLE you can

• Extend ECCO's performance.  You can work in programs that support OLE from
within ECCO.

• Concentrate on a task by collecting in one location—an ECCO file—all the tools you
need to complete the task.  You can open the program from within ECCO, make your
changes, and continue working without interruption.

• Update all linked objects in your ECCO file.

You can link and embed OLE objects in several ways:

• By using the Shooter

• By copying information from another program and then using the Paste Special
command on the Edit menu

• By creating an embedded object “from scratch” with the Insert command on the Edit
menu

Should I Link or Embed?

If you want an object to appear in several documents and if you want changes made in
one place to be reflected every place the objects exists, you should link it.  If you don't
want changes made reflected everywhere an object exists, then you should embed the
object.

For example, you might move a spreadsheet chart into your ECCO file but later add new
figures to the spreadsheet—figures that affect the chart.  If you want all such changes to
the spreadsheet reflected in the chart you've inserted into ECCO, you should insert the
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chart as an OLE link.  If you don't want the chart to change after you place it in ECCO,
you should insert the chart as an OLE object.

Embedding OLE Objects
You can embed an object in ECCO in three ways:

• By using the Shooter.

• By using the Insert command on the Edit menu.

• By copying and pasting using the Paste Special command on the Edit menu.  For
graphics, you use the Paste command on the Edit menu.

To embed an existing object using the Shooter

1. Select the information (object) you want to embed in ECCO.

2. From the Shooter menu, choose Preferences, and then choose one of the following:

• To send text, choose Send Text As.

• To send graphics, choose Send Graphics As.

3. Choose OLE object.

 Or

 Choose Ask Before Sending.

4. Using the Shooter, send the object to ECCO (choose Active view, Calendar, Folders
or Relative to Last).

 If you chose Ask Before Sending, ECCO displays either the Send Text Selection As
or the Send Graphics Selection As dialog box.  Select OLE Object.

To create and embed an object from within ECCO

1. Move the insertion point to the position in the ECCO file at which you want to embed
the new object.

2. From the Edit menu, choose Insert Object, and then choose the program you'll use to
create the embedded object.

 The program opens.

3. Create the object and then quit the program.  If the program asks if you want to
update the embedded object or save changes before proceeding, choose Yes.

The program window closes, and the ECCO window (containing the new embedded
object) appears.
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To embed an existing object using the Paste Special command

1. In another program, select the information (object) you want to embed in ECCO.

2. From the Edit menu, choose Copy.

3. Switch to ECCO.

4. From the Edit menu in ECCO, choose Paste Special, and then choose OLE Object.
ECCO embeds the object at the insertion point.

Editing Embedded Objects
You edit an embedded object from within the program it was created in, without affecting
the source file.

To edit an embedded object

1. Double-click the embedded object.

 Or

 Select the object and, from the Edit menu, choose Objects, and then choose Edit.
The originating program opens, displaying the object.

2. Make any desired changes.

3. Quit the program.

 ECCO prompts if you want to update the embedded object in your ECCO file before
proceeding.

4. Choose the Yes button.

The program window closes and the ECCO window (containing the edited embedded
object) appears.

Linking OLE Objects
You can link an object from another program to ECCO in two ways—by using the
Shooter or by using the Paste Special command.

To create an OLE link using the Shooter

1. Select the information (object) you want to link to ECCO.

2. From the Shooter menu, choose Preferences, and then choose one of the following:

• To send text, choose Send Text As.

• To send graphics, choose Send Graphics As.

3. Choose OLE Link.
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 Or

 Choose Ask Before Sending.

4. Using the Shooter, send the object to ECCO.

 If you selected Ask Before Sending, ECCO displays either the Send Text Selection
As or the Send Graphics Selection As dialog box.  Select OLE Link.

To create an OLE link using the Paste Special command

1. In another program, select the information (object) you want to embed in ECCO.

2. From the Edit menu, choose Copy.

3. Switch to ECCO.

4. From the Edit menu in ECCO, choose Paste Special, and then choose OLE Link.
ECCO inserts the link at the insertion point.

Editing Linked Objects
You edit a linked object from within the file in which it was originally created (the source
file).  When you edit a linked object, the changes are reflected in ECCO and in the
original source file.

To edit a linked object

1. Double-click the linked object.

 Or

 Select the object and, from the Edit menu, choose OLE Links to display the Links
dialog box.  Select the link you want to edit, and then choose the Edit button.  The
source file opens.

2. Make any desired changes.

3. Quit the program.  The program asks if you want to save changes before proceeding.

4. Choose the Yes button.

The program closes and the ECCO window (containing the updated linked object)
appears.

Updating Links
ECCO can update links automatically, or you can update links manually:

• Automatic updating is the default.  If ECCO is running and the file is open, changes
in the linked file are reflected immediately.  If ECCO is not running when changes
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are made, you have the option of updating the links the next time you open an ECCO
file.

• Manual updating can be used for any link.  Use this option to maintain greater control
over the updating of information.  When you close or save a file that contains
manually updated links, ECCO gives you the option of updating them.

To specify manual link updating

1. From the Edit menu, choose Links.

 The Links dialog box appears.

2. From the list, select the link or links you want to update manually.

3. Change the Update option to Manual.

4. Choose the OK button.

To update links manually

1. From the Edit menu, choose Links.

 The Links dialog box appears.

2. From the list, select the links you want to update.

3. Choose the Update Now button.

 ECCO updates the selected links

Changing Links
Once you've linked an OLE object to ECCO, you can change the link if you need to.  For
example, suppose you link a spreadsheet to ECCO and then save the updated spreadsheet
under a different name, thus breaking the link to the file containing the most recent
changes.  You can change the linked item in ECCO so it reflects the new filename and re-
establishes the link.
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To change a link

1. From the Edit menu, choose Links.

 The Links dialog box appears.

2. From the Link list, select the link you want to change.

3. Choose the Change Link button.

 The Change Link dialog box appears

4. From the File Name list, choose a new file to which to link.

5. Choose the OK button, and then choose the OK button again to close the Links
dialog box.

Resizing Linked or Embedded Objects
You can change the size of a linked or embedded object.

To resize a linked or embedded object

1. Select the object you want to resize.

2. Drag the handle in the lower-right corner of the object.

 Or

 Click the button in the upper-left corner of the object, and then take one of the
following actions:

• To reduce the selected object to a minimized size, choose Minimize.

• To return an object to its previous resized state, choose Adjusted Size.

• To return an object to its original size, choose Original Size.

Deleting Linked or Embedded Objects
You delete linked and embedded objects just as you delete any other item in ECCO.

To delete an OLE object

1. Select the object you want to delete.

2. From the Edit menu, choose Delete Items.

 The object is deleted from the file.

 Or

 If the Delete Items dialog box appears, choose OK to delete the object entirely from
the file.
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Correspondence Manager
Correspondence Manager integrates your ECCO PhoneBook with the most popular
Windows word processors.  Just select an individual contact or a group of contacts, and
ECCO’s Correspondence Manager gives you the following choices:

• Print your letter using your favorite word processor

• Fax your letter using Symantec’s WinFax PRO

You can create a personalized single letter on the fly, or create form letters to be sent to a
group of contacts.

Correspondence Manager can even automatically record the date and imbed a link to the
letter as part of the record’s contact history.

Note: Correspondence Manager is designed to work with the U.S. English versions of
supported word processors. If you are using a word processing program written for
distribution outside of the United States, Correspondence Manager may not work.
In addition, Correspondence Manager is designed for U.S. English only. Foreign
language menus are not supported.

Configuring the Correspondence Manager

The first time you start Correspondence Manager, you will be asked to configure it for use
with your word processor.

1. Choose Correspondence Manager from the PhoneBook menu.  If this is the first time
you have used Correspondence Manager, the Setup dialog box will appear
automatically.

 Or

2. If you have previously used Correspondence Manager and want to make changes the
setup, choose the Setup button from the Correspondence Manager dialog box.

3. From the Word Processor - Name list box, select your word processor.  Only the
word processors and versions listed in the Name list box are supported in ECCO Pro
4.01. Word processors and versions not listed are not supported.

4. Click the Browse button next to the Word Processor - Program to Run field to
browse and select the executable filename for your word processor.

5. The Correspondence Manager Directory and History Directory paths will default to
subdirectories of your main ECCO directory.

• The Correspondence Manager Directory is where your templates and
Correspondence Manager configuration file will be stored. You may use the
Browse button to change this location.

• The History Directory  is where the letters you create using Correspondence
Manager will be saved.  You may use the Browse button to change this location.
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6. When you’re done configuring Correspondence Manager, choose OK.

You are now ready to begin using Correspondence Manager.

Using Correspondence Manager to Create a Single Letter

The Create Single Letter option in Correspondence Manager allows you to create
personalized letters.  ECCO performs the initial merge of the name, address and other
fields you define, then pauses to allow you to type in a personal message or greeting.

To create a single letter:

1. Select a single name from the PhoneBook.

2. From the PhoneBook menu, choose Correspondence Manager.

3. In the Choose Letter to Send section, select the template you’d like to use from the
list box.

4. Select Create Single Letter.

5. Under Send By, select Fax, if available, or Printed Letter.

6. Under Save Contact Record, choose Save Individual Copy or Don’t Save Copy or
Reference.  By default, the name of the template you chose will be displayed in the
text box.  If you want the reference to your letter to say something different, you can
change it now.

• Save Individual Copy will save a copy of the letter in the History directory you
chose when you configured Correspondence Manager, with a system-generated
filename consisting of part of the contact’s name and today’s date.  A sub-item
will be created under the contact’s name with the name of the template (or the
text you typed in the box), and a launchable reference to that document.  To view
the document later, just double-click on the filename.

• Don’t Save Copy or Reference will still create a sub-item under the contact’s
name with the name of the template (or the text you typed in the box), but the
letter will not be saved as a file and no launchable reference will be created.

7. Choose the Continue button.

 A message is displayed indicating that the letter is being created in your word
processor.

8. Correspondence Manager starts your word processor, loads the template you chose,
and fills in the merge fields.  You can then type in any text and make any
modifications you require.

When you are done, choose Save and Print if you want to save the document and
print.

 Or
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 Choose Save Only if you want to save the document and print at a later time.

When the document has been saved and/or printed, you will be returned to ECCO.

Using Correspondence Manager to Create Form Letters

The Create Form Letters option in Correspondence Manager allows you to create form
letters using pre-defined templates.  You select a group of contacts to send the form letter
to, and ECCO merges the names selected with the template you created.

To create a form letter:

1. Select a group of names from the PhoneBook.

2. From the PhoneBook menu, choose Correspondence Manager.

3. In the Choose Letter to Send section, select the template you’d like to use from the
list box.  See the following section for instructions on creating, using and editing
templates.

4. Click Create Form Letters.

5. Under Send By, select Fax, if available, or Printed Letter.

6. Under Send To, choose Selected Entries Only, All Items Currently In This View, or
Entire PhoneBook.

• Selected Entries Only will create the form letter only for the currently
highlighted contacts.

• All Items Currently In This View  will create the form letter for all contacts in
the current filtered view.  For more information on filters, see the chapter on line
help on “Other ECCO Features.”  If no filter is currently active, choosing All
Items Currently In This View is the same as choosing Entire PhoneBook.

• Entire PhoneBook will create the form letter for every contact in your
PhoneBook.

Note:   Once a merge has started, there is no way to stop it.  We recommend that you
try out the Correspondence Manager with small sets of names and addresses
to make sure everything has been setup correctly before you process a large
job.

7. Under Save Contact Record, choose Save Individual Copy, Save Reference to
Template, or Don’t Save Copy or Reference.  By default, the name of the template
you chose will be displayed in the text box.  If you want the reference to your letter to
say something different, you can change it now.

• Save Individual Copy will save a copy of the letter in the History directory you
chose when you configured Correspondence Manager, with a system-generated
filename consisting of part of the contact’s name and today’s date.  A sub-item
will be created under the contact’s name with the name of the template (or the
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text you typed in the box) and a launchable reference to that document.  To view
the document later, just double-click on the filename.

• Save Reference to Template will create a sub-item under the contact’s name
with the name of the template (or the text you typed in the box) and a launchable
reference to the template.  Individual copies of each letter created will not be
saved as files.

• Don’t Save Copy or Reference will still create a sub-item under the contact’s
name with the name of the template (or the text you typed in the box), but the
letter will not be saved as a file and no launchable reference will be created.

8. Choose the Continue button.

 Correspondence Manager will start your word processor, merge the template with the
contacts you selected, and print the letters.

Creating Templates in Correspondence Manager

You can create new templates from within Correspondence Manager using the following
steps:

1. From the PhoneBook menu, choose Correspondence Manager.

2. Click the Create/Edit Template Button and choose New.

3. Enter a description of the template in the Template Description field.

4. Type a file name in the Template File Name field.  You don’t need to type a path,
since the template will automatically be saved into the Correspondence Manager
Directory you specified when you initially set up Correspondence Manager.  Be sure
that you give your template the proper template extension for your word processor.

5. Choose the fields you want to have in your template from the Choose Fields list.
You can double-click on the fields you want, or highlight the fields and click the Add
button.  If you want to base the new template on an existing template, choose that
template in the from the Based On drop-down list.  The fields from the existing
template will be added to the Fields Chosen box.  You can add more fields from the
Choose Fields list also.

6. Choose the Continue button.

 Correspondence Manager will launch your word processor and load the template.

 If you based the new template on an existing template, the fields from the existing
template will already be inserted into this new template.  Otherwise, the template will
be blank.

7. Insert merge fields for the fields you chose in ECCO according to your word
processor’s instructions.  Add any text that you want to be part of the template.
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8. When you’re done configuring your new template, choose the Save & Return button
at the top of the screen to return to ECCO.

9. You will see your new template description added to the drop-down list of templates
to use.  Choose the Cancel button to close the Correspondence Manager dialog box.

Note:   When you create a template in Correspondence Manager, two files will be
created in the default Correspondence Manager directory—one will have the
template extension for your word processor, and the other will have a .INI
extension.  If you want to share a template with another user, you need to give
them both files to put in their default Correspondence Manager directory.

Using Existing Templates From Your Word Processor With
Correspondence Manager

You can also use templates that you previously created in your word processor with
ECCO’s Correspondence Manager.

1. Make a copy of the template and open the copy in your word processor.  Be sure the
new file has the proper template extension for your word processor.

2. Delete any existing merge fields in the template and close the file.

3. Move the copy to your ECCO Correspondence Manager directory.

4. From the PhoneBook menu, choose Correspondence Manager.

5. Click the Create/Edit Template Button and choose New.

6. Type a description of the template in the Template Description field.

7. Type the file name, including extension, in the Template File Name field.  You don’t
need to type a path, since the template is in the Correspondence Manager Directory
you specified when you initially set up Correspondence Manager.

8. Choose the fields you want to have in your template from the Choose Fields list.
You can double-click on the fields you want, or highlight the fields and click the Add
button.

 The Based On entry should say <none>.

9. Choose Continue.

 Correspondence Manager will launch your word processor and load the template.

10. Insert merge fields for the fields you chose in ECCO according to your word
processor’s instructions.

11. When you’re done configuring your new template, click the Save & Return button at
the top of the screen to return to ECCO.
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12. You will see your new template description added to the list box of templates to use.
Choose the Cancel button to close the Correspondence Manager dialog box.

Editing Existing Templates

If you need to edit a template, use the following steps:

1. From the PhoneBook menu, choose Correspondence Manager.

2. Select the template you wish to edit from the drop-down list.

3. Click the Create/Edit Template Button and choose Edit.

 The Create/Edit template dialog box will appear, showing the fields currently in your
template

4. Add or remove any fields you want to change and choose Continue.

 Correspondence Manager will start your word processor and load the template.

5. Delete the merge fields for any fields you removed in the Create/EditTemplate dialog
box, and add merge fields for any new fields you added in Create/Edit Template.
Make any necessary text changes to the template.

6. When you’re done editing your template, choose the Save & Return button at the top
of the screen to return to ECCO.

7. Choose the Cancel button to close the Correspondence Manager dialog box.

Deleting Existing Templates

To delete a template you no longer need, use the following steps:

1. From the PhoneBook menu, choose Correspondence Manager.

2. Select the template you wish to delete from the drop-down list.

3. Choose the Create/Edit Template Button and choose Delete.

4. Choose Yes in the Confirm Template Deletion dialog box.

5. Choose Yes again in the Delete Document File dialog box to have the template file
and .INI file deleted from your default Correspondence Manager directory.

6. Click the Cancel button to close the Correspondence Manager dialog box.

Faxing using the Correspondence Manager

The Correspondence Manager uses WinFax PRO to send faxes directly from ECCO.

Due to limitations with the DDE interface, WinFax PRO does not recognize local area
codes when they are passed to them from applications like Correspondence Manager.
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Thus, WinFax will try to dial the local area code, and your fax will fail. The only work
around is to remove local area codes from fax numbers in your ECCO file.

You can also use the Correspondence Manager with other fax software using the
following method:

1. Make sure your word processor is set up with the fax modem as the default printer.

2. In the ECCO Correspondence Manager, select "Printed Letter" checkbox. This will
send the output directly to the fax modem via your word processor.

Troubleshooting and Error Messages

If you have problems using Correspondence Manager or encounter error messages,
request the Correspondence Manager Troubleshooting and Error Messages Tech Note
from ECCO Technical Support.
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Chapter 11.  Folders

About Folders
As you manage information, you’re often faced with two challenges:

• the need to categorize information.

• the need to put the same information in several places.

ECCO folders let you handle these challenges easily.

Understanding Folders

ECCO folders are like the paper folders in your file drawers.  Folders allow you to collect
related items of information.  Just as you’d collect all papers and receipts related to
insurance in a paper folder labeled “Insurance,” ECCO lets you create a folder, name it
“Insurance,” and use it to collect information related to that topic.

And just as you might place a photocopied item into multiple paper folders, you can place
an ECCO item into multiple folders.  And whenever you change one ECCO item, the
copies in other folders are automatically changed in the same way.  Folders are the ideal
tool for managing the large volume of diverse information that confronts you every day.

Definitions: Items, Folders, and Views

As you begin to work with ECCO folders, it’s important that you understand three basic
ECCO concepts: items, folders, and views.

• Items:  These are the basic element of information in ECCO. Every bulleted line in a
Notepad, every name in the PhoneBook, and every appointment in the Calendar is an
item.  Put another way, every line of text or graphics with an item bullet to its left is
an item.

• Folders:  These are containers used to collect and cross-reference related items.
Whenever you create items in an ECCO view, you are actually adding them to a
folder.  For example, when you create an appointment in the Calendar, ECCO
automatically adds that appointment item to a folder named Appointments.
Similarly, whenever you add a name to your PhoneBook, ECCO automatically adds
that name to the PhoneBook folder.

• Views:  Windows showing one or more folders and the items in those folders.  The
PhoneBook view, for example, displays the PhoneBook folder and all of the items
(names) in that folder.  Notepad views can display the items in one or more folders of
your choice.
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Using Folders: Examples

Consider the following three typical users and their information management needs.  Each
of them needs to view information in multiple contexts.

Bob, Hanna’s administrative assistant, creates a Notepad of tasks to be done.  Items in the
Notepad need to be collected in the following groups:  items that need to be reviewed by
a coworker; items related to a particular event; and items that need immediate resolution.
Some items would need to be in all three folders.  Bob sets up his ECCO folders so that
he can view items in any of these contexts, together with the other items of that type,
without delay.

Sample folder setup for task notes

Stephanie, a lawyer, puts together a Notepad that shows the logical flow of a case.  When
she interviews a witness, Stephanie wants to easily review all points that pertain to that
witness.  She must be able to view the information from two perspectives: according to its
degree of value to the case and as a set of problematic points, drawing information from
other cases.

Sample folder setup for case notes

Pat, a research chemist, gathers information for each type of experimental procedure,
chemical compound, and institution she works with.  As she creates notes on journal
articles, she records the important points in each article in several places.  When she
wants a summary of her reading on a specific compound, all the relevant information is
available in one place.
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Sample folder setup for research notes

Using Folders: An Overview

The basic steps for using folders are described in the following procedures.

To display the folder window

From the View menu, choose Folder Window.  The folder window appears.

To create and name folders

1. From the Folder menu, choose New Folder.

2. Type a name for the folder.

3. Reorganize the folders as you would any outline item, by dragging the folder icon.

To add items to folders

1. Click on the item’s bullet.

2. Drag the item bullet to a folder in the folder window.

 The item is added to the folder and remains in the current view as well. You can
remove the item from the current view by choosing Delete Items from the Edit menu.

To view a folder’s items

Double-click any folder in the folder window.  The folder and its items appear in a scratch
Notepad.
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Working with Folders
When you work with folders, you actually work with several ECCO elements:

• The Folder window

• Default folders

• Folder outlines

The Folder Window

In the Folder window, you can view existing folders as well as perform a variety of
operations on them.  You display the folder window at the left side of the ECCO program
window.  To view the folder window, from the View menu, choose Folder Window.  To
hide the folder window, choose Folder Window again; or choose the Close button in the
upper-left corner of the folder window.

Folders:  In the folder window, you can add new folders and edit, rearrange, or select
existing folders.

Folder menu:  Choose commands from this menu to switch between Assign and Edit
modes, to add or delete folders, to change folder types or properties, to assign by keys, or
to make folders public.

Folder buttons:  Checkmarks on these buttons indicate that the selected items in the
active view have been added to these folders.

Zoom button:  Click this button to display, hide, or resize the folder window.

Close button:  Click this button to close the folder window.

You work with the folder window in one of two modes:

• To add items to a folder, use Assign mode.  You switch to Assign mode by clicking
outside the folder window or by choosing Assign Folders from the Folder menu.

• To add new folders and edit and rearrange existing ones, use Edit mode.  You switch
to Edit mode by choosing Edit Folders from the Folder menu or by clicking the title
bar of the folder window.

Organizing the Folder Window

To more easily understand the relationship between folders, you can organize them in a
way that makes most sense for your needs.  For example, you can place folders containing
similar material into groups and at the same time make other folders subordinate to them
(thereby creating subfolders).  You can also expand and collapse folders to view them
more easily.  You can even create multiple-folder columns so that you can view multiple
values in one cell.  For more information, see the chapter or online help on  “Columns and
Values.”
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To organize the Folder window, choose Edit Folders from the Folder menu, and then
perform any of the following actions:

• Move a folder up, down, right, or left in the outline by dragging its folder icon or by
pressing ALT+LEFT ARROW or ALT+RIGHT ARROW.

• Expand and collapse a folder that contains subfolders by clicking the plus or minus
sign to the left of the folder icon.

• Create a new folder at a lower or higher level than the selected folder by pressing
CTRL+R (to create a subfolder) or CTRL+L (to create a folder one level higher).

In addition, you can apply formatting in the folder window. For more information, see the
chapter or online help on “Working with Items and Formatting.”

Default Folders

ECCO provides the following default folders:

• PhoneBook:  Contains items (in this case, names) created in the PhoneBook.  The
PhoneBook folder has several subfolders containing related information entered in
the PhoneBook, such as telephone numbers and addresses.

• Appointments:  Contains items created in the Appointment section of the Calendar.

• To Do’s:  Contains items created in the Tickler section of the Calendar.

• Done, Start Dates, and Due Dates:  Allows you to organize scheduled items.

• Search Results:  Contains items found when you search the entire ECCO file.

• New Columns:  Contains subfolders based on any new columns you create in the
column pane.

Note: ECCO includes several templates that provide folder structures for some typical
types of projects or applications.  Each ECCO template includes a view titled
“How to use this File.”  Depending on the template you use, you will see
additional folders in the folder window.  New ECCO files are based on the
template DEFAULT.ECT in your ECCO directory.

Creating Folders

When you need to create a new information category, you can create a new folder in the
folder window.

To create a folder

1. Open the folder window, if necessary, by choosing Folder Window from the View
menu.

2. From the Folder menu, choose New Folder.

3. Type a name for the folder.
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Note: You can also create a folder by choosing New Folder from the Folder menu.
When you create a new Notepad, ECCO creates a new folder with the name of the
Notepad.  You can edit the name at any time.

Renaming Folders

You can change the name of a folder from any location.  The name will change wherever
the folder appears.

To change the name of a folder

1. From the Folder menu, choose Edit Folders.

2. In the folder window, select the name of the folder you want to change.

3. Type a new folder name.

Note: You can also change the name of a folder from a Notepad. In the Notepad, select
the folder name, and then type a new name for the folder.

Deleting Folders

When you no longer need a folder, you can delete it from an ECCO file.  When you
delete a folder, its subfolders are deleted as well.  You cannot delete a default ECCO
folder, such as PhoneBook or Appointments.

Note: When you delete a folder from the folder window, items found in only that folder
are permanently deleted from your ECCO file.  If you want to continue to view
them, be sure to move them to another folder before you delete the folder.

To delete a folder

1. From the Folder menu, choose Edit Folders.

2. Select the folder that you want to delete.

 You can delete multiple folders using any of the methods for multiple selections.

3. From the Folder menu, choose Delete Folder.

 If the folder is empty, the folder name disappears from the folder window.

 If the folder contains items, ECCO displays the Delete Folder dialog box, which
includes a warning that the folders will be removed from all views and columns.
Choose the OK button to complete the deletion.

Note: If the folder you delete is the only folder in a Notepad, an untitled folder is created
to preserve the view.
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Adding Items to Folders
You can add an item to a folder in any of the following ways:

• by typing a new item into any ECCO view

• by dragging an item from a view to a folder in the folder window

• by selecting an item and choosing a gray folder button in the folder window

• by using columns

Typing Items into a View

You can add items to folders by typing them into a view.  As you type, ECCO adds the
items to folders as described in the following table:

Type of Item Folder

Calendar appointment Appointments

Calendar tickler item (created in
the Tickler section)

Date folder of your choice

PhoneBook name PhoneBook

Notepad item Folder above the item in the
Notepad

Adding Items with the Folder Window

You can add items to folders by dragging the items into the folder window or by using the
folder options pop-up menu.

To add items to folders

1. If the folder window is not displayed, from the View menu, choose Folder Window.

2. Switch to the view that contains the items you want to add to folders.

 You can add items from any view to any folder or group of folders.

3. Select the item you want to add by clicking it.

 You can select a single item, multiple items in sequence, or nonsequential multiple
items.

4. Drag the items into a folder in the folder window.

 Or
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 Click a gray folder button at the left side of the folder window to select a folder, or
drag through several folder buttons to select multiple folders, and then choose Add
Selected Items To Folder(s) from the folder options pop-up menu, as shown in the
following illustration.

5. If ECCO displays an edit box, enter a value in the box, and then choose the
checkmark button.

 Or

 If you are adding the item(s) to multiple folders, ECCO displays the Specify Folder
And Column Values dialog box. Enter a value for each folder, and then choose the
OK button.

For the selected item, ECCO displays a checkmark in the gray folder button for each
folder to which the item has been added.

Auto-Assigning Items to Folders
ECCO’s auto-assign feature automatically evaluates items throughout your file
(PhoneBook, Calendar, and Notepads) and gathers them into specific folders.

For example, you can:

• Have ECCO gather items that contain the word “Action” to your Tasks folder

• Assemble all items related to a particular company or person into a folder

• Have personalized codes to quickly reference items to various folders and views

Creating Auto-Assignment Rules

To allow ECCO to auto-assign items to a folder, you first must specify a rule for the
folder.  A rule is simply a text string (word) that ECCO will compare against items that
you create.  If the item text matches the rule, it is added to the folder.

Five ways of defining rules are available:

• A single word: You can assign every item containing a single word to a folder.

• A phrase with blanks:  In this case, a blank says that you want to collect any item
containing the words indicated.  If you have a rule that says “Bill Smith,” you could
collect items such as “Bill Smith,” “send bill to Smith Uptown Construction for
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sinks,” or “Jennifer Smith-Banks hired Bill Williamson.”  However, “Billings and
Smithton” would not be considered a fit for this rule and would not be added to the
folder.

• A phrase with underscores:  Underscores can be substituted as blanks. Replacing
the blanks with underscores would make “Bill Smith” read  “Bill  Smith.” In this
case, this rule would be treated as if it were a single word.

• A prefix:  You define a prefix by using an asterisk at the end. A prefix rule that is
defined as “mari*” would collect every item beginning with those letters. This rule
would assign items containing the words “maritime,” “Mariners,” “Marilyn,”
“marigolds,” “marimba,” and “marinades” if they all were used in one file.

• A compound rule:  This rule combines any of the four rules above to form one,
more complex rule.  An example of this would be “Dav*_Jones” which looks for
both “David Jones” or “Dave Jones.”

Adding Auto-Assignment Rules to a Folder

Rules are assigned to and removed from a particular folder through the Auto Assignment
Rules dialog box.  You can assign up to 255 rules to a folder.

To assign rules to a folder

1. In the folder window select the folder to which you want to add the rule.

2. From Folder Menu, choose Auto Assign Rules.

 The Auto Assign Rules dialog box appears.

3. Choose New.

4. Type your rule in the box where the Rule 1 text appears.

5. Repeat steps 3 and 4 for each additional rule you want to add.

6. Choose OK when you have finished.

7. Choose one of the following options:

• To search the entire file for items that currently match the new rule, choose Search
All.

• To match only newly created or modified items, choose Don’t Search.

To remove rules from a folder

1. In the folder window, select the folder from which you want to remove the rule.

2. From Folder Menu, choose Auto Assign Rules.

3. Select the rule you wish to remove.
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4. Choose the Delete button.

5. Repeat steps 3 and 4 for each additional rule you wish to remove.

6. Choose OK when you have finished.

Note: Deleting a rule will not remove items that have been assigned to a folder using the
rule.

Removing Items from Folders
You can remove items from folders in either of the following ways:

• Use the folder options pop-up menu to remove the selected items from one or more
folders that you select in the folder window.

• Delete an item from a Notepad, thereby removing that item from the folder under
which it appears or from all folders.

Note: You can also remove items from folders by deleting checkmarks or values from
columns in the column pane. For more information, see the chapter or online help
“Columns and Values.”

Removing Items from a Notepad

When you delete a top-level item from a Notepad you can choose to remove it from the
folder in which it appears or from all folders. Top-level items are located at the highest
(left-most) level of a view. Deleting a top-level item also deletes its subitems. When you
delete a subitem, it is removed from all folders and deleted from the ECCO file.

To remove items from a Notepad

1. In a Notepad, select the items you want to remove.

2. From the Edit menu, choose Delete Items, or press CTRL+D.

 Depending on the items you selected, one of the following events happens:

• If you selected items that were assigned to only one folder, the items are removed
from the folder and, therefore, from the ECCO file.

• If you selected top-level items that are currently in multiple views, ECCO asks
whether you want to remove the items from the current folder or from the entire
ECCO file.

• If you selected subitems that were added to multiple folders, ECCO asks you to
confirm that you want to remove the items from all folders to which they have been
added.
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Removing Items Using the Folder Window

Use the folder options pop-up menu in the folder window to remove selected items from
any folder.

To remove items from folders using the folder window

When you remove an item from a folder using the folder window, the item remains in all
other folders to which it has been added.

1. In the active view, select the item you want to remove.

 You can select a single item, multiple items in sequence, or non-sequential multiple
items.

2. In the folder window, click the gray button at the far left of the folder from which you
want to remove the items.

 Or

 Drag through several buttons to select multiple folders. The folder options pop-up
menu appears.

3. From the folder options menu, choose Remove Selected Items From Folder(s).

 The selected items are removed from the folder(s).

Viewing Folder Contents
To view the contents of a folder, you can:

• Double-click a folder in the folder window to display its contents in the scratch
Notepad.

• Create a new Notepad. You can add any folder to the Notepad and see all the items in
that folder.

• Add folders to an existing Notepad.  You can add the same folders to multiple
Notepads, allowing you to view the same information in different contexts.

Viewing a Folder’s Contents in the Scratch Notepad

The fastest and easiest way to view a folder’s contents is to display it in the Scratch
Notepad view.

To view a folder’s contents in the Scratch Notepad

Double-click any folder in the folder window.  The folder and its items appear in the
Scratch Notepad view.
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Creating a New Notepad Based On a Folder

When you create a new Notepad, the information in it is saved whenever you save your
ECCO file.  You can open the Notepad from the View menu by choosing the Notepads
command and then choosing the Notepad’s name from the list.

To create a new Notepad

1. From the View menu, choose Notepads, and then choose New Notepad.

 The Create Notepad dialog box appears.

2. In the Name box, type a name that describes the information you will add to the view.

 This name appears in the menu when you choose the Notepads command.

3. Choose the Options button.

 The Create Notepad Options dialog box appears.

4. To add folders to the Notepad, click the folder names in the folder window displayed
in the dialog box.

 As you add them to the Notepad, the folder names appear in the list box on the right.

5. To remove a folder, highlight the folder in the list on the right, and then choose the
Remove button.

6. When you have finished adding folders, choose the OK button.

7. Choose the OK button again.

 ECCO displays a new Notepad that shows the items in the folders you added.  The
name of the Notepad appears at the top of the Notepad window.

The next time you choose Notepads from the View menu, this name will appear at
the end of the menu.  To switch between Notepads, choose names from this menu;
or, click the tabs at the bottom of the ECCO program window.

Adding Folders to a Notepad

You can add additional folders to an existing Notepad. When you do, you see the items
contained in those folders.

To add folders to a Notepad

1. Switch to the Notepad to which you want to add additional folders.

2. If the folder window is not already open, from the View menu, choose Folder
Window.

 The folder window is displayed.

3. Drag into the Notepad the folders you want to add.
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Note: You can also add folders to a Notepad using this method. From the View menu,
select Choose Notepad Folders.  In the Choose Notepad Folders dialog box, click
folder names to add them to the view.

Removing Folders from a Notepad
You can remove folders from a Notepad at any time. When you remove a folder from a
view, you are removing it from the view only—you are not deleting it or its items from
the file.

Every Notepad must contain at least one folder.  If you remove the only folder in the
Notepad, a new, untitled folder is created to preserve the view.

To remove folders from a Notepad

You can remove a folder from a Notepad by dragging it or by using the Remove Folders
command.

1. Select the folder you want to remove from the Notepad.

2. Using the mouse, drag the folder(s) out of the Notepad window.

 Or

 From the Edit menu, choose Remove Folders.

Note: Use the Choose Notepad Folders dialog box to remove folders from a Notepad.
From the View menu, select Choose Notepad Folders.  In the Choose Notepad
Folders dialog box, highlight the folders you want to remove, and then choose the
Remove button. Choose the OK button.

Folder Types and Folder Values
A folder can store a value with each item it contains. A folder value gives you a way to
associate an additional piece of information with each item. Because an item can be added
to many different folders, each item can have many different values associated with it.

Before you can associate items with values, you must declare the folder’s type; that is,
you must specify what kind of values the folder will contain. Values are of four types:

• Text values are comments, descriptions, or miscellaneous text.

• Number values are numerical information.

• Date values are date and time information.

• Pop-up list values are user-defined values.

Accordingly, a folder can be one of these four types as well.  A fifth folder type—
checkmark folder—is also available.
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Checkmark Folders

Checkmark folders are not associated with values.  They simply provide an opportunity to
include or exclude an item.

A new folder is, by default, a checkmark folder.

Text Folders and Values

Text folders contain any text of up to 32,000 characters in length.  Here are some
examples of ways you might use text values:

• Suppose a set of items describes each part of a problem.  As you resolve each item,
you might type a text value that describes the solution to that part of the problem.

• For a set of items describing proposed marketing plans or business strategies, you
might create several text folders, one for each manager, and enter a text value
describing each manager’s response to each proposal.

• You might create a list of outside consultants with whom you work, create text
folders for each project, and type a brief summary of each consultant’s involvement
with a project.

Number Folders and Values

Number folders let you associate numbers with items. Here are some examples of ways
you might use number values:

• Associate a budget amount with each of the tasks that constitute a project

• In a list of equipment, associate an inventory number or a quantity with each item

• In an outline that describes courier deliveries, associate a confirmation number with
each delivery

Note: ECCO accurately records numbers of up to seven digits long.

Date Folders and Values

The management and scheduling of tasks is integrally associated with dates. You can
associate dates with items by:

• creating appointments and tickler items in the Calendar

• entering dates in date columns

• adding items to date folders in the folder window

• making any selected item a tickler when you choose Ticklers from the Tools menu

Unless you specify otherwise by changing the date properties, when you give an item a
date, the item appears in the Calendar.
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Pop-up List Folders and Values

Pop-up list folders let you define a list of values (such as high, medium, and low for a
priority list) and then associate those values with items.

Using pop-up list folders, you can

• Quickly associate with an item values from a user-definable list—without retyping

• Standardize the entry of values so that filters and sorts can be applied to them

• Add or edit the values in the pop-up list

Declaring the Folder Type

Before you begin adding items to a folder, you should declare the folder’s type.

To declare the folder type

1. In the folder window, choose Edit Folders from the Folder menu.

2. Select a folder that contains no items.

3. From the Folder menu, choose Folder Type.

4. Choose a folder type from the menu.

 If you choose a pop-up list folder type, the Pop-up List Column Values dialog box
appears in which you can define a set of values for the folder.

Customizing a Folder’s Properties
Date, pop-up, and number folders can be customized to reflect specific user preferences.

Customizing a Date Folder

Select a date folder and choose Properties from the Folder menu to display the Date
Properties dialog box.

In this dialog box, you can select from the following options:

Default Settings For New Items  Specify the default settings. You can override these
default settings for individual items using the Date Settings dialog box. For more
information, see the chapter or online help on “The Calendar.”

Note: These settings affect items that will subsequently be placed in the folder as well as
any items currently in the folder that match the pre-existing defaults.

Page 189



ECCO User’s Guide180

• Show Item In Calendar’s Tickler Section:  Choose whether to show the items
added to the folder in the Calendar’s Tickler section.  If you choose to display the
items in the Tickler section, you can select the default lead time and follow-up time
during which you’d like the items to be displayed.

• Default Recurrence:  ECCO allows you to specify an appointment or tickler
recurrence at a time interval you specify.  You can select an option from the list to
change the default setting for the recurrence pattern you use most often for items
using this date folder.

• Default Alarms:  Select an alarm from the list to change the default setting for the
alarm you use most often for this date folder.

• Calendar Busybar Color:  Select a color from the list to change the default color
for the Busybar displayed at the left side of the Calendar view.

Entering Dates  In this portion of the Date Folder Properties dialog box, you can specify
the default display of the value edit box that appears when you add a date value to an item
in a column or in the folder window.

• You can choose whether to initially display an edit box, allowing you
to type the date from the keyboard, or the Date Settings dialog box,
allowing you to select a date and other properties using the mouse.

• You can choose whether the value edit box always includes fields for
entering time in addition to a date or whether the time fields are
displayed only for appointments.

Customizing a Pop-up List Folder

When you create a new pop-up list folder or when you choose Properties from the Folder
menu, ECCO displays a Pop-up List dialog box in which you can create and change pop-
up list values. In this dialog box, you can

• Add new values to the list by choosing the New button.

• Choose a value and rename it in the Edit box.

• Delete values from the list by choosing the Delete button.

• Reorder the values in the list.

Note: When you type a new value in an existing pop-up list, the value is added to the end
of the pop-up list.

To add values to a new pop-up list folder or column

1. Create a new pop-up list folder or column.

 ECCO displays the Insert Pop-up List Column Values dialog box.

2. Choose the New Pop-up Value button.  “Value 1” is highlighted in the Edit box.

3. Type the first value, overtyping “Value 1.”
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4. Choose the New button (without choosing OK) and continue to add the values you
want to include in the pop-up list.

 Each time you choose New, the previously entered value appears in the list box.

5. When you have typed the last value, choose the OK button.

Customizing a Number Folder

Select a number folder and choose Properties from the Folder menu to display the
Number Properties dialog box. Using this dialog box, you can specify the type of number
you want the folder to display. You can choose from 13 different number formats:
general, 0.00, 0%, $0.00, and so forth.

Note: If you select a number column and choose Properties from the Column menu, you
can specify the type of number format, the alignment of the number in the column,
and the column width.  For more information about working with columns, see the
chapter or online help on “Columns and Values.”

Understanding an Item’s Context
ECCO gives you two easy ways to view an item’s context:

• You can view a folder’s items.  When you view a folder’s contents in a Notepad,
ECCO displays all items that have been placed in that folder.  Some of these items
might not be meaningful without their parent items displayed for context. To give
meaning to such items, ECCO displays the parent items in green text to indicate that
these green items were not actually placed in the folder.

• View the folders to which an item has been added.  Using the Show Item Info
command on the Item menu, you can look at all of an item’s folders and values from
anywhere in ECCO.

Understanding Context Parents

Problem: Viewing Only the Information You Need

Too much information is as much of a problem as too little. Once you’ve collected a large
body of information, the problem is no longer “How do I find and view this information?”
but “How do I view only the most relevant information and still understand it?”

Solution: Context Parents

Consider the following example.  Suppose you’ve just logged a phone conversation in
your PhoneBook. In this conversation, your friend Pat made a marketing proposal.  You’d
like to track this proposal under your “Marketing Issues” folder, so you drag this
conversation into the “Marketing Issues” folder in the folder window.

When you next look at your Marketing outline view (which contains this folder), it might
look like this:
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Because the item logging the conversation was explicitly added to the folder, it appears in
black.  All of its subitems have been brought in and are hidden (as indicated by the black
triangle).  The name Redline Cruises, from the PhoneBook, was not added to the folder
and appears in this outline view solely to provide meaning and context. It appears in
green to indicate that it has not been explicitly placed in the folder.  In ECCO, this item is
called a context parent.

If the name Redline Cruises had been explicitly placed in the Marketing Issues folder, all
other appointments, conversations, and other items, appearing under that name in the
PhoneBook would appear here as well.  This would obscure the marketing proposal that
you wanted to track.

The ability to add a subordinate item to a folder without adding its parent allows you to
exclude extraneous information, while the appearance of the context parent provides the
necessary context to understand the item.

Note: If a filter is applied in an outline view, context parents not meeting the criteria are
displayed in green. For more information, see the chapter or online help on “Other
ECCO Features.”

Viewing an Item’s Folders

Another way to view an item’s context is to view the folder names to which an item has
been added.  You can view an item’s folders in either of two ways:

• Select the item and open the folder window.  A checkmark on a Folder button
indicates that the selected item has been added to that folder.

• Use the Show Item Info command on the Item menu to quickly see which folders an
item has been added to and what column values have been associated with the item.

Using the Show Item Info dialog box, you can move quickly through the items in a view,
getting a broader view of the item’s context, viewing an item’s folders, and even changing
the values associated with a given item.

To view an item’s folders

1. Select the item whose folders you want to view.  Select the first item in the view if
you want to step through all the items in a view.

2. From the Item menu, choose Show Item Info.

 The Show Item Info dialog box appears.  The text of the selected item is displayed in
the Item Text box.  The folders to which the item has been added (or the columns in
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which the items have been given values) are listed on the left.  The values associated
with the selected item for each folder or column are listed to the right.

3. To edit a value, select it, and then change the value in the value edit box.  To clear a
value, select it, and then choose the Clear Value button.

4. To view the folders for the next item in the view, choose one of the Next Item
buttons.

 The Next Item buttons let you move through the items in the active view without
closing the dialog box.

5. When you are done viewing items’ folders, choose the Done button.

 If you have made changes in the dialog box, the Done button changes to an OK
button.  Choose the OK button when you have finished viewing and making changes
in the dialog box.

Under the Hood:  Item Levels
When you add an item to a folder, ECCO treats the item differently, depending on
whether it is a top-level item or a subitem.  ECCO automatically adds top-level items to
the folder in which they are typed, whereas you must explicitly add subitems to a folder
before they are added to it.  When you add an existing subitem to a second folder, ECCO
displays the parent item in green in any views displaying the second folder to allow you to
see the context of the item without viewing a lot of information you don’t need.

• When you promote or demote an item to or from the first level in a Notepad, ECCO
adds it to or removes it from the folder in which it appears.

• When you promote or demote an item or its context parents in a Notepad, ECCO
changes the context information as well.

Item Levels and Folders

When you type and rearrange items in a folder that appears in a Notepad, those items are
added to and removed from that folder in different ways, depending on their level.

• When you type a top-level item under a folder name, it is automatically added to that
folder. If you select the item, you will see a checkmark in the folder button next to
the folder name in the folder window.

• Because a Notepad shows all subitems of an item included in a folder, ECCO does
not explicitly add subitems to a folder when you type them.  This makes it easier to
remove items from folders since removing a parent item will automatically remove
all the subitems.
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Top-level items are added automatically to the folder
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Chapter 12.  Columns and Values
ECCO provides you with the flexibility you need to organize related items of information
in a useful way.  You use ECCO views and folders to organize and collect items of
information.  You use columns to display additional pieces of information associated with
items.  Also, columns are a quick way of seeing which items are in a particular folder.

Example:  Tracking Information in Columns
As the owner of an event-coordination business, Hanna has been using an ECCO file to
enter items of information regarding all aspects of her business, and she has been
organizing those items into folders.  One of those folders is a “Tasks” folder to which she
adds items for each of the major tasks she must accomplish in the coming week.

Items in Hanna’s folder

Hanna decides she would like to track additional information, such as priority and cost,
for each item.  Columns are the perfect answer to her need.

Entering Values in Columns

The first thing Hanna wants to do is prioritize the tasks for the week. In the Notepad
displaying the Tasks folder, she displays the column pane (by choosing Show Columns
from the Column menu) and inserts two columns – Priority and Cost.  She then assigns a
“High,” “Medium,” or “Low” priority to each item using the Priority column.  While
she’s at it, she decides to enter, in the Cost column, some budget figures associated with
those same items.
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Items with associated information entered in columns

Column Types

Column types provide a way to simplify entry and formatting of different types of values,
such as dates, numbers, text, and pop-up lists.  Pop-up lists let you define a list of values
and then associate values from that list with items. In the example above, Hanna inserted
a pop-up list column (Priority) and a number column (Cost).

Using the Insert Column command, Hanna could also insert a date column for storing the
due dates of each task.  Entering dates in a date column is simple using the Date Settings
dialog box.  When Hanna enters dates for her tasks, those tasks will also appear on the
appropriate dates of her Calendar.

Anatomy of a Column
Columns, which are made up of individual cells, appear in the column pane, a special area
at the right side of every ECCO view.  To view the column pane, from the Column menu,
choose the Show Columns command.

Cell:  A cell can contain a value, such as a date, checkmark, text, or number.

Column headings:  The title of the column, which you supply when you create a column.

Column scrolling buttons:  If the pane contains more columns than can be displayed at
one time, use the column scrolling buttons to view them.

Column menu:  Contains commands for hiding, displaying, inserting, or deleting
columns; modifying column properties; naming, aligning, moving, or sizing columns; and
making the contents of a column public.

Pane border:  Drag this border to resize the column pane.
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Column Types:  An Overview
When you create a column, you must specify its type.  The type dictates the kind of
information a column will contain. Six types are possible:

• Checkmark columns let you to click column cells to checkmark items.

• Text columns contain miscellaneous text.

• Number columns contain numerical information.

• Date columns contain date and time information.

• Pop-up list columns let you choose a value from a user-defined list.

• Gantt columns let you represent date ranges graphically, as a bar.

For detailed information on each of these column types, see “About Column Types” later
in this chapter.

Using Columns

Inserting Columns

A column displays the contents of an existing folder or allows you to enter new
information.  Each view can include up to 100 columns (and your ECCO file can include
a combination of up to 64,000 folders and columns).

To insert a column with new content

1. From the Column menu, choose Insert Column.

2. From the Insert Column submenu, choose the type of column you want to add.

3. In the Column Heading dialog box, supply a name for the column, and then choose
the OK button.

Note: When you insert a column with new content, ECCO creates a folder with the same
name as the column. This folder contains the items that have values in the column.

To insert an existing column or folder

Use the Insert Column command to insert a column or folder that was created in another
view. For example, you might want to use the Start Dates column in several different
Notepads. To add an existing folder or column to the view, follow these steps:

1. From the Column menu, choose Insert Column, and then choose Existing Column Or
Folder.

 The Insert Folder Columns dialog box appears.

2. Select one or more columns from the list.

3. Choose the OK button.
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Note: You can also insert a single folder column by dragging a folder from the folder
window into the column pane.

Entering Values in Columns
When you enter a value in a column, the item associated with it is added to the folder that
has the same name as the column.

To enter a value in a column

1. If the column pane is not displayed, choose the Show Columns command from the
Column menu.

2. Find the desired column. Use the column scrolling buttons as necessary.

3. Using the mouse or the arrow keys, select the desired cell.

4. Enter a value in the value edit box.

5. Choose the ENT (checkmark) button or press the ENTER key.

Editing and Deleting Values in Columns
When you delete a value, the value and the item associated with it are deleted from the
column and from the folder that has the same name as the column.

To edit or delete a value

1. Use the mouse or the arrow keys to select a cell, and then press the ENTER key.

2. In the value edit box that appears, make changes to the value, or press the DELETE

key to delete the value.

3. When you are finished, choose the ENT (checkmark) button.

Removing Columns from the View
To remove a column, select a cell in the column, and choose the Remove Column
command from the Column menu.

Note: This procedure removes the column and its values from the view;  but it does not
delete them from the file.  They still exist in the corresponding folder in the folder
window.  To redisplay the column and its values, drag the folder into the column
pane.  To delete the column entirely from the file, delete it from the folder
window.
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Customizations
Using a variety of commands and techniques, you can customize the appearance of ECCO
columns and the ECCO column pane.

Customizing the Column Pane

With ECCO you can customize the appearance of the column pane to best suit your
needs:

• To display or hide the column pane, choose the Show Columns command from the
Column menu.

• To adjust the width of the column pane, use the mouse to drag the left border of the
pane.

Customizing Columns

ECCO also lets you customize the appearance of individual columns. Use the procedures
listed in the following table:

To
[Menu] and
Command Mouse Procedure

Change column width [Column] Width Drag border of column heading

Move a column [Column] Move
Column

Drag column heading

Minimize or restore a
column

[Column] Width (Use
the Minimize
checkbox in the
Column Width dialog
box)

Double-click column heading

Change column’s
character formatting

[Format] command Right-click in column, then choose
Character

Change alignment [Column] Alignment

Change a column
heading

[Column] Heading

Note: Formatting attributes and styles applied to a column override outline styles. For
more information on formatting, see the chapter or online help on “Working with
Items and Formatting.”

Page 199



ECCO User’s Guide190

About Column Types
Earlier in the chapter, you learned a little about the six column types in ECCO. The
following sections describe each of these column types in greater detail.

Checkmark Columns

Checkmark columns have no values associated with them.  By selecting a cell in a
checkmark column, you add a checkmark to the cell and add the item on that line to the
folder that has the same name as the column.

Note: To customize the appearance of the checkmark, choose Properties from the
Column menu.

Text Columns

Text columns let you associate text with a single item.

If you select a cell in a text column, ECCO displays an empty, sizable, value edit box that
can hold up to 32,000 text characters.  If you type more characters than will fit in the box,
the text scrolls up so that you can continue to enter your value.

• Press CTRL+ENTER to insert carriage returns in the text.

• To expand the borders of the value edit box, drag them.

• When you finish entering text, press the ENTER key. The edit box disappears, and
ECCO displays only the amount of text that can fit into the on-screen cell.

Note: When you print columns, you’ll see only the amount of text that fits into the on-
screen cell.  Therefore, if you plan to use and print lengthy text values, you should
use outline notes instead of columns to ensure that you see all of your material.

Number Columns

Number columns let you associate numbers with items.

If you select a cell in a number column, ECCO displays an empty value edit box.  Type
any number in this box.  Nonnumeric values will not be accepted.  Press the ENTER key
when you’re done.

Date Columns

Date columns let you associate dates with items.  By giving an item a date value, you
integrate it with the rest of your schedule.

Unless you specify otherwise, all items with date values appear in the Tickler section of
the Calendar.  If you associate a time as well as a date with the item, the item also appears
in the Appointment section of the Calendar view.
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When you select a cell in a date column, ECCO displays an empty value edit box in which
you can type the date.  (Or choose the down arrow to display the Date Settings dialog
box.  Use the dialog box to set the date, together with any other date attributes.)

Note: Values in the date column can have all the attributes of dates in the Calendar. For
more information, see the chapter or online help on “The Calendar.”

ECCO has several default date folders, such as Start Dates and To-Do’s, that you can use.
For more information, see the chapter or online help on  “Folders.”

Pop-up List Columns

With pop-up list columns you select a cell value from a pre-established list.  A pop-up list
allows you to choose a value from a user-defined, editable list.

If you select a cell in a pop-up list column, ECCO displays a value edit box. In this box
you can

• Choose the down arrow to display a list of existing values (and then select a value
from the list).

• Type a new value.

• Select Edit Values to display the Pop-Up List Column Values dialog box.  In this
dialog box, you can add, modify, or delete values in the pop-up list column. For more
information, see the chapter or online help on “Folders.”

Gantt Columns

In a Gantt column, time values are displayed in graphic form as a bar.
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A Gantt column

Creating a Gantt Column

An item’s start and end dates define the length of its bar in the Gantt column.

To create a Gantt Column

To create a Gantt column, do the following:

1. From the Column menu, choose Insert Column, and then choose Gantt.  ECCO
displays the Create New Gantt Column dialog box.

2. In the Chart Range boxes, specify the date range for the chart.

 By default, ECCO uses today’s date as the starting date and 90 days from today as
the ending date.  In either value edit box, you can choose the down arrow to select a
date from the calendar.

3. From the drop-down list of date folders, select folders whose names best describe the
beginning and end of each bar (for example, Start Date and End Date).

4. Choose a bar color from the Bar Color list.

5. Choose the OK button.

ECCO displays the column without a heading.  If you drag the right column
boundary to the right, ECCO displays dates, in the date range you specified, across
the top of the column.  ECCO spaces the dates proportionate to the total space you
have allotted to the column.

Note: A Gantt column does not create a folder.

To add bars to a Gantt column

1. In the Gantt column, choose the desired cell.

 If you have not added date values to this item in the date folders specified for the
chart, ECCO displays a value edit box in which you can enter the starting and ending
dates.
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2. Type the dates, or choose the down arrow button to display the Date Settings dialog
box and select the dates.

3. Press the ENTER key.

Customizing Gantt Columns

Once they’re created, Gantt columns can be easily changed:

• To change the date range, the folders from which values are taken, or the color of the
bars, select the desired cell, choose Properties from the Column menu, and then make
the necessary changes.

• To change dates, choose the desired cell and change the date in the value edit box (or
change the value elsewhere in ECCO).  If the new date falls outside the date range
specified for the Gantt chart, the bar will not appear in the chart.

• To change the width of the chart, resize the column.  Drag it to the desired width or
choose Width from the Column menu.

Viewing Folder Contents in a Column
To view a folder’s contents as a column, use one of the following procedures:

■ Drag a folder from the folder window into the column pane.
■ From the Insert Column submenu, choose Existing Column, and then

choose from the list.

Calculating Values in Columns
ECCO’s Sum feature allows you to calculate totals in your columnar data or multiply and
total one column’s values with those of another.

For example, you can:

• Determine how many items have been selected with a checkmark.

• Add all or some of the values in a column.

• Multiply and total the hours spent on a project by a selected rate.

Calculating Totals and Sums
ECCO can perform math calculations on almost every column type. Gantt and text
columns are the exceptions.

Columns are evaluated in the following ways:
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• Checkmark columns produce a count of all items that have been marked. Blank
cells are treated as zeros.

• Appointment and Date columns total hours and minutes.  If the column contains
only a date and no times, its value is considered to be zero.  For example, the sum of
all values in the Done column will be zero.

• Other column types, such as Number, Pop-Up List, and Text columns, will add or
multiply only those entries that are numbers.  With Pop-Up List columns, you can
total a list of frequently used numbers (such as hours worked or interest rates) or use
them to perform calculations on other columns. Non-numeric values are treated as
zeros.

To total a column

1. If you want to total specific items in a column, select them.

2. From the Tools menu, choose Sum.

 The Calculate Sum dialog box appears.

3. Select the Sum The Value Of option, and then choose a column from the drop-down
list.

4. Choose the Calculate button.

 The total will appear beside Results.

5. Choose Close when you are done.

To multiply and then total two columns

1. If you want to perform the calculation on specific items, select them.

2. From the Tools menu, choose Sum.  The Calculate Sum dialog box appears.

3. Select the For Each Item Multiply option, and then choose the two columns you want
to multiply from the drop-down lists.

4. Choose the Calculate button.

 ECCO will first multiply each item’s entry in each column together and will then add
the answers for the final total. The sum will appear beside Results.

5. Choose Close when you are done.

Creating Standard Column Sets
ECCO gives you the option of creating standard column sets that will appear as part of
every newly created Notepad.
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To include a column in a standard column set

1. Select a cell in the desired column.

2. From the Column menu, choose Properties.

 The Column Properties dialog box appears.

3. Select the Include This Column In New Notepads By Default checkbox.

Sorting by Column Value
You can sort the items in a view by their column value.  For example, suppose you want
to sort the items in your Tasks notepad chronologically by due date. Using the Due Dates
column, you can sort the items in ascending order so that those items with the earliest due
dates are at the top of the list.

Note: When you sort items in a pop-up list column, the sort is based on the position of
the values in the list. You can modify this order at any time by choosing Edit
Values from the list.

For detailed instructions on sorting, see the chapter or online help on  “Working With
Items and Formatting.”

Making Columns Public
If you share an ECCO file with others over a network, all columns in shared (or public)
views are automatically made public.  New columns added after the share remain private,
however, until you explicitly share them.

To share a column

1. Select a cell in the column you want to share.

2. From the Column menu, choose Make Public.

Using Multiple-Folder Columns
Although a column typically displays the values for a single folder, it’s possible to have a
column show values from several folders.  This can be useful when only a few (of many)
folders are likely to be used with each item in a view.  Setting up columns for multiple
folders is also useful for working with items that have multiple values or folder
assignments that you want to view and edit in one place.

For example, Hanna has a folder for each of her assistants.  As tasks come up that need to
be attended to, Hanna can assign them to her assistants by adding them to folders.  Hanna
would like to see at a glance which tasks are in which folders without having to dedicate a
column to each of her assistants.

Page 205



ECCO User’s Guide196

In the folder window, Hanna creates a folder called “Assistants” and makes a folder for
each of her assistants subordinate to that folder.

The Assistants folder with four subordinate folders

She then creates a multiple-folder column using the “Assistants” column.  For each task in
the Notepad, those subordinate folders that contain the item will be displayed in the
corresponding cell of this column.

A multiple-folder column

Note the following about multiple-folder columns:
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• If an item in the view has been added to a subfolder, the folder’s name appears in the
multiple-folder column cell to its right.

• If the folder contains a value, the value appears along with the folder name.

• You can add, delete, or edit the values in each subfolder by clicking the column cell.

• You can include folders without values in a multiple-folder column, and you can use
the column to view folder assignments, add items to folders, and remove items from
folders quickly, in a single location.

Displaying Multiple Folders in a Column
You can display the subfolders of a folder in a single cell of a column.

To display multiple folders in a column

1. In the folder window, arrange a group of folders as subfolders of a single folder.  For
more information about organizing folders in the folder window, see the chapter or
online help on  “Folders.”

 For example, you might make “Date 1,” “Date 2,” and “Date 3” subfolders of a
“Project Dates” folder.

2. In the column pane, insert a folder column for the folder to which the group of
folders is subordinate.

 To extend the preceding example, you would insert a folder column based on the
Project Dates folder.

3. With the column selected, from the Column menu, choose Properties.

 The Column Properties dialog box appears.

4. In the For Each Item, Cell Displays area of the Properties dialog box, select the Sub
Folders Of <Folder Name> That Contain Item option.

5. Choose the OK button.

 When you add an item in the view to one of the subfolders, the folder’s name appears
in the column cell on the same line as the item.

Editing Multiple Folders in a Column
To change values and folder assignments in a multiple-folder column, click on a column
cell and make changes in the box that appears.

To edit the cells of a multiple-folder column

1. Click a column cell, or select the cell and then press the ENTER key.   ECCO displays
a box listing all folders subordinate to the folder heading the column, together with
the value assigned to the item for each folder.
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2. Click the subfolder you want to edit, or select the folder, and then press ALT+S.
ECCO displays a value edit box appropriate for the folder type.  If the folder is a
checkmark folder, click the folder name to “check” or “exclude” it.

3. Enter a value or edit the existing value.

To remove the item from that folder, delete the value.  If the folder is a checkmark
folder, click the folder name to add or remove the item from that folder.

4. When you have finished editing folder values, do one of the following:

• To save the changes you have made, choose the ENT button (checkmark) in the
upper right corner of the edit box.

• To close the edit box without saving the changes you have made, choose the ESC

button (it looks like the letter “X”).
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Chapter 13.  Forms
If your work involves adding items to multiple folders or if you frequently update folder
values for a large number of items, you can automate these tasks by using ECCO forms.

A form isn’t a visible part of ECCO.  It’s a template that lists a set of folders and folder
values that can be applied to an item.

To create and work with forms, you use the following commands on the Tools menu:

• New Form lets you create and define a form.

• Manage Forms lets you structure the form submenu (part of the Tools menu).

• Add Item By Form lets you create a new item and give it a specific set of values.

• View Item By Form displays (and allows you to change) an item’s values.

Note:   For more information, see the section on Folders in the User’s Guide or in
online Help.

• Apply Form To Items lets you associate existing text with a specific set of values.

Using Forms:  A Practical Example
Petrie’s Beverages, Inc. has hired Hanna Jay to organize a nationwide launch for
Chameleon Springs Sparkling Waters, its new line of carbonated beverages.  Petrie’s has
selected shopping centers across the country to host the launch, and each store will have
its own activities.  Hanna needs to keep track of the planning process on a nationwide
basis.  To streamline the collection of data, Hanna decides to create a form called Springs
which will let her work with her data in a useful way.

First, she must decide what fields (and default values, if any) will be associated with the
form.  For more information on the types of fields that are available, see the chapter or
online help on “Folders.”  She decides that, for the Scents form, the following fields best
suit her needs:

• A text field titled City that lists the store’s location (no default value).

• A pop-up list folder titled Turnout that lists the projected degree of customer
attendance at the event (Low, Medium, or the default, High).

• A number field titled Budget that lists the projected total expenses for the event on a
per-store basis ($5,000 default value).

• Checkmark fields listing party details that need to be taken care of (default is
unchecked).

• A date field that lists the date that the event is to occur (no default).
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The Create New Form dialog box

Once Hanna created the Springs form, she used it in several different ways:

• Whenever she planned an event in a new city, she created a new item with the Add
Item By Form command.

• She applied the Springs form to a list of selected stores already listed in ECCO by
using the Apply Form To Items command.

• Whenever she needed to change data on a particular store, she used the View Items
By Form command.

The following sections describe each of the steps involved in creating and using forms.

Note: As you learn about forms, keep in mind that three terms are interchangeable:
folders=fields=columns.

Creating a New Form
The first step in working with forms is the actual creation of a form.

To create a new form

1. From the Tools menu, choose New Form.

 The Create New Form dialog box appears.

2. In the Rename box, type a name for the form.  This name will appear in a submenu
whenever you choose any form command.

3. From the Choose Fields list, select the fields you want to add to the form. To create a
new field, choose the New Field button.  The field names appear in the Fields Chosen
list as you add them.
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 To enter a default value for a field, click the Default Values button and then enter a
value in the Set Default Values For Form dialog box.

Note:   Specify default values for those fields that have a standard value that changes
infrequently, if ever.

4. Choose the OK button.

Adding Items by Form
Once you’ve created a form, you can use it within ECCO to add new items

For example, using the Springs form, Hanna added an item for the Tacoma store, and as
she did so, she customized the default information:

• She specified the City as Tacoma.

• She changed the default Turnout value to Medium (since the Tacoma store is smaller
than the average store).

The default values for the Budget, party details, and date fields required no change.

You can change default field values when you add a new item by form.

Note: To add items by form from other programs, use the Shooter.  For more
information, see the chapter or online help on “Importing and Exporting.”

To add a new item by form

1. From the Tools menu, choose Add Item by Form, and then choose the desired form
from the menu.

2. The Add by Form dialog box appears, listing the fields associated with the form.

3. In the Item Text box, type the item you want to add.

4. Customize the fields as desired:
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• To set or change a field value, double-click the field name in the list on the left,
and then enter a value in the field on the right.

• To reset all values to the default, choose the All Defaults button.

• To exclude the new item from a listed field, highlight the field value, and then
choose the Clear Value button.

5. To add the new item below the selected item in the active view, select the Add To
Active View checkbox.

6. To add the item, do one of the following:

• To add the item and close the dialog box, choose the Add button.

• To add the item and continue adding other items, choose one of the Add &
Continue buttons.  You can then add subsequent items equal to or to the right of
the item just added.

Applying Forms to Items
To apply an existing form to existing items, use the Apply Form To Items command.

Because Hanna had an existing list of flagship stores, she applied the Springs form to
these items just to ensure that all of her information was in parallel form.

To apply a form to items

1. Select the item(s) to which you want to apply the form.

2. From the Tools menu, choose Apply Form to Items, and then choose the form you
want to apply.

3. Customize the folder list as desired:

• To set or change a field value, double-click the field name in the list on the left,
and then enter a value in the list on the right.
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• To reset all values to the default, choose the All Defaults button.

• To exclude the item text (the selected item in the view) from a listed field,
highlight the folder value, and then choose the Ignore button.

4. Choose the OK button.

Viewing Items by Form
The View Item By Form command lets you examine an item in relation to an existing
form. You can

• See and change the item’s field values.

• Add or remove the item from a field on the form.

For example, when Petrie’s suddenly decided to cut back its promotions budget for
Mighty Mart in Poughkeepsie, Hanna used the View Items By Form command to view the
information for Mighty Mart, to change the value of the Budget field to $1000, and to
exclude clowns from the party details checklist.

To view an item’s fields

1. Select the item whose fields you want to view.

From the Tools menu, choose View Item by Form, and then choose the form by
which you want to view the item.  The View by Form dialog box appears, listing the
text of the selected item, the folders associated with the form, and the fields.

2. Customize the folder list as desired:

• To set or change a field value, double-click the field name in the list on the left,
and then enter a value in the list on the right.

• To reset all field values to the default, choose the All Defaults button.
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• To exclude the item text (the selected item in the active view) from a field in the
field list, highlight the field value, and then choose the Clear Value button.

• To delete the item text (the selected item in the active view) from all fields,
choose the Delete Item button.

3. Conclude the changes or proceed:

• If you are done making changes, choose the OK or Done button.

Note:   The Done button becomes an OK button if you make changes in the dialog
box.

• To exit the View By Form dialog box without saving changes to the selected
item, choose the Close button.

• To view fields for the previous or next items in the view, choose either the Prev
or the Next button.

Note:   If you choose to view fields for another item at this time, you will be unable to
undo the changes you have just made.  Close is valid only for the currently
selected item.

4. Repeat Step 3 as desired.

Managing Multiple Forms
With the Manage Forms dialog box you can edit or rename existing forms, delete forms,
reorder forms on the menu, or make forms public.

To manage forms

1. From the Tools menu, choose Manage Forms. The Manage Forms dialog box
appears.

2. Take one or more of the following actions:

• To rename a form, select it, and then type the new name in the Rename box.

• To create a new form, choose the New button.

• To edit a form, select it, and then choose the Edit button.

• To delete forms, select them and then choose the Delete button.

• To reorder forms on the menu, select them, and then choose either the Up button
or the Dn button.

• To make forms public, select them, and then select the Make Public checkbox in
the lower-right corner of the dialog box. For more information, see the chapter
or online help on “File Sharing.”

3. When you have finished making changes, choose the OK button.
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Chapter 14.  Other ECCO Features
At this point, you know how to make full use of ECCO to collect items of information,
cross-reference them, and associate values with them.  But perhaps you’re worried that
you have too much of a good thing.  You need a way to narrow and order the information
you’re viewing—a way to focus on a particular situation or set of circumstances.

A filter can help you. By using a filter, you can display only those items that meet certain
search criteria.

You can use filters in a variety of ways, as shown in the following examples.

Let’s say you’re planning your work week and you want to know which outstanding
issues you need to tackle first.  In your Priority column you’ve added values indicating
the priority of the Tasks folder’s items.

Pop-up values indicate the priority of your tasks

You can create a filter to display only those items with a priority of High.

A filtered view based on the Priority column
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Or let’s say you’re taking a trip to San Francisco and want to print a list of the telephone
numbers of your clients living there.

A PhoneBook view before applying a filter

In the PhoneBook, you could apply a filter to display only those names with a city value
of San Francisco.

A filtered view based on the City column

Perhaps you’re cleaning up your list from the Tasks folder and want to know which ones
are completed.  As you’ve completed tasks, you’ve added the date to your Completed
column.
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A Completed column indicating completed tasks

You can create a filter to display only those items in the Tasks folder that are included in
the Completed column.

A filtered view based on the Completed column

Creating Filters
You can create a simple filter based on any column displayed in a view (the column must
contain at least one value).  You can also select an operator, such as “Has any value” or
“Equals,” that specifies the type of comparison to be made.

For example, if you want a Priority column to display only those items with a low priority
value, in the dialog box you would select Priority from the list of columns, select Equals
from the list of operators, and type or select Low as the value.
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Create a single column filter

To create a simple filter be sure that some values or checkmarks have already been
entered in the column for which you are creating the filter.

1. From the Tools menu, choose Filter view.

 A menu of filter commands appear.

2. Choose New.

 The Filter Current View dialog box appears.

3. From the Choose Column list, select the column whose values you want to filter.
ECCO includes in the list all columns currently in the active view.

4. From the Operator list, select one of the available operators.  The list of available
operators changes according to the column type.

5. In the Value box, type the value upon which the filter is to be based or use the default
value.  The value must be appropriate for the column type.  For example, if the
column type is Number, then the value you enter must be a number.

6. To add the filter name to the Filter View submenu and save it for future use, choose
the Add To Menu option and type a name for the filter.

7. ECCO displays the new filter name on the Filter View submenu.  The filter is then
available in any ECCO view as well as from the Find command. For more
information about finding items, see the section on Working With Items and
Formatting in the User’s Guide or in online Help.

8. Choose the OK button.

9. ECCO immediately applies the filter to the view currently active.  Only the items
whose values meet the specified criteria are displayed (in addition to those parent
items necessary to provide context, displayed in green).  The status bar displays the
message “Filter: filtername.”

Note:   When you name a filter, it appears as a command on the Filter View submenu
If you want, you can add your new filter to the toolbar. For more information,
see the chapter or online help on “Using the Toolbar.”

Page 218



209 ECCO User’s Guide

Applying Filters
When you create a filter, the filter is applied immediately to the items in the active view.
ECCO displays only the items whose values meet the specified criteria, along with their
subitems (in a Notepad, parent items necessary to show the context also appear, displayed
in green).

You can apply only one filter at a time to the items displayed in a single view.  The filter
remains active until you either choose Ignore Filter from the Filter View submenu, create
a new filter, or apply an existing named filter.

When a filter is active, the status bar displays the message “Filter: filtername.”  When you
choose Ignore Filter, the message disappears and all the items in the view reappear.

Note: When a filter is active and you add a new item that does not meet the criteria, the
item is displayed in green until the filter is deactivated.

Applying Filters in the Calendar
The Calendar acts as a kind of date filter in that it displays tickler items and appointments
for only the date, week, or month you choose.  However, you might want to further limit
the items displayed in your Calendar.  For example, you could filter out all but the “High”
priority items from the view.

Filters applied to the Calendar affect the entire view, not just the date or date range
currently displayed. In the Calendar, only tickler items and appointments that meet the
filter criteria are shown, regardless of whether or not their subitems meet the criteria.

Applying Filters in the PhoneBook
When you initially apply a filter to the PhoneBook, ECCO will display any item in the
PhoneBook that meets the filter criteria.  If you click a letter tab, only items that meet the
filter criteria and begin with that letter are displayed.  When you search for text, the filter
is applied to that search as well.  If a name is displayed in the entry form, that name
disappears if it does not meet the filter criteria.

In the PhoneBook, only names that meet the criteria are shown, regardless of whether or
not their subitems meet the filter criteria.

When a filter is active in the PhoneBook and you add a new name, that name appears only
if it meets the filter criteria.
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Applying Filters in a Notepad
When you apply a filter to a Notepad, only those items meeting the filter criteria are
displayed in the view, along with their subitems.  If the items are subordinate to items that
do not meet the criteria, the parent items appear as well and are displayed in green (that
is, they appear as context parents).  For more information about context parents, see the
chapter or online help on “Folders.”

Using Named Filters
You can name and save for later use any ECCO filter you create.  To name a filter, create
a new filter, choose the Add To Menu option in the Filter Current View dialog box (or in
the Create A New Filter dialog box) and type a name for the filter.  The filter name
appears on the Filter View submenu, where it is available at any time from any view.

If you name and save a filter, you can:

• Retain the specifications of the filter for future use.

• Add the filter name to the Filter View submenu from which it can be used in any
view.

• Apply the filter to items in any view.

• Add a toolbar button for the filter.  For more information, see the section on Using
the Toolbar in the User’s Guide or in online Help.

If you create a filter but do not name and save it, you can use it only in the current view.
Should you switch to or create another filter, the specifications of the original will
disappear and not be retained by ECCO.

Advanced Filters
You can also create an advanced filter that has multiple sets of criteria.  This criteria must
be fulfilled before an item can appear in the filtered view.

For example, let’s say you’re supervising a team of consultants and want to ensure that
Bob, the new hire, is working on his most important assignments.  You could show the
team’s task list in a Notepad and create a filter to display those items that meet two sets of
criteria: items that 1) are in Bob’s folder and 2) have a value of High.
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A filter based on multiple criteria

But as Bob has so few high-priority assignments, you decide to display the medium-
priority assignments as well.  To do so, you would modify the filter to display items in
Bob’s folder that have a value of High or Medium.

A filter based on AND and OR criteria

By default, ECCO treats subitems of an item that match as a specific line of criteria as
though the subitems meet the criteria as well.

For example, you might want to know which of your daily tasks are still uncompleted.
You have your daily task list in the Tasks Notepad, and as you complete tasks, you add
them to your Done folder.
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In the Create a New Filter dialog box, you could create a filter specifying that the items
displayed are included in the Tasks folder and not included in the Done folder.

Creating a filter based on the Tasks and Done folders

When you apply the filter, only your uncompleted tasks will be displayed in the Tasks
folder.

Note: If you used the Create a New Filter dialog box to create the current filter, when
you subsequently choose New from the Filters menu, ECCO will display the
current filter in the same dialog box.  To return to the Filter Current View dialog
box, choose the Simple button.

Creating Advanced Filters
To create an advanced filter, use the Advanced button in the Filter Current View dialog
box.

To create an advanced filter

1. From the Tools menu, choose Filter View, and then choose New.

 The Filter Current View dialog box appears.

2. Choose the Advanced button.

 The Add To Filter dialog box appears on top of the Create a New Filter dialog box.

3. From the Columns list, select the first column upon which you want to filter.

4. From the Operator list, select one of the available operators (the list of available
operators changes according to the column type).
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5. In the Value box, type the value on which the filter is to be based or use the default
value.

6. Choose the Add button.

7. ECCO adds the first set of criteria to the Create a New Filter dialog box.

8. Under Combine Using, do one of the following:

• Select the And option if you want items to meet all sets of criteria.

• Select the Or option if you want items to meet only one set of criteria.

• Add a second set of criteria and choose the Add button.

9. Repeat steps 4 through 6 to add additional sets of criteria. Before each set of criteria,
be sure to select either the And or Or option accordingly.

10. When you are done specifying sets of criteria, choose the Done button.

 ECCO displays the Create a New Filter dialog box in which you can view all the
criteria for the specified filter.

11. To add the filter to the Filter View submenu, select the Add to Menu checkbox and
then type a name for the filter in the Name box.

12. To modify one of the sets of filter criteria, select that set in the list, and then choose
the Modify button.

13. To delete one of the sets of filter criteria, select that set in the list, and then choose
the Delete button.

14. When you have customized the filter to your satisfaction, choose the OK button.

ECCO immediately applies the filter to the currently active view. Only the items meeting
the criteria specified are displayed. The status bar displays the message “Filter:
filtername.”
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Managing Filters
ECCO lets you edit or rename existing named filters, delete named filters, or reorder
named filters on the Filter View submenu.  You can perform all these tasks from the
Manage Named Filters dialog box.

To manage named filters

1. From the Tools menu, choose Filter View, and then choose Manage.

2. ECCO displays the Manage Named Filters dialog box.

3. Take one or more of the following actions:

• To rename a filter, select its name from the list box and then change the name in
the Rename text box.

• To create a new filter, choose the New button. The Create a New Filter dialog
box appears in which you can design a new filter.

• To edit a filter, select its name from the list box and then choose the Edit button.
The Edit a Named Filter dialog box appears in which you can make the desired
changes.

• To delete a named filter, select its name from the list box, and then choose the
Delete button. This action deletes the filter from all views.

• To reorder named filters on the Filter View submenu, select the names of the
filter(s) you want to move, and then choose either the Up or Dn reorder button.

4. When you have finished, choose the OK button.

Finding Information with Filters
In addition to using a filter to limit the amount of information displayed, you can use a
filter to find items. For more information about finding items, see the section on Working
with Items and Formatting in the User’s Guide or in online Help.

To find items using a filter

1. From the Edit menu, choose Find.

 The Find dialog box appears.

2. In the Find box, type the text you want to find.

 Or

To use a filter without specifying search text, press the DEL key to clear the
highlighted text.

3. Choose the Unfold button (>>) to expand the Find dialog box.

 The Find dialog box expands, displaying additional options.
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4. In the Find Items Matching Filter box, select an existing filter, or select the Custom
option and create a filter.

5. Specify additional search options. For more information, see the chapter or online
help on “Working With Items and Formatting.”

Tracking Time and Expenses
Time and Expense Billing gives you an organized way of tracking and calculating your
costs, hours, and expenses. You can

• Set different rates for clients and activities.

• Categorize your expenses for easier bookkeeping.

• Use your billing numbers to track orders and jobs.

• Quickly calculate billings for a particular client or expenses for a particular a time
period.

Setting Up Time and Expense Billing
The first time you choose Time & Expenses from the Tools menu, ECCO makes some
changes to your ECCO file.

To set up Time and Expense Billing

1. From the Tools menu, choose Time & Expenses.

 The Set Up Time Expense Billing dialog box appears.
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2. Choose the OK button. At this time ECCO will:

• Create a new Notepad called Time & Expenses.

• Add several new columns and folders to help you track your information.

• Create a new Expense form to facilitate adding new expense-related items.

About the Time & Expenses Notepad
The Time & Expenses notepad comes equipped with a number of columns designed to
streamline the process of tracking your time and expenses:

• Billing Code is used for your existing billing codes. It is a text field, so the code can
be a combination of letters and numbers.  You can supply a Billing Code for a parent
item and it will apply to all subordinate items.

• Billable Hours are used to enter hours to be billed that aren’t tracked in the
Phone/Time Log or the Appointments columns.  You can specify Billable Hours for
any item that has a Phone/Time Log or Appointment time.  In that case, ECCO will
use the Billable Hours rather than the actual time logged when calculating Expenses.

• Expense Amount is used to list expenses that are not calculated at an hourly rate.
Examples are the cost of airfare, building materials, or a subcontractor’s services.

• Expense Date is the date on which expense was incurred. ECCO uses this date, the
Phone/Time Log date, or Appointment date when a date range is requested.  There is
no need to specify Expense Date for an Appointment or Time Logged item.

• Expense Type is a pop-up list used to set up different classifications for tracking
your expenses regarding billing, bookkeeping, and expense reports.  Values can be
edited and added at any time.

• Hourly Rate allows you to keep the various rates that you charge at your fingertips.
It is a pop-up list so you can add and edit values at any time.  You specify an hourly
rate for an item and that hourly rate will apply to all subordinate items for which
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there are Billable Hours, Time Logged, or Appointment settings, provided that no
other Billing Rate is supplied for those subitems.  If this field is left blank, ECCO
will use the default rate specified in the Calculate Time & Expenses dialog box.

The Expenses Due folder can be inserted as a column in other views where billable items
are stored.  Once you have done so, you can check that column for any item to have it
appear in the Time & Expense view.  You might want to insert that column in your
Calendar, for example, to easily bill expenses on certain appointments.  Similarly, you can
drag any item from any view into the Expense Due folder in the Folder window. The item
will be added to the Time & Expense view.

The Phone/Time Log column from the PhoneBook and the Appointments column from
the Calendar are also included since some logged items and appointments might also be
billable items or expenses.

Recording an Expense
There are four basic ways to record an expense:

• Record the expense directly in the Time & Expenses Notepad.

• Choose the Expense form from the Add New Item By Form submenu to add new
expenses from anywhere inside ECCO.

• Use the Phone Dialer or Time Logger to automatically create a logged item as an
expense.

• Use the Expense form from the View Item By Form submenu to specify expenses for
any existing ECCO item (such as an appointment, a logged call, or a task item).

Adding Items to the Time & Expenses Notepad

You can add expense items directly to the Time & Expenses notepad.

To add items to the Time & Expenses notepad

1. Switch to the Time & Expense notepad.

2. Enter the name of the expense as an item.

3. Add the appropriate information to the columns in the view.

If you enter an expense as a subordinate item and if the parent item has a billing code and
an hourly rate, you would not need to supply either of those for the new expense.  The
time expense calculation will use those values from the item’s parent if the item itself has
no values.

Note: You can override the Billable Hours or the Expense Amounts for all subordinate
items by entering those directly into a parent item.  If you’ve entered Billable
Hours or Expense Amounts for both a subitem and its parent item, ECCO will
alert you when it calculates expenses that only the parent’s value will be used.
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To summarize, if you have hourly rates for both a subitem and its parent item, the
subitem values will be used.  If you have Billable Hours or Expense Amounts for
both a subitem and its parent item, the parent values will be used.

Adding New Expenses Using the Expense Form

You can use the Add by Form dialog box to add a new item and record expenses for it.

To add expenses using the Expense form

1. From the Tools menu, choose Add New Item by Form, and then choose Expense.

2. The Add By Form: Expense dialog box appears.

3. In the Item Text box, type a description of the expense.

4. Customize the fields as desired:

• To set or change a field value, double-click the field name in the list on the left
and then enter a value in the field on the right.

• To reset all values to the default, choose the All Defaults button.

• To exclude the new item from a listed field, highlight the field value and then
choose the Clear Value button.

5. To add the new item below the selected item in the active view, select the Add To
Active View checkbox.

6. Choose the Add or the Add as Sub button.

The expense is automatically recorded in the Time & Expenses notepad.

If you choose Add as Sub, the new item will be added as a subordinate item to the
currently selected item.  In that case, if the selected item had a billing code and an
hourly rate you would not need to supply either of those to the new expense.  The
time expense calculation will use the values from the item’s parent item.

Note:   You might want to supply billing codes and hourly rates to your PhoneBook
entries so that all logged phone calls and other expenses can use those values
without requiring re-entry for each new expense.

Using the Time Logger Or Phone Logger

To use the Time or Phone Logger, do the following:

1. From the Tools menu, choose Time Logger.

 Or

From the PhoneBook menu, choose Dial Phone.

 The Time Logger dialog box or the Dialer/Call Logger dialog box appears.
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2. Choose one of the following options to add the logged item:

• Below the selected item

• To the Time & Expenses view

• Below the selected item and to the Time & Expenses view

3. Choose Begin to begin logging

4. When finished, choose the Close button on the Elapsed Time dialog box.

5. Record the appropriate information in the Time & Expenses view.

Note: You do not need to enter billable hours or an expense date for Phone/Time
logging. ECCO will use the actual date and time logged for those values.  You
may specify billable hours if you wish, in which case ECCO will use the billable
hours you specify rather than the actual time logged.

Using View Items By Form to Specify Expenses

You can use the View By Form dialog box to record expenses for an existing item.

To add expenses using the Expense form

1. Select any existing item for which you wish to specify expenses (such as an
appointment or task item).

2. From the Tools menu, choose View Item By Form, and then choose Expenses.

3. Check the Expenses Due field and fill out all other appropriate fields.

Note:   If you’re specifying expenses for an appointment, Phone Log, or a Time
Logged item, you do not need to specify a value for Billable Hours or
Expense Date.  ECCO uses the actual date and time logged when it calculates
expenses.  If you do specify Billable Hours for those items, ECCO uses the
billable hours specified rather than actual logged time.  Also note that, if the
item has a parent item with a Billing Rate or Billing Code, you can ignore
those fields and ECCO will calculate expenses using the parent item’s values.

4. Choose the Done button when you have finished.

Calculating Time and Expense Billing
Time & Expenses is available on the Tools menu from anywhere in ECCO. Selecting this
command will immediately take you to the Time & Expenses notepad and present you
with the Calculate Time and Expense Billing dialog box.

To calculate Time and Expense Billing

1. From the Tools menu, choose Time & Expenses.

 The Calculate Time and Expense Billing dialog box appears.
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2. Under Calculate Expense Totals For, select one of the following:

• To calculate expense totals for all items in the Time & Expenses notepad, select
All Items Currently Shown In View.

• To calculate expense totals for selected items only, select Selected Items Only.

• To calculate expense totals for all items matching a specific date range, billing
code, or expense category, select Items Matching, and then specify the criteria.

If you use a particular hourly rate for most of your billings, you can enter it in
the Default Hourly Rate box.

This rate will be automatically applied to any item that has no specific rate
associated with it or with its parent item.

Note: Specific rates can be applied to an item or its parent item by using either the
Expense form or by entering it directly into the Time & Expenses notepad.

3. To have the total calculated and written to the view, select the Add “Totals” Line To
View check box. This is useful for printing expense reports.

4. Choose the Calculate button.

5. Once the calculation is finished, you can select Done to return to the Time &
Expense notepad.

 Or

 Select Back to return to the Calculate Time And Expenses Billing dialog box.

 Or

Select Print View to display the Print Notepad dialog box. For more information
about printing notepads, see the section on Printing in the User’s Guide or in online
Help.

Launching the Internet
If you have access to the Internet, you can use a World Wide Web (WWW) browser
(such as the WebSurfer in NetManage’s Internet Chameleon) and ECCO to go directly to
any FTP or WWW site.

To launch the Internet from ECCO

1. Select an item containing an Internet address, FTP, or World Wide Web site.

 Or

 Double-click any Internet address description.

2. From the Tools menu, choose Launch Internet.
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The first time you use the feature, the Setup Internet Connectivity dialog box will
appear.  Select your browser and provide a path to the program.

After you have setup Internet Connectivity, selecting the Launch Internet option will
open your Web browser.

Note: Try shooting Internet addresses and World Wide Web locations directly into your
ECCO PhoneBook using the Shooter.  ECCO’s auto-assign feature automatically
puts Internet addresses into a folder called Net Location.  For more information on
Auto Assignment, see the chapter or online help on “Folders.”

Using the ECCO Internet Address Book
The ECCO Internet Address Book provides a directory of more than 2,000 World Wide
Web sites.  The ECCO Internet Address Book is an ECCO file (INTERNET.ECO) that
you can use with your favorite Web browser.  Double-click an item or use the Launch
Internet feature from the Tools menu to go to an item.

To use the ECCO Internet Address Book

1. Choose the Start button and select Programs from the Start menu.

2. Select NetManage ECCO Pro, then Internet Address Book.

3. Select a Web site and, from the Tools menu, choose Launch Internet.

 Or

4. Double-click a Web site’s description.
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Chapter 15.  File Sharing
If you’re working on a networked system, you can take advantage of ECCO’s file sharing
capabilities.  With file sharing, the dissemination of information is simplified; users are
granted a certain degree of access to a file, and they can easily read, modify, or add
information according to the level of permission they’ve been granted.

The ECCO Workgroup Directory
The ECCO Workgroup Directory is a network directory that stores shared ECCO files.
All ECCO users who have access to this directory can access shared files.

Note: Your ECCO user identification is based on your mail system address (user name
and password).  As a result, anyone who knows your user name and password has
complete access to information in your shared files.  NetManage recommends that
you follow standard security procedures to protect the data in your ECCO files.

Connecting to the ECCO Workgroup Directory
Before you can share files or access shared files, your computer must be connected to the
ECCO Workgroup Directory.

To create and connect to a new ECCO Workgroup Directory

1. Create an empty directory on the network.  This directory needs to be in a commonly
accessible location to all users who will connect to the workgroup and that provides
file read and write access privileges to each user.

2. From the File menu, choose Workgroup Settings.

 ECCO displays the Workgroup Settings wizard.  This wizard will help you quickly
and easily connect to an ECCO Workgroup Directory.  Choose the Next button to
proceed.

3. In the mail client list box, select the mail client installed on your computer.

4. You can also choose to have ECCO login to mail upon startup by checking the Login
to mail when ECCO starts checkbox.  If you leave the checkbox blank, ECCO will
not login to your mail client until group scheduling functions occur.  Choose the Next
button to proceed.

5. You are now presented the option to connect to an existing ECCO Workgroup
Directory.  To create the ECCO Workgroup Directory select Yes, then choose the
Next button.
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6. To complete the process of creating an ECCO Workgroup Directory, type a
description up to 60 characters that others will see when connecting.

7. In the Workgroup Path text box, type the path to the directory on the network or use
the Browse button to select the directory.  Choose the Next button to continue.

Note:   Consult your network administrator for assistance.  In addition, when creating
ECCO Workgroup Directories through this wizard, all users must have the
identical drive mapping to the network directory.

8. Choose the Finish button to complete your connection to the ECCO Workgroup
Directory.

To connect to an existing ECCO Workgroup Directory

1. From the File menu, choose Workgroup Settings.

 ECCO displays the Workgroup Settings wizard.  This wizard will help you quickly
and easily connect to an ECCO Workgroup Directory.  Choose the Next button to
proceed.

2. In the mail client list box, select the mail client installed on your computer.

3. You can also choose to have ECCO login to mail upon startup by checking the Login
to mail when ECCO starts checkbox.  If you leave the checkbox blank, ECCO will
not login to your mail client until group scheduling functions occur.  Choose the Next
button to proceed.

4. You are now presented the option to connect to an existing ECCO Workgroup
Directory.  To connect to an existing ECCO Workgroup Directory select No, then
choose the Next button.

5. Select Yes for Configuring ECCO for Connecting to an ECCO Scheduling Server
only if you will be performing group scheduling via TCP/IP servers.  Otherwise,
leave the default of No, and choose the Next button to proceed.

6. If you chose Yes for ECCO scheduling server, the wizard will request the server
name—either the name or IP address is acceptable.  Enter the information in the
Server Name field.

If you chose No for ECCO scheduling server, the wizard will request the path to an
ECCO Workgroup Directory.  Enter the path or choose the Browse button to search
and select the directory.

Note:   You may want to consult your network administrator for scheduling server or
ECCO Workgroup Directory information.

7. Choose the Next button to proceed, and then choose the Finish button to complete
your connection to the ECCO Workgroup Directory.
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Note: You need to connect to an ECCO Workgroup Directory only once unless you
move to a different group or server.  If your duties change or if you transfer to
another department within your organization, you may need to change ECCO
Workgroup Directories.  See your network administrator for details.

You can now share your group files—Calendar, PhoneBook, and Notepads—with other
ECCO users who have both access to this ECCO Workgroup Directory and access
privileges to the shared file.

Sharing ECCO Files
There are two types of shared ECCO files:

• The Main Calendar and PhoneBook file. ECCO uses the information in this file to
determine your schedule availability.  This file also logs you in to the ECCO user
database and sets up a name to allow others to give you access privileges to their own
ECCO files.

• Other shared files. These are primarily data files that contain task or project
information.

Note: If you try to share a file before you have established workgroup connections,
you’ll see a dialog box that informs you E-mail Service Not Found.   Refer to the
above section on Connecting to the ECCO Workgroup Directory for assistance.

To share an ECCO file

1. From the File menu, choose Share.

 ECCO displays the Workgroup Settings wizard.  This wizard will guide you through
the steps required to share your file.  Choose the Next button to proceed.

2. The wizard presents you with three options:

• Select the My calendar for group scheduling option if the file contains your
primary Calendar and PhoneBook.

• Select Another Shared File if the file does not contain your main Calendar and
PhoneBook.

• Select A Meeting Resource if you are making modifications to a existing
Meeting Resource.  For more information on Meeting Resources, see the section
on Creating Meeting Resources in the User’s Guide or in online Help.

3.  Select the ECCO Workgroup Directory from the Share in Workgroup list box.
Choose the Next button to proceed.

To share your Main Calendar File

1. If you choose the My calendar for group scheduling option you will be asked to
select how much information from your file will be available to other users.  Make a
selection and then choose the Next button.
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• Available times only allows other users to see if you are available.  Other users
can’t see any additional information about your schedule, such as description of
appointments.  They also do not have access to any of your PhoneBook or
Notepad views.

• Appointments and times allows other users to view your Calendar and see
detailed information about your schedule, such as a description of appointments
on your calendar.

• Custom options for sharing PhoneBook and notepad views allows you to
assign default access privileges or by user for all areas of your ECCO file,
including the ability to add, modify, and delete items.

2. Select whether to designate an administrative assistant to help you manage your
schedule.  The administrative assistant will receive your group scheduling requests
and can respond to or initiative scheduling actions on your behalf.  Choose the Next
button to proceed.

3. If you chose to use an Administrative Assistant, the wizard will display a list box of
the available ECCO Workgroup Directories and the users in each one.  Select the
user to designate as your administrative assistant.  Choose the Next button to
continue.

4. If you chose Custom options for Sharing PhoneBook and Notepad views the File
Sharing wizard will display options for the degree of access that others will have to
the file.  For more information on access privileges see the following section
Granting Access Privileges.  Choose the Next button to proceed.

5. The File Sharing wizard will display the file name that will appear to other users.
Choose the Finish button.

To share as Another Shared File

1. If you chose the Another Shared File option you will be asked for a description for
the file.  This is the description other users will see when they choose the Open
Shared File command from the File menu.  Choose the Next button to proceed.

2. Select how much information from the file will be available to other users. Selecting
the Custom option will allow you to assign access privileges by user.  Choose the
Next button to proceed.

• • See information only permits any changes or manipulations to how the ECCO
views are displayed.

• • Change information allows users to modify information contained in the file.

• • Customize views and information allows users to customize views with the
ECCO file.

• Custom allows you to assign default access privileges or by user for all areas of
the ECCO file.
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3. Select the public status of existing notepads in the file you are sharing.  You can
choose to share all existing notepads, or reserve the right to do so at a later time.
Choose the Next button to proceed.

4. If you chose Custom options for Allow Others To, the File Sharing wizard will
display options for the degree of access that others have to the file.  For more
information on access privileges see the following section Granting Access
Privileges.  Choose the Next button to proceed.

5. The File Sharing wizard will display the file name that will appear to other users.
Choose the Finish button.

Shared Files and the ECCO Workgroup Directory
For each file that is shared, two files (*.ECG and *.ECB) are created in the ECCO
Workgroup Directory. A third file (*.ECC) is created when you grant access privileges.

• The Master File (.ECG) This file lists access privileges of (and user changes to) the
shared file and the master log of changes.

• The ECCO Group OLE Object File (.ECB)  This file contains all OLE objects
embedded in the shared file.

• The Common ECCO File (.ECC) This file contains saved Calendar, PhoneBook,
and Notepad information associated with the file.  If the shared file is the Main
Calendar and PhoneBook file, its file name is based on your mail user identification
(username.ECC).  If the shared file is of the other type, its file name is based upon
the public file description entered in the File Sharing & Access Privileges dialog box.
For example, if you typed “Policy Notes” in the File Sharing & Access Privileges
dialog box, ECCO would save your file as POLICYNO.ECC.

Granting Access Privileges
For each file you share, you must specify the degree of access that others can have to it:

• None prevents others from having access.

• See grants read-only privileges.

• Add allows others to add information to the file.

• Modify  allows others to modify information in the file.

To grant access privileges

1. From the File menu, choose Share.  Refer to the prior section on how to share an
ECCO file for using the File Sharing wizard.

 The File Sharing privileges dialog box appears.

Page 237



ECCO User’s Guide228

 The access privileges dialog box is displayed during the File Sharing wizard by
choosing the Custom option.

2. As desired, modify the names on the file-access list, or change privileges for those
already there and choose OK.

 For detailed information on modifying file-access lists and privileges, see the
descriptions below.

Note: Unless you grant specific access privileges for each user, all users with access to
the ECCO Workgroup Directory will have default privileges for shared files.

To add names to a file-access list

1. Choose the Add button under Access Privileges.

 The Choose Users, Groups, and Resources dialog box appears.

2. Select the users who will be authorized to access the file. To create a group of users
under one name, choose the Groups button and complete the Edit Groups dialog box.

3. Choose OK.
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To grant access privileges for each user

1. Select the user name in the Access For list box and choose the down arrow beside the
view’s privileges you want to modify.

2. Select the appropriate privilege for the selected user. Repeat this step for all views
you want to change. (You must repeat this process for all users listed in the Access
For box.)

To specify default access privileges for a view

1. Select Default Privileges in the Access For list box.

2. Choose the Down arrow beside the view you want to change.

3. Choose the desired privilege for the view.

4. Choose OK to save your settings.

Note: You can also grant administrative assistant privileges for your main Calendar and
PhoneBook file to another user.  For more information, see the chapter or online
help on “Group Scheduling.”

These default privileges will be in effect for any unregistered user who tries to access
your file or when you add new users to a file’s access privileges list.  Unregistered users
are users who are connected to your workgroup directory but are not specifically named
in your access privileges list, or, they are named in your list but have not yet connected to
your ECCO Workgroup Directory.

Using Passwords to Protect ECCO Files
By adding passwords, you can protect the information in your private .ECO files.

Note: If you forget the password, you will not be able to open your file.  There is no
“backdoor” method of accessing the file.

To add or change a password

1. From the File menu, choose Properties.

 The File Properties property sheet appears.

2. Select the Password tab. In the Old Password text box, type your old password and
press TAB.  If you have not previously set up a password for this file, leave this box
blank.

For maximum security, ECCO does not display the characters as you type; an
asterisk (*) appears for each character.

3. In the New Password text box, type your new password and press TAB.

4. Verify your new password by typing it again in the Confirm Password text box.
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5. Choose the OK button.

If your second attempt to type the new password does not match the first, ECCO
displays an error message in the bottom portion of the dialog box.

Your new password is saved with your .ECO file.  You will be required to use it the next
time you open the file.  You must give the password to anyone using a shared copy of
your file.

Note: Each file can have its own password. Passwords are case sensitive.

To delete an existing password

1. From the File menu, choose Properties.

 The File Properties property sheet appears.

2. Select the Password tab. In the Old Password text box, type your old password,
leaving the new password text boxes empty.

For maximum security, ECCO does not display the characters as you type; an
asterisk (*) appears for each character.

3. Choose the OK button.

Working with Shared Files
Depending upon the access privileges you have been granted for a file, you can add,
modify, and delete appointments, meetings, notes, and outlines.

With sufficient privileges you can also modify folders, columns, and forms.

To open a shared file

1. From the File menu, choose Open Shared.

 The Open Shared ECCO File dialog box appears.

2. Under File Type, select either Main Calendar, PhoneBook, etc. of individual users or
Other Shared Files.

3. Select the ECCO Workgroup Directory from the list box for the workgroup you want
to view.

4. Under File Description, select the file that you want to open.

 When you open a shared file, you can also create your own private folders, columns,
and views.  Select the Let Me Create Private Columns and Folders option to keep a
local copy of the shared file.

5. Choose OK to open the shared file.
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 ECCO verifies that you have appropriate privileges for that file and then displays the
Calendar with the authorized information.

When you no longer need access to the file, you can disconnect from it.

Disconnecting from a Shared File
The time will come (for example, if you complete work on a specific project or if you
transfer to another department) when you will want to disconnect from a shared file.  You
must then decide whether to maintain public information in  your private file.

To disconnect from a shared file

1. From the File menu, Properties.

 The Open Shared ECCO File dialog box appears.

2. On the Connection Status tab choose the Disconnect button.

3. Choose the Disconnect button.

Deleting a Shared File
To delete a shared file

1. Open the local file.

2. From the File menu, choose Properties.

 The Open Shared ECCO File dialog box appears.

3. On the Connection Status tab choose the Disconnect button.

4. Choose the Disconnect button.

5. Use Windows Explorer or File Manager to delete the local file (*.ECO), the master
file (*.ECG), the graphics file (*.ECB), and the common ECCO file (*.ECC). All
private and shared information will be deleted.  You cannot undo this step.

Working with Shared Views and Items
When a view is shared, so are its items, filters, folders, label styles, and columns.

How to Identify a Shared Item
Shared items are distinguished by a yellow, marked bullet; shared folders are
distinguished by a mark in the upper-left corner of a yellow folder icon (shared menu
items, filters, outlines, label styles, and so forth, are distinguished by an asterisk  [*] next
to their name).
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Sharing ECCO Notepads
To make a Notepad public, you must explicitly share it.

To share a Notepad

1. Switch to the Notepad you want to share.

2. From the View menu, choose Make Public.  A share mark appears inside a yellow
item bullet for each item in the view, which indicates that the item is public.

To make an item private
If there are a few items you would like to keep private in a folder you have shared, you
can make those items private.  Private items are indicated by a blue item bullet.

1. Select any shared item.

2. From the Item menu, choose Make Item Private.

Note: To quickly mark an item private, select the item and click the right mouse button.
From the pop-up menu, select Make Item Private.

Shared Items and Context Parents
When you add a subitem to a public folder, only that subitem goes into the folder.
However, the items directly above the subitem, the context parents, appear in the files of
all users to provide the necessary context.

Changing Shared Items
Anyone with access privileges that permit modification can change a shared item.

To change shared items

1. Select the item you want to change.

2. Make the desired changes.

Changes appear immediately throughout the file and in all open copies of the file.

Sharing Folders
When you share a folder, the items in the folder become available to other users. Any
item added to a public folder also becomes public.  For more information, see the chapter
or online help on “Folders.”

You can share a folder by adding it to a public view or by using the Folder menu in the
folder window.  Folder sharing is not a reversible process—shared folders must remain
public unless the file is disconnected.
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To share folders

1. From the Folder menu, choose Edit Folders, and then select the folder you want to
share.

2. From the Folder menu, choose Make Public.

 A share mark appears inside the folder icon, and its color changes to yellow.  All
items in the folder (or added to this folder) will be public.

Viewing the Contents of a Shared Folder
You can display a shared folder’s contents in the Scratch notepad.

To view the contents of a shared folder

1. From the View menu, choose Folder Window.

 The Folder window appears.

2. Double-click the folder icon you want to see.

 The Scratch notepad appears and displays the contents of the selected folder.

Sharing Columns
When you share a view, its columns become public.  Once the view has been made
public, any ECCO user can add private columns.  For more information about columns,
see the section on Columns and Values in the User’s Guide or in online Help.

Note: Before you can share a column, you must first make public the view in which it
appears.

To share a column

1. Select a cell in the column you want to share.

2. From the Column menu, choose Make Public.

To add a private column to a public view

1. Select a cell in any column or click any column heading in the Column pane.  You
can select a cell using either the mouse or the arrow keys.

2. From the Column menu, choose Insert Column, and then choose a column type from
the menu.

3. In the Column Heading dialog box, supply a name for the column.

4. Choose the OK button.

 The New Column dialog box appears, in which you can specify whether you want the
new column to be public or private.
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5. Choose the Private button. ECCO inserts a new, private column in the view.

Note:   This will create a local copy of the shared file if one does not already exist.

Sharing Forms
To share a form, do the following:

1. From the Tools menu, choose Manage Forms.

 The Manage Forms dialog box appears.

2. In the list of forms, select the form you want to share.

3. Select the Make Public check box.

4. Choose the OK button.

 This form will appear on the various forms menus when other users open your shared
file.
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Chapter 16.  Group Scheduling
It’s easy to schedule meetings with anyone on your network using the group scheduling
feature in ECCO.  Using this feature, you can:

• Determine the availability of other ECCO users and schedule meetings accordingly.

• Send meeting mail.

• Add outline notes to a meeting description.

• Change the time, date, or duration of meetings.

• Cancel or reschedule meetings.

• Respond to meeting request.

• Delegate another user to attend a meeting on your behalf.

• Decline an invitation.

• Invite others to a meeting.

Scheduling Meetings
In ECCO, the user scheduling the meeting is called the initiator; users selected to attend
the meeting are called attendees.  Before you can schedule a group meeting, you must
connect to an ECCO Workgroup Directory and share your ECCO file to make your
Calendar available to others.  For more information, see the chapter or online help on
“File Sharing.”

To schedule a meeting

To schedule a group meeting, you must first open the Calendar.  Then follow these steps:

1. From the Calendar menu, choose Add Group Meeting.

 The Schedule Group Meeting dialog box appears.
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 If you want to make recurrences of this meeting choose the Recurring Meeting button
and select the desired frequency.

2. Choose the Attendees & Resources button to select meeting attendees.

 ECCO displays the Choose Users, Groups, and Resources dialog box.

3. Select the attendees for the meeting.  If you have access to multiple ECCO
Workgroups, you can select the workgroup in the Scheduling Address Book list box.

Note: Attendees are “Required” by default.  To designate attendees as “Optional,”
double-click the users’ names in the Schedule Group Meeting dialog box.

ECCO displays the schedule availability in the time grid:

Color Indicates

Blue Proposed meeting

Red Schedule conflict (attendees with conflicts have an X next to their
names)

Green Initiator’s appointments

Dark Gray Required Attendees’ appointments

Light Gray Optional Attendees’ appointments

4. Take one of the following actions:

• If schedule conflicts exist, select a new date and time by either clicking on them
or by using the Search buttons.
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• If no schedule conflicts exist, choose OK.  The Send Meeting Request dialog
box appears.

5. Type additional meeting message information, and then choose Send.

To make an appointment into a group meeting

1. Open the Date Settings dialog box by clicking the appointment time of the
appointment you want to change.

2. Choose the Group button in the Date Settings dialog box.

3. Choose the Make Group Meeting command.

 ECCO displays the Change Appointment to Group Meeting dialog box.  Follow steps
2 through 5 under “To Schedule a Meeting,” above.

Selecting Meeting Attendees
Use the Choose Users, Groups, and Resources dialog box to select meeting attendees.
You can invite other ECCO users who share the same ECCO Workgroup Directory, users
of other connected ECCO Workgroup Directories, and anyone listed in your mail post
office.

To select meeting attendees

1. Choose the Attendees & Resources button in the Schedule Group Meeting dialog
box.

 ECCO displays the Choose Users, Groups, and Resources dialog box.

2. Select any user in the Scheduling Address Book list by clicking on the user’s name.
To select multiple users, click while holding down the SHIFT key (for sequential
names) or the CTRL key (for non-sequential names).

 To view users in other connected ECCO Workgroup Directories choose the down
arrow button to the right of the Workgroup name list box and select the other
connected workgroup user listing you want.

 Choose Mail Address Book to invite users who are not in the Scheduling Address
Book list.  This command uses the addressing services of your electronic mail
program. You can send meeting invitations to anyone in your network post office.

3. Choose the right arrow button to add the selected users to the Meeting Attendees list.

4. When you have selected all the attendees for your meeting, choose the OK button.

 ECCO checks the availability database and then displays meeting availability for
meeting attendees who are connected to the same or a connected ECCO Workgroup
Directory as your main file.

Note: You can quickly add users to the Meeting Attendees list by double-clicking the
name.
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Creating a Meeting Attendee Group
If you frequently invite the same people to group meetings, you’ll find it more efficient to
create a meeting attendee group–an alias that organizes groups of users under a single
name.  For example, the “Interns” meeting attendee group contains the names of all 25
college students working at the Daily Bugle newspaper.  When the managing editor needs
to schedule a meeting, she invites the Interns meeting attendee group and thereby avoids
having to individually invite the 25 people who make up the group.

Meeting attendee groups are easy to identify — they’re preceded by a small x in the
Scheduling Address Book list box.

Note: Any users sharing the ECCO Workgroup Directory can create, modify, and delete
meeting attendee groups.

To create a meeting attendee group

A meeting attendee group can include 1) other ECCO users who share the same ECCO
Workgroup Directory 2) other ECCO users who are in connected ECCO Workgroup
Directories and 3) external users (anyone who is in your e-mail post office address list).

1. From the Calendar menu, choose Add Group Meeting.

 The Schedule Group Meeting dialog box appears.

2. Choose the Attendees & Resources button.

 The Choose Users, Groups, and Resources dialog box appears.

3. Choose the Groups button in the Choose Users, Groups, and Resources dialog box.

 The Edit Groups dialog box appears.

4. Choose the New button.

 The Edit Groups dialog box appears.
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5. In the Rename Group text box, type a name that will allow you, and other users
sharing your ECCO Workgroup Directory, to identify the meeting attendees for that
group.

6. Select users for your new group by clicking on names in the Scheduling Address
Book.  You must select at least one user for a group.

7. Choose the right arrow button (labeled “In”) to add the selected users to the Group
Members list.

Note: You can quickly add users to the Group Members list by double-clicking the
name.

8. When you have finished selecting members for the group, choose the OK button.

 ECCO displays your new meeting attendees group in the Edit Groups dialog box.

9. Choose the OK button.

 Your new meeting attendee group is created and appears in the Scheduling Address
Book list box.  Each time this group is selected to attend a meeting, ECCO
automatically checks schedule availability for each individual in the group.

Modifying a Meeting Attendee Group
From time to time, you might want to change the name of a meeting attendee group or add
or remove individuals from your group.

To change a meeting attendee group

1. From the Calendar menu, choose Add Group Meeting.

 The Schedule Group Meeting dialog box appear.

2. Choose the Attendees & Resources button.

 The Choose Users, Groups, and Resources dialog box appears.

3. Choose the Group button in the Choose Users, Groups, and Resources dialog box.
The Edit Groups dialog box appears.

4. Select the group you want to edit, and then choose the Edit button.

 The Edit Group dialog box appears.

5. Take one or more of the following actions to modify your group attendee list:

• To change the name of the group, type a new name in the Rename text box.

• To add another user, click on the user’s name in the Scheduling Address Book
list, then choose the In button to add the selected user to the Group Members list.
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• To remove a user, double-click on the user’s name in the Group Members list
box, or select the name and then press the Out button.  You cannot remove all
users from a group.

6. When you are through changing your group, choose the OK button.

 ECCO displays the modified group in the Edit Groups dialog box.

7. Choose the OK button.

Sending Meeting Mail
ECCO uses electronic mail to send meeting notices between meeting initiators and
attendees.  Meeting mail is automatically generated when you schedule a meeting, cancel
a meeting, or respond to a meeting request.  You can display a list of your meeting mail in
a Mail window at the bottom of the ECCO program window.

To send meeting mail

1. Go to the meeting date and time in the Calendar.

2. In the Appointment section, click on the meeting time.

 The Review Meeting dialog box appears.

3. Choose Send Mail.

 ECCO opens a Send Meeting Notes dialog box. ECCO completes the message
header section for you by using information stored in the meeting database.  ECCO
also includes any notes in your Calendar, such as meeting agenda, meeting minutes,
and so forth.

4. Type your message text, or edit the existing text.

5. Choose Send to send your message to the addressees listed on the To line.

Note: For some meetings, a description of just a few words might be adequate.  For
others, you might want to include additional background information, such as a
meeting agenda, in the form of outline notes.

Rescheduling a Meeting
You can change the scheduled time or date of a meeting by:

• using the Review Meetings dialog box

• dragging the Busybar block to another time or date

• dragging the meeting to another time or date

To reschedule with the Review Meetings dialog box

1. Select the meeting that you want to reschedule.
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 If necessary, use the Navigator to switch to the meeting date and time in the
Calendar.

2. In the Appointment section, click on the meeting time.

 The Review Meeting dialog box appears.

3. In the Review Meeting dialog box, choose Reschedule.

 The Reschedule Group Meeting dialog box appears.

4. Select a new date and time for the meeting by clicking on a new date and time in the
time grid or by using the Search arrows.  ECCO automatically checks the Availability
Database and displays the scheduled meetings for attendees in the time grid.

5. Take one of the following actions:

• If there are schedule conflicts, use the Search From and Mini-Navigator buttons
to select another date and time for the meeting.

• If there are no schedule conflicts, choose OK.  ECCO will open the Send
Meeting Request dialog box.

6. Choose Send to send the new meeting request message.

Note: When a meeting is rescheduled, the status of each attendee is set to undecided.
Each user can then accept or decline the new meeting date.

To reschedule with the Busybar or item bullet

You can drag a meeting’s Busybar block or item bullet to any time or date that appears in
the appointment section of the Calendar.

1. Point to the middle portion of the Busybar block for the meeting and hold down the
mouse button.

 Or

 Point to the item bullet (to the left of the meeting text) and hold down the mouse
button.

 The pointer changes to a four-headed arrow. If you’re dragging the Busybar block, a
box displays the meeting time as you drag.

2. Drag the meeting to a new time or date.

 ECCO indicates any conflicts with a red-and-white striped pattern in the Busybar
block.

 The Change Meeting Appointments dialog box appears.

3. Choose OK to confirm the change.

 The Send Meeting Request dialog box appears.
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4. If desired, type in an explanation for the changes.

5. Choose Send to notify the attendees of the change in meeting time.

Changing Meeting Duration
To change the duration of a meeting, use the Busybar or the Reschedule Group Meeting
dialog box.

To change meeting duration

1. Select the Busybar block for the meeting whose duration you want to change.

 ECCO displays an arrow at both ends of the bar.

2. Drag either arrow to the appropriate beginning or ending time.

 ECCO displays the new meeting time in 15-minute increments as you drag.

3. Release the mouse button when the appropriate time is displayed.

Note: You can also select the meeting text and press F2. In the meeting edit box you can
enter or change dates and times from the keyboard. Click the down arrow or press
the INSERT key to display the Review Meeting dialog box.

Reviewing and Changing Attendee Status
Once your group meeting is scheduled, you can quickly review and change attendee
status.  This option is particularly useful when you schedule meetings with non-ECCO
users.  For example, since ECCO is compatible with most popular electronic mail
programs, you can send meeting invitations to non-ECCO users who are connected to
your e-mail network.

To change attendee status

1. In the Calendar, select the meeting, and then click on the meeting time to the left of
the meeting description.

 The Review Meeting (Initiator) dialog box appears.

2. In the Attendees list, select the name of the user for whom you want to change
attendee status.

3. Choose the Status button.

 The Attendee Status dialog box appears.

4. Select the new status option for the attendee.

5. Choose OK.

ECCO automatically updates the meeting database with this information.
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To uninvite an attendee

1. In the Calendar, select the meeting, and then click on the meeting time to the left of
the meeting description.

 The Review Meeting (Initiator) dialog box appears.

2. In the Attendees list, select the name of the user for whom you want to un-invite.

3. Choose the Status button.

 The Attendee Status dialog box appears.

4. Choose the Un-Invite User button.

5. Choose OK.

ECCO automatically updates the meeting database with this information.

Canceling Meetings
Only initiators (and administrative assistants of initiators) can cancel meetings.

To cancel a meeting

1. In the Calendar, click on a meeting for which you are the initiator.  The Review
Meeting Dialog appears.

2. Choose the Delete Mtg. button.

 A dialog box appears, asking you to confirm your actions.

3. Choose OK

 The Send Cancellation dialog box appears.

4. If desired, type in a reason for the cancellation. Then choose Send.

 Or

5. In the Calendar, select a meeting.

6. From the Edit menu, choose Delete Items.

 A dialog box appears, asking you to confirm your actions.

7. Choose OK.

 The Send Cancellation dialog box appears.

8. If desired, type in a reason for the cancellation.  Then choose Send.
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Checking Group Calendars
If you want to check the schedules of others, it’s easy to do so using the Show Group
Calendar command.

To check group calendars

1. From the Calendar menu, choose Show Group Calendar.

 The Choose Users, Groups And Resources dialog box appears.

2. Add one or more names as meeting attendees, and choose OK.

 You can select ECCO users from other connected ECCO Workgroup Directories by
pressing the down arrow button to the right of the workgroup name field and
selecting the desired ECCO Workgroup Directory.

 The week’s summary view appears, showing the calendars of all attendees (the
information can also be shown in month summary).

Responding to Meeting Requests

Reading Meeting Mail
To view the Meeting Mail window, from the View menu, choose Meeting Mail. To hide
the Meeting Mail window, choose the Close button, which is located in the upper-left
corner of the Meeting Mail window.

To read meeting mail

Once the Meeting Mail window is visible, use one of the following procedures to read
meeting mail:

• Select the message in the message pane of the Meeting Mail window, and choose
Read Mail.

 The Meeting Message dialog box appears.

• Double-click the message in the message pane of the Meeting Mail window.

 The Meeting Message dialog box appears.

• Select the message in the message pane of the Meeting Mail window, and choose
Find Meeting.

 The meeting date and time appears in your Calendar.

 Then choose Read Mail.  The Meeting Message dialog box appears.
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Reviewing Your Schedule before Responding to a
Meeting Request
ECCO makes it easy to double-check your existing commitments for the day of a
requested meeting.

To review your schedule

1. In the meeting message window, select the Meeting Request message.

2. Choose Find Meeting to locate the date and time the meeting is scheduled to occur.

 ECCO displays the meeting date in your Calendar and selects the time for the subject
meeting.

Accepting, Declining, or Delegating a Meeting
Request
Attendees receive a Meeting Request message whenever a meeting is scheduled. They can
accept, decline, or delegate the meeting to someone else.

• When an attendee accepts a Meeting Request message, ECCO adds the meeting to
the Calendar in the user’s main ECCO file that contains the Calendar and
PhoneBook.

• If the Show On Calendar If Declined Or Delegated option is selected, the meeting is
added in gray text to the Calendar if the user declines the meeting request.

To accept or decline a meeting request

1. In the meeting message window, select the Meeting Request message.

2. Choose Read Mail to open and read the meeting request message.

 Or

 Double-click on the Meeting Request message to open the message.  The Meeting
Request message appears.

3. In the Meeting Request dialog box, choose Accept or Decline.

 ECCO prepares the appropriate meeting response message.

4. To include additional information with your response, type the information in the text
area of the message form.  Then choose Send to transmit the message.

To appoint a delegate

1. In the Meeting Request dialog box, choose Delegate.

 The Choose Users, Groups, and Resources dialog box appears.
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2. Select the name of the delegate.

 You can select ECCO users from other connected ECCO Workgroup Directories by
pressing the down arrow button to the right of the workgroup name field and
selecting the desired ECCO Workgroup Directory.

3. Choose OK.  ECCO displays a Send Delegation request message addressed to the
delegate, with a courtesy copy addressed to the initiator.

4. Choose Send in the Meeting Request dialog box.

When the delegate accepts or declines the meeting invitation, ECCO sends a courtesy
copy of the meeting response to the delegator.

Note: If you choose to send a delegate, ECCO keeps you informed by sending courtesy
copies of all messages that pertain to the meeting.

Inviting Additional Attendees
Attendees can invite others from the Meeting Request dialog box or from the Calendar.

To invite from the Meeting Request dialog box

1. In the Meeting Request dialog box, choose Invite.

 The Choose Users, Groups, and Resources dialog box appears.

2. Select the names of the desired attendees.

 You can select ECCO users from other connected ECCO Workgroup Directories by
pressing the down arrow button to the right of the workgroup name field and
selecting the desired ECCO Workgroup Directory.

3. Choose OK.

 ECCO displays a Send Invitation request message, with a courtesy copy addressed to
the initiator.

4. Choose Send in the Send Invitation dialog box.

To invite from the Calendar

1. Use the Navigator to switch to the meeting date and time in the Calendar.

2. In the Appointment section, click on the meeting time.

 The Review Meeting dialog box appears.

3. Choose Invite.

 The Choose Users, Groups, and Resources dialog box appears.

4. Select additional invitees that you want to attend the meeting.
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 You can select ECCO users from other connected ECCO Workgroup Directories by
pressing the down arrow button to the right of the workgroup name field and
selecting the desired ECCO Workgroup Directory.

5. Choose OK in the Choose Users, Groups, And Resources dialog box.

 ECCO displays a Send Invitation meeting request dialog box addressed to your
guests, with a courtesy copy addressed to the initiator.

6. Choose Send in the Meeting Request dialog box.

Declining after Accepting
Even after you’ve accepted a meeting invitation, you or your administrative assistant can
subsequently decline it.

To decline after accepting

1. In the Calendar, click on the time of a meeting.

 The Review Meeting Dialog appears.

2. Choose Decline.

 The Send Decline dialog box appears.

3. If desired, provide a reason for declining.

4. Choose Send.

 Or

5. In the Calendar, select a meeting.

6. From the Edit Menu, choose Delete Items.

 A dialog box appears, asking you to confirm your actions.

7. Confirm your actions.

 The Send Decline dialog box appears.

8. If desired, provide a reason for declining.

9. Choose Send.

Deleting Meeting Mail
With one exception, ECCO keeps copies of meeting mail until you delete them. (Meeting
requests are deleted as soon as you respond to them.)
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To delete meeting mail

1. In the meeting message window, select the Meeting Request message that you want
to delete.

2. Choose Discard Mail to remove the meeting message from your ECCO Meeting Mail
window.

 ECCO deletes the message — both in your ECCO Meeting Mail window and your
mail inbox.

Note: Although deleted messages are removed from your inbox, you might need to
explicitly delete copies from the “sent mail” box of your mail program.

The Administrative Assistant
With ECCO, you can grant administrative assistant privileges to another user, who can
then make changes to your schedule as well as respond to meeting requests on your
behalf.  Administrative assistants always receive copies of meeting mail messages.

Note: Administrative assistant privileges are valid for the Calendar only.  You must
explicitly grant user privileges for PhoneBook, Notepad, or other folders or
columns.

To add an Administrative Assistant

Administrative Assistants are designated in the File Sharing wizard.  You can designate
your Administrative Assistant when you first share your file, or subsequently by executing
the File Sharing wizard.

1. From the File menu, choose Share.

 ECCO displays the File Sharing wizard. This wizard will guide you through the steps
required to share your file.  Choose the Next button to proceed.

2. Select the My calendar option.

3. Select the workgroup from the Share in workgroup list box.  Choose the Next button
to proceed.

4. Select how much information from your file will be available to other users.

5. Select Yes to designate an Administrative Assistant.  Choose the Next button to
proceed.

6. Selecting Yes will cause the wizard to display a list box of the available ECCO
Workgroup Directories and the users in each one.  Select the user to designate as
your Administrative Assistant  Choose the Next button to proceed.

 The File Sharing wizard will display the file name that will appear to other users.
Choose the Finish button.

Page 258



249 ECCO User’s Guide

To remove an Administrative Assistant

If you want to change your Administrative Assistant, or exclusively make your own
scheduling decisions, you will use the File Sharing wizard.

1. From the File menu, choose Share.

 ECCO displays the File Sharing wizard. This wizard will guide you through the steps
required to share your file.  Choose the Next button to proceed.

2. Select the My calendar option.

3. Select the ECCO Workgroup Directory from the Share in workgroup list box.
Choose the Next button to proceed.

4. Select Custom options for sharing PhoneBook and Notepad views.  Choose the Next
button to proceed.

5. Select No to designate an Administrative Assistant. Choose the Next button to
proceed.

6. Highlight the current Administrative Assistant’s name in the Access For section and
choose the Remove button.  Choose the Next button to proceed.

 The File Sharing wizard will display the file name that will appear to other users.
Choose the Finish button.

Note: If you want to add a new Administrative Assistant, you can specify Yes in step 5
above, but you must still remove the former assistant as outlined in step 6 as they
will retain access to your Calendar, but no longer receive your meeting requests.

To respond to meeting requests for another user

1. Select the message in the message pane of the Meeting Mail window, and choose
Read Mail.

 The Meeting Request dialog box appears.  To help you quickly identify meeting
requests for another user, the Meeting Request dialog box contains a group icon in
the upper-right corner.

2. In the Meeting Request dialog box, choose Find.

 The Open Calendar dialog box appears.

Note: To add the meeting to the user’s calendar, ECCO must be able to open the user’s
calendar. For example the administrative assistant needs the password for the file.

3. Choose OK to open the user’s Calendar.  If you have several large files open, you
might need to close these files before proceeding.  ECCO opens and displays the
user’s Calendar and selects the date and time of the proposed meeting.

4. In the message pane of the Meeting Mail Window, choose Read Mail to display the
Meeting Request dialog box again.
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5. Take one or more of the following actions to respond to the meeting request:

• Choose Accept or Decline

• Choose Delegate to appoint another individual to attend the meeting.

• Choose Invite to invite others to the meeting

• Choose Defer to postpone a decision

Sharing Meeting Resources
With ECCO, you can not only schedule the time of people, but you can schedule the time
of resources, such as rooms and equipment.  In ECCO, such resources are known as
shared meeting resources.  By including shared meeting resources as meeting attendees,
you reserve them for the selected date and time.

Creating a New Meeting Resource
Before you can consider a white board, a meeting room, or an overhead projector a
meeting attendee, you must create it as a meeting resource.

To create a new meeting resource

1. Have your mail system administrator establish a new mail account for the resource.

2. From the File menu, select Create Meeting Resource.

 The Create Meeting Resource dialog box appears.

3. Click the Choose button beside the Resource Name text box.

 The Choose Users, Groups, and Resources dialog box appaears.

4. Choose the Mail Address Book button.

 The Select Users dialog box appears.

Page 260



251 ECCO User’s Guide

5. Select the resource in the list, and then choose OK.  (For more information on
selecting users, refer to the documentation that accompanied your mail program.)

6. From the Choose Users, Groups, and Resources dialog box, choose OK.

7. You automatically become the resource administrator for any meeting resource that
you create, unless you click the Choose button beside the Administrator for this
Resource text box and select a different user.

8. Select Schedule Resource Automatically if Available (the default).

 Or

 Select Send Scheduling Requests To An Administrator if you want to control
scheduling of the new resource.  Other users will be able to invite the resource, but
the resource won’t be reserved until the administrator accepts or declines the meeting
request.

9. When you are satisfied with the configuration for the resource, choose OK in the
Create Meeting Resource dialog box.

 ECCO creates a shared file for the resource.

Note: Before other users can directly open the shared file for the resource, you must also
grant the appropriate access privileges for the file.

Appointing a Meeting Resource Administrator
When you create a meeting resource, you must appoint a resource administrator (by
default, you automatically become the resource administrator for any meeting resource
that you create).

The resource administrator is responsible for managing the main ECCO file for the
resource.  This includes:

• reviewing and responding to meeting request messages (if Schedule Resource
Automatically is not selected)

• changing user access privileges to the Calendar files of the resource

• changing file passwords

In addition, the resource administrator receives a copy of all meeting messages addressed
to the resource.

To change a resource administrator

Use the File Sharing wizard to appoint a new meeting resource administrator.

1. From the File menu, choose Open Shared.

 The Open Shared ECCO File dialog box appears.
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2. Under File Description, select the meeting resource that you want to change and
choose OK.

 ECCO opens the main calendar for the resource and displays the Calendar.

3. From the File menu, choose Share.

 The File Sharing wizard appears.

4. Select a meeting resource and choose the Next button to proceed.

 The wizard displays the current resource administrator.  Choose Next to proceed.

5. Select the user name of the person to become the resource administrator.  Choose the
Next button to proceed.

6. Select whether the resource is autobooked.  Choose the Next button to proceed.

7. Select Custom options for sharing PhoneBook and Notepad views.  Choose the Next
button to proceed.

8. Select the former resource administrator’s name from the Access for section and
choose the Remove button.  Choose the Next button to proceed.

 The File Sharing wizard will display the file name that will appear to other users.
Choose the Finish button.
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Chapter 17.  Synchronizing with
ECCO
If you use multiple computers (for example, one at the office and one at home), ECCO
can keep track of changes you make on both computers.  This process keeps the contents
of the files in sync.  ECCO does this through synchronization.

Synchronization requires two elements — the original file and a special working copy of
the file (called the replica) that resides on the second computer.  Instead of replacing
entire files, ECCO exports and imports only the changes made to a file.

For example, in your original file on your office computer, you wrote the sentence “The
quick brown fox jumped over the lazy dog.”  Later, you worked on the file on your home
computer and changed the word “jumped” to “tripped”.  With synchronization, only the
changed word “tripped” would need to be exported from your home computer file to the
office computer file.  Likewise, if you made a change in your office file, only the changed
information would need to be imported from the office file to the replica file on your
home computer.

Synchronization: The Terminology
The synchronization process has a language all its own.  The following terms are the most
important to understand:

The original file is the file that exists before the start of synchronization.  Original files
have the extension .ECO.

The replica is a special copy of the original file that you work on at the second computer.
Replicas also have the extension .ECO.

The master file contains a master log of all changes that occur. It is actually two files that
are created when you create a replica: the *.ECG file that contains the changes, and the
*.ECB file which contains any OLE links in the file. The master file is updated when
synchronization takes place.

Note: Any user — regardless of access privilege — can export or import changes to or
from any remote replica.
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Methods of Synchronization
ECCO provides three methods of synchronization:

• Disk synchronization (the most common method)

• Electronic mail synchronization

• Automatic synchronization

Each method is, in essence, an exporting and importing process. But only the changes
made to a file are exported and imported from computer to computer. How the changes
get from one computer to another depends on the synchronization method you’re using.

Creating the Synchronized Copy
The first step in utilizing the ECCO synchronization process is to create the special
synchronized copy.  This special copy will be used on your other machine.  The
advantage to this process is that only a small changes file will be copied between your two
machines, versus copying the entire ECCO data file each time.

1. Open the file from which you want to make a synchronized copy.  If the file is
already open, save it.  From the File menu, choose Workgroup Settings.

 ECCO displays the Create Synchronized Copy wizard.

2. Select the appropriate computer option (home computer, laptop computer, another
computer) to indicate the computer where the synchronized copy will reside.  Enter a
description for the copy in the description text field.  Choose the Next button to
proceed.

3. Enter the file name for the synchronized copy or choose the Browse button to select a
path and new file name.  Choose the Next button to continue.

4. The wizard will display the path and file name you are about to create. Choose the
Finish button.

5. Using Windows Explorer or File Manager, move the replica file to the other
computer’s hard drive, either via diskette or your network.

 This is the file that you will open and use on your other computer.

6. Make sure to delete the file from the original location where ECCO saved the replica
to avoid confusion (moving versus copying the file in step 5 will automatically delete
the original source file).

Note: If the computers are networked, depending upon the network connection, you can
save the replica file directly to a common network location and then move via the
network to the second computer.  If the other computer is not networked, you
should save the replica file directly to your hard drive.  Copy the replica file to a
diskette and use the diskette to transfer the file to another computer.
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Disk Synchronization
With disk synchronization, you export and import information between computers by
means of a removable disk, such as a floppy or Iomega zip disk.  For example, you
would perform manual synchronization between two non-networked computers that have
no other way of communicating.  Disk synchronization is the most commonly used
synchronization method.

Note: It is important to complete the full synchronization process. If you synchronize
only one way, the master file will get very large.  ECCO will alert you that you
should export your changes.

To export changes

1. Open your original file or any shared file when the network is available.

2. Insert a disk into the disk drive.

3. From the File menu, choose Synchronize, and then choose Export Changes.

 ECCO displays the Export Changes wizard.

4. Select the remote file from the displayed list that will receive changes.  Choose the
Next button to proceed.

5. Select Floppy disk. Choose the Next button to proceed.

6. Enter the name of the changes file or choose the Browse button to select a new path
and file name. Choose the Next button to proceed.

7. The wizard will display the path and file name you are about to create or the e-mail
recipient if you chose the Electronic mail option. Choose the Finish button.

Note: If you have synchronized a replica with the Export Changes command, be sure to
export changes from the replica back to the master file, even if you have not made
any changes to the replica.

To import changes

Once you’ve exported changes, you need to import them to the remote file.

1. Open the remote ECCO file.

2. Insert the disk into the remote computer.

3. From the File menu, choose Synchronize, and then Choose Import Changes.

 ECCO displays the Import Changes wizard.

4. Select the source option for your changes.

5. Enter the update file’s path and file name or choose the Browse button to locate and
select the file.  Choose the Next button to proceed.
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6. Press the Finish button to import the changes.

ECCO imports all changes and merges them into the remote ECCO file.

 ECCO creates a file that reflects changes made in the remote file and reports (to the
master file) which changes have been received.

To complete disk synchronization

To complete disk synchronization, repeat the exporting and importing steps, working
from the replica to the original file.

Note: You can use the same .EMF file when exporting to and from both the original and
replica files.  Don’t worry if you forget to export changes back to either of these
files; ECCO will keep exporting all changes until it receives confirmation that they
have been accepted by the other PC.  Confirmation will occur the next time you
synchronize changes from the other PC.

Automatic Synchronization
If the original file is a shared network file, its replicas have direct access to the master
file, and they are automatically synchronized.  In this case, no .EMF file is created. This
process is also called working on-line.

This method of synchronization might be used by someone who has two offices or two
machines on one network.  With automatic synchronization replicas are automatically
updated.

Remote Access Synchronization

If you use third-party software, such as LapLink or PC Remote, to access the computer,
you need to perform remote access synchronization.  No .EMF file is created for this
procedure.  With remote access synchronization files are updated through third-party
software.

To perform remote access synchronization

To help ECCO find your master file, from the File menu choose Synchronize, and then
choose Remote Access Sync.

ECCO displays the name and path of the file it expects to find. Once it has found the
appropriate file, ECCO will remember its new name and location. If the remote access
program is run after the replica has been opened, you’ll need to use the Remote Access
Sync command again to initiate synchronization.

Synchronization Using Electronic Mail
You can also use an e-mail program (such as NetManage Z-Mail Pro or Lotus cc:Mail) to
export and import changes to original files and replicas. This method of synchronization
might be used by a traveling salesperson who dials in for mail.

Page 266



257 ECCO User’s Guide

Choose the method that best suits your needs:

• Mail To: lets you mail changes to someone who has a remote replica of the master
file (the changes are sent as an attachment).

• Send Automatically Using Mail Message: lets you export changes at regular,
scheduled times.

To synchronize using mail

1. Open your original file or any shared file when the network is available.

2. From the File menu, choose Synchronize, and then choose Export Changes.

 ECCO displays the Export Changes wizard.

3. Select the remote file from the displayed list that will receive changes.  Choose the
Next button to proceed.

4. Select Electronic mail. Choose the Next button to proceed.

5. Enter the name e-mail recipient. Choose the Address button to access the e-mail
address book. Choose the Next button to proceed.

6. The wizard will display the name of the e-mail recipient. Choose the Finish button.

Advanced Synchronization
1. Open your original file or any shared file when the network is available.

2. From the File menu, choose Synchronize, and then choose Export Changes.

 ECCO displays the Export Changes wizard.

3. Select the remote file that will receive changes.

4. Choose the Advanced button.
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5. Select the remote file that will receive changes.

6. Select Disk File, and either specify a filename (with path), or choose Browse to select
from a list of names.  (CHANGES.EMF is a good choice for the filename.)

7. Select the method to send the changes.  If selecting one of the two electronic mail
options, choose the method that best suits your needs:

• Mail To (type the address in the To field, or choose Address to select the
recipient from an existing list of names).

• Send Automatically Using Mail Message (type the address in the To field, or
choose Address to select the recipient from an existing list of names; type values
in the On and At fields to specify when messages should be sent, or make
selections from the drop-down lists).

8. Choose the OK button.

9. Repeat steps 5 through 7 as desired.

• With Mail To, messages with files containing the changes are created and sent
immediately.

• With Send Automatically Using Mail Message, messages are sent at the
specified times, provided that the ECCO file associated with the merge is open.
If it is closed, ECCO sends expected messages as soon as the file is opened.

10. Repeat steps 2 through 6 on the replica to synchronize back.

Note: ECCO checks your mail inbox for messages at the times indicated in the ECCO
Options property sheet, mail system tab.  When it finds a message containing
changes for the replica, it imports the changes and merges them with the data in
the replica.

Creating a Replica
ECCO is designed to synchronize up to 250 replicas of each file.  A replica is more than a
simple copy of a file: it contains special features that make synchronization possible.  You
cannot create a replica by using standard copy commands from File Manager or MS-
DOS.  Replicas are synchronized with their original file, never with each other.

To create a replica

1. Open the file you want to replicate.

2. From the File menu choose Create Synchronized Copy.

 The Create Synchronized Copy wizard appears.  If you’re working with a shared file,
ECCO will ask if you would like to create a synchronized copy for use on this
computer, a laptop computer, or another computer.  For this procedure, select
Another Computer.
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3. Supply a description for the replica, and choose the Next button (it’s a good idea to
include the date as part of this description).

4. Enter a filename for the replica or choose the browse button to locate and select and
filename. Choose the Next button.

 It’s a good idea to include rpl as part of the name: this will help you identify the file
as a replica.  Like the original file, the replica will have an .ECO extension.

5. The wizard will display the path and filename of the replica you are about to create.
Choose the Finish button to proceed.

6. Repeat steps 1 through 4 for each replica you want to create.

There are two other ways to create a replica:

• If you’re working with a shared ECCO file, choose Save As from the File menu and
save the current file under a new name.  The newly named file is the replica.

• Open a shared file and choose Let Me Create Private Columns Folders And Views.

Once the replica is created, move it to the other computer.

Note: Be sure to delete the replica from the first machine after moving or copying it to
the second machine.

To move a replica to another computer

• If you’re networked to the other computer, use Windows Explorer or File Manager to
move the replica to the other computer’s ECCO folder or directory.

• If you’re not networked to the other computer, copy the replica to a floppy disk and
take the floppy to the other computer.  Once you’ve made the copy, be sure to delete
the replica from the first computer.

Page 269



261 ECCO User’s Guide

Chapter 18.  Command Reference
Use this Command Reference to find in-depth information on the commands and options
unique to ECCO Pro.  For information on the standard Windows commands and
environment, refer to the Microsoft Windows User’s Guide.

Menu Bar Commands
The following menus appear on the menu bar of the ECCO program window.  The menus
are listed in the order in which they appear, from left to right.  Non-menu bar menus are
listed in the next section of the Command Reference, “Non-Menu Bar Commands.”
Commands that appear on menus in the Date Settings dialog box are listed in the final
section of the Command Reference, “Date Settings Commands.”

File Menu
The File menu includes the standard Windows commands for tasks such as opening new
or existing files; closing, saving, and printing files; sending mail; and quitting the
program.  It also includes powerful ECCO commands for tasks such as importing,
exporting, and sharing files and information.

File:  New

Opens a blank ECCO file based on the template DEFAULT.ECT.  To open a new file not
based on a template, hold down the CTRL key and choose New.

Note: Every ECCO file contains a Calendar, a PhoneBook, and up to 26 Notepads.

File:  Open

Displays a dialog box in which you select the ECCO file or template you want to open.
To open a new, untitled file based on an existing ECCO file, select the Untitled checkbox.
To open a file as read-only, select the Read-Only checkbox.

File:  Open Shared

Displays the Open Shared ECCO File dialog box in which you can open shared files.
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Open Shared ECCO File dialog box

File Type  Select the type of shared file that you want to view:

Main Calendar, PhoneBook, etc., of individual users  Select this option to display
a list of the primary shared files of individual users and resources in the ECCO
Workgroup Directory.

Other Shared Files  Select this option to display a list of other shared files in the
ECCO Workgroup Directory.

File Description  Displays the list of shared files in the ECCO Workgroup Directory.
If you choose Main Calendar, PhoneBook, etc., under File Type, ECCO displays the
owner’s name (based on the user’s mail identification).  If you choose Other Shared
Files, ECCO displays a list of other shared files in the ECCO Workgroup Directory.
In this case, the shared file description (entered in the File Sharing And Access
Privileges dialog box) appears in this list box.

Let me create private columns, folders, and views  Includes your private
information in the shared file.  Any private information that you add to the shared file
remains private until you make the information public.  When you choose this option,
ECCO creates a local copy of all of the information in the shared file on your hard
disk.

Workgroup   Choose the down arrow key to the right of the field to display the list
box for other connected ECCO Workgroups.

Browse Button  Choose this button to display the Browse For Shared Files dialog
box, in which you can search through the list of drives and directories that are
available to you until you find the one you want.  If you use the Browse button to
open a shared file, you are only granted default access privileges.

Details Button  Choose this button to display the Shared File Details dialog box.
This dialog provides information on a file’s ownership, access privileges by user,
paths to the Common and Master ECCO files, a list of connections to the file, and a
Manage button for removing connections no longer needed.

Report Button  Choose this button to display the Shared File Report dialog box.
You can choose to print or save the report to a file.  The information in the report is
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the same contained by using the Details button on the Open Shared ECCO File dialog
box.

File:  Close

Closes the active file.  If you have not saved changes to the file and if you have not
selected the Autosave On File Close option in the File Properties dialog box, ECCO
prompts you to save your changes before closing the file.

File:  Save

Saves all changes in all views of the active file under its current name.

File:  Save As

Displays a dialog box in which you specify the name under which you want to save the
file.  The newly saved file then becomes the active file.

File:  Send Mail

If you are running NetManage Z-Mail Pro or have an electronic-mail program supporting
VIM (such as Lotus cc:Mail) or MAPI (such as Microsoft Exchange), this command
opens the program and places the selected items and their subitems into a mail message.
Additional options are available when you choose this command from the PhoneBook.

File:  Share

Displays the File Sharing wizard, in which you can share your files with others and grant
access privileges for other ECCO users.

Using the File Sharing wizard, you can specify default privileges and grant access
privileges for users who have access to your ECCO Workgroup.  Its flexible design lets
you allow some users to only view your information while allowing other users to add,
modify, and delete information in your file.

File: Share:  Custom

If you select Custom options for sharing PhoneBook and Notepad views during the File
Sharing wizard the Access Privileges dialog box will appear during the wizard process.
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Access for  This list box contains the list of users to whom you have granted individual
user access privileges for this file.  This list box also contains a <Default Privileges> user
identification.  Users who are not granted individual access privileges have the <Default
Privileges> restrictions.  Users who open this file using the Browse button in the Open
Shared ECCO File dialog box also have the <Default Privileges> restrictions—even if
you have granted them specific access privileges.

Your main file has the following default privileges:

View Default Privilege

Calendar See Available Time for Group Scheduling

PhoneBook None

Notepads None

Other None

Other shared files have the following default privileges:

View Default Privilege

Calendar See Appts, To-Do’s, Columns, & Notes

PhoneBook See Name, Form, Columns, & Notes

Notepads See Items, Columns, & Notes (In Public Notepads)

Other None

Views and Privileges

Specify the level of access privileges for the Calendar, PhoneBook, and Notepads; and
folders, columns, and forms in each ECCO file.  The following is a list of the privilege
levels:
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Calendar

• None

 Cannot open the Calendar.

• See Available Time For Group Scheduling

 This access privilege is available only for main files.  By granting this privilege, you
allow other ECCO users who are trying to schedule a meeting with you to see when
you are available.  They will not, however, be able to see any details about specific
meetings or appointments.

Note: If you share a main file with only See Available Time for Group Scheduling
privileges, ECCO does not create a common .ECO file in the ECCO Workgroup
Directory.  Therefore, your main Calendar and PhoneBook file will not appear in
the list of Main Files for other users.  It will appear in your own list because you
have a local .ECO file.

• See Appts, To-Do’s, Columns, & Notes

 Can open the Calendar and see all shared ticklers, appointments, subitems, and
columns.  Authorized users can create their own private columns.

• Add Appointments & To-Do’s

 Can add items to any published date folder in the file, complete with ticklers, times,
or alarms.

• Add & Modify Appointments & To-Do’s

 Can add or change appointment times, item text, subitems, or date folder values of
any existing item in any published date folder in the Calendar.

• Add, Modify, & Delete Appointments & To-Do’s

 Can add or change appointment times, item text, subitems, or date folder values of
any existing item in any published date folder in the Calendar.   Can also remove any
appointment, item text, subitem, tickler, or alarm from any published date folder in
the Calendar.

• Administrative Assistant

 All privileges above, plus privileges to initiate meetings, and accept or decline
meeting invitations, on your behalf.

Note: Administrative Assistant privileges are valid in the Calendar only!  If you want
your administrative assistant to view or modify anything in any other view, folder,
or column, you must grant the appropriate level of privileges for those views.

• Owner Of File

 Choose this option to change the ownership of the entire file to the selected user.
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PhoneBook

• None

 Cannot open the PhoneBook.

• See Name, Form, & Columns

 Can open the PhoneBook and perform searches.  Can also see items in the
PhoneBook form.

• See Name, Form, Columns, & Notes

 Can open the PhoneBook, perform searches, and see subitems in the PhoneBook.
Can also see items in the PhoneBook form.

• Add PhoneBook Entries

 Can add new items to the PhoneBook using the PhoneBook form or any columns in
the PhoneBook.

• Add & Modify PhoneBook Entries

 Can add new items to the PhoneBook using the PhoneBook form or any columns in
the PhoneBook.  Can also change any item, notes or subitems in the PhoneBook,
which includes adding, removing, or modifying folder values in any standard
PhoneBook folder or in any folder shown as a column in the PhoneBook.  Users
cannot, however, remove items from the PhoneBook folder.

• Add, Modify, & Delete PhoneBook Entries

 Can add new items to the PhoneBook using the PhoneBook form or any columns in
the PhoneBook.  Can also change any item, notes or subitems in the PhoneBook,
which includes adding, removing, or modifying folder values in any standard
PhoneBook folder or in any folder shown as a column in the PhoneBook.  In
addition, users can remove items from the PhoneBook folder.

• Owner Of File

 Choose this option to change the ownership of the entire file to the selected user.

Notepads

• None

 Cannot open any Notepad.

• See Items, Columns, & Notes

 Can open any published Notepad; add private columns; expand or collapse items;
expand, collapse or resize columns.

• Add, Modify, & Delete Items And Column Values

 Can rearrange, add, and remove items, and make any changes to folder assignments
(except items that affect the PhoneBook and Calendar, unless the user has those
specific permissions for the PhoneBook and Calendar).
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• Owner Of File

 Choose this option to change the ownership of the entire file to the selected user.

Other (folders, columns, and forms)

• None

 Cannot open folder window.

• Add Items By Form

 Can use any shared form to add items to the file.  Restrictions on specific views still
apply.  This option also enables the Add By Form menu command on the Tools
menu.

• See Folder Window (Add And Remove Items)

 Can open folder window but cannot go into edit mode.  Can assign, change, and de-
assign folder values.  View-specific restrictions still apply.

• Add, Modify, & Delete Public Folders, Columns, And Forms

 Activates the Manage Notepads command on the View menu and permits editing in
the folder window.  When you grant this privilege to another user, you also make
your Calendar and PhoneBook information accessible.  When you grant this privilege
level, your Calendar, PhoneBook, and Notepads will be automatically updated to
reflect the appropriate access privileges.

• Owner Of File

 Choose this option to change the ownership of the entire file to the selected user.

Add  Opens the Choose Users, Groups, And Resources dialog box.  Use this command to
append users to the Access Privileges list box.

Remove  Use this command to remove users from the access privileges list.  When you
remove a user from the list, all individual privileges are canceled.  The user will,
however, retain the level of privileges you have granted to the <Default Privileges> user
identification.

File:  Create Synchronized Copy

Displays the Create Synchronized Copy wizard, in which you specify the computer(s) you
will be using while working off-line.  The wizard will take you step-by-step through
setting up a synchronized copy of your file for use at home, on a laptop, or another
computer.

File:  Synchronize

Displays a menu from which you can set up a duplicate ECCO file (replica) for use on
another computer, import changes from and export changes to your duplicate file, modify
your setup, and synchronize remote files automatically.
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File: Synchronize:   Export Changes

Displays the Export Changes wizard, in which you select the remote file to synchronize
with the ECCO file currently open.  The wizard takes you step-by-step through the export
process, including selecting making the transfer by disk or electronic mail, or specifying
automatic export by choosing the Advanced button.

File: Synchronize:   Export Changes:  Advanced

The Advanced button on the Export Changes wizard provided you with additional
customization options.

Send changes to master file using  Specifies whether to send the merge file (the file
containing the changes) by means of disk or mail.  If you send the file by means of mail,
ECCO will automatically import those changes without using the Import Changes
command.

Disk file  Creates a merge file that you can later copy to your remote computer.
Choose the Browse button to specify a filename with a path.

Mail to   ECCO sends a mail message with the merge file attached.  Choose the
Address button to select the recipient of the file.

Send automatically using mail message  ECCO periodically sends a merge file
using mail.  Choose Address to specify the recipient of the file.  Specify the days and
times you want the messages sent.

Always use Advanced mode dialog  Specifies whether to use this Advanced dialog box
in place of the wizard when you select Export Changes.

File: Synchronize:   Import Changes

Displays the Export Changes wizard, which takes you step-by-step through the import
process to synchronize with the ECCO file currently open.  The wizard includes selecting
making the transfer by disk or electronic mail.
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File: Synchronize:   Remote Access Sync

Displays the Remote Access Synchronization dialog box.  Use this dialog box to locate
your master file if you are connected to the network through a remote access program.
You can also use this command to synchronize your ECCO file in a peer-to-peer network
environment

File:  Create Meeting Resource

Displays the Create Meeting Resource dialog box, in which you can create a shared
meeting resource.  Meeting resources can include facilities and equipment, such as a
conference room, audio-visual equipment, and so forth.

Resource Name  Displays the currently selected resource.  Use the Choose button to
display the Choose Users, Groups, and Resources dialog box and to select the name of a
mail account created for a resource (for example, Conference Room).

Administrator  for this resource  Select a user who will be responsible for maintaining the
Calendar for the new resource.  Displays the currently selected administrator.  Use the
Choose button to display the Choose Users, Groups, and Resources dialog box in which
you can select another administrator.

Schedule resource automatically if available  Select this option if you want other
ECCO users to schedule this meeting resource when it is available.

Send scheduling requests to an administrator  Select this option to control scheduling
of the new resource.  When you select this option, other users can “invite” the resource
but cannot reserve it.  The administrator is responsible for reserving the resource, and
must accept or decline the meeting request message on behalf of the resource.

File:   Workgroup Settings

Displays the Workgroup Settings wizard, which takes you step-by-step through the
connecting to an ECCO Workgroup Directory process.  The wizard includes selecting a
mail client, setup for connecting to ECCO TCP/IP scheduling servers, and specifying the
path to the ECCO Workgroup Directory.
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File: Properties

Displays the File Properties property sheet.  There four tabs on this display – Connection
Status, Display, Backups, and Password.

Connection Status tab

Current local file Displays the filename of the local file you are currently
using.

Connected to master file Displays the filename of the master file to which you
are currently connected.

Owner name Displays the owner of the file.

Admin name Displays the Administrative Assistant of the file.

User name Displays the current user name.

Connection name Displays the connection name.  The Connection name
is usually a user name unless you are connected to a
replica synchronized file, in which case the replica file
description appears.

Work Offline/Online button Disconnects you from or reconnects you to the master
file.

Review connections button Choose this button to review connections to other local
files to disconnect ECCO files that are no longer active
from the master file.  This button is available only is
you are the owner of a shared file.

Disconnect button Choose this button to disconnect from the master file,
maintaining a copy of all public information in your
local ECCO file.

Apply button Becomes active when changes are made to the property
sheet.  Changes are implemented, but the property sheet
remains open.
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Display tab

Show View Tabs for Select which view tabs are displayed –
Calendar, PhoneBook, and Notepads.

Color Preferences button Displays the Color Preferences dialog box,
in which you can select different colors for
ECCO views.

Apply button Becomes active when changes are made to
the property sheet.  Changes are
implemented, but the property sheet
remains open.

Backups tab

Local Backup Select whether to keep rotating backup
copies (up to nine) of your current ECCO
file.  Each time you save your file, ECCO
creates a new backup copy using the same
filename, but with an extension such as
.BK1, .BK2, and so forth.  The most recent
backup will have the extension .BK1.  This
option is file specific.
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Network Backup Select to backup your file automatically
across a network.

Apply button Becomes active when changes are made to
the property sheet.  Changes are
implemented, but the property sheet
remains open.

Password tab

Old Password Enter the old password for your file.  If a password has
not been specified previously, leave this field blank.
For maximum security, ECCO does not display the
characters as you type.  An asterisk (*) appears for each
character.

New Password Enter the new password for your file.

Confirm Password Enter the news password again for verification.

Apply button Becomes active when changes are made to the property
sheet.  Changes are implemented, but the property sheet
remains open.

File:   Database

Displays the commands for ECCO database functions, including importing and exporting
data, achieving, compacting, testing, data recovery, and checking your group scheduling
availability with the ECCO Workgroup Directory.

File:   Database:  Import

Displays the File Import dialog box, in which you can specify a file to import into the
active PhoneBook or Notepad.  Before choosing Import from the File menu, switch to the
view to which you want to import.
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Note: Although you cannot use the Import command to import data into the Calendar,
you can convert Calendar data from other programs.  For more information, see
the chapter or online help on “Importing and Exporting.”

You can import files in either of two formats: TXT (text) or CSV (comma-separated
values).

File Name  Type here, or select from the list, the name of the file you want to import.

Files of Type  Select the type of file you want to import.

Directories   Select a different directory if the file you want to import is not in the
current directory.

Look in Select from the list a different drive if the file you want to import is not on the
current drive.

After you choose Open in the File Import dialog box, one of the dialog boxes listed below
may appear, depending upon the active view and whether you choose to import columns.

Active view Dialog box

PhoneBook Choose Fields For Import Into PhoneBook

Notepad Import Into Current View

Notepad Choose Columns For Import Fields
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Choose Fields for Import into PhoneBook dialog box

Field Name  Displays a list of all field names in the file you are importing.

Destination  For each field, displays the destination.

Choose a Destination  Choose from this list a destination for the selected field.  If you do
not want ECCO to import the selected field, choose <Ignore>.  To create a new column to
import to, select a field name surrounded by angle brackets.

Sample buttons  Move through the file you are importing, one record at a time.

Rename New Field  If you are creating a new column to import to, type a name for it
here.

Ignore Mail Merge Header  This will cause the first record of the import file not to be
added.  This is useful if the first record contains only the header information for the data
being imported..

Import into Current View dialog box

Insert imported items  Specify where in your outline you want to insert the imported
information.

At bottom of notepad  Places the imported information at the bottom of the Notepad.
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After currently selected item  Places the imported information after and at the same
level as, or after and subordinate to, the selected item in the active view.

Import file has columnar data  Specifies that the import file has data that you want to
import into columns.

Create new columns using mail merge header  Creates new columns based on names in
the file’s first record.

Use existing columns if matching names found  Imports to existing columns if names in
the first record match existing column names.

Choose column for each field  Choose a destination column for each field.

Choose button  Displays the Choose Columns For Import Fields dialog box, in which
you can choose the columns you want to import to.

Choose Columns for Import Fields dialog box

Import Field   Displays a list of all field names or sample fields in the file you are
importing.

Destination Column  For each field, displays the destination column.

Choose a Column  Choose from this list a destination column for the selected field.  If
you do not want ECCO to import the selected field, choose <Ignore>.  To create a new
column to import to, select a field name surrounded by angle brackets.

If you choose a <New Date Field>, imported items will be shown by default in the
Calendar on the dates imported into that column.  To override this, choose the Properties
command from the Column menu after importing, and then choose Defaults and deselect
Show Item In Calendar’s Tickler Section.

Sample buttons  Move through the file you are importing one field at a time.

Rename Column  If you are creating a new column to import to, type a name for it here.
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File:   Database:  Export

Displays a dialog box specific to the active view.

You cannot export from the Calendar.

Active View Dialog Box

PhoneBook Export PhoneBook

Notepad Export Notepad

Export PhoneBook dialog box

Items To Export  Specify whether you want to export the entire PhoneBook, items
currently displayed in the view, or the selected items only.

Format  Displays format options that allow you to export information for use in word-
processing, spreadsheet, database, and other programs.

Mail Merge Header  Exports field names as the first line in the exported file.

DOS Text  Exports the file as a DOS text file.

Choose Field Set  Select from the list a field set, or select <Create Set> to display the
Choose Field Set dialog box in which you can choose a set of fields to export.

Fields Chosen  Displays the columns that will be exported.

Remove Field button  Removes a field from the Fields Chosen list.  As a result the field
column will not be exported.

Delete Set button  Deletes a field set from the Choose Field Set list.

Export to file   Type here the name of the file that will contain the exported information.

Browse button  Displays the File Export dialog box, in which you can specify an existing
file to export to.
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Choose Field Set dialog box

Choose Fields  Displays a list of the fields in the PhoneBook.

Add button  Adds the selected field in the Choose Fields list to the Fields Chosen list.

Fields Chosen  Displays the list of fields you have chosen to export.

Remove Field button  Removes the selected field from the Fields Chosen list.

Add Field Set to Menu  Adds the field set to the Choose Field Set list in the Export
PhoneBook dialog box.

Name  Type here a name for your field set.

Export Notepad dialog box

Items To Export  Specify whether you want to export all the items in the Notepad, the
selected items only, or the selected items and their subitems.

Format  Displays several format options that allow you to export information for use in
word-processing, spreadsheet, database, and other programs.

Columns button  Displays the Export Notepad And Columns dialog box, in which you
can specify which columns you want to export.

DOS  Exports the file as a DOS text file.

Export to file   Type here the name of the file to which you want to export.

Browse button  Displays the File Export dialog box, in which you can specify an existing
file to export to.
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Export Notepad and Columns dialog box

Items To Export  Specify whether you want to export all items in the Notepad, the
selected items only, or the selected items and their subitems.

Format  Displays format options that allow you to export information for use in word-
processing, spreadsheet, database, and other programs.

Mail Merge Header  Exports field names as the first line in the exported file.

DOS Text  Exports the file as a DOS text file.

Export to file   Type here the name of the file to which you want to export.

Browse button  Displays the File Export dialog box, in which you can specify an existing
file to export to.

Choose Column Set  Select from the list a column set, or select <Create Set> to display
the Choose Column Set dialog box, in which you can choose a set of columns to export
and create a named columns set.

Columns Chosen  Displays a list of the columns in the chosen column set.  As a result,
the field column will not be exported.

Remove Col. button  Removes the selected column from the Columns Chosen list.

Delete Set button  Deletes a field set from the Choose Field Set list.

Choose Column Set dialog box

Choose Columns  Displays a list of the columns in the active view.

Add button  Adds the selected column in the Choose Columns list to the Columns
Chosen list.
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Columns Chosen  Displays the list of columns you have chosen to export

Remove Col.  Removes the selected column from the Columns Chosen list.

Add Column Set to Menu  Adds the column set to the Choose Column Set list in the
Export Notepad And Columns dialog box.

Name  Type here a name for your column set.

File:   Database:  Archive

Save all appointments and ticklers before the date you specify to a separate ECCO file.

Archive Appointments and Ticklers dialog box

Archive items before  All appointments and ticklers occurring before the selected dated
will be archived.

To file  Type in a filename for the ECCO archive file, or choose the Browse button to
open the Save As dialog box.

Delete after archiving  Select to delete appointments and ticklers after they have been
saved to the archive file.

File:   Database:  Compact

This process removes unused space from your ECCO file to reduce the file size.  This
feature is most effective after you have deleted a large amount of information from your
file.

File:   Database:  Test

This process checks your file for data consistency.  If an error is found, the recovery
option will be displayed.  If Recovery is unable to resolve the problem, you should begin
using one of your backup files which passes this test.

File:   Database:  Recover

This process will recover data from an ECCO file that has been damaged.  It may not be
possible to recover all of the data.  You can choose between recovering the active open
file or a file saved to disk.
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File:   Database:  Test Availability

This process verifies the group scheduling availability information in your local file
against the information contained in the ECCO Workgroup Directory database.  This
scheduling availability information is used by other users for checking your availability. If
an error if found, you will be presented with an option to refresh to ECCO Workgroup
Directory database.

File:  Print

Displays a dialog box specific to the active view.  For more information about printing,
see the chapter or online help on “Printing.”

Active View Dialog Box

Calendar Print Calendar

PhoneBook Print PhoneBook

Notepad Print Notepad

If you choose the Setup button in any of these dialog boxes, the Page Setup dialog box
appears, in which you can specify page size, print areas, margins, page orientation, and
create a new named page setup from the settings.

Print Calendar View dialog

Catalog of Print Settings  Select an existing print catalog.

Page Setup  Select a page setup.  Choose the Setup button to display the Page Setup
dialog box, in which you can select page setup options and create a new named page
setup.

Format  Specify a daily, weekly, or monthly format, or specify whether you want to print
only the selected items and their subitems.

Date Range  Specify the range of dates you want to print.

Sections  Select whether you want to print appointments, tickler items, or both.
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Preview button  Displays the Print Preview window, in which you can see how your
document will look when printed.

Header/Footer button  Displays the Header And Footer dialog box, in which you
specify the font and title text you want in the header and footer of your printed document
and whether to print page numbers and the current date in the footer.

Font button  Displays the Item Text Fonts dialog box, which lets you print using the font
and font size in the current view or allows you to specify a custom font and font size.

Notes/Columns button  Displays the Appointment Notes And Columns dialog box.

Appointment Notes and Columns dialog box

Copies  Specify the number of copies you want to print, whether to use two-sided printing
(both sides of the page), and whether to print pages in reverse order.

2-Sided Printing Specifies that the printout will be to both sides of the paper.

Reverse Order Specifies that the printer should print starting with the last page first and
continue backwards to the first page.

Multiple Copies on a Page Specifies that a page break should not be sent to the printer
between each copy.

Outline Notes and Columns dialog box
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Format  Specify whether you want to print your Calendar with or without outline notes
and columns:

Summary Pages: No Outline Notes or Columns  Prints time slots, appointments,
and tickler items for the selected day or week; or prints a grid for the selected month.
Does not print outline notes, subitems or information in columns.

Detail Pages with Outline Notes (Skip Empty Slots)  Choose this option to make
the following options available.

Outline Notes  Specify to what level of subitems you want to print (levels 1 through 9),
whether to skip hidden subitems in a collapsed outline, and whether to print item bullets
and folder icons.

Columns  Specify column printing options:

Print Columns  Select to print columns and make the following options available.

Skip Minimized Columns  Does not print minimized columns.  You can minimize a
column by double-clicking its column heading.

Custom Columns  Select to print specific columns.  Choose the Columns button to
display the Custom Columns dialog box in which you can select the specific columns
you want to print, specify their order, and set the size of each column.

No. of Cols on 1st Page  Specify the number of columns you want printed on the
first page.

Maximum Item Text Width  Specify the maximum width measurement for your
items’ text.

2-Sided Printing Specifies that the printout will be to both sides of the paper.

Reverse Order Specifies that the printer should print starting with the last page first
and continue backwards to the first page.

Multiple Copies on a Page Specifies that a page break should not be sent to the
printer between each copy.
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Print PhoneBook View dialog box

Catalog of Print Settings  Select an existing print catalog.

Page Setup  Select a page setup.  Choose the Setup button to display the Page Setup
dialog box, in which you can select page setup options and create a new named page
setup.

Range  Print the entire PhoneBook, all items in the current view, or selected item(s) only.

Format  Select a format for printing a combination of names, companies, addresses,
phone numbers, columns, outline notes, PhoneBook forms, or envelopes, and specify
whether to sort items by name or by company.

Preview button  Displays the Print Preview window, in which you can see how your
document will look when printed.

Header/Footer button  Displays the Header And Footer dialog box, in which you
specify the font and title text you want in the header and footer of your printed document
and specify whether to print page numbers and the current date in the footer.

Font button  Displays the Item Text Fonts dialog box, which lets you print using the font
and font size in the current view or specify a custom font and font size.

Options button  Displays the PhoneBook Options dialog box.

Copies  Specify the number of copies you want to print, whether to use two-sided printing
(both sides of the page), and whether to print pages in reverse order.

2-Sided Printing Specifies that the printout will be to both sides of the paper.

Reverse Order Specifies that the printer should print starting with the last page first and
continue backwards to the first page.

Multiple Copies on a Page Specifies that a page break should not be sent to the printer
between each copy.
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PhoneBook Options dialog box

Format  Specify whether you want to print your PhoneBook with a new page at the start
of every alphabet letter, whether to switch the order of first and last names, and if both the
home and business addresses are to be printed.

Outline Notes  Specify to what level of subitems you want to print (levels 1 through 9),
whether to skip hidden subitems in a collapsed outline, and whether to print item bullets
and folder icons.

Print Notepad dialog box

Catalog of Print Settings  Select an existing print catalog.

Page Setup  Select a page setup.  Choose the Setup button to display the Page Setup
dialog box, in which you can select page setup options and create a new named page
setup.

Range  Print all items in the view or selected item(s) only.

Item Options  Specify to what level of subitems you want to print (levels 1 through 9),
whether to skip hidden subitems in a collapsed outline, and whether to print item bullets
and folder icons.

Columns  Specify column printing parameters:

Print Columns  Prints columns.

Skip Minimized Columns  Does not print minimized columns.  You can minimize a
column by double-clicking its heading.
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Custom Columns  Select to print specific columns.  Choose the Columns button to
display the Custom Columns dialog box in which you can select the columns you
want to print, specify their order, and set the size of each column.

No. of Cols. on 1st Page  Specifies the number of columns you want printed on the
first page.

Maximum Item Text Width  Specify the maximum width measurement for your
items’ text.

Preview button  Displays the Print Preview window, in which you can see how your
document will look when printed.

Header/Footer button  Displays the Header and Footer dialog box, in which you specify
the font and title text you want in the header and footer of your printed document and
specify whether to print page numbers and the current date in the footer.

Font button  Displays the Item Text Fonts dialog box, which lets you print using the font
and font size in the current view or specify a custom font and font size.

Copies  Specify the number of copies you want to print, whether to use two-sided
printing, and whether to print pages in reverse order.

2-Sided Printing Specifies that the printout will be to both sides of the paper.

Reverse Order Specifies that the printer should print starting with the last page first and
continue backwards to the first page.

Multiple Copies on a Page Specifies that a page break should not be sent to the printer
between each copy.

Custom Columns dialog box

Choose Columns  Displays a list of the columns in the active view.

Columns Chosen  Displays the list of columns you have chosen to print.

Add button  Adds the selected column in the Choose Columns list to the Columns
Chosen list.

Remove button  Removes the selected column from the Columns Chosen list.
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Col. Size  Specify the size (number of characters) of each column you print.

Reorder buttons  Changes the order in which the selected columns will be printed.

Page Setup dialog box

Name  Displays the name of the current page setup.

Test button  Prints one page of sample data in the selected format.

Edit Settings For  Select the type of page settings you want to change:

Page size  Select the paper size, width, height, and orientation (portrait or landscape).
Choose the Printer button to display the Print Setup dialog box, in which you can
select a printer and specify printer options.

Change the following settings by typing numbers in text boxes or by dragging the
yellow rectangles in the example in the dialog box.

Page margins  Specify top, bottom, left, and right margins for the entire page.

Print areas  Specify number of columns across and down, the space between
columns and rows, and specify whether you want to cut sheets.

Internal margins   Specify top, bottom, left, and right margins for the individual
print areas.

Envelope address positions  Specify how far return addresses are offset from the
upper-left corner of each print area.

Paper  Specify the paper you are printing to.

Size  Specify the size of the paper.

Width   Specify the width of the paper.

Height  Specify the height of the paper.

Orientation   Specify whether your printing orientation is portrait or landscape.
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Enable envelope addresses  Specifies that the paper information entered is for
envelope printing (and provides margin setups for return and address areas).

Printer  Select the printer to use.

When you choose the OK button, ECCO asks you if you’d like to save your settings by a
creating a named page setup.  To use these pages settings again, choose the Yes button
and give the page setup a name.

File:  Print Catalog

Creates a print catalog (a named set of selected printer options), manages an existing print
catalog, or prints the current view using the selected saved print catalog.

Print Catalog:  New

Opens the New Print Catalog dialog box specific to the active view, which contains the
same print settings options as the Print dialog box for the active view.  Select the settings
you want, and name the new print catalog to add it to the Print Catalog menu.

Print Catalog:  Manage

Displays the Manage Print Catalog Entries dialog box, in which you rename or delete
existing print catalogs or reorder them on the menu.

Manage Print Catalog Entries dialog box

Rename  Type here the new name you want to give the selected print catalog.

Edit button   Edit the selected print catalog.

Delete button  Deletes the selected print catalog.

Reorder buttons  Move the selected print catalog(s) up or down one row at a time on the
Print Catalogs menu.

Print Catalog:   <Print Catalogs>

Lists the available print catalogs.  Choosing a print catalog prints the active view using
the print settings of the selected catalog.
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File:  Printer Setup

Displays the Choose ECCO Default Printer dialog box, in which you can select a printer
and specify printer options.

File:  Manage Page Setups

Displays the Manage Page Setups dialog box, in which you rename or delete existing
page setups or reorder them on the menu.

Manage Page Setups dialog box

Rename  Type here the new name you want to give the selected page setup.

Delete button  Deletes the selected page setup.

Reorder buttons  Move the selected page setup(s) up or down one row at a time in the
list in the Print Notepad dialog box, the Print Calendar View dialog box, and the Print
PhoneBook View dialog box.

File:  <Recently Opened Files>

Lists the last four opened files.  Choose a filename to reopen the file.

File:  Exit

Quits the ECCO program.  If you have selected the Autosave On File Close option in the
ECCO Preferences dialog box, ECCO automatically saves any changes to the file;
otherwise, ECCO prompts you to save any changes before quitting the program.

Edit Menu
This menu includes commands for tasks such as editing text, finding and replacing text,
and creating links and embedded objects.

Edit:  Undo

Undoes the previous editing or formatting action.
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Edit:  Cut

In general, this command cuts the selected information from the active view and copies it
onto the Clipboard, from where it can be pasted into another location.

Cutting items or sub-items  Cuts the items from an ECCO file if the items and all of
their subitems have been added to only one folder.

Displays the Cut Items dialog box if the item or any of its subitems exist in more than one
view.  Selecting the From Folder: <folder name> option deletes the item and its subitems
from the selected folder, but the items remain in all other folders to which they have been
added.  Does not copy the cut items onto the Clipboard.  Selecting the Cut Entirely From
File (All Views) option deletes the item and its subitems from all views in your ECCO file
and places them on the Clipboard.

Cutting folders from a Notepad  Cuts the selected folders from the active view only.
Does not place the cut folders onto the Clipboard; the Paste command is not available.
Does not remove folders from the folder window or any other view.

Cutting folders from the Folder window  Cuts the selected folders and their subfolders
from all views in your ECCO file.  You can’t cut any of the default folders, such as
PhoneBook and Appointments.

If the deleted folder was the only folder in a Notepad, ECCO creates a new untitled
folder.

To cut folders in the folder window, you must have already chosen Edit Folders from the
Folder menu.

Edit:  Copy

Copies the selected information onto the Clipboard.

Edit:  Paste

Pastes the contents of the Clipboard into the location you specify with the insertion point.

Edit:  Paste Special

Pastes the contents of the Clipboard as an OLE link or as an embedded OLE object into
the location you specify with the insertion point.

Edit:  Delete Items

In general, choosing this command deletes the selected items from the active view without
copying them onto the Clipboard.

Items or subitems are deleted from ECCO if the items and all of their subitems have been
added to only one folder.
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The Delete Items dialog box appears if the items or any of their subitems have been added
to more than one folder.  Selecting the Delete Entirely From File (all Views) option
deletes the item and its subitems from all views in your ECCO file.

Edit:  Remove Folders

Removes the selected folders from the active Notepad or Calendar without copying them
onto the Clipboard.  This command does not remove any items from the folders.  It also
does not remove the folders from any other view or from the folder window.

Edit:  Find

Allows you to find information in the active view or gather information from an entire file
into a Search Results view.  When you first open it, the Find dialog box is displayed in a
collapsed state.

To display the entire Find dialog box, click the Unfold button (>>).  (If you opened this
dialog box by choosing the Find Folder command, the Unfold button and other options
are not available.)

Find dialog box

Find box  Type here the text you want to find.

Drop-down arrow button   Displays a list of your previous search requests.  This list is
saved with the file and is available from session to session.

Unfold (>>) button   Expands and hides the Find dialog box.

Find button  Begins the search.  Depending on the search parameters, this button might
be labeled Collect All .

Scope  Specify the current view or the entire file as the scope of your search:

Current View   Limits the search to the active view.  In the Calendar, this option
changes to Future Dates, and limits the search to Calendar items from the currently
selected day and all future dates.
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Entire File  Includes in the search all items in the file.

Match  Specify whether to search for the text within items, within columns, or both.

Find Items Matching Filter  Find only those items with criteria that match the specified
filter.  You can search for items matching filters without typing text in the Find box.
Select a named filter, or select Custom to display the Use Custom Filter dialog box, in
which you can specify parameters for your filter.  For more information, see the chapter
or online help on “Other ECCO Features.”

Actions  Specify whether you want to find the next instance of the specified item, select
all instances, or copy the found items to the Search Results notepad:

Find Next  Finds the next instance of the specified item.

Select All in View  Selects all the items in the active view that meet the search
criteria.

Copy to Search Results view  Copies the found items to the Search Results notepad.
Specify whether you want ECCO to replace all the found items in the Search Results
notepad with the newly found items or append the newly found items to the contents
of the Search Results notepad.

Edit:  Find/Replace

Displays the Find and Replace dialog box, in which you can specify the text you want to
find and the text with which you want to replace it.

Find and Replace dialog box

Find box  Type here the text you want to find.

Drop-down arrow button   Displays a list of your previous search text.  This list is saved
with the file and is available from session to session.

Find button  Begins the search.  Depending on the search parameters, this button might
be labeled Collect All .

Replace box  Type here the text with which you want to replace the found text.  If you
leave this box empty, ECCO will delete all instances of the found text when you choose
the Replace button.
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Replace button  Replaces the current instance of the found text with the text you
specified.

Repl All button   Replaces all instances of the found text with the text you specified.

Scope  Specify the scope of your search:

Current View   Limits the search to the active view.

Entire File  Includes in the search all items in the file.  When you choose this option,
the Find button changes to the Collect All button and makes the Replace and Repl All
buttons unavailable.  All found items will be displayed in the Search Results notepad.

Match  Specify whether to search for the text within items, within column values, or both.

Find Items Matching Filter   Find only those items with criteria that match the specified
filter.  You can search for items matching filters without typing text in the Find box.
Select a named filter or select Custom to display the Use Custom Filter dialog box, in
which you can specify parameters for your filter.

Edit:  Find Next

Finds the next instance of the text you most recently searched for.

Edit:  Go To Pane

Switches you to different panes in the active window.

Left <-> Right  Opens the column pane or switches you to or from the column pane.

Top <-> Bottom  In a Notepad, this command splits the active window or switches you
between top and bottom panes of the window.  In the Calendar, this command switches
you between the Appointment section and the Tickler section.  In the PhoneBook, this
command switches you between the PhoneBook list and the PhoneBook entry form.

Edit:  Insert

Displays a menu in which you can specify the line, tab, or object you want to insert.

Edit:  Insert Date Stamp

Inserts date and time at the insertion point when you are editing an item.

Edit:   New Line

Begins a new line at the insertion point when you are editing an item.

Edit: Insert:   Tab

Inserts a tab at the insertion point when you are editing an item.
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Edit: Insert:   Object

Inserts an object into your ECCO file, such as a Paintbrush Picture or WordPad
Document.

Edit: Links

Displays the Links dialog box, in which you can specify options that let you change or
update existing OLE links in your file.  You create OLE links by sending information to
ECCO using the Shooter.

Link list   Lists the links in the active file.

Update Now button  Updates the selected link.

Change Link button  Displays the Change Link dialog box, in which you can choose a
file for a new link.

Update Options  Lets you specify whether the links are updated automatically or by you
on a case-by-case basis.

Edit:  Objects

Lets you modify the selected OLE object’s size or open the program in which the object
was originally created and make changes to the object, without leaving ECCO.  When an
object is selected, the command name changes to reflect the name of the program with
which the object was created and indicates whether or not the object is linked.

Edit: Objects:  Minimize

Reduces the selected object to a minimized size.
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Edit: Objects:  Adjusted Size

If the selected object is minimized or is in its original size, returns the object to its
previous resized state.

Edit: Objects:  Original Size

If the selected object has been minimized or resized, returns it to the size it was when you
first embedded it.

Edit: Objects:  Edit

Opens the program in which the selected embedded or linked object was created so you
can edit it.

Edit: Objects:  <Other>

Displays other options provided by the program used to create the OLE object.

View Menu
Commands on the View menu allow you to work with all the ECCO views, including
adding or removing views from the current window and making the active view public,
and reading meeting mail.

You also use this menu to display the folder window and choose folders to display in the
current Notepad.

View:  Calendar

Makes the Calendar the active view.

View:  PhoneBook

Makes the PhoneBook the active view.

View:  Notepads

Creates new Notepads, manages existing Notepads, or makes an existing Notepad the
active view.

View: Notepads:  New Notepad

Displays the Create A New Notepad View dialog box, in which you can create and name
a new Notepad.
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Create Notepad dialog box

Name  Type here a name for your view.

Options button  Displays the Create Notepad Options dialog box, in which you can
select folders to include in your Notepad.

View: Notepads:  Manage

Displays the Manage Named Notepads dialog box, in which you can rename or delete
existing Notepads or reorder them on the menu.

Manage Named Notepads dialog box

Rename  Type here the new name you want to give the selected view.

Delete button  Deletes the selected Notepad.

Reorder buttons  Move the selected Notepad(s) up or down one row at a time on the
Notepad menu.

View: Notepads:  <Notepad Views>

Displays a list of Notepads.  Choosing a Notepad switches you to that view and makes it
the active view.

View:  Meeting Mail

Opens the meeting message window, which displays a list of the electronic mail messages
associated with scheduled meetings.  The meeting message window can be opened or
closed in any ECCO view.

Read Mail button  Choose this button to open the select meeting mail message.
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Discard Mail button   Choose this button to discard without opening the selected meeting
message.

Find Meeting button  Choose this button to move the Calendar view to the day of the
meeting being requested.

View:  Folder Window

Displays and hides the folder window.

View:  Add View To Window

Displays a list of all views in the ECCO file, from which you can select a view to add to
the current window.  A window can contain up to four views.  Any items, columns, or
folders you add to a view in one window are reflected in any other instances of that view
in other windows.

View:  Remove View From Window

Removes the selected view from the current window.  You cannot remove the view that
has the same name as the window.

View:  Choose Notepad Folders

Displays the Choose Notepad Folders dialog box, in which you choose the folders whose
items you want to display in the active Notepad.  For more information, see the chapter or
online help on “Folders.”

Choose Notepad Folders dialog box

Choose folders to view in notepad  Choose one or more folders from the folder window
by clicking a folder button or name.

Folders in notepad  Displays the list of folders whose items will be displayed in the
Notepad.

Remove button  Removes the selected folder from the view.

View:  Make View Public

Displays a confirmation dialog box, in which you can make the current view public.
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This command is valid only if you’ve previously shared the file by choosing the Share
This File subcommand from the Network command on the File menu.

Item Menu
With commands on the Item menu, you can insert, move, and display items in various
ways, mark items as done, show an item’s column or folder values, and make items
private.

Item:  Add Item

Inserts a new item below the selected item.

In the folder window, choosing Add Item inserts a new, untitled folder after the selected
folder.

Item:  Add Item Right

Inserts a new subitem below and to the right of the currently selected item.

In the folder window, choosing this command inserts a new, untitled subfolder below and
to the right of the selected folder.

Item:  Add Item Left

Inserts a new item below and to the left of the currently selected item.

In the folder window, choosing Add Item Left inserts a new, untitled folder below and to
the left of the selected folder.

Item:  Split Item

Cuts the item text to the right of the insertion point, creates a new item at the same level,
and pastes the cut text into the new item.

Item:  Join Items

Merges the selected items into a single item. The merged item retains the folder values of
only the first selected item.

Item:  Show Item Info

Displays the Show Item Info dialog box, in which you can view all columns or folders to
which the selected item has been added, edit the values associated with the item, or delete
the item.
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Show Item Info dialog box

Item Text  Displays the text of the selected item.

Folders and column values of item above  Displays a list of the columns or folders
associated with the selected form.  Click to the right of each column or folder name to
create or change the value to be associated with the item.

Prev and Next buttons  Let you move through the items in the active view while you are
in the dialog box.  You can move up or down the outline at the same level, or move from
one level to another.

Delete Item button  Removes the selected item from all views.

Clear Value button  Removes the item from the selected folder or column.

Item:  Show Levels

Displays the Show Levels dialog box, in which you can hide and expand your outline
level by level by clicking the level number buttons.

Show Levels dialog box

All   Select this option to affect your entire outline.

Selected  Select this option to affect only the selected items and their subitems.

Unselected Only  Select this option to affect your entire outline with the exception of the
selected items.  This is useful if you want to collapse every item other than the selected
items (to see the context of the selected items more clearly).

Item:  Show Sub-Items

Displays or hides subitems of the selected items.
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Item: Show Sub-Items:  Hide

Hides all subitems of all selected items.  This command is available when selected items
are expanded.

Item: Show Sub-Items:  Expand

Displays all subitems that were displayed before the items were last hidden.  This
command is available when selected items are collapsed.

Item: Show Sub-Items:   All Subs

Displays all subitems of all selected items.

Item: Show Sub-Items:  1 Level Only

Displays one level of subitems below each of the selected items.

Item:  Move Items

Moves the selected items up, down, left, or right.

Item:  Move Items:  Up

Moves the selected items and their subitems up one position, but does not change their
outline level.

Item: Move Items:  Down

Moves the selected items and their subitems down one position but does not change their
outline level.

Item: Move Items:  Left

Moves the selected items and their subitems left (promotes them) one level.

Item: Move Items:  Right

Moves the selected items and their subitems right (demotes them) one level.

Item:  Mark As Done

Marks the selected items or subitems as done.  You can specify that To-Do’s and other
tickler items remain shown in the Calendar until they are marked done.  Choosing this
command removes such items from the Calendar, even if the command is applied to the
item within another view.  Marking an item as done also adds it to the Done folder.  Most
templates have a Completed Work notepad where items will appear when they have been
marked as done.
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Item:  Make Item Private

Makes the selected items and their subitems private or reverses that action.  You can
choose this command for items even if they have not been shared.  When the view
containing those items is made public, the items will remain private.

Format Menu
Commands on the Format menu let you format the text of items and outline levels and
specify the type of outline labels you want to use.

Format:  Character

Displays the Character dialog box, in which you can specify character formats or apply an
outline style to previously formatted text.

Character dialog box

Font  Displays the selected text in the font you specify.

Size  Displays the selected text in the point size you specify.

Color  Displays the selected text in the color you specify.

Style  Displays the selected text in the style you specify.  You can select more than one
attribute at a time.

Example  Displays text with the attributes you’ve specified.

Apply button   Applies the specified attributes to the selected text.  If you hold down the
CTRL key while you choose this button, ECCO applies the specified attributes to the
outline style for the levels of the selected items.

Reapply button  Reapplies the outline style associated with the outline level of the
selected text, removing any character formatting you’ve applied.

Format:  Font

Formats the selected text in the font you specify (such as Arial or Times New Roman).
Choose More to display more fonts.

Page 309



301 ECCO User’s Guide

Format:  Size

Formats the selected text in the point size you specify.

Format:  Style

Formats the selected text in the style you specify (plain, bold, italic, underline,
superscript, and subscript).

Format:  Color

Formats the selected text in the color you specify.

Format:  Text Touch-Ups

Displays a menu that allows you to create, edit, or apply a text touch-up, which is a
custom set of character attributes (font, size, color, and style).  Text touch-up styles
override outline styles.

Format: Text Touch-Ups:  New

Displays the New Named Text Touch-Up dialog box, in which you can create a custom
set of character attributes for the selected text.

New Named Text Touch-Up dialog box

Name  Type here a name for your text touch-up.

Font  Displays the selected text in the font you specify.

Size  Displays the selected text in the point size you specify.

Color  Displays the selected text in the color you specify.

Style  Displays the selected text in the style(s) you specify (plain, underline, bold, italic,
superscript, and subscript).

Example  Displays text with the attributes you’ve specified.

Apply button   Applies the specified text touch-up to the selected text.
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Format: Text Touch-Ups:   Manage

Displays the Manage Text Touch-Ups dialog box, in which you can create a new text
touch-up, rename or edit an existing text touch-up, delete a text touch-up, or reorder the
list of text touch-ups .

Manage Text Touch-Ups dialog box

Rename  Type here the new name you want to give the text touch-up.

New button  Displays the New Named Text Touch-Up dialog box.

Edit button   Displays the Edit Named Text Touch-Up dialog box (identical to the New
Named Text Touch-Up dialog box), in which you can modify an existing touch-up.

Delete button  Deletes the selected text touch-up.

Reorder buttons  Move the selected touch-up(s) up or down one row at a time on the
Text Touch-Ups menu.  You might want to move the touch-ups you use most often to the
beginning of the list.

Format: Text Touch-Ups:  <Named Text Touch-Up>
Displays a list of existing text touch-ups.  When you select a text touch-up from the list,
ECCO applies it to the highlighted text.

If you hold down the CTRL key while you choose the text touch-up, ECCO applies the
attributes of the touch-up to the outline styles for the selected items.

Format:  Outline Styles

Displays the Outline Styles dialog box, in which you define a style (font, size, color, and
style) for all items of the selected level in your outline.
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Outline Styles dialog box

Font  Displays the outline level in the font you specify.

Size  Displays the outline level in the point size you specify.

Color  Displays the outline level in the color you specify.

Style  Displays the outline level in the style(s) you specify (plain, bold, italic, and
underline).

Example  Displays text with the attributes you’ve specified.

Use this view’s outline styles for new views  Select to set these outline styles as the
default for new views you create.

Apply button   Applies the specified attributes to the outline level.

Format:  Outline Labels

Displays or hides outline labels and allows you to create new or edit existing outline
labels.  This command is not available in either the Calendar or the PhoneBook.

Format: Outline Labels:  Show Labels

Shows or hides all labels in the outline.

Format: Outline Labels:  Skip Label & Icon

Skips the label for the selected items and hides the item bullet, but resumes the labeling
sequence with the next item.

Format: Outline Labels:  Restart Sequence

Restarts the labeling sequence beginning with the selected items.

Format: Outline Labels:  New

Displays the Outline Labels dialog box, in which you can create custom label formats (for
example, I, II, III; 1, 2, 3; A, B, C) for selected outline levels.
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Outline Labels dialog box

Rename  Type here a name for the outline label you are creating.

Prefix  Choose or type the prefix you want displayed in front of the label.  The prefix can
be up to two characters long.

Label  Choose a Roman or Arabic numeric or an alphabetic format for the label (for
example, I, II, III; 1, 2, 3; A, B, C).

Suffix  Choose or type the suffix you want displayed behind the label.  The suffix can be
up to two characters in length.

Cumulative  For a given level, displays the labels for all levels to its left.  This feature is
useful for tracking item levels in long documents.

Based On button  Displays a dialog box, in which you can apply attributes of an existing
label to all levels or to selected levels only.

Format: Outline Labels:  Manage

Displays the Manage Outline Labels dialog box, in which you can edit, delete, reorder,
and rename existing outline labels.  You can also create a new outline label from this
dialog box.

Manage Outline Labels dialog box

Rename  Type here the new name you want to give the outline label style.
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New button  Displays the Outline Labels dialog box, in which you can create a new
outline label style.

Edit button   Displays the Outline Labels dialog box, in which you can edit an existing
outline label style.

Delete button  Deletes the selected outline label style.

Reorder buttons  Move the selected outline label(s) up or down one row at a time on the
Outline Labels menu.

Format: Outline Labels:  <Named Outline Labels>

Lists all existing outline labels.  Choose a name to apply a set of labels to the active view.
The default named set of outline labels is called Simple Numeric Labels.

Tools Menu
Commands on the Tools menu let you sort items; insert files into ECCO; launch other
programs from ECCO; manage alarms and tickler items; customize the toolbar; specify
ECCO default preferences; and display or hide the column grid, dialog alerts, and the
Shooter.

You can also apply a filter to see only items with values that match criteria you specify,
and create forms that automate your work by adding items and their values to several
folders at once.

Tools:  Sort View

Displays the Sort Items dialog box, in which you can sort items or subitems subordinate
to the selected folders or items in the active view.

Sort Items dialog box

Entire view  Sorts all top-level items in the active view.  In the Calendar, this option
changes to Tickler Sections and sorts all items displayed in the Tickler section.

Sub-items of selected items or folders  Sorts the subitems of the selected items or
folders.

Sort key 1  Select a column or item text as your primary sort key.
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Sort key 2  If appropriate, select a column or item text as your secondary sort key.

Ascending  Sorts items in ascending order.  If the selected column is a pop-up list, items
whose value is first in the list will be sorted first.

Descending  Sorts items in descending order.

Tools:  Filter View

Filters allow you to limit the display of items in the view to those items that meet the
criteria you specify.

Commands on this menu let you create a new filter, edit an existing one, ignore a filter
and see all the information in a view, or apply an existing filter to a view.  A checkmark
appears next to the name of any filter currently in use.

Tools: Filter View: New

Displays the Filter Current View dialog box, in which you can create a filter and display
specific information contained in the view.  After you create a new filter, it is applied to
the active view.

Filter Current View dialog box

Show only Items for which  Specify a column, operator, and value for your filter:

Choose Column  Displays a list of the columns currently displayed in your active
view.

Operator  Displays a list of comparison phrases (equals, greater than, less than, and
so on).

Value  Type here a comparison value, if applicable.

Add to menu  Type here a name for your filter to save it and add it to the Filter menu for
use in other views.  Filters added this way are also available to you from the Find and
Find And Replace, dialog boxes.  This option is available only if the selected column has
a heading.

Advanced button  Displays the Create A New Filter dialog box and the Add To Filter
dialog box, in which you can specify multiple folders and sets of criteria for your filter.

Page 315



307 ECCO User’s Guide

Create a New Filter dialog box

View Items that Match  Displays the list of columns (and column values) and folders
(and folder values) that are the criteria for the filter.

Add Line button   Displays the Add to Filter dialog box, in which you specify the column
or folder, value, and operator for each criterion, and specify whether you want items to
match more than one criteria (And) or any of the criteria (Or).  Choose the Add button to
add one or more criteria.  When you are finished adding criteria, choose the Close button
to return to the Create a New Filter dialog box.

Modify button   Displays the Modify Filter dialog box, similar to the Add to Filter dialog
box, in which you can change the criteria for the filter.

Add to menu  Type here a name for your filter to save it and add it to the Filter menu.
These same filters are also available to you from the Find and Find And Replace dialog
boxes.

Delete button  Removes the selected criterion from the Criteria list.

Simple button  Redisplays the Filter Current View dialog box.

Tools: Filter View:  Manage

Displays the Manage Named Filters dialog box, in which you rename or delete existing
named filters or reorder them on the menu.

Manage Named Filters dialog box

Rename  Type here the new name you want to give the selected filter.
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New button  Displays the Create a New Filter dialog box, in which you can create a new
filter.

Edit button   Displays the Edit A Named Filter dialog box (identical to the Create A New
Filter dialog box) and the Add To Filter dialog box, in which you can modify an existing
filter.

Delete button  Removes the selected filter.

Reorder buttons  Move the selected filter(s) up or down one row at a time in the Filters
menu.

Tools: Filter View:  Ignore Filter

Ignores the applied filter and displays all information contained in the view.  When
chosen again, this command restores the filter .

Tools: Filter View: <Named Filters>

Applies the filter to the active view, displaying only those items that match the filter.

Tools:  Sum

Displays the Calculate Sum dialog box, in which you can specify columns for which you
want to calculate a numeric total.

Calculate Sum dialog box

Items to Calculate  Specify whether you want to calculate a sum of the selected items
only or all items in the view.

Type of sum  Choose whether you want to total the values in one column or multiply one
column by another column and total the results.  From the drop-down lists, select the
columns whose values you want to use.

Result  Displays the result of the sum, after you choose the Calculate button.

Calculate button  Calculates the sum for the columns you specified.
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Tools:  New Form

Displays the Create New Form dialog box, in which you can create a form.  The forms
created here can be used with the Add New Item By Form, View Item By Form, and
Apply Form To Items commands.

Create New Form dialog box

The options in the following dialog box are also available in the Edit Form dialog box,
which appears when you choose the Edit button in the Manage Forms dialog box.

Choose a folder or column to add to your new form.

Create New Form dialog box

Rename  Type here a name for your form.

Choose Fields  Displays a list of columns or folders you can add to the new form.

Fields Chosen  Displays a list of the columns or folders you have added to the new form.

Add button  Adds the selected column(s) or folder(s) to the new form.

Remove button  Removes the selected column(s) or folder(s) from the new form.

New Field button  Displays the New Field & Column dialog box, in which you can
create a new column or folder to add to your form and specify the column or folder type.

Default Values button  Displays the Set Default Values For Form dialog box.
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Set Default Values for Form dialog box

Reorder buttons  Move the selected column(s) or folder(s) up or down in the Folder list
one row at a time.

Set default values for fields in the form  Click to the right of each column or folder
name to create or change the default value to be associated with the item when the form is
applied.

Apply form, don’t display dialog  When you next choose the Apply Form To Items
command, the form will be applied using its default settings, without displaying the Apply
Form dialog box.  This option is available only when all columns or folders have default
values.

Clear Value button  Removes the selected default value.

Tools:  Manage Forms

Displays the Manage Forms dialog box, in which you rename or delete existing forms or
reorder them on the menu.

Manage Forms dialog box

Rename  Type here the name you want to give the selected form.

New button  Displays the Create New Form dialog box, in which you can specify options
to create a new form.

Edit button   Displays the Edit Form dialog box, in which you can edit the settings for the
selected form.  This dialog box is identical to the Create New Form dialog box.
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Delete button  Deletes the selected form or forms.

Reorder buttons  Move the selected form(s) up or down one row at a time on the Forms
menu.

Make Public  Makes the selected form(s) public.  When a form is shared, it is available
to other users.  This option is valid only if you’ve previously made the ECCO file
available by choosing the Share This File subcommand from the Network command on
the File menu.

Tools:  Add New Item By Form

Displays a list of named forms.  Choosing a named form displays the Add By Form dialog
box for that form.  In this dialog box, you can specify options to create a new item and
add it to ECCO by form without having to first add it to any specific view.

Add by Form dialog box

Add a new item, specifying folders and column values  Type here the text of your item.

Click below to specify folders & column values for the item above  Displays a list of
the columns or folders associated with the selected form.  Click to the right of each
column or folder name to create or change the value to be associated with the item.

Add button  Adds the item to the form’s folders and lets you continue adding items.

Close button  Closes the Add By Form dialog box when you are done adding items.

Add to active View  Adds the item to the active view and either enters values for the
form’s columns or adds the item to the form’s folders.

Add As Sub button  Adds the item as a subitem to the selected item in the active view.

Clear Value button  Prevents the item from being given a column value or from being
added to the selected folder.

All Defaults button  Restores the default values of all columns as defined in the form.

Tools:  View Item By Form

Allows you to
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• View and edit individual items by form.

• See which of the form’s folders and columns the item is in.

• See each item’s associated column values.

• Navigate through the items in a view and see and edit their folders and column values
in a form.  For a better understanding of folder values, see the chapter or online help
on “Folders.”

Displays a list of existing forms.  When you select a form from the list, the View By Form
dialog box is displayed.  In this dialog box, you can view and edit the selected item’s
folders, columns, and associated values for the form you chose.  You can also use the
Next button in this dialog box to move sequentially through a view and see the form’s
folders, columns, and values for each item.

View By Form dialog box

Show Form info for item selected in view  Displays the text of the selected item.

Click below to edit folders & column values for the item above  Displays a list of the
columns or folders associated with the selected form.  Click to the right of each column or
folder name to create or change the value to be associated with the item.

Prev and Next buttons  Navigate through the items in the active view, displaying each
item’s columns and associated values by form.  You can move up or down the outline at
the same level or move from one level to another.

Delete Item button  Deletes the selected item(s).

Clear Value button  Removes the item from the selected column or folder.

All Defaults button  Restores the default values of all columns as defined in the form.

Hints button  Displays some helpful hints on forms.
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Tools:  Apply Form To Items

Displays a list of existing forms.  When you select a form from the list, ECCO displays
the Apply Form dialog box, in which you can set column values and apply the form to the
currently selected items in the active view.  Allows you to put multiple items into a set of
folders or columns at one time and associate values for those items with each of the
columns in the form.

If you selected the Don’t Display Dialog checkbox when you created the form, ECCO
applies the default columns and values in the form to the selected items without
displaying the Apply Form dialog box.

Apply Form dialog box

Item text  Displays the text of the selected item.

Click below to specify folders & column values for the item above  Displays a list of
the columns or folders associated with the selected form.  Click to the right of each
column or folder name to create or change the value to be associated with the item.

Ignore button  Prevents the item from being given a column value or from being added
to the selected folder.

All Defaults button  Restores the default values of all columns or folders as defined in
the form.

Tools:  Get Disk Files

Inserts file, directory, or program names into ECCO.

Tools: Get Disk Files: From File Manager/Explorer

Opens the File Manager if running Windows NT 3.5x or Windows Explorer if under
Windows 95 or Windows NT 4.0 or later, from which you can insert references to one or
more files, directories, or programs into ECCO by using the Shooter.

Tools: Get Disk Files:   Browse, Add As Item

Opens the Choose File Name To Paste dialog box in which you can select a file to insert
as a reference in ECCO.
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Tools: Get Disk Files:   Browse, Add To Menu

Opens the Add File Name Or Program To Menu dialog box in which you can select a
program application, batch file, and so forth to add to your ECCO menu.

Add File Name or Program to Menu dialog box

Menu Text  Type in the text you want displayed on the Get Disk Files menu.  If you
leave this blank, ECCO automatically supplies the filename.

File Name  Select the file that you want added to the menu.

Files of Type  Select the type of file—program files (*.EXE, *.PIF, *.BAT) or all files
(*.*) — that you want displayed in the files list box.

Look in box  Select the drive where the file is located if the file is on another drive.

Toolbar icon  Select a toolbar icon for this menu item by clicking the up and down
arrows to the right of the icon.

Tools: Get Disk Files:  Manage Menu

Opens the Manage Menu dialog box in which you can rename, delete, or reorder
programs on the Get Disk Files menu.

Manage Menu dialog box

Rename Type the new name you want to give the selected program.  This new name will
then appear on the Get Disk Files menu.

Programs box Select the program item that you want to change.
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Delete Removes the selected program item from the Get Disk Files menu.

Reorder buttons Moves the selected program item up or down in the Get Disk Files
menu.

Tools: Get Disk Files:  < Files to Launch >

Launches the named file.

Tools:  Launch

When a filename is selected, choosing this command launches the program and opens the
file.  When an executable file (which has an .EXE file extension) is selected, choosing
this command launches the program.

Tools:  Launch Internet

Launches an Internet World Wide Browser (see README.ECO for supported browsers)

Tools:  Timex Data Link

Walks you through the process of downloading your ECCO data into a Timex® Data-Link
Watch.  For more information, see the chapter or online help on “Importing and
Exporting.

ECCO Timex Data Link dialog box

Select the types of items to be sent from your ECCO file to the Timex watch.

Tools:  Timex Data-Link:  Options

Displays a menu that allows you to specify the watch model and the type and amount of
data to send from ECCO.
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ECCO Timex Data Link Options dialog box

Watch model Select the Timex watch you will be transferring data to.

Transmit using Select the method of transfer — Monitor or Laptop adapter.

Information to transmit Select the number of days of Appointments, To-Do’s and
Ticklers, Anniversaries, and Alarms to transmit.

Phone numbers selected using Enter the name of checkmark column that specifies
which items are to be transmitted.

Tools:  Pilot HotSync Options

Note: This feature is available only in the 32-bit version of ECCO Pro. The Pilot
HotSync Options command on the Tools menu is displayed, but disabled, in the
16-bit version of ECCO Pro.

This displays the Pilot Synchronization Options dialog box.
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General

Field Meaning

PhoneBook Synchronize data in ECCO’s PhoneBook and Pilot’s Address
Book.

Calendar Synchronize data in ECCO’s Calendar and Pilot’s Date Book.

To-Do’s Synchronize data in ECCO’s To-Do’s section and Pilot’s To Do
List.

Memos Synchronize data in ECCO’s Notepads and Pilot’s Memo Pad.

HotSync button Launches Pilot HotSync Manager or maximizes if minimized.

Calendar, PhoneBook, To-Do’s, and Memos

Field Meaning

No Subs Do not synchronize subitems for the selected module.

Delete As Archive Any data deleted on the Pilot should be assigned to ECCO’s
archive folder.

Normal Sync Synchronize data that is new or has been modified for the
selected module.

Full Sync Synchronize all data regardless of status for the selected module.

Clear Pilot Data First Erase the data in the selected Pilot module before resending
ECCO data.

Note: The Memos tab does not have an option for No Subs.

Tools:  Alarms

Displays a menu with commands that let you create new alarms, review existing alarms,
and edit existing alarms.  Alarms are used  to warn you about important events before
they occur.

Tools: Alarms:  Create New Alarm

Displays the Create an Alarm dialog box, in which you can create a simple alarm or a new
named alarm.  This command is unavailable in the Calendar, where alarms can be
attached to items using the Date Settings dialog box.
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Create an Alarm dialog box

Attach alarm to selected Item Attaches the alarm to the selected item and displays the
item’s text in the Alarm Text box.

Alarm Text  Type the text you want the alarm to display when it “goes off.” Typing will
be disabled if the alarm is attached to a selected item.

Date Select the date on which you want the alarm to go off.

Time Select the time at which you want the alarm to go off.

Type If you select the Simple Alarm option, the alarm displays a text message at the
specified time.

If you select the Custom option, the Custom Alarm dialog box (similar to the Alarms
dialog box) appears.  Use the Custom Alarm dialog box to set multiple alarms for this
event.

If you select the Manage option, the Manage Named Alarms dialog box appears.

If you select any named alarm, the times and options specified by the named alarm will be
invoked relative to the date and time of this event.

Tools: Alarms:  Review Alarms

Displays the Review Alarms dialog box, in which you can view upcoming alarms and
delete those you no longer want.

Review Alarms dialog box

Alarms occurring the week of Select the week for which you want to review your
alarms.

Next Alarm: Displays a list of dates for which alarms are set.

Appt. Date:  Displays the dates of the events associated with the upcoming alarms.
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Alarm Message:  Displays the events or messages associated with the upcoming alarms.

Delete button:  Deletes the selected alarm.

Tools: Alarms:  Manage Named Alarms

Displays the Manage Named Alarms dialog box, in which you can create or edit named
alarms, delete existing named alarms, or reorder the list of named alarms.

Manage Named Alarms dialog box

Rename Type the new name you want to give the selected alarm.

New button Displays the New Named Alarm dialog box, in which you can specify
options to create a new named alarm.  This dialog box is similar to the Alarms dialog box.

Edit button  Displays the Edit Named Alarm dialog box, in which you can modify an
existing named alarm.

Delete button Deletes the selected named alarm.

Reorder buttons Move the selected named alarm(s) up or down on the menu one row at
a time.

Tools:  Ticklers

Displays the Show Item in Calendar Tickler Section dialog box, in which you can choose
to display the currently selected item as a tickler item in the Tickler section of the
Calendar.

Show Item in Calendar Tickler Section dialog box

Add Tickler For  Specify the event date you want to associate with the tickler item.

Advance warning Specify the date you want to begin displaying the tickler item before
the event date associated with the tickler item.
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Carry Forward  Specify the date you want to stop displaying the tickler item.  Options
range from the date associated with the tickler item to as many as two weeks after, or until
you mark the item as Done.

Type of Tickler (Add to which Folder) Specify the date folder into which you want to
put the tickler item.  Tickler items are organized by folder in the Calendar.

Tools: Move Items’ Dates

Allows you to move selected items forward or backward in terms of their dates.

Move Items’ Dates dialog box

Add < > days to each date  Type the number of days you want the item to be moved
forwards or backwards.

Count business days only  Allows you to exclude weekends in your item movement.

Tools:  Time & Expenses

Displays the Set Up Time Expense Billing dialog box, adds to the current ECCO file a
Time & Expenses notepad and an Expenses form, and then displays the Calculate Time
and Expense Billing dialog box.  Once you have set up the notepad and form, this
command displays the Calculate dialog box immediately.

You can enter expenses directly into the Time & Expenses notepad; or you can use the
form to add expense items or associate expense values with any phone log, appointment,
or other item.

Calculate Time and Expense Billing dialog box

Calculate expense totals for  Specify whether you want to calculate a sum of the
selected items only or of all items in the view.
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Items matching  Specify whether you want items’ column values to match a date range,
a billing code you enter, or an expense type that you select from the drop-down list.

Default Hourly Rate  Enter a dollar amount.

Add “Totals” line to view  Adds a Totals item to the Time & Expenses notepad, listing
the date the total was calculated, with subitems for hourly and other expenses.

Calculate button  Calculates the sum for the items you specified and displays the results
in the Calculated Expenses dialog box.

Tools:  Time Logger

Displays the Time Logger dialog box, in which you can log the duration of a job, task, or
phone call.

Tools:  Phone/Time Log

Phone / Time Log dialog box

Displays the Phone/Time Log dialog box, in which you can display all your phone/time
log entries between specific dates in a Notepad.

Tools:  Toolbar

Displays the Toolbar dialog box, in which you customize the toolbar display.  (You can
also customize the toolbar by using the right mouse button to drag icons.)   

Tool Bar dialog box

Show large buttons with captions  When selected, the toolbar shows large icons with
captions for each toolbar button.  Otherwise, the toolbar shows small icons without
captions.

Action  Specify the icon action you want to take:
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Add/Arrange Icons  Allows you to add or arrange the icons.

Arrange Groups  Allows you to move groups of icons as a single unit.

Add/Del Spaces  Allows you to add or delete spaces between icons on the toolbar.

Description  Describes the procedure for each action you want to take.

Rows  Specify the number of toolbar rows you want displayed:

Main Window   Specify the number of rows you want displayed in the toolbar of the
ECCO program window.

Views  Specify the number of rows you want displayed in the toolbar of the ECCO
view windows.  This setting is specific to each type of view.

Shooter  Specify the number of rows you want displayed in the Shooter toolbar.

Tools:  Display

Commands on this menu let you display or hide the column grid and restore any dialog
box alert messages you have turned off.   

Tools:  Display:  Column Grid

Displays or hides the column grid (vertical column lines) in the column pane of the active
view only.

Tools:  Display:  Restore Dialog Alerts

Restores any dialog box messages you previously turned off.

Tools:  Options

Displays the ECCO Options property sheet.
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Files tab

Autosave all files every Select a time interval from the list to save your file
automatically at regular intervals.

Autosave on file close Select this option to save your file automatically on
closing.  If this option is not selected, ECCO overrides
this setting when you are working in a shared file.
(When you are using a shared file, your changes are
saved automatically in the shared file as they occur.
Therefore, to ensure the highest level of data integrity
and consistency, ECCO saves any file associated with a
shared file automatically on closing.)

Open last file on startup When you start ECCO, automatically opens the ECCO
file last opened.

Show Column Prompts Select this option to display column descriptions in
column cells.

Display Shooter Specifies if you want the Shooter icon to be displayed.

Keyboard access to Shooter
menu: CTRL+ALT+

Specify the keyboard combination you want to use to
display the Shooter menu using the keyboard.

User name for report
headings:

Specify the user name you want to appear in headers
when you print.

Apply button Becomes active when changes are made to the property
sheet.  Changes are implemented, but the property sheet
remains open.

ECCO Preferences dialog box

Mail System tab

Mail client Displays the mail system you will use for connecting to
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the ECCO Workgroup.

Login at startup Select to login to your mail system when starting
ECCO.  If unchecked, ECCO will not start your mail
program until a you perform a ECCO Workgroup
function such as opening a shred file or sending a group
meeting request.

Check mail every Select this option if you want ECCO to check for
meeting mail or merge files (for file synchronization) at
the specified time interval.  If this option is not
selected, you must launch the mail check manually each
time you want to check for new meeting messages.

Apply Button Becomes active when changes are made to the property
sheet.  Changes are implemented, but the property sheet
remains open.

Column Menu
The Column menu includes commands for hiding, displaying, inserting, or deleting
columns; modifying column properties; naming, aligning, moving, or sizing columns; and
making the contents of a column public.

Checkmarks and values in column cells are always associated with items on the same line,
just as spreadsheet cells are commonly associated with their titles.  When you move an
item, the values and checkmarks in columns move with the item.  For more information,
see the chapter on online help on “Columns and Values.”

Column:  Show Columns

Shows or hides the column pane in the active view.  This command is unavailable if there
are no columns.  To create columns, choose Insert columns.

Column:  Insert Column

Inserts the column type you specify.  The available column types are folder, text, number,
checkmark, date, pop-up list, and Gantt.

When you insert a column, ECCO automatically creates a new folder with the name and
adds it to the list in the folder window.  The column can then be added to any other view
as a folder column using the Insert Column: Existing Column or Folder command.
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Column: Insert Column:  Existing Column or Folder

Displays the Insert Folder Columns dialog box, in which you choose one or more folders
(or named columns from other views) to insert as columns.  When you make multiple
selections from this dialog box, ECCO creates a separate column for each folder you
select.  You can also insert a folder column by dragging a folder from the folder window
to the column pane.

Column: Insert Column:  New Text

Displays the Column Heading dialog box, in which you can type a heading to display in
the column.  Inserts a column that allows you to type text into its cells.

Column: Insert Column:  New Number

Displays the Column Heading dialog box, in which you can type a heading to display in
the column.  Inserts a column that allows you to type a number into its cells.

Column: Insert Column:  New CheckMark

Displays the Column Heading dialog box, in which you can type a heading to display in
the column.  Inserts a column that allows you to enter checkmarks (or other one-character
symbols) into its cells.  Clicking a cell toggles the checkmark on or off.  To change the
checkmark symbol, use the Checkmark command on the Column menu.

Column: Insert Column:  New Date

Displays the Date Column Heading dialog box, in which you can type a heading to
display in the column.  Inserts a column that allows you to enter dates into its cells.  After
you select a date column, you can enter, view, and edit dates in the cells of the column.

Use the Column Properties command to specify the date format you want to use.

Column: Insert Column:  New Pop-Up List

Displays the Insert Pop-Up List Column dialog box, in which you can specify a pop-up
list of values for the column.  For example, the pop-up list values for a column titled
“Priorities” might include the values “High,” “Medium,” and “Low.” You could click on
any cell in the column and choose one of the priorities for the item on that line .

The Insert Pop-Up List Column dialog box is identical to the Pop-Up List Column Values
dialog box.

Column: Insert Column:  New Gantt

Displays the Create New Gantt Column dialog box, which allows you to create a Gantt
chart column for the items in that view.
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New Gantt Column dialog box

Chart Range  Select the date range on which you want to base your chart.

Choose folders which best describe start and end of each Gantt bar  Select the date
folders on which you want to base the start and end date of the bars of your chart.

Bar Color  Select a color for the bars of your chart.

Column:  Remove Column

Removes the selected column.

Column:  Properties

Displays the Column Properties dialog box specific to the selected column’s type, in
which you can specify properties for the selected column.  However, you cannot change
the type of an existing column.

Column Type Available Options

Text Alignment; Width; “For each Item, cell displays”;
“Include this column in new notepads by default”

Number Format; Alignment; Width; “For each Item, cell displays”;
“Include this column in new notepads by default”

Checkmark Checkmark; Alignment; Width; “For each Item, cell displays”;
“Include this column in new notepads by default”

Date Format; Alignment; Defaults; Width; “Include this column in new
notepads by default”

Pop-Up List Alignment; Values; Width; “For each Item, cell displays”;
“Include this column in new notepads by default”

Gantt Displays a dialog box identical to the Create New Gantt Column
dialog box.

Alignment  Specifies the alignment of the column’s contents (left, right, or center).

Width   Displays the Column Width dialog box.

For each Item, cell displays  Specify whether the column should display the values
normally associated with its type or whether it should display subfolders, making the
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column a multiple-folder column.  Multiple-folder columns display in each cell any of
those subfolders that contain the item on the same line.

Format  Specifies the number format (for a Number column) or date format (for a Date
column).

Checkmark  Specifies the type of checkmark or symbol displayed in a checkmark
column.

Defaults  Displays the Date Properties dialog box.

Values  Displays the Pop-Up List Column Values dialog box.

Column:  Heading

Type or edit the text you want to appear as the heading of the selected column.  When you
change the heading of a column, ECCO automatically changes the folder with that name
in the folder window.

Column:  Format

Lets you specify the number format (dollar, percent, scientific notation) or date format
(month/day/year order and separators) of the selected column’s contents.  This command
is available only for Number columns and Date columns.

Column:  CheckMark

Lets you specify the type of symbol you want to display in the selected checkmark
column.  This command is available only for Checkmark columns.

Column:  Alignment

Lets you specify the alignment of the selected column’s contents (left, right, or centered).

Column:  Width

Displays the Column Width dialog box, in which you can specify the column width or
minimize the column to a narrow width (to display a greater number of columns at one
time) .

Column Width dialog box

Column Width   Specify a width for your column.  The width is measured in number of
characters.
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Minimize Column  Minimizes your column to a narrow width.  (You can also minimize a
column by double-clicking the column header.  To return a minimized column to its
preminimized width, double-click the column header.)

Use Standard Width  Specifies use of the standard column width.

Standard Width  Specifies the column width for all columns that are using the standard
width.

Column:  Move Column

Lets you move a column left or right, using the keyboard.  To move a column with the
mouse, drag its heading to a new position in the column pane.

Column:  Show Home Folder

Displays or hides the Home Folder column in the column pane, a multiple-folder column
which shows the folder in which the item was first created.

Column:  Make Public

Lets you make the contents of a specific column public for workgroup interaction by
adding the column to a view in a shared file (and in all local files attached to the shared
file).  This command is valid only if you’ve previously connected to a shared file by
choosing the Share This File command from the Network options on the File menu.

Calendar Menu
This menu is available only when the Calendar is displayed.

Commands on the Calendar menu let you add tickler items and appointments, make multi-
day appointments, schedule group meetings, and navigate through the Calendar.  For
more information, see the chapter or online help on “The Calendar.”

Calendar:  Add Appt. Item

In the Appointment section, creates a new appointment item at the selected time.  If the
Calendar is displayed in week or month or summary views, this command displays the
Add Appointment dialog box.
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Add Appointment dialog box

Change Date  Use the Mini-Navigator and the date grid to select a date for the
appointment.

Change Time  Use the buttons to set a duration for the appointment.

Enter Appointment  Type a description for the appointment (its item text).

Tickler button  Displays the item’s Calendar Tickler Options dialog box.

Alarms button  Displays the Alarms menu.

Recur button  Displays the Recur menu.

Color button  Select a color for the appointment’s Busybar block.

Jump to Notes button  Adds an outline note for the appointment, and displays the
Calendar by day.  Outline notes do not appear in summary displays.

Calendar:  Add Multi-Day Appt.

Displays the Add Multi-Day Appointment dialog box, in which you can specify the
beginning and ending dates for a multiday appointment.  Multi-day appointments are
shown in the Tickler section, and they appear in the Busybar in red.

If you are working in your main Calendar file, you’ll be given the option to keep time
available for group meetings.  If you turn off that option, you’ll appear as “unavailable” in
the Group Scheduling dialog box.
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Add Multi-Day Appointment dialog box

Beginning  Specify the first date of the multi-day appointment.

Ending  Specify last date of the multi-day appointment.  The default duration is one day.

Enter Appointment  Type a description for the appointment.  If the Calendar is
displayed in week summary, month summary, or year views, this option changes to Enter
Appointment.

Jump to Notes button  (Available only when the Calendar is displayed by week
summery, month summery, or year views.) Adds an outline note for the appointment and
displays the Calendar by day.  Outline notes do not appear in summary views.

Calendar:  Add Tickler

Displays the Add Tickler Item dialog box if the Calendar is displayed by day or in detail
or the Add Tickler dialog box if the Calendar is displayed in summary.  In either of these
dialog boxes, you specify settings for the tickler item you are adding.

Add Tickler Item dialog box

Add Tickler For   Displays the date associated with the tickler item (the date currently
displayed in the Calendar).

Tickler Text   Enter or change the text of your tickler item.

Advance warning  Specifies the date you want to begin displaying the tickler item,
before the date associated with the tickler item.

Page 339



331 ECCO User’s Guide

Carry Forward   Specify the date you want to stop displaying the tickler item.  Options
range from the date associated with the tickler item to as many as two weeks after, or until
you mark the item as Done.

Type of Tickler (Add to which Folder)  Specifies the folder into which you want to put
the tickler item.

Add Tickler dialog box

Change Date  Use the Mini-Navigator and the date grid to select a date for the
appointment.

Put item into which Folder  Specifies the folder into which you want to put the tickler
item.

Enter Reminder or To-Do  Type a description for the tickler item (its item text).

Tickler button  Displays the item’s Calendar Tickler Options dialog box.

Alarms button  Displays the Alarms menu.

Recur button  Displays the Recur menu.

Jump to Notes button  Adds an outline note for the tickler item and displays the
Calendar by day.  Outline notes do not appear in summary displays.

Calendar:  Add Group Meeting

Displays the Schedule Group Meeting dialog box, in which you can schedule group
meetings.
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Schedule Group Meeting dialog box

Meeting Subject  Type here the subject of the meeting.

Duration  Specify the length of the meeting.

Recurring Meeting   Specify if there will be recurrences of this meeting.

Attendees & Resources  Choose this button to display the Choose Users, Groups, and
Resources dialog box, in which you can specify who you want to attend the meeting.

Search  Specify the starting date and workday time limits, including or excluding
weekends, in which you want to find an available time.

Find buttons  Find available time by searching forward (>) or backward (<).

+5/-5 buttons  Click repeatedly to change meeting start time by increments of five
minutes.

Group Calendar button  Displays the Group Calendar for the selected workgroup users.

The following dialog box appears when you choose the Attendees & Resources button in
the Schedule Group Meeting dialog box.

This dialog box is also displayed in other situations where you need to supply the name of
an ECCO user or a mail address.  This dialog box lets you specify the users, groups, or
mail addresses desired.
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Choose Users, Groups, and Resources dialog box

Scheduling Address Book  Displays a list of all names in your Scheduling Address
Book.  Choose the down arrow list box control to view other connected  ECCO
Workgroup Directories and their users.

Mail Address Book  Choose this button to select meeting attendees from your mail
program’s address book.

In button   Adds the selected name in the Scheduling Address Book list to the Meeting
Attendees list.

Out button  Deletes the selected name from the Meeting Attendees list.

Meeting Attendees  Displays the list of meeting attendees you have selected.

Clear List  Choose this button to clear all names from the Meeting Attendees list.

Groups  Choose this button to display the Edit Groups dialog box, in which you can edit
or create new scheduling groups.  When you create a scheduling group, you assign a set
of people or resources to a single name.  When you add that group name to the Meeting
Attendee list, each individual receives a request to attend the meeting.  When you create a
group, the group is made available to everyone.

Calendar:  Time, Date, Alarm, etc.

Displays the Date Settings dialog box for the selected item.  This command is available
only if the selected item is an appointment or tickler item and the Calendar is displayed by
day or in week or month detail view.

For multi-day appointments, this command displays the Edit Multi-Day Appointment
dialog box, which is similar to the Add Multi-Day Appointment dialog box.

Calendar:  Add Outline Note

Adds to the selected item a subitem, which you can use to record notes.  This command is
available only when an item is selected and the Calendar is displayed by day or in week or
month detail views.
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Calendar:  See All Recurring Notes

Shows outline notes for the selected instance of a recurring event or for all instances of
the event.  This command is available only when the Calendar is displayed by day or in
week or month detail views and only when a recurring appointment is selected.  This
option effects only the selected appointment and is remembered for that recurring
appointment whenever it appears in the Calendar.

Calendar:  Navigate

Moves the Calendar display to the previous or next day, month, or year, or to any date
you specify.

Calendar:  Sidebar Shows

Changes the display of the sidebar (the left-most area of the Calendar window, under the
Day/Week/Month/Year buttons) to show a Busybar for the selected day, week, or month,
or show “thumbnail” calendars for the selected, previous, and next month, or hides the
sidebar.

Calendar:  Show Group Calendar

Allows you to see other workgroup users’ appointments.  Displays the Choose Users,
Groups, and Resources dialog box, in which you select the users whose appointments you
want to view.  Then displays the Group Calendar for the selected users, by week or month
in summary views, and opens the Group Calendar Options dialog box.

Group Calendar Options dialog box

Users button  Displays the Choose Users, Groups, and Resources dialog box, in which
you can select the users whose calendars you want to view.

Make Meeting button  Displays the Schedule Group Meeting dialog box.

Initials button  Specify whether you want to see initials or full names for workgroup
users.

Done button  Closes the Group Calendar Options dialog box.

Calendar:  Show Tickler Section on Top

When checked, displays the Tickler section above the Appointment section, rather than to
the right of it.  This command is available only when the Calendar is displayed by day or
week or month detail view.

ECCO is sensitive to state of your computer screen, so this command may be unavailable
if the ECCO program window is crowded or if your monitor display is at a low resolution.
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Calendar:  Use with PhoneBook

Opens the PhoneBook and arranges the windows side by side so that both the PhoneBook
and the Calendar are visible.  You can drag any name in the PhoneBook to the Calendar
to automatically create an appointment.

Calendar:  Options

Appointments tab

Week starts on Monday Specify whether your calendar week should begin on
Monday, rather than Sunday.

Start of Day Specify the time your workday begins.

End of Day Specify the time your workday end.

Default Appointment
Duration

Specify the default appointment length.

Appointment Time Slot
Interval

Select a default appointment time increment to be
displayed in the Day view.

Appointment Item Options
button

Displays the Date Properties dialog box, in which you
can select default settings for all new appointments.

Apply button Becomes active when changes are made to the property
sheet.  Changes are implemented, but the property sheet
remains open.
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Ticklers tab

Show Ticklers in Summary
Views for Week

Select this option to display tickler items when the
Calendar is displayed by the week view.

Show Ticklers in Summary
Views for Month

Select this option to display tickler items when the
Calendar is displayed by the month view.

Tickler Item Options button Displays the Choose Tickler Type dialog box, in which
you select a default type or folder for new tickler items.

Apply button Becomes active when changes are made to the property
sheet.  Changes are implemented, but the property sheet
remains open.

Time Zone tab

Time Zone Select your location’s time zone (used for group
scheduling).  For example, if someone in New York
schedules a 3:00 p.m. phone conference and your
primary time zone is Pacific time, the meeting would
appear at 12:00 p.m. on your Calendar.
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Time Zone Adjustment Specify any local differences from international
standard time zones (15 to 45 minutes), or select U.S.
daylight savings time, which adjusts one hour between
April and October.

Apply button Becomes active when changes are made to the property
sheet.  Changes are implemented, but the property sheet
remains open.

Holidays tab

Show Holidays for Specify the country whose national holidays you want
displayed in the Calendars.

Custom Holiday button Displays the Manage Custom Holidays dialog box, in
which you can add, delete, or rename custom holidays
(such as birthdays), or delete standard holidays.

Apply button Becomes active when changes are made to the property
sheet.  Changes are implemented, but the property sheet
remains open.

PhoneBook Menu
The PhoneBook menu is located on the main menu and is available only in the
PhoneBook.

Commands on the PhoneBook menu let you create, edit, delete, and add notes to
PhoneBook items; search your PhoneBook; and autodial numbers.  For more information,
see chapter or online help on “The PhoneBook.”

PhoneBook:  New Name

Displays the New PhoneBook Name dialog box, in which you enter information for a new
PhoneBook item and add it to the PhoneBook.

Page 346



ECCO User’s Guide338

PhoneBook:  Delete Name

Deletes the selected PhoneBook item.  If the selected item appears in other views, the
Delete Items dialog box appears.  You are asked whether you want to make the deletion
from the PhoneBook or from all views.

PhoneBook:  Add Outline Note

Adds to the selected item a subitem, which you can use to record notes.

PhoneBook:  Show All Names

Displays all items in your PhoneBook.  If a filter is on, all items meeting filter criteria will
be displayed.

PhoneBook:  Search Options

Displays the Search Options dialog box, in which you specify whether you want to
include first names, outline notes, company, or any other fields when you search for
PhoneBook text.  By default, ECCO will always search last names.

PhoneBook:  Address Printing

Displays the Address Printing Defaults dialog box, in which you specify whether to use
home addresses when printing the current PhoneBook name.  You can also set home
address as the default when printing any new PhoneBook names.

PhoneBook:  Change PhoneBook Form

Allows you to create or manage customized PhoneBook forms, containing fields for any
folders you specify.

PhoneBook: Change PhoneBook Form:  New

Opens the Create Phone Form dialog box, in which you select existing fields (folders) for
your new PhoneBook form or choose the New Field button to create a new field and
specify the order of the fields in the new form.

Create Phone Form dialog box
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Rename  Type here the new name you want to give the selected PhoneBook form.

Choose Fields Select a folder name to include as a field in the new PhoneBook form.

Fields Chosen  Displays the fields that will be included in the PhoneBook form.

Add button  Adds the selected field in the Choose Fields list to the Fields Chosen list.

Remove button  Removes the selected field from the Fields Chosen list.

New Field button  Displays the New Field & Column dialog box, in which you can
create a new column or folder to add to your form.

Reorder buttons  Move the selected PhoneBook field(s) up or down one row at a time in
the PhoneBook form.

PhoneBook: Change PhoneBook Form:  Manage

Opens the Manage Phone Forms dialog box, in which you can create, rename, or edit
PhoneBook forms or reorder them on the Change PhoneBook Form menu.

Manage Phone Forms dialog box

Rename  Type the new name you want to give the selected PhoneBook form.

Delete button  Deletes the selected PhoneBook form.

Reorder buttons  Move the selected PhoneBook form(s) up or down one row at a time
on the Change PhoneBook Form menu.

Make Public  Makes the selected PhoneBook form public.  When a form is shared, it is
available to other users.  This option is valid only if you’ve previously made the ECCO
file available by choosing the Share This File subcommand from the Network command
on the File menu.

PhoneBook:  Hide Form

When checked, hides the PhoneBook form.
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PhoneBook:  Show Form At Right

When checked, displays the PhoneBook form to the right of the PhoneBook list rather
than below it.

PhoneBook:  Show Full Columns

When checked, displays the PhoneBook form below the PhoneBook list rather than to the
right of it.

PhoneBook:  Dial phone

Displays the Dialer/Call Logger dialog box, in which you can dial or log a phone call.

Dialer/Call Logger dialog box

Name  Displays the selected name from the PhoneBook list.

Prefix  Specifies a dialing prefix and maintains a history of previously used prefixes.

Dial 1  Dials 1 for a long-distance number.  ECCO automatically turns this option off
when you dial local calls.

Number to Dial  Displays the phone number to be dialed.  When you open the dialog
box, ECCO displays the work number corresponding to the selected item.  You can select
a different number from the Phone # Choice list.

Suffix  Dials additional numbers after the phone number (for use with calling cards, etc.).

Phone # Choice  Displays the phone number categories for the selected item (for
example, home #, work #, and fax #).  If you add a new phone number column, it appears
in this list.

Select text for dialing  Select the text you want ECCO to dial (for example, the phone
number but not an extension number).

Don’t dial local area code; local code is  Type your local area code if you want ECCO
to omit the local area code when dialing local phone numbers.

Dial button  Dials the number displayed in the Number to Dial box.  The name of this
button changes to Hangup while your call is in progress.

Talk button  Releases control of the phone line from the modem so that you can begin
your conversation.
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Setup button  Displays the Phone Dialer Setup dialog box, in which you can specify your
modem’s prefix, suffix, and port connection.

Call Logging  Specify options for logging your call:

Begin Logging upon dialing or Start/Stop Logging here  Starts logging as soon as
you choose Dial.

Begin Logging button  Manually begins logging, and brings up the Elapsed Time
dialog box.

Close button  Closes the Dialer/Call Logger dialog box.

PhoneBook:  Correspondence Manager

Displays the Correspondence Manager dialog box, in which you can create and send your
correspondence.

PhoneBook:  Use with Calendar

Displays a combined PhoneBook and Calendar.  You can drag any name in the
PhoneBook to the Calendar to automatically create an appointment.

PhoneBook:  Options

General tab

New cards use business
address when printing

Specifies to use the business address when printing.

New cards use home
address when printing

Specifies to use the business address when printing.

Search Last Name and First
Name

Searches look at the last and first name.

Search Last Name and Searches look at the last name and notes field.
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Notes

Search Last Name Searches look at the last name only.

Search Last Name and
Company or Fields

Searches look at the last name, company, or fields.

Show form at right When checked, displays the PhoneBook form to the
right of the PhoneBook list rather than below it.

Show form at bottom When checked, displays the PhoneBook form to the
bottom of the PhoneBook list rather than to the right of
it.

Hide form When checked, hides the PhoneBook form.

Use white text for selected
PhoneBook name

Select this option to change the text color from black to
white on the selected PhoneBook name.

Apply button Becomes active when changes are made to the property
sheet.  Changes are implemented, but the property sheet
remains open.

Help Menu
The Help menu includes commands to view the online User’s Guide and view specific
Help topics, do a keyword search of the online User’s Guide, or choose a command for
which you want to view a Help topic.

Help:  Contents

Displays a list of Help topics.

Help:  Search

Displays the Search dialog box.

Help:  Menu Help

Displays a “choose menu” cursor, with which you can choose the menu or command for
which you want to see a Help topic.

Help:  Shortcut Keys

Displays a list of keyboard shortcuts.

Help:  Help on this View

Displays a Help topic on how to use the active view.
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Help:  Help on ECCO Folders

Displays a Help topic on how to use folders.

Help:  Show Dynamic Help

Displays or hides status bar help messages that change dynamically as you move the
mouse.

Help:  About ECCO

Displays information about your version of ECCO.

Non-Menu Bar Commands
The commands in this section appear on menus that are not on the menu bar.  The
following menus are included in this section:

■ The Folder menu (in the folder window)

■ The folder options pop-up menu (appears when you click folder names in the folder
window)

■ The Shooter menu (appears when you click the Shooter icon in any program)

Folder Menu
The Folder menu appears in the upper-right corner of the folder window.

Commands on this menu let you edit folders; add items to folders; create new folders;
assign values to folders; change default properties; delete folders; assign folders using the
keyboard; and make folders public.

Folders are the basic organizational container for your information and are used for
organizing, collecting, and cross-referencing items.  Every item goes into a folder, but an
item can exist in many folders at one time.  You can view folders in the folder window,
view the contents of any folder in a Notepad, and you can insert and view folders as
folder columns in the column pane of any view.  For more information, see the chapter or
online help on “Folders.”

Folder:  Assign Folders

After you choose this command, clicking a folder name opens the folder options pop-up
menu.

Folder:  Edit Folders

After you choose this command, you can use the folder window to rename folders,
reorganize the folder outline, add new folders, view a folder type, change default
properties, delete folders, or make folders public.
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Folder:  Find Folder

Displays a Find dialog box, in which you specify all or part of the name of the folder you
want to find in the folder window.

Folder:  New Folder

Inserts a new folder after the selected folder in the folder window. Alternatively, you can
insert a new folder by pressing the ENTER key.

Folder:  Folder Type

Lets you view or change the type of the selected folder.  If a folder currently contains
items, you cannot change the folder’s type.  Also, you can’t change the type of any default
folder, such as PhoneBook or Appointments.  Folder types allow you to associate a
checkmark, text, numbers, or dates with items when you add the items to folders.  This
command is available only when you have previously chosen the Edit Folders command.

Folder Type:  Text

Makes the selected folder a text folder, which allows you to associate additional text with
each item you add to the folder.

Folder Type:  Number

Makes the selected folder a number folder, which allows you to associate a number with
each item you add to the folder.

Folder Type:  CheckMark

Makes the selected folder a checkmark folder, which allows you to associate a checkmark
with each item you add to the folder (rather than associating a number, text, or a date).
Checkmark is the default folder type.

Folder Type:  Date

Makes the selected folder a date folder, which allows you to associate a date and time
with each item you add to the folder.  Items added to a date folder automatically appear in
the Calendar on the appropriate date and time.

Folder Type:  Pop-Up List

Displays the Pop-Up List Column Values dialog box, in which you can specify a pop-up
list of values.  When you add an item to a pop-up list folder, you can associate one of the
values in the pop-up list with the item.
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Pop-Up List Column Values dialog box

Edit box  Type here to edit the text of a pop-up list value.

Pop-up Value button  Creates a new value.  Displays “Value 1” in the Edit box.  Type in
the Edit box to specify new value text.

Delete button  Deletes the selected value.

Reorder buttons  Move the selected value up or down one line at a time.

Folder:  Properties

This command is available only for number folders, date folders, and pop-up list folders.

If a number folder is selected, this command displays the Number Properties dialog box,
in which you can select a number format.

If a date folder is selected, this command displays the Date Properties dialog box, in
which you can specify properties for the selected date folder.  If you often set alarms, or if
you like to display tickler items a particular number of days before an appointment, you
can change the default settings to the settings you use most often.

Date Properties dialog box

Default Settings for new Items:  Specifies Tickler, recurrence, alarm, and Busybar
settings for new appointments or any items you add to date folders.

Show Item in Calendar’s Tickler Section  If checked, new items added to the
folder are displayed in the Calendar’s Tickler section by default.

Beginning  Specify the number of days or weeks before a tickler item’s date that you
want to begin displaying it in the Tickler section.  This gives you advance warning
for an event on a specific date.
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Ending  Specify the number of days or weeks after the tickler item’s date that you
want to stop displaying it in the Tickler section.  Alternatively, you can choose to
display the item in the Tickler section until it is marked Done.

Default Recurrence  Specify a recurrence option.

Default Alarms  Specify an alarm.

Calendar Busybar Color  Specify a color for the appointment’s busybar in the
Calendar.

Entering Dates  Specify options for displaying a value edit box or the Date Settings
dialog box when you enter dates.

Initial Display   Specify keyboard or Date Settings dialog box options for entering
dates.

Keyboard Entry   When you edit a date value, displays a value edit box in which you
can enter a date.

Date Settings Dialog  When you edit a date value, displays the Date Settings dialog
box, in which you can select dates or use other date settings options.

Appt. Time Fields  Specify display options for the Appointment Time fields.

Always Displayed  Always displays the appointment time fields at the bottom of the
Date Settings dialog box.

Optional  Displays the appointment time fields at the bottom of the Date Settings
dialog box only when you’re setting an appointment.

Folder:  Auto Assign Rules

Displays the Auto Assignment Rules dialog box, in which you can automatically add all
items containing text you specify (the assignment rule) to the folder selected in the folder
window.

Auto Assignment Rules dialog box
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Edit   Type here the text (the assignment rule) of the items you want to add automatically
to the folder selected in the folder window.

New button  Adds a new rule (Rule 1) to the Edit text box.  Type over this text to add a
new rule.

Delete button  Deletes the selected rule.

Folder:  Delete Folder

Removes the selected folders and their subfolders from all views and the folder window,
without copying them onto the Clipboard.  Removes items from the folders without
removing items from the file.

Because any item can appear in many folders, deleting a folder does not delete the items it
contains.  You can delete items in any folder by displaying the folder in a view and
deleting items from the view.  You can also search for any items and collect them in the
Search Results folder using the Find command.

You can’t remove any of the default folders, such as PhoneBook and Appointments.

This command is available only when you have previously chosen the Edit Folders
command.

Folder:  Assign/Search by Keys

Allows you to use the keyboard in the folder window.  When you choose this command,
the folder most recently selected in the folder window changes to black.  Type any letter
to find the next folder whose name begins with that letter; type it again to find the next,
and so on.  You can move the highlight with the up and down arrow keys.  Press the left
arrow key to hide subfolders, press the right arrow key to expand subfolders, and press
the SPACEBAR or the ENTER key to display the folder options pop-up menu.

Folder:  Add Folders to View

Adds the folders you have selected to the bottom of the active Notepad.  The items in
these folders will be displayed in the view.  Alternatively, you can add folders to a
Notepad by dragging them from the folder window into the view.

Folder:  Show Folder Column

Inserts a folder column that shows a checkmark (for checkmark folders) or a column
value (for folders that have a type other than checkmark) for each item that is in the
selected folder.  The checkmark or value appears in the column, on the same line as the
item.

Alternatively, you can add folder columns to a view by dragging folders from the folder
window into the column pane of any active view.
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Folder:  Make Public

Makes the selected folder public for use by others over a network.

This command is valid only if you’ve previously connected to a shared file by choosing
the Share This File command from the Network options on the File menu.

Folder Options Pop-up Menu
This menu pops up when you have chosen the Assign Folders command from the Folders
menu, and then either

• Click a folder button, to the far left of a folder name; or

• Choose a folder name and press the ENTER key.

The folder options pop-up menu

Commands on this menu let you add items to folders, remove items from folders, and
show the folder’s items in the active Notepad.

Folder Options:  Add Selected Items to Folder(s)

Adds the selected items in the active view to the selected folder(s) in the folder window.
To add items to multiple adjacent folders, drag the mouse pointer through the folder
buttons for the desired folders.  If you select multiple folders that have values (folders of
any type other than checkmark), the Specify Folders and Column Values dialog box
appears, in which you can associate a value with the items in each folder.

Folder Options:  Remove Items from Folder(s)

Removes the selected items and their associated values from the folder or column.

Folder Options:  View Folder’s Items

Displays the folder and its items in a scratch Notepad, replacing any folders previously in
the scratch view.

Shooter Menu
Using Shooter menu commands, you can send, or “shoot,” selected information from
other programs to ECCO views or folders, from ECCO views to other programs, or
between other programs.  Click the Shooter icon to display its menu.

The Shooter menu

Depending upon the preference you have selected, ECCO might display the Send Text
Selection As dialog box or the Send Graphics Selection As dialog box before sending
your information.  The only difference between these dialog boxes is that the Send
Graphics Selection As dialog box does not have an Editable Text option.
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When the information has been sent, a small Item Sent message window appears briefly
next to your Shooter icon.  For more information, see the chapter or online help on
“Using ECCO with Other Programs.”

Send Text Selection As dialog box

Editable Text  Sends your selection to ECCO as editable text.  In addition, many
applications add special hidden characters to the text you see on the screen.  For example,
word processors and telecommunications applications typically add hidden control
characters (carriage returns) at the end of each line of text.  When you select and shoot
this kind of editable text, Shooter sends the text and includes all the carriage returns
embedded within the text.  Unless you select one of the following options, Shooter sends
each line as a separate item.  ECCO creates multiple outline items for every line ending
with a carriage return.

Only One Item  Sends your selection as one item.  Each line in your selection is a
separate paragraph within that item.

Fewer Paragraphs  Sends your selection as one item.  All lines in your selection become
a single paragraph in that item.

OLE Link   Sends your selection to ECCO as linked text or graphics.

OLE Object  Sends your selection to ECCO as an embedded object.

Always Ask When Sending  Displays the Send Text Selection As dialog box every time
before sending.  Canceling this option prevents the dialog box from appearing when you
send selections in the future.  To reinstate the dialog box, choose Preferences from the
Shooter menu, choose either Send Text As or Send Graphics As, and then choose Ask
Before Sending.

Shooter:  Active View

Sends the selection to the active view or to the most recent ECCO view.

Shooter:  Calendar

Sends the selection to the Calendar.  After you choose OK in the Send Text Selection As
dialog box, an appointment edit box appears, in which you can set date and time options
before sending the selection by clicking the ENT button or pressing the ENTER key.  If no
time is specified, the selection is sent to the Tickler section of the Calendar. If a time is
specified, the selection is sent to the Appointment section.

Page 358



ECCO User’s Guide350

Shooter:  Folders

Displays the Shooter toolbar and the folder window (which contains a list of all the
folders in your ECCO file).  Choose the folders to which you want to send the selection.
To close the window, double-click the Shooter icon or, from the Shooter menu, choose
the Close Folders command.

Shooter:  Relative to Last

Sends the selection to the same level as the last selection you sent, one level to the right of
the last selection (as a subitem), or one level to the left of the last selection.

Shooter:  <Other Program>

Displays a list of active files of the other Windows programs that are currently running,
from which you can choose where to send your selection.  If you choose this command
while ECCO is active, the command inserts the text into and switches you to the program
you choose.

Shooter:  Show

Specify the display of the Shooter and its icon, the Shooter toolbar and the folder window.
If you hide the Shooter, you can display it again by switching to ECCO and choosing the
Show Shooter command from the Tools menu.

Shooter:  Preferences

Changes the default Shooter settings.

Preferences:  Choose ECCO File

Selects the ECCO file to which you want to send information.  Choosing the Open
Another command displays the File Open dialog box, from which you can select other
ECCO files.  All open ECCO files are listed at the bottom of this menu.

Preferences:  Send Text As

Changes the default settings for sending text as editable text, OLE linked text, or an OLE
embedded object, and changes the default setting to display or hide the Send Text
Selection As dialog box before sending text.

Preferences:  Send Graphics As

Changes the default settings for sending graphics as OLE linked objects or OLE
embedded objects and changes the default setting to display or hide the Send Graphics
Selection As dialog box before sending text.

Shooter:  Add By Form

Displays a list of existing forms that you can apply to the current selection.
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Shooter:  Get Address

Displays the Get Address dialog box, in which you can get an address from your
PhoneBook.

Get Address dialog box

The dialog box contains the following fields:

Search Text box Displays any text you have selected.  You can also type in any
name in your PhoneBook for which you want to get an address.

Search button Searches for the text you specified in the PhoneBook of the
active ECCO file.

PhoneBook Names Lists the PhoneBook names that matched the search text you
specified.

Phone Specify whether you want to include work and fax phone
numbers, or all fields, in the address you get.

Address Specify whether you want to get the home or business address.

OK button Choose to copy the address into the active document in the
active program

Shooter: Go To ECCO

Switches you to the active view in ECCO.

Shooter: ECCO Shooter Help

Opens online Help for the Shooter.  For more information, see the chapter or online help
on “Using ECCO with Other Programs.”

Date Settings Commands
The Date Settings commands appear on menus that are available from the buttons in the
Date Settings dialog box.  For more information, see the chapter or online help on “The
Calendar.”
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The Date Settings dialog box

Alarms Menu
Commands on this menu let you create a custom alarm.  You use alarms to get advance
warning for important events.  For more information, see the chapter or online help on
“The Calendar.”

The Alarms menu

Alarms:  None

Removes the alarm from the selected item.

Alarms:  Custom

Displays the Alarms dialog box, in which you can specify parameters for a new alarm for
the selected item.

The dialog box contains the following fields:

Invoke Alarm at time of appointment Specifies whether the alarm will go off at
the time of the selected appointment.

Additional Alarms before appointment Sets additional alarms to occur minutes,
hours, days, weeks, or any combination of
time increments before the specified date.
Selecting multiple options will cause
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alarms to go off multiple times before the
event.

Follow-Up Alarms after appointment Sets additional alarms to occur minutes,
hours, days, weeks, or any combination of
time increments after the specified date.

Add to Menu Adds the named alarm to the Alarms menu
so that these same settings can be used for
other appointments or to-do’s.

Rename Renames the alarm for the menu display.

Options button Expands the dialog box to display the
following additional options:

Dialog Message Specifies that you want to display a dialog
box message; type the text of the message
in the adjacent box.  By default, an alarm
displays a dialog box with the item’s text.

Play Sound Specifies a sound file you want to play at
the alarm time.  Choose the Browse button
to select a file.

Launch Document/.BAT File Specifies a document or a .BAT file you
want to launch at the alarm time.  Choose
the Browse button to select a file.

Confirm Before Launch Displays a dialog box asking

you to confirm that you want to launch the specified document or .BAT file.

Alarms:  <Named Alarms>

Displays the list of named alarms.  The default named alarm is Simple Alarm.

Recur Menu
The Recur button in the Date Settings dialog box displays the Recur menu.  From this
menu, you can create a custom recurring event or a standard recurring event, or you can
change an existing recurring event into a non-recurring event.  For more information, see
the chapter or online help on “The Calendar.”
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The Recur menu

Recur:  Non-Recurring

Removes the recurring event attributes from an item.

Recur:  Custom

Displays the Recurring Event dialog box, in which you can create a custom recurring
event.

Recurring Event dialog box

The dialog box contains the following fields:

Type Specify the kind of recurrence you want for the recurring event. The
options are: daily, weekly, monthly by date, monthly by weekday,
monthly by business day, and yearly.

On Specify the dates on which you want to recurring event to take
place, such as the 16th of each month.  You can choose as many of
these options as you want.

Repeating Specify the frequency of recurrence.  For example, if you choose the
Monthly By Date option, you can specify recurrence ranging from
every month to every 20 months, or specific selected months to be
repeated every year.

Until Specify the date you want to end the recurring event.

Recur:  Every Day

Sets the event to recur daily.
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Recur:  Every Mon thru Fri

Sets the event to recur every weekday.

Recur:  <Date-Specific Options>

Sets the event to recur at a weekly, monthly, or yearly interval based on the selected
item’s date.

Group Menu
Using the commands on this menu, you can schedule group meetings, as well as keep time
available in your Calendar for other meetings or appointments.

Group:  Make Group Meeting

Displays the Change Appointment to Group Meeting dialog box, in which you can set up
a meeting, invite meeting attendees, schedule meeting resources, and so forth.  This
dialog box is identical to the Schedule Group Meeting dialog box.

Group:  Keep Time Available

Schedules the meeting in your Calendar without blocking out time in the group
availability database.  In this case, ECCO does not display a possible schedule conflict
error message if another user schedules a group meeting with you at that time.  This
command is useful if you want to be aware of an event but don’t plan to attend.
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Appendix A:  Keyboard and Mouse
Shortcuts

File Menu
To choose Press

New (file not based on a template)ALT+F+N

Open CTRL+O

Save CTRL+S

Print CTRL+P

Exit ALT+X

Edit Menu
To choose Press/Click

Undo CTRL+Z

or ALT+BACKSPACE

Cut CTRL+X

or SHIFT+DELETE

or click right mouse button and choose command
from pop-up menu

Copy CTRL+C

or CTRL+INSERT

or click right mouse button and choose command
from pop-up menu

Paste CTRL+V

or SHIFT+INSERT

or click right mouse button and choose command
from pop-up menu

Delete Items CTRL+D

or click right mouse button and choose command
from pop-up menu;
or if whole item is selected, press DELETE or
BACKSPACE
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To choose Press/Click

Find CTRL+F

Find Next CTRL+N

Insert Date Stamp CTRL+Q

Insert New Line (in item) SHIFT+ENTER

Insert Tab (in item) CTRL+T

Working with Windows
To Press/Click

View the Calendar ALT+1

View the PhoneBook ALT+2

View Notepads (first through
seventh created)

ALT+3 through ALT+9

View meeting mail ALT+B

Get Help on the active view F1

Copy item(s) between views in the
same window

Click item(s) and drag between views

Move clockwise between views in
active window

CTRL+TAB

Move counter-clockwise between
views in active window

CTRL+SHIFT+TAB

Open column pane, or switch to or
from column pane

F11

Notepads: splits the active
window, or switches between top
and bottom panes of the window.
Calendar: switches between the
Appointment section and the
Tickler section.
PhoneBook: switches between the
PhoneBook list and the
PhoneBook entry form.

F12
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Moving the Cursor
You can extend your selection by holding down the SHIFT key with any of the following
key combinations.

To move Press

One character left LEFT ARROW

One character right RIGHT ARROW

One word left CTRL+LEFT ARROW

One word right CTRL+RIGHT ARROW

To end of line END

To beginning of line HOME

To previous item at same level CTRL+UP ARROW

To next item at same level CTRL+DOWN ARROW

To previous item at level to left CTRL+PAGE UP

To next item at level to left CTRL+PAGE DOWN

To beginning of view CTRL+HOME

To end of view CTRL+END

One screen down PAGE DOWN

One screen up PAGE UP

Clockwise between views in
active window

CTRL+TAB

Counter-clockwise between views
in active window

CTRL+SHIFT+TAB

Outlining
To Press/Click

Add item at same level as selected
item

CTRL+ENTER
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To Press/Click

Add item right (indented subitem
one level below selected item)

CTRL+R

or click right mouse button and choose Add Item
Right or Add Outline Note from pop-up menu;
or, if no subitems exist, double-click item bullet

Add item left (one level above
selected item)

CTRL+L

Show item’s folder values Click right mouse button and choose Show Item
Info from pop-up menu

Show subitems (levels 1
through 9) in view

CTRL+1 through
CTRL+9

Show subitems (levels 1 through
9) of selected items

SHIFT+CTRL+1 through 9

Display the Show Levels dialog
box

CTRL+W

Hide (collapse) subitems of
selected items

CTRL+H

or, double-click
item bullet

Expand (show) next level of
subitems of selected items

CTRL+E

or double-click
item bullet

Delete single subitem containing
no text

Double-click item bullet of parent item

Expand (show) all subitems of
selected items

CTRL+G

or ALT+double-click
item bullet

Select sequential items SHIFT+UP ARROW

or SHIFT+DOWN ARROW

Select nonsequential items CTRL+click item bullets

Move item(s) right TAB

or ALT+RIGHT ARROW

Move item(s) left SHIFT+TAB

or ALT+LEFT ARROW

Move item(s) up ALT+UP ARROW
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To Press/Click

Move item(s) down ALT+DOWN ARROW

Mark item(s) as done CTRL+M

or click right mouse button and choose command
from pop-up menu

Make item(s) private Click right mouse button and choose command from
pop-up menu

Sort items by column value Click right mouse button in Column pane and
choose Sort, Sort Up, or Sort Down from pop-up
menu

Insert new line (line break) in text
in a cell of a text column

CTRL+ENTER

Delete one character of item text
to right of cursor

DELETE

Delete item text to beginning of
word

CTRL+BACKSPACE

Display Shooter menu in another
program

CTRL+ALT+S

or CTRL+ALT+any other letter you specify in the
ECCO Preferences dialog box

Dial phone CTRL+F3

or click right mouse button and choose command
from pop-up menu

Formatting
To Press/Click

Display the Character dialog box CTRL+K

or click right mouse button and choose command
from pop-up menu

Apply bold formatting CTRL+B

Apply italic formatting CTRL+I

Apply underline formatting CTRL+U

Remove character formatting CTRL+SPACEBAR

Page 370



ECCO User’s Guide362

To Press/Click

Display the Outline Styles dialog
box

CTRL+Y

Apply a Format menu command
or toolbar button to the outline
style of selected levels

CTRL while choosing the command or toolbar button

The Calendar
To Press/Click

Add tickler item below selected
tickler item

ENTER

Add item right (outline note as
subitem)

CTRL+R

or select appointment and press ENTER

Open an appointment edit box for
selected tickler item or
appointment

F2

Go to today ALT+G

Go to date—specify date or
number of week

F4

Go to next day F10

Go to previous day F9

Go to next month F8

Go to previous month F7

Go to next year F6

Go to previous year F5

Display the Calendar by day ALT+D

Display the Calendar by week ALT+K

Display the Calendar by month ALT+M

Display the Calendar by year ALT+Y
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To Press/Click

Switch between summary and
detail displays of week or month

SHIFT+F10

Switch between Tickler section
and Appointment section

F12

Dial phone CTRL+F3

or click right mouse button and choose command
from pop-up menu

The PhoneBook
To Press/Click

Add a new PhoneBook name
(item)

F3

or ALT+W

or ALT+A

Delete a PhoneBook name (item) CTRL+D

Add item right (outline note as
subitem)

CTRL+R

or select PhoneBook item and press ENTER

Show all PhoneBook names
(items)

ALT+CTRL+A

Show or hide PhoneBook form F2

Use the standard PhoneBook formALT+CTRL+1

Switch between the PhoneBook
list and the PhoneBook form

F12

Use other PhoneBook forms
(second through ninth created)

ALT+CTRL+2 through ALT+CTRL+9

Search in the PhoneBook ALT+S

(Then type search text and press ENTER)

Search for the next occurrence ALT+N

Specify search options ALT+CTRL+S

Specify address printing options ALT+CTRL+P

Query by form ALT+Q
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To Press/Click

Dial phone CTRL+F3

or click right mouse button and choose command
from pop-up menu

The Toolbar
To Press/Click

Show or hide toolbar Click Show/Hide Toolbar button (on status bar, left
of date and time)

Add button to toolbar Click right mouse button on icon in Repeat box and
drag icon to desired toolbar location

Insert or remove space between
toolbar buttons

SHIFT+click right mouse button between the toolbar
buttons

Move toolbar button Click right mouse button and drag

Move toolbar button groups CTRL+click right mouse button and drag

The Folder Window
To Press/Click

Display the Folder menu ALT+L

Create a new folder Click right mouse button and choose command from
pop-up menu

Add folder(s) to any Notepad Drag folder(s) from folder window to a Notepad
or click right mouse button and choose command
from pop-up menu

Add folder(s) to a scratch Notepad Double-click folder name in the folder window
(after you have chosen to assign folders)

Insert folder column(s) Drag folder(s) from Folder window to column pane

Expand and collapse subfolders of
a folder in the folder window

Click plus or minus icon

Change folder type Click right mouse button and choose command from
pop-up menu

Find folders CTRL+F
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To Press/Click

Make folder(s) public Click right mouse button and choose command from
pop-up menu

Assign folders Click to the left of the folder icons
or click right mouse button and choose command
from pop-up menu

Assign selected item(s) to folders
by keys (after you have chosen to
assign folders)

CTRL+A

or click right mouse button and choose command
from pop-up menu
(Then use ARROW KEYS to select folder(s), and press
ENTER twice)

Edit folders Click the folder window title bar
or double-click folder buttons (to the left of the
folder icons)
or click right mouse button and choose command
from pop-up menu

View folder properties (after you
have chosen to edit folders)

Click right mouse button and choose command from
pop-up menu

Edit folder names in the folder
window (after you have chosen to
edit folders)

Double-click folder name

Delete folder(s) from the folder
window  (after you have chosen to
edit folders)

CTRL+D

or click right mouse button and choose command
from pop-up menu
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Appendix B.  Glossary

Access Privileges
Access privileges allow you to control who has access to your shared files on the
Workgroup Directory. You can specify general (or default) privileges, or you can grant
special access privileges for each user.

Active view
A view must be active before you can work in it. To make a view active, click its tab. In a
composite view, click anywhere within the border of the Calendar, PhoneBook, or
Notepad you want to make active.

Add
To collect like items by dragging them into folders, thereby adding them to the folders.
When you drag an item from any view into a folder in the folder window, the item
remains in the original view as well.

Administrative Assistant
An individual who has been granted special privileges for another user. Administrative
assistants can change schedules and respond to meeting requests for another user. A user
can grant administrative assistant privileges to only one person at a time.

Alarm
An ECCO feature that lets you display a message or trigger an action associated with an
event or any item. You can set an alarm to go off at the time of the event; minutes, hours,
days, or weeks before or after the event; or any combination of those settings. You can
also set alarms to display dialog messages, play sounds, and launch documents or batch
files.

Alarm files
ECCO automatically saves all of your alarm settings (including text, date, time, alarm
type, and so forth) in a special alarm file (ECCO.ALM). ECCO updates this file
automatically each time you create a new alarm or change an existing alarm.
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Alignment
The horizontal arrangement of text within the width of a column. You can align
information in columns by centering, left-aligning, or right-aligning it.

Application Program Interface (API)
A standard used for communicating and exchanging information with other programs.
ECCO’s Dynamic Data Exchange (DDE) based API provides the ability to exchange
information between ECCO and other Windows programs that support DDE. See
API.ECO for a listing of programming commands.

Appointment
An item you type into the Appointments section of the Calendar. Other items that are
associated with a time value are also appointments and appear in the Appointments
section.

Appointment edit box
A value edit box for a date column. You can display the Date Settings dialog box from an
appointment edit box by choosing INS. See also value edit box.

Appointment section
The area of the Calendar in which you schedule, view, and edit appointments.

Attribute
A formatting characteristic applied to text. Character style, such as bold or italic; font,
such as Helvetica or Times Roman; point size; and color are all examples of formatting
attributes.

Availability Database
ECCO saves all currently scheduled meeting times for all ECCO users in an ECCO Group
Availability Database (ECCO_GRP.ADB) on the network server. Each time a user
schedules a meeting, ECCO checks this database to determine the availability of the
selected attendees. ECCO then displays this information in the Schedule Group Meeting
dialog box.

Backup files
Using ECCO’s automatic backup feature (default is enabled), ECCO creates a new
backup copy (with the extension .BK1, .BK2, and so forth up to the number specified) of
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your Calendar, PhoneBook, and Notepad information each time you exit ECCO or save
your files.

Busybar
The vertical bar you can display in the Sidebar of the Calendar window that shows you at
a glance your scheduled appointments. Use the Busybar to change the time and duration
of appointments. The block in the Busybar shows the time and the duration of each
scheduled appointment. You can drag a Busybar block to change the time and duration of
an appointment.

Calendar
In the Calendar, you can schedule appointments, remind yourself of upcoming meetings,
set alarms, and add tickler items for important engagements. Using the group scheduling
feature of ECCO, you can schedule group meetings.

Calendar/PhoneBook button
The button in the upper-right corner of both the PhoneBook and the Calendar that you
choose to display the two views side by side. Drag any name from the PhoneBook to any
day or time in the Calendar to automatically make an appointment.

Call logger
A feature that logs the time, date, and duration of your calls and stores the information in
the Phone Log column.

Checkmark column or folder
A type of column or folder that displays checkmark values. For example, you might use a
checkmark column to mark an item as personal. A checkmark folder is the default folder
type.

Close box button
The button in the upper-left corner of any window and some dialog boxes that you choose
to close the window or dialog box.

Collapse
To hide an item’s subitems. Do this by double-clicking an item bullet, or by choosing
Show Sub-Items from the Item menu and then choosing Hide.
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Column
A spreadsheet-style display that contains specific information about items. Column values
can be text, numbers, checkmarks, dates, pop-up lists, or Gantt charts. A column displays
folder values associated with the folder of the same name.

Column heading
The gray area at the top of a column. The column heading contains the name of the
column. When you create a new column and assign it a heading, ECCO automatically
makes the column into a new folder (with the same name) and adds it to the list of folders
in the folder window under the “New Columns” folder. When you click a column heading
with the right mouse button, the Column menu appears. To minimize a column, double-
click its column heading.

Column pane
An area of each view in which you can display specific information about items. You can
create columns that display text, numbers, checkmarks, dates, and Gantt charts.

Comma-separated values
A text file format that includes columnar data surrounded by quotation marks and
separated by commas. For example: “James Monroe”, “212-555-6423”, “1234 Any
Street”.

Common ECCO file
When a file is shared with privileges greater than See Available Time For Group
Scheduling, ECCO creates a common file in the Workgroup Directory. This file has the
extension .ECC and contains all public information.

Composite view
A view to which you have added one or more additional views. Using the Add View To
Window command on the View menu, you add additional views to the one you are in,
allowing you to see anywhere from two to four views side by side.

Context parent
Green-shaded items that would not ordinarily appear in a particular Notepad , but are
included to provide context.

CSV
See comma separated values.
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Cumulative label
A series of numbers and letters to the left of an item in a Notepad. For example, a
cumulative fourth-level outline label might display “1.A.1.a.”, whereas a noncumulative
fourth-level label would display only “a.” Used primarily to track item levels in long
documents.

Date column or folder
A type of column or folder that lets you associate a date with each item you add to the
folder. When you enter a date into a date column, you are both supplying a date for the
item on the corresponding line and adding that item to the folder whose name appears as
the heading of that column. Unless you specify otherwise, items with dates appear in the
Tickler section of the Calendar.

Date Settings dialog box
The dialog box in which you can change the time and date of appointments as well as set
tickler item options, alarms, and recurring events. Using the group scheduling feature of
ECCO, you can schedule group meetings. To display the Date Settings dialog box when
the Calendar is active, click an existing date or time.

Day, Week, Month, and Year buttons
Buttons at the far left of the Navigator that, when chosen, switch you between day, week,
month, and year displays of your schedule. Located in the Calendar.

Detail
A way of displaying your Calendar. When you display the Calendar in detail, you see the
appointment and tickler items for the selected week or month. You also see any outline
notes and whether an appointment or tickler item is recurring or whether an alarm or
group meeting has been set.

Detail/Summary button
Button to the right of the Day, Week, Month, and Year buttons that, when chosen,
switches you between the detail and summary displays of the Calendar.

Embed
See OLE object.

ENT (Enter) button
A button that, when chosen, enters the specified action and closes the value edit box.
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ESC (Escape) button
A button that, when chosen, cancels the specified action and closes the value edit box.

Event
An appointment, group meeting, or item that has a date associated with it. You can set
alarms for events or set an event to recur at specified intervals. See also recurring event.

Export
To copy items from an ECCO files to a text file. See also comma-separated values.

Filter
A feature of ECCO Pro that limits the items displayed in a view according to user-
definable column (or folder) criteria. For example, if you created a column titled
“Priority,” you could use a filter to display in the view only the items with a priority of
“high.”

Folder
Folders are containers of items used to collect and cross-reference related items.
Whenever you create items in any of ECCO’s views, you are actually adding them to a
folder. For example, when you create an appointment in the Calendar, ECCO
automatically adds that appointment item to a folder named “Appointments.” Similarly,
whenever you add a name to your PhoneBook, ECCO automatically adds that name to the
PhoneBook folder.

■ You can also drag any item to any number of additional folders in the folder window.
When you do so, the item remains in its original location as well.

■ You can see the items in any folder by double-clicking the folder to display it in a
scratch view.

For a complete understanding of folders, see the chapter or online help on “Folders.”

Folder button
A button along the left side of the folder window that, when chosen, displays the folder
options pop-up menu. Using this menu, you can add selected items to folders, remove
selected items from folders, or view folders’ items in a Notepad. A checkmark on a folder
button indicates that the selected items in the active view have been added to the
corresponding folder.
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Folder options pop-up menu
Using this menu, you can add selected items to folders, remove selected items from
folders, or view folders’ contents in a Notepad.

Folder value
A folder can store a value with each item it contains. A folder value gives you a way to
associate an additional piece of information with each item. Because an item can be
added to many different folders, each item can have many different values associated with
it.

Folder window
A window on the left side of the main ECCO window that displays your folders. Use the
folder window to

■ Add new folders.

■ Edit existing folders.

■ View folder types.

■ Change folder preferences.

■ Add items to folders.

■ Remove items from folders.

■ Choose folders whose items you want displayed in a Notepad.

■ Insert a folder into the column pane.

Form
A template that lists a set of fields and corresponding values that can be applied to an
item.

Gantt column
A column type. Gantt charts are bar charts that display task or project start and finish
dates and durations.

Group files
When you create a network file, ECCO saves your data in three files on the Workgroup
Directory:

■ ECCO saves your Calendar, PhoneBook, and Notepad information into the common
ECCO file with the extension .ECC.
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■ Access privileges and the changes log are stored in an ECCO file with the same
name, but with the extension .ECG. When other users share your group file, ECCO
creates a link to the selected .ECG file. As a result, you can share parts of the group
ECCO file — Calendar, PhoneBook, folders, Notepads, columns, and forms.

■ When you create a public file, ECCO also creates an ECCO Group OLE Object file
with the same name, but with the extension .ECB. This file contains all OLE objects
embedded in the group file.

Group meeting
An appointment that involves several users. ECCO shows you when other users in your
Workgroup Directory have appointments and meetings scheduled, allowing you to
schedule group meetings.

Group OLE Object files
When you create a public file, ECCO also creates an ECCO Group OLE Object file with
the same name, but with the extension .ECB. This file contains all OLE objects embedded
in the group file.

Home folder
The folder in which an item originated. For example, the home folder for an item first
entered in the PhoneBook  is the PhoneBook folder. You can display home folders in the
column pane.

Import
To bring a tab-separated file or CSV (comma-separated values) file from another
program into ECCO. You import into the active view.

Initialization file
ECCO saves the path for your Workgroup Directory, user identification, and other
program-specific settings in a special initialization file (ECCO.INI) in the Windows
directory on your local drive. ECCO updates this file when you change network
directories.

Initiator
The individual who initially schedules a group meeting. Only the initiator (or the
administrative assistant appointed by the initiator) can cancel or reschedule a group
meeting.
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Item
The primary unit of information in ECCO. Each item is a distinct element and has a item
bullet to its left. Items can have values (dates, numbers, and text) associated with them
and may have parent items or subitems, which are themselves items.

Item bullet
The icon at the left of an item that can be used like a handle to move the item up, down,
left, or right. Double-clicking an item bullet expands or hides the item’s subitems. A black
triangle at the lower-right corner of an item bullet indicates the item is collapsed and its
subitems are hidden.

Label
See outline label.

Letter tab
The letters on the left side of the PhoneBook  window. You choose a letter tab to display
all items beginning with that letter. For more information, see Chapter 4, “The
PhoneBook.”

Level
The relative horizontal position of an item in an outline.

Link
See OLE link.

Main file
When you create a main file, ECCO automatically saves your Calendar, PhoneBook,
Notepad, information and so forth in a file on the Workgroup Directory. The filename is
based upon your mail user identification.

All group meetings and appointments that you schedule in your main file are recorded in
the ECCO group availability, meeting, and user databases. You create a main file by
selecting the This Is The Main Calendar And PhoneBook For <Username> option in the
File Sharing & Access Privileges dialog box. (You can have only one main file.)

Make Private
An option that, when chosen, makes a Notepad, folder, column, or form unavailable for
use by others in a shared file. This option is available only if you’re using a shared file.
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Make Public
An option that, when chosen, makes a Notepad, folder, column, or form available for use
by others in a shared file. This option is available only if you’re using a shared file.

Master file
ECCO creates a master file with the filename extension .ECG when you first set up for
synchronization or when you first share a file. The master file holds a log of changes
made to the shared file. When no longer needed, those changes are discarded. When
sharing a file using ECCO’s network features, ECCO creates the master file in the
Workgroup Directory.

Meeting Database
ECCO saves information about all currently scheduled meetings in an ECCO Group
Meeting Database (ECCO_GRP.MDB) on the network server. This database contains
information about the group meeting, such as dates, meeting duration, subject of the
meeting, attendees, attendees’ status, notes, and so forth. Each time a user schedules a
meeting, ECCO checks this database for current information about the meeting, and then
displays this information in the public ECCO Calendar.

Minimized column
A column that has been narrowed. Minimized columns let you view more columns at once
or hide the information in columns you don’t currently need to see. You can skip (choose
not to print) minimized columns when you issue a print command. To minimize or restore
a column, double-click the heading at the top of the column.

Multiple-folder column
A column that displays in each cell a group of folders to which the item on the
corresponding line has been added. These folders must be subfolders of the folder whose
name appears in the column heading.

Navigator
A control in the Calendar that lets you move forward and backward by day, month, or
year.

Network files
When you create a shared file, ECCO saves your data in three files on the Workgroup
Directory:

■ ECCO saves your Calendar, PhoneBook, and Notepad information into the common
ECCO file with the extension .ECC.
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■ Access privileges are stored in an ECCO file with the same name but with the
extension .ECG. When other users share your group file, ECCO creates a link to the
selected .ECG file. As a result, you can share parts of the group ECCO file —
Calendar, PhoneBook, Notepads, folders, columns, and forms.

■ When you create a public file, ECCO also creates an ECCO Group OLE Object file
with the same name but with the extension .ECB. This file contains all OLE objects
embedded in the group file.

Notepad
A view showing one or more folders and the items in them. Each item in an outline can be
repositioned to a different level of indentation to express major and minor points. Items
can be expanded or collapsed to hide subordinate levels.

Number column or folder
A type of column or folder that lets you associate a number with each item. A number
column can be used to display a number value for each item in a view.

OLE link
A dynamic link between the data in an ECCO file and a file that contains the same data in
another program. Changes to the file in the other program are reflected in the data linked
to it (the data in the ECCO file). If the ECCO file is open, the data in the ECCO file is
automatically updated. If the ECCO file is closed, the next time you open it, you will be
asked whether you want to update the linked data.

Original file
A file as it exists before file sharing and synchronization take place.

OLE object
An embedded object in an ECCO file. Double-click an embedded object to open the
program in which the object was originally created. You can thereby edit or make changes
to the object without leaving ECCO or affecting the original source file.

Other shared files
Other shared files are used primarily for sharing information about special group projects.
You cannot schedule group meetings in these files; appointments that you schedule in this
file are not recorded in the ECCO group databases. (You can have an unlimited number
of other shared ECCO files, each with unique Calendar, PhoneBook, and Notepad
information.)
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Outline label
The number or letter to the left of an item bullet in a Notepad.

Outline note
An outline item added to a PhoneBook entry or Calendar item. To create an outline note,
select the item for which you want to create an outline note, and then press the ENTER key.
Press ENTER again to create more notes. Use the TAB key to indent items and SHIFT+TAB to
promote them. Double-click any item bullet to collapse or expand an item’s subitems.

Outline style
A set of character-formatting attributes that applies to a particular level of item in a view.
Using different outline styles for each level makes it easier to differentiate between your
outline levels.

Parent item
An item that has another item subordinate to it. The subordinate item is called a subitem.

Phone dialer
A PhoneBook feature that dials a phone number for you. See also telephone button.

PhoneBook entry form
An entry form in the PhoneBook in which you add new or modify existing PhoneBook
items.

PhoneBook
Use the PhoneBook to store phone numbers, addresses, and other information about your
friends, clients, business contacts, and others.

Pop-up list column or folder
A type of column or folder that lets you associate user-defined values with each item. For
example, a pop-up list for a column or folder titled “Priority” might include the values
High, Medium, and Low. When you select a cell in the “Priority” column, you can
quickly associate the degree of priority with the item on the corresponding line.

Public
A term describing a file, Notepad, folder, column, or form that has been made accessible
to others in a shared file. See also Make Public.
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Recurring event
An event that occurs at regular intervals. For example, if you have an appointment that
occurs every Wednesday morning, you could set a recurring event in the Calendar so that
ECCO automatically schedules your appointment on Wednesday of each week. You can
also make alarms and to-do’s recurring.

Repeat box
The box in the upper-right corner of the ECCO program window when the toolbar is
displayed that displays the icon representing the command last chosen. You can repeat a
command by clicking the icon with the left mouse button. You can customize your toolbar
by clicking the icon in the repeat box with the right mouse button and dragging the icon
onto the toolbar.

Replica
A special copy of a file that can be synchronized with the original file. You can have up to
250 replicas of a file, all of which can be synchronized in a variety of ways.

Search Results view
The ECCO view that displays the results of a search.

Shared File
A file that has been made available to the Workgroup Directory. Shared files can be
accessed by any ECCO user who has access to this directory.

Shooter
A tool that sends information from other programs to ECCO, from ECCO to other
programs, or between two other programs. Using the Shooter, you can insert, link, and
embed objects and selected information from other programs to or in ECCO views or
folders, from ECCO views to other programs, or between other programs. Choose the
Shooter icon to display its menu.

Sidebar
The area at the far left side of the Calendar that displays either the day, week, or month
Busybar, or a 3-month thumbnail.

Status bar
The bar at the bottom of the ECCO program window that displays the date, the time, and
messages to help you use ECCO, such as information about the selected command.
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Status area
The area in the Calendar that lies to the right of Calendar items. It shows whether an
appointment or tickler item is recurring and whether an alarm or group meeting has been
set.

Subfolder
A folder that is subordinate to another folder in the folder window. In other words, a
folder that is below and to the right of another folder.

Subitem
An item that is subordinate to another item. In other words, an item below and to the right
of another item. See also parent item.

Submenu
A menu that opens from another menu when you choose a command.

Summary
A graphical way of displaying the Calendar in date squares that resemble a paper
“planner,” with appointments and tickler items shown in each square. When you display
your Calendar in summary, you do not see outline notes, nor can you see whether an
appointment or tickler item is recurring or whether an alarm or group meeting has been
set.

Synchronization
The matching and updating of data between the master and remote ECCO files so that all
data in these files is consistent. ECCO provides three methods of synchronization:
automatic synchronization, synchronization using email, and manual synchronization.

Telephone button
A button located in the PhoneBook toolbar that, when chosen, displays the Dialer/Call
Logger dialog box.

Template
A preformatted ECCO file that may contain Notepads, folders, columns, forms, and filters
to help you become productive quickly. ECCO comes with a variety of templates to help
you get started. Each template includes customized Notepads, folders, columns, forms,
and filters. Templates have the file extension .ECT.
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Text column or folder
A type of column or folder that lets you enter or display text for each item in a view.
Using a text column, you can associate additional text or notes with each item.

Text touch-up
A group of character-formatting attributes that you name and store. Apply text touch-ups
to a range of selected text to override outline styles.

Tickler item
A note, reminder, or appointment displayed in the Tickler section of the Calendar that
“tickles,” or jogs, your memory.

Tickler section
Area of the Calendar in which reminders that “tickle” your memory—tasks you need to
do or upcoming appointments you need to prepare for—are displayed.

Toolbar
An ECCO feature that gives you quick access to frequently used commands. The toolbar
can be displayed across the upper part of the ECCO program window, ECCO views, and
the Shooter.

Top-level item
An item located at the highest (left-most) level of an outline. When you type top-level
items in a Notepad, they are automatically added to the folder.

User Database
ECCO saves information about ECCO users who share a directory on the network server
in an ECCO Group User Database (ECCO_GRP.UDB) on the network file server.

User Identification
When you choose a Workgroup Directory, ECCO adds your user identification to the
User Database. (Your ECCO network user identification is based on your mail system
user name and password.)

Value
A number, date, or additional text associated with an item. You can associate any number
of values with an item by entering those values into any number of columns.
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Value edit box
A pop-up box in which you enter or edit text, numbers, appointment times, dates, and
pop-up list values. The value you enter is associated with the selected item(s). See also
appointment edit box.

View
A window displaying the Calendar, the PhoneBook, or a Notepad. Every ECCO file
contains a Calendar, a PhoneBook, and any number of Notepads. See also composite
view.
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Index
1 Level Only command, 297
3-month sidebar display, 22
About ECCO command, 341
Accepting meeting request, 243
Access privileges

administrative assistant, 225, 246
default, 223, 225
described, 365
granting, 223, 225, 261
resource administrator, 250

Active view
described, 365

Active View command, Shooter menu,
347
Add, 365
Add Appointment dialog box, 27, 327
Add Appt. Item command, 27, 327
Add by Form

dialog box, 309
Add by Form command, Shooter menu,
348
Add by Form dialog box, 199, 216
Add File Name or Program to Menu
dialog box, 312
Add Folders to View command, 345
Add Group Meeting command, 233,
236, 237, 329
Add Item

command, 295
Left command, 295
Right command, 295

Add Multi-Day Appointment
command, 28
dialog box, 28

Add Multi-Day Appointment dialog
box, 327
Add Multi-Day Appt. command, 327
Add New Item by Form command, 199,
216, 309
Add Outline Note

command, Calendar menu, 45, 331,
332
command, PhoneBook menu, 336

Add Related Dates
command, 49
dialog box, 49

Add Selected Items to Folder(s)
command, 169, 346
Add Tickler

command, 31, 328
dialog box, 31, 328

Add Tickler Item dialog box, 31, 328
Add View to Window command, 294
Adding

appointments, 27, 327
buttons to toolbar, 92
folders to Notepad, 174, 345
group meetings, 233, 329
items, 295
items by form, 199, 216, 309, 348
items to folders, 165, 169, 346
multi-day appointments, 28, 327
outline notes, 45, 331, 332, 336
PhoneBook names, 335
related dates, 49
ticklers, 31, 33, 328
views to window, 294
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Adding files or programs to Get Disk
Files menu, 147
Address Printing command, PhoneBook
menu, 336
Address Printing Defaults dialog box,
336
Addresses

envelope printing, 284
getting with Shooter, 349
printing

home/business, 336

Adjusted Size command, Objects
submenu, 292
Administrative assistants, 225, 246

described, 365
Advanced filters, 208, 210
Alarms

actions, 38
canceling, 40
command, Tools menu, 36, 37, 38,
41, 315
creating, 36, 37, 40, 315, 350
custom, 36, 37, 40, 41
described, 36, 365
files described, 365
managing, 41, 317
menu, 40, 350
reviewing, 41, 316
simple, 36, 40

Alarms dialog box, 350
Alarms Occurred dialog box, 36
Alerts, restoring, 320
Aliases (See Meeting attendee groups),
236
Alignment

column, 187, 324, 325
command, Column menu, 187, 325
described, 366

All Subs command, Show Sub-Items
submenu, 297
Anchor dates, 48
Application program interface (API),
366
Apply Form dialog box, 200, 311
Apply Form to Items command, 200,
311
Applying

filters, 207, 208, 306
forms, 200, 311
outline styles, 81
text touch-ups, 79

Appointment section, 17
described, 366

Appointments
adding, 27, 327
changing, 29
default folders, 167
deleting, 30
described, 25, 366
edit box, described, 366
multi-day, 28, 327, 331
options, 23
scheduling, 27, 28, 29
section, 290
ticklers for, 31, 33

ASCII characters, exporting PhoneBook
as, 110
Assign Folders command, 166, 341
Assign/Search by Keys command, 345
Assigning folders, 166, 341, 345, 346
Attendee Status dialog box, 240
Attendees, meeting, 233, 235, 236, 237,
240, 244
Attributes

character formatting, 77
described, 366
outline styles, 81
text touch-ups, 79, 299
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Audio-video equipment (See Meeting
resources), 267
Auto Assign Rules command, Folder
menu, 171, 344
Auto Assignment Rules dialog box,
171, 344
Auto-assigning folders, 170, 171, 344
Automatic synchronization, 254
Autosave, 16, 320
Availability database, 235, 239

described, 366
Available, keeping time, 353
Backup files

described, 366
saving, 16, 320

Bar chart of dates (See Gantt columns),
324
Billing, 213, 214, 215, 217
Bold style, 299
Bottom pane, 290
Browse

Add as Item command, 311
Add to Menu command, 312

Busybars, 17, 22, 177, 332
described, 367

Calculate Sum dialog box, 191
Calculate Time and Expense Billing
dialog box, 217
Calculating

sums, 191
time & expense billing, 217

Calendar
Calendar menu, 326
columns, 47
command, Shooter menu, 347
command, View menu, 17, 292
customizing, 23
default folders, 167
described, 3, 17, 367
detail display, 20, 21

exporting from, 114
filtering, 207
group, 242, 332
importing date information into
Notepads, 107
main file, 223
menu, 326
navigating in, 332
options, 21, 23
Options command, 21, 23
PhoneBook, using with, 28, 332,
333, 339, 340, 341
printing, 48, 278, 280
sending selection to, 347
summary display, 20, 21
viewing, 14, 17, 19, 20, 292
window, 17

Calendar Options dialog box, 23
Calendar/PhoneBook button, 17, 28

described, 367
Call logger, 367
Calls

dialing, 338
logging, 216, 319, 338

Canceling
alarms, 40
group meetings, 241
recurring events, 45

ccMail, 255, 261
Chained dates, 49
Chameleon Z-Mail Pro, 255, 261
Change Appointment to Group Meeting
dialog box, 353
Change PhoneBook Form command,
336
Change Recurring Event dialog box, 44
Character

command, 77, 81, 187, 298
dialog box, 77, 81, 298
formatting, 77, 187, 298
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Chart of dates (See Gantt columns), 324
Checkmark column or folder, 367
Checkmark columns or folders

changing folder type, 342
described, 176, 188
inserting, 323
properties, 324
specifying symbol, 325

CheckMark command
Column menu, 325
Folder Type submenu, 342

Choose Column Set dialog box, 112,
114
Choose ECCO Default Printer dialog
box, 286
Choose ECCO File command,
Preferences submenu, 348
Choose Field Set dialog box, 110, 116
Choose Fields for Import into
PhoneBook dialog box, 105, 116
Choose File Name to Paste dialog box,
311
Choose Notepad Folders command,
174, 294
Choose Notepad Folders dialog box,
174, 294
Choose Users, Groups, and Resources
dialog box, 225, 233, 235, 236, 237,
242, 243, 244, 248, 250, 332

access privileges, 225
group calendar, 242, 332
group meetings, 233, 235, 236,
237, 243, 244
meeting resources, 248, 250

Close box button, 367
Close File command, 16, 261
Closing files, 16, 261
Collapse, 367
Color

Busybar, 22, 25, 177
outline styles, 300

text, 299
views (preference), 320

Color command, Format menu, 299
Color preferences, 269
Column Character Format dialog box,
77
Column Grid command, Display
submenu, 320
Column heading, 323, 325

dialog box, 323
Column menu, 322
Column pane, 54

column grid, 320
customizing, 187
described, 13, 184, 368
opening, 290
showing, 47, 323
switching to, 290

Column pane, resizing, 75
Column Properties dialog box, 192,
195, 324
Column values

printing, 102
Column Width dialog box, 187, 324,
326
Columns

(See also Folders), 323
(See also specific column types),
323
alignment, 187, 324, 325
calculating sums, 191
Calendar, 47
Calendar printing, 280
character formatting, 77, 187
Column Heading dialog box, 185
Column menu, 322
customizing, 187
described, 183, 184, 368
descriptions in cells (preference),
320
entering information, 75

Page 395



ECCO User’s Guide 387

entering values, 183, 186
examples, 183
exporting, 112, 114
heading, 185, 187, 368
importing, 105, 107, 114
inserting, 185, 190, 191, 195, 231,
323, 345
Make Public, 193, 231, 326
minimizing, 187, 326
moving, 187, 326
multiple folders (See Multiple-
folder columns), 193
printing Notepads, 282, 283
properties, 192, 195, 324
removing, 186, 324
sharing, 231
showing, 184, 187
showing item info, 295
showing more, 76
standard column sets, 192
types, 184, 185, 323
width, 187, 324, 326

Combining
Notepads, 114
PhoneBooks, 116

Commands
(See also specific commands), 13
adding to toolbar as buttons, 92
Date Settings dialog box, 349
Help on, 340
menu bar, 259
non-menu bar, 341
Shooter menu, 341

Comma-separated values, 105, 110
described, 368

Common ECCO file, 368
Composite view, 368
Computer

system requirements, 9

Computers, synchronizing (See
Synchronizing files), 251
Connecting to Workgroup, 221
Contents command, 340
Context parents, 86, 179, 181, 230

described, 368
Copy command, 287
Copying

Copy command, 287
files, 16

Copying information between programs,
139
Correspondence Manager, 339

command, 339
dialog box, 339

Country settings, 23
Create a New Filter dialog box, 210
Create an Alarm dialog box, 36, 37, 315
Create Meeting Resource command,
Network submenu, 267
Create Meeting Resource dialog box,
248, 267
Create New Alarm command, Alarms
submenu, 36, 37, 38, 315
Create New Form dialog box, 198, 307
Create New Gantt Column dialog box,
190, 324
Create Notepad dialog box, 174, 292
Create Notepad Options dialog box, 174
Create Phone Form dialog box, 336
Creating

(See also Inserting), 323
alarms, 36, 37, 40, 315, 350
files, 11
filters, 205, 210, 304
folders, 165, 167
forms, 198, 307
meeting resources, 248, 267
Notepads, 174, 292
outline labels, 83, 301
PhoneBook entry forms, 336
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recurring events, 42
related dates, 49
replicas, 257
templates, 12
text touch-ups, 79, 299
ticklers, 31, 33

CSV, 368
Cumulative labels, 83

described, 369
Custom Alarm dialog box, 37, 38
Custom alarms, 36, 37, 40, 41
Custom command, Recur submenu, 352
Custom Holiday dialog box, 23
Custom recurring events, 42
Customer Service, 6
Customizing

(See also Preferences), 320
Calendar, 23
column pane, 187
columns, 187
date folders, 177
Gantt columns, 191
holidays (options), 23
number folders, 179
pop-up list folders, 178
toolbar, 91, 92, 319

Cut command, 287
Daily events (See Recurring events),
352
Daily network backup, 16, 320
Database, 270

compact, 277
recover, 277
test, 277
test availability, 278

Date columns or folders
customizing, 177
described, 176, 188, 369
inserting, 323
properties, 177, 324, 343

Date Properties dialog box, 177, 324,
343
Date Settings dialog box

changing appointments, 29
changing ticklers, 34
commands, 349
creating recurring events, 42
creating ticklers, 33
described, 17, 25, 369
displaying, 331
scheduling group meetings, 233
setting alarms, 40

Date stamp, 290
Dates

bar chart of (See Gantt columns),
324
column formats, 324, 325
folder formats, 343
international formats, 23
moving to, 19
related, 48, 49, 51
stamp, 290

Date-Specific Options command, Recur
submenu, 353
Day

button, 17, 20
details, 21
Details dialog box, 21
moving to, 19
start of (preference), 23
viewing Calendar by, 17, 20

Day, week, month, and year buttons,
369
Declining meeting request, 243, 245
Default

access privileges, 223, 225
address printing, 336
column properties, 324
columns in Notepads, 192
folder properties, 177, 343
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folders, 167
template, 11

DEFAULT.ECT file, 11
Delegating meeting request, 243
Delete Folder

command, 168
dialog box, 168

Delete Folder command, 345
Delete Items

command, 30
dialog box, 30

Delete Items command, 172, 287
Delete Items dialog box, 287, 336
Delete Name command, 336
Deleting

(See also Managing), 317
(See also Removing), 294
alarms, 40, 316
appointments, 30
folders, 168, 345
group meetings, 241
items, 172, 287, 295
meeting mail, 246
PhoneBook names, 336
recurring events, 45
shared files, 229
values, 186

Demoting items, 181, 297
Detail display, 20, 21

described, 369
Detail/Summary button, 21, 369
Dial Phone command, 216, 338
Dialer/Call Logger dialog box, 216, 338
Dialing phone, 338
Dialog box messages

alarms displaying, 38, 350
restoring, 320

Directory, ECCO Workgroup (See
ECCO Workgroup Directory), 222
Directory, Workgroup (See ECCO
Workgroup Directory), 222
Disconnecting from shared file, 229
Disk files, 311

managing, 148
working with, 147

Display command, Tools menu, 320
Display options, 320
Documentation

16- vs. 32-bit, 6
described, 5
Getting Started Guide, 5
Online Help, 5
README.WRI, 6
TECHINFO.ECO, 6
User’s Guide, 5

Done
column/folder, 47
marking as, 34, 297
showing ticklers until, 33, 34

DOS text, exporting PhoneBook as, 110
Down command, Move Items submenu,
297
Downloading ECCO technical
information, 6
Drag and drop

adding folders to Notepads, 174
adding items to folders, 90, 165,
169
customizing toolbar, 92
inserting folder columns, 191
promoting/demoting/moving items,
90
scheduling appointments, 28, 90

Dynamic Help, 341
ECCO

Customer Service, 6
described, 1
documentation, 5

Page 398



ECCO User’s Guide390

exiting, 16, 286
files, switching between, 15
Help, 5, 340
installing, 9
navigating in, 12
online support, 6
options, 320
other features, 5
program window, 13
starting, 10, 320
system requirements, 9
Technical Support, 6
tutorial, 5
version of, 341

ECCO Workgroup Directory
connecting to, 221, 222
described, 221
files created in, 225

Edit Appointment or Tickler dialog box
adding outline notes, 45
changing appointments, 29
changing ticklers, 34
creating recurring events, 42
options described, 25
setting alarms, 40

Edit command, Objects submenu, 292
Edit Folders command, 166, 168, 230,
341, 342
Edit Form dialog box, 308
Edit Groups dialog box, 236, 237
Edit menu, 286
Edit Multi-Day Appointment dialog
box, 331
Electronic mail (See Mail), 261
Embedded objects

editing, 151
Embedding objects

Paste Special command, 287

End of day/week (Calendar options), 23
Enter (ENT) button, 186

described, 369
Entry form, 54
Envelope address position, 284
Equipment (See Meeting resources),
267
Ergonomic reminders, 42
ESC (Escape) button, 370
Event, 370
Every Day command, 352
Every Mon thru Fri command, 353
Existing Column or Folder command,
Insert Column submenu, 114, 185, 191,
323
Exit command, 16, 286
Exiting ECCO, 16, 286
Expand command, Show Sub-Items
submenu, 297
Expenses, billing for, 213, 214, 215,
217
Export, 370
Export Changes command, Synchronize
submenu, 253, 255, 266
Export Changes dialog box, 253, 255,
266
Export command, 105, 110, 112, 114,
116
Export Notepad and Columns dialog
box, 112, 114
Export Notepad dialog box, 112, 114
Export PhoneBook dialog box, 110, 116
Exporting

Calendar, 114
changes to synchronized file, 252,
253, 255, 266
described, 105
Notepads, 112, 114
PhoneBook, 110, 116
Timex® Data Link™, 119, 313
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Facilities (See Meeting resources), 267
File

compact, 277
menu, 259
Properties, 227, 229
recovery, 277
test data integrity, 277

File Import dialog box, 105, 107, 114,
116
File Manager, 311
File Open dialog box, 11, 259
File Properties, 16

command, 229
Connection Status tab, 229
Password tab, 227

File sharing
columns, 231
connecting to ECCO Workgroup,
221, 222
described, 221, 223, 261
disconnecting, 229
files created, 225
folders, 230, 231
granting access privileges, 225
Notepads, 230
opening shared files, 228, 259
wizard, 223, 225

File Sharing and Access Privileges
dialog box, 225, 250, 261
Files

backup, 320
closing, 16, 261
creating, 11
exporting (See Exporting), 105
importing (See Importing), 105
inserting references to, 311
launching, 38, 313, 350
main, 223
master, 225, 251
opening (See Opening files), 259

original, 251
replica, 251, 257
saving, 15, 16, 261, 286, 320
sharing (See File sharing), 261
switching between, 15

Files menu, 14, 15
Files to Launch command, Get Disk
Files submenu, 313
Filter Current View dialog box, 205,
208, 210, 304
Filter View command, 205, 210, 212,
304
Filters

advanced, 208, 210
applying, 207, 208, 306
creating, 205, 210, 304
described, 203, 304, 370
finding with, 86, 212
managing, 212, 305

Find
command, 85, 86, 212, 288
dialog box, 85, 86, 212, 288

Find and Replace dialog box, 87, 289
Find Folder command, 85, 288, 342
Find Next command, 85, 290
Find/Replace command, 85, 87, 289
Finding

and replacing, 85, 87, 289
folders, 85, 288, 342
items, 85, 86, 212, 288
next instance, 85, 290

Flags (See Ticklers), 31
Floppy disk, synchronizing with, 253
Folder buttons, 166

described, 370
Folder menu, 166, 341
Folder options pop-up menu, 169, 172,
173, 346

described, 371
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Folder Type command, 177, 342
Folder values

described, 175
Folder window

adding folders to Notepads, 174
adding items to folders, 169
command, View menu, 294
creating folders, 165, 167
deleting folders, 168
described, 14, 165, 166, 371
folder buttons, 166
organizing, 166
removing items from folders, 173
shared folders, 231
Shooter, 348
viewing, 165, 294
viewing item's folders, 180

Folder Window command, View menu,
165, 169, 231
Folders

(See also Columns), 323
(See also specific folder types), 342
adding items to, 165, 169, 346
adding to Notepad, 174, 345
assigning, 166, 341, 345, 346
auto-assigning, 170, 171, 344
choosing for Notepad, 174, 294
command, Shooter menu, 348
creating, 165, 167
creating Notepad from, 174
cutting, 287
default, 167
defined, 163
deleting, 168, 345
described, 163, 164, 165, 370
editing, 166, 341, 342
examples, 164
finding, 85, 288, 342
Folder menu, 341
Folder options pop-up menu, 346

folder window described, 165, 166
Help on, 341
Home folder, 326
inserting, 342
inserting as columns, 191, 323
levels and, 181
Make Public, 230, 346
moving, 166
multiple in column (See Multiple-
folder columns), 193
organizing in folder window, 166
properties, 177, 178, 179, 343
removing from Notepads, 175, 288
removing items from, 172, 173, 346
renaming, 168
sending selection to, 348
shared, 230, 231
showing item info, 179, 180, 295
Tickler section, 31
types, 175, 177, 342
value, 371
viewing contents, 173, 179
viewing in scratch Notepad, 165,
173, 346

Font command, 298
Fonts

applying, 298
outline styles, 300

Form, 371
Format

command, Column menu, 325
menu, 298

Formatting
date and number columns, 324, 325
date and number folders, 343
international dates and numbers, 23
items, 77, 298

Forms
adding items by, 199, 216, 309, 348
applying, 200, 311
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creating, 198, 307
described, 197
example, 197
expense, 216
Make Public, 232
managing, 202, 232, 308
PhoneBook (See PhoneBook
forms), 336
sending selection by, 348
sharing, 232
viewing items by, 201, 217, 310

FTP
launching address from ECCO, 218

ftp.netmanage.com, 6
Gantt columns

creating, 190, 324
customizing, 191
described, 189, 371
properties, 324

Get Address command, Shooter menu,
349
Get Address dialog box, 349
Get Disk Files command, 311
Go to ECCO command, 349
Go to Pane command, 290
Go to Today button, 17, 19
Granting access privileges, 223, 225,
261
Graphics

(See also OLE objects), 291
sending with Shooter, 346, 348

Group Calendar, 242, 332
Group Calendar Options dialog box,
332
Group files, 371
Group meetings

accepting request, 243
additional attendees, 244
administrative assistants, 225, 246
attendee groups, 236, 237

canceling, 241
changing attendees, 240
changing duration, 240
Date Settings dialog box, 25
declining request, 243, 245
delegating request, 243
described, 372
keeping time available, 353
meeting resources, 248, 250, 267
reading meeting mail, 242, 293
rescheduling, 239
reviewing schedule, 243
scheduling, 233, 239, 329, 353
selecting attendees, 235

Group menu, 353
Group OLE object files, 225

described, 372
Group scheduling

(See also Group meetings), 233
availability database, 235, 239
meeting database, 238

Heading
column, 187
command, Column menu, 187

Heading command, Column menu, 325
Heading, column, 185, 323, 325
Help

described, 5, 340
dynamic, 341
ECCO Customer Service, 6
ECCO Technical Support, 6
menu, 340
online, 5
Shooter, 349

Help on ECCO Folders command, 341
Help on this View command, 340
Hide command, Show Sub-Items
submenu, 297
Hide Form command, 337
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Hiding
column pane, 323
folder window, 294
levels, 296
PhoneBook entry form, 337
sidebar, 22
subitems, 297
toolbar, 91

Holidays, 23
Home folder, 326, 372
Ignore Filter command, 207, 306
Import, 372
Import Changes command, Synchronize
submenu, 253, 266, 268
Import command, 105, 107, 114, 116
Import ECCO Merge File dialog box,
266, 268
Import into Current View dialog box,
107, 114
Importing

changes to synchronized file, 253,
255, 266, 268
described, 105
Notepads, 107, 114
PhoneBook, 105, 116

Initialization, 372
Initiator, 233, 372
Insert Column command, 114, 185, 190,
191, 231, 323
Insert command, Edit menu, 290
Insert Date Stamp command, 290
Insert Folder Columns dialog box, 114,
185, 323
Insert Pop-Up List Column dialog box,
178, 324
Inserting

columns, 185, 190, 191, 195, 231,
323, 345
file references, 311
folders, 342
new line in item, 290

OLE objects, 291
tab in item, 290

Installing ECCO, 9
International settings, 23
Internet

launching, 313
launching addresses, 218
online support for ECCO, 6

Italic style, 299
Item, 373
Item bullets

described, 373
skipping, 84, 301

Item menu, 295
Item's Calendar Tickler Options dialog
box, 33, 34
Items

adding, 295
adding by form, 199, 216, 309, 348
adding to folders, 165, 169, 346
applying forms to, 200, 311
cutting, 287
defined, 163
deleting, 172, 287, 295
demoting, 181, 297
formatting, 77, 298
Item menu, 295
joining, 295
Make Private, 230, 298
moving, 297
promoting, 181, 297
removing from folders, 172, 173,
346
shared, 229, 230
showing item info, 179, 180, 295
sorting, 47, 88, 193, 303
splitting, 295
top-level, 88, 181
typing, 169
viewing by form, 201, 217, 310
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working with, 77
Join Items command, 295
Keep Time Available command, 353
Keyboard and mouse shortcuts

Calendar, 360
Edit menu, 355
File menu, 355
Folder window, 362
Formatting, 359
Moving the cursor, 357
Outlining, 357
PhoneBook, 361
Toolbar, 362
Working with Windows, 356

Language settings, 23
LapLink, 254
Launch command, 313
Launch Internet command, 218, 313
Launching

files, 38, 313, 350
Internet, 218, 313
other programs, 313

Launching other programs from ECCO,
146
Learning ECCO (See Tutorial), 5
Left command, Move Items submenu,
297
Left pane, 290
Letter tab, 373
Levels, 373

described, 181
folders and, 181
outline styles, 81, 300
showing, 296

Line, inserting in item, 290
Linked objects

editing, 152
Linked or embedded objects

deleting, 154
resizing, 154

Linking and embedding
introduction, 149

Linking objects
Paste Special command, 287

Links
changing, 153
updating, 152

Links dialog box, 291
List of values (See Pop-up list columns
or folders), 342
Locking shared files, 223
Logging

calls, 216, 319, 338
time, 216, 319

Lotus ccMail, 255, 261
Mail

ECCO preferences, 320
group meetings, 235, 238, 242,
243, 246, 293
merge files, 255
sending, 238, 261

Mail-merge
exporting records, 105, 110, 112,
114, 116
importing records, 107, 114, 116

Main file, 223, 373
Make Appointment or Tickler dialog
box, 28
Make Group Meeting command, 233,
353
Make Item Private command, 230, 298
Make Private, 230, 231, 298

described, 373
Make Public

columns, 193, 231, 326
command, Column menu, 326
described, 374
folders, 230, 346
forms, 232
PhoneBook entry forms, 337
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views, 230, 295
Make Public command

Folder menu, 346
Make Public command, Column menu,
193, 231
Make Public command, Folder menu,
230
Make View Public command, 230, 295
Manage command

Change PhoneBook Form
submenu, 337
Filter View submenu, 305
Notepads submenu, 293
Outline Labels submenu, 83, 302
Print Catalog submenu, 285
Text Touch-Ups submenu, 80, 300

Manage command, Filter View
submenu, 212
Manage Custom Holidays dialog box,
23
Manage Forms

command, 202, 232, 308
dialog box, 202, 232, 308

Manage Menu
command, Get Disk Files submenu,
312
dialog box, 312

Manage Named Alarms
command, 317
dialog box, 317

Manage Named Alarms command, 41
Manage Named Alarms dialog box, 41
Manage Named Filters dialog box, 212,
305
Manage Named Notepads dialog box,
293
Manage Outline Labels dialog box, 83,
302
Manage Page Setups

command, 286
dialog box, 286

Manage Phone Forms dialog box, 337
Manage Print Catalog Entries dialog
box, 285
Manage Text Touch-Ups dialog box,
80, 300
Managing

alarms, 41, 317
filters, 212, 305
forms, 202, 232, 308
Get Disk Files menu, 312
holidays, 23
Notepads, 293
outline labels, 83, 302
page setups, 286
PhoneBook entry forms, 337
print catalogs, 285
text touch-ups, 80, 300

Manual synchronization, 253
Margins, 278, 284
Mark as Done command, 34, 297
Marking items as done, 34, 297
Master file, 225, 251

described, 374
Meeting attendee groups, 236, 237
Meeting database, 238

described, 374
Meeting mail, 235, 238, 242, 243, 246,
293

command, 242, 293
Meeting Message dialog box, 242
Meeting Request dialog box, 243, 244,
246
Meeting resources, 248, 250, 267
Meetings, group (See Group meetings),
329
Menu bar

commands, 259
ECCO program window, 13

Menu Help command, 340

Page 405



ECCO User’s Guide 397

Menus
(See also specific menus), 12, 13
adding to toolbar, 93
Help on, 340
submenus, 93

Merge mail
(See Mail-merge, exporting
records), 105

Merging items, 295
Message window, 293
Messages

dialog box,alarms displaying, 350
displaying alarm dialog box, 38
mail (See Mail), 293
restoring dialog box, 320

Microsoft Exchange, 255, 261
Microsoft Mail, 255, 261
Minimize command, Objects submenu,
291
Minimized column, 374
Minimizing

columns, 187, 326
objects, 291

Month
button, 17, 20
moving to, 19
viewing Calendar by, 17, 20

Monthly events (See Recurring events),
353
Move Column command, 187, 326
Move Items command, 297
Moving

columns, 187, 326
folders, 166
items, 297
to dates, 19

Multi-day appointments, 28, 327, 331
Multiple computers (See Synchronizing
files), 251

Multiple-folder columns
described, 193, 374
displaying, 195
editing, 195
Home folder, 326

Named Alarms command, 351
Named Filters command, 306
Named Outline Labels command, 303
Named Text Touch-Ups command, 300
Names, PhoneBook (See PhoneBook
names), 335
Naming (See Creating, Managing,
Saving), 285
Navigate command, Calendar menu,
332
Navigating in ECCO, 12
Navigator, 374
Navigator (Calendar), 17, 19
NetManage

Chameleon Z-Mail Pro, 255, 261
ECCO Customer Service, 6
ECCO Technical Support, 6
FTP server, 6

Network
backup files saved to, 16, 320
backups, 270
files, 374

New CheckMark command, Insert
Column submenu, 323
New command

Change PhoneBook Form
submenu, 336
File menu, 11, 259
Filter View submenu, 304
Outline Labels submenu, 301
Print Catalog submenu, 285
Text Touch-Ups submenu, 299

New command, Filter View submenu,
205, 210
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New command, Outline Labels
submenu, 83
New command, Text Touch-Ups
submenu, 79
New Date command, Insert Column
submenu, 323
New Folder command, 165, 167, 342
New Form command, 198, 307
New Gantt command, Insert Column
submenu, 190, 324
New Line command, Insert submenu,
290
New Name command, 335
New Named Text Touch-Up dialog box,
79, 299
New Notepad command, Notepads
submenu, 174, 292
New Number command, Insert Column
submenu, 323
New PhoneBook Name dialog box, 335
New Pop-Up List command, Insert
Column submenu, 324
New Print Catalog dialog box, 285
New Text command, Insert Column
submenu, 323
Next button, 54
Next day/month/year, 19
Next instance of found text, 85, 290
None command, Alarms menu, 350
Non-Recurring command, 352
Notepad Views command, Notepads
submenu, 293
Notepads

adding folders to, 174, 345
choosing folders for, 174, 294
combining, 114
command, View menu, 174
creating, 70, 174, 292
default columns in, 192
described, 375
exporting, 112, 114

filtering, 208
importing, 107, 114
managing, 74, 293
printing, 98, 278, 282
removing folders from, 175, 288
removing items from, 172
shared, 230
using, 70
viewing, 14, 292, 293

Notepads (See also Outlining, Views), 4
described, 4

Notepads and outlining, 70
Notepads command

View menu, 292
Number columns or folders

changing folder type, 342
customizing, 179
described, 176, 188, 375
inserting, 323
properties, 179, 324, 343

Number command, Folder Type
submenu, 342
Number formats

columns, 324, 325
folders, 179, 343
international, 23

Number Properties dialog box, 179, 343
Numbering outlines (See Outline
labels), 82
Objects (See OLE objects), 291
Objects command, Edit menu, 291
OLE links

command, 291
creating, 287
described, 375
editing linked objects, 291
sending selection as, 348

OLE objects
described, 375
editing, 292
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embedding, 150, 287
group, 225
inserting, 291
linking, 151, 287
other options, 292
resizing, 291
sending selection as, 348

Online
Help (See Help), 5, 340
support for ECCO, 6
working, 254

Open command
File menu, 11, 259

Open Shared ECCO File dialog box,
228, 250, 259
Opening files

described, 11, 259
recently opened, 286
shared, 228, 259
templates, 11, 259

Options, 15
Calendar, 21, 23
command, Tools menu, 320
ECCO, 320

Orientation, page, 278, 284
Original file, 251, 375
Original Size command, Objects
submenu, 292
Other command, Objects submenu, 292
Other Program command, Shooter
menu, 348
Other programs

command, Insert submenu, 291
exporting to (See Exporting), 105
importing from (See Importing),
105
inserting file references to, 311
inserting OLE objects from, 291
launching, 313

Other shared files, 223, 375
Outline items

adding, 71
deleting, 73
promoting, demoting, and moving,
72
selecting, 72
viewing, 73

Outline labels, 82, 83, 84, 301
command, 301
described, 376
dialog box, 301

Outline Labels command, 83, 84
Outline Labels dialog box, 83
Outline notes

(See also Subitems), 296
adding, 45, 331, 332, 336
described, 376
printing, 280, 282
recurring events, 44, 45, 332
using, 70

Outline Notes and Columns dialog box,
280
Outline styles, 81, 300

command, 300
described, 376
dialog box, 300

Outline Styles command, 81
Outline Styles dialog box, 81
Page Setup

specifying, 100
Page Setup dialog box, 278
Page setups

managing, 286
specifying, 278, 284

Page size, 278, 284
Panes, 290
Parent item, 376
Password tab, 227
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Passwords, 227, 270
Paste command, 287
Paste Special command, 287
PC Remote, 254
Phone dialer, 376
Phone, dialing, 338
Phone/Time Log

command, 319
dialog box, 319

PhoneBook, 376
about displaying information, 62
adding entries, 56
adding new entries, 55
adding outline notes, 56
calendar, 66
Calendar, using with, 28, 332, 333,
339, 340, 341
combining PhoneBooks, 116
creating custom entries, 57
default folders, 167
deleting entries, 57
described, 1
dialing, 64
dialing and logging calls, 63
displaying all entries, 62
displaying and hiding entries, 58
entering information, 55
entry form, 54
exporting, 110, 116
filtering, 207
finding information, 59
getting addresses with Shooter, 349
importing, 105, 116
importing, exporting, and mail
merge, 66
introduction, 54
letter tabs, 60
list, 54
logging calls, 65
logging time, 66

main file, 223
menu, 53
modem setup, 63
multiple entries, 58
Next button, 54
PhoneBook menu, 335
printing, 97, 278, 281, 282
querying, 61
Search button, 54
search for text, 60
search options, 59
toolbar, 53
viewing, 14, 292

PhoneBook command
View menu, 292

PhoneBook entry form, 376
PhoneBook entry forms

changing, 336
creating, 336
hiding, 337
Make Public, 337
managing, 337
show at right, 338
show below, 338
switching to, 290

PhoneBook menu, 335
PhoneBook names

adding, 335
deleting, 336
searching, 336
showing all, 336

Plain style, 299
Playing sounds, 38, 350
Pop-Up List Column Values dialog box,
324, 342
Pop-up list columns or folders

adding values, 47, 178
changing folder type, 342
customizing, 178
described, 177, 189, 376
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inserting, 324
properties, 178, 324, 343

Pop-Up List command, Folder Type
submenu, 342
Preferences

Shooter, 348
Preferences command, Shooter menu,
348
Previous day/month/year, 19
Print areas, 278, 284
Print Calendar View dialog box, 278
Print Catalog

command, 285
command, Print Catalog submenu,
285
described, 285

Print command, 278
Print Notepad dialog box, 278
Print PhoneBook View dialog box, 278
Print settings

catalog of, 102
Print settings (See Page setups, Print
catalogs), 285
Printer Setup command, 286
Printing, 95

Calendar, 48, 278, 280
catalogs, 102
described, 278
envelope addressing, 284
home/business addresses, 336
managing page setups, 286
Notepads, 278, 282, 283
page setups

specifying, 278

PhoneBook, 278, 281, 282
print catalogs, 285
printer setup, 286
specifying page setups, 284

Printing options, 101
Private, 230, 231, 298
Program window, 13
Programs other than ECCO  (See Other
programs), 311
Project tracking

(See Gantt columns, Related dates),
48
(See Related dates), 48

Promoting items, 181, 297
Properties

columns, 192, 195, 324
command, Column menu, 324
command, Folder menu, 343
folders, 177, 178, 179, 343

Properties command, Column menu,
195
Properties command, Folder menu, 177,
178, 179
Public, 376

(See also File sharing, Make
Public), 295

Quitting (See Exiting ECCO), 16
Reading meeting mail, 242
README.WRI file, 5
Read-only files, 259
Recently opened files, 286
Recur menu, 42, 351
Recurring Event dialog box, 352
Recurring events

canceling, 45
changing, 44
creating, 42
custom, 42
described, 42, 377
dialog box, 42
outline notes, 44, 45, 332
Recur menu, 351

Related dates, 48, 49, 51
Options dialog box, 49
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Relative to Last command, Shooter
menu, 348
Reminders (See Ticklers), 31
Remote Access Sync command,
Synchronize submenu, 254, 267
Remote access synchronization, 254,
267
Remote Access Synchronization dialog
box, 267
Remove Column command, 324
Remove Folders command, 175, 288
Remove Selected Items from Folder(s)
command, 173, 346
Remove View From Window command,
294
Removing

(See also Deleting), 287
(See also Managing), 317
alarms, 350
columns, 186, 324
folders from all views, 345
folders from Notepad, 175, 288
items from folders, 172, 173, 346
items from Notepad, 172
ticklers, 34
view from window, 294

Renaming
(See also Managing, Saving), 41
folders, 168

Reordering (See Managing), 285
Repeat box, 13, 92, 93, 377
Repeating events (See Recurring
events), 351
Replacing text

(See also Finding), 289
described, 85, 87, 289

Replica, 251, 257
described, 377

Reschedule Group Meeting dialog box,
239

Rescheduling
appointments, 29
group meetings, 239

Resizing
OLE objects, 291

Resource administrator, 250
Resources, meeting, 248, 250, 267
Restart Sequence command, Outline
labels

submenu, 301
Restart Sequence command, Outline
Labels submenu, 84
Restore Dialog Alerts command,
Display submenu, 320
Review Alarms

command, 316
dialog box, 316

Review Alarms command, 41
Review Alarms dialog box, 41
Review Meeting (Initiator) dialog box,
240
Review Meeting dialog box, 238, 239,
241, 244, 245
Right command, Move Items submenu,
297
Right pane, 290
Rooms (See Meeting resources), 267
Rules, auto-assignment, 170, 171, 344
Running ECCO, 10
Running other ECCO programs, 146
Save As

command, 12, 261
dialog box, 12, 15, 261

Save command, 15, 261
Save File for Other Computer dialog
box, 257
Saving

backup files, 15, 320
ECCO Options, 15, 320
files, 15, 16, 261, 286, 320
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print settings (See Page setups,
Print catalogs), 285
templates, 12

Schedule Group Meeting dialog box,
233, 235, 236, 237, 329
Scheduling

(See also Calendar, Group
scheduling), 19
appointments, 27, 28, 29
group meetings, 233, 239, 329, 353
meeting resources, 248
multi-day appointments, 28
vacations, 28

Scratch Notepad, 165, 173, 346
Search

command, Help menu, 340
dialog box, 340

Search button, 54
Search Options command, PhoneBook
menu, 336
Search Options dialog box, 336
Search Results view, 86, 114, 288, 377
Searching

(See also Filters), 203
(See also Finding), 288
Help, 340
PhoneBook names, 336

See All Recurring Notes command, 44,
45, 332
Send Cancellation dialog box, 241
Send Decline dialog box, 245
Send Graphics As command,
Preferences submenu, 348
Send Graphics Selection As dialog box,
346, 348
Send Invitation dialog box, 244
Send Mail command, 261
Send Meeting Notes dialog box, 238
Send Meeting Request dialog box, 233,
239

Send Text As command, Preferences
submenu, 348
Send Text Selection As dialog box, 346,
348
Sending

mail, 238, 261
meeting requests, 233, 238, 243,
244
Shooter, via, 346

Sending information between non-
ECCO programs, 144
Sending information from ECCO, 142
Sending information to ECCO, 141
Setting up

ECCO, 9
pages (See Page setups), 286
printer, 286
synchronization, 257, 265
time & expense billing, 213

Settings (See Default, Preferences), 320
Setup command, Synchronize submenu,
257, 265
Setup for Remote Synchronization
dialog box, 257
Setup Time Expense Billing dialog box,
213
Share command, 223, 225
Share This File command, Network
submenu, 261
Shared columns, 231
Shared file, 377
Shared File Status

File Properties command, 229
Shared files

(See also File sharing), 228
deleting, 229
opening, 228, 259
other, 223
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Shared folders, 230, 231
Shared forms, 232
Shared items, 229, 230
Shared meeting resources, 248
Shared Notepads, 230
Shooter, 346

compatibility, 145
described, 377
displaying, 140
introduction to, 139
menu, 341, 346
setting preferences, 141

Shortcut Keys command, 340
Shortcuts

(See also Drag and drop), 90
Help on, 340
Shooter menu (ECCO preferences),
320

Show All Names command, 336
Show Columns command, 47, 114, 184,
187, 323
Show command, Shooter menu, 348
Show Day Details command, 21
Show Dynamic Help command, 341
Show Folder Column command, 345
Show Form At Right command, 338
Show Full Columns command, 338
Show Group Calendar command, 242,
332
Show Home Folder command, Column
menu, 326
Show Item in Calendar Tickler Section
dialog box, 317
Show Item Info

command, 179, 180, 295
dialog box, 180, 295

Show Labels command, Outline labels
submenu, 301

Show Labels command, Outline Labels
submenu, 84
Show Levels

command, 296
dialog box, 296

Show Related Dates command, 51
Show Sub-Items command, 296
Show Tickler Section on Top command,
23, 332
Show/Hide Toolbar button, 91
Sidebar, 17, 19, 22, 332, 377
Sidebar Shows command, 22, 332
Simple alarms, 36, 40
Size

font point size, 299
OLE objects, 291
outline styles text, 300
page, 278, 284

Size command, Format menu, 299
Skip Label & Icon command, Outline
labels

submenu, 301
Skip Label & Icon command, Outline
Labels submenu, 84
Sort Items dialog box, 88, 303
Sort View command, 88, 303
Sorting, 47, 88, 193, 303

Sort Down command, 47
Sort Up command, 47
Sort View command, 47

Sounds, 38, 350
Specify Folders and Column Values
dialog box, 169, 346
Split Item command, 295
Splitting

items, 295
windows, 290
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Stamp, date/time, 290
Standard column sets, 192
Start of day/week (Calendar options),
23
Starting ECCO, 10, 320
Status

meeting attendees, 240
Status area, 378
Status area (Calendar), 36, 42
Status bar, 14, 341

described, 377
Status icons (Calendar), 17, 36, 42
Style command, Format menu, 299
Styles

applying, 299
character formatting, 77
outline styles, 81, 300

Subfolder, 378
Subfolders, 166, 195
Subitem, 378
Subitems

(See also Outline notes), 331, 332,
336
adding, 295
hiding, 297
showing, 296
sorting, 88

Submenu, 378
Submenus, 93
Subscript style, 299
Sum command, 191
Summary, 378
Summary display, 20, 21
Sums, 191
Superscript style, 299
Switching between

(See also Viewing), 292
detail and summary displays of
Calendar, 21
files, 15

other programs and ECCO, 348,
349
panes, 290
views, 14

Synchronization
described, 378

Synchronize command, 253, 254, 255,
257, 265
Synchronizing files

automatically, 254
described, 251, 265
exporting changes, 252, 253, 255,
266
files created, 251
importing changes, 253, 255, 266,
268
mail, using, 255
manually, 253
methods, 252
remote access, 254, 267
setup, 257, 265
terminology, 251

System requirements, 9
Tab command, Insert submenu, 290
Tab scrolling buttons, 14
Tab-delimited text files, 105, 110
Tabs

inserting in items, 290
view tabs, 13, 14

Task lists (See Ticklers), 31
Technical Support, 6

e-mail, 6
newsgroup, 6
online, 6

Telephone button, 378
Templates

creating, 11
default folders, 167
described, 378
opening, 259
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opening files based on, 11
Text column or folder, 379
Text columns or folders

changing folder type, 342
described, 176, 188
inserting, 323
properties, 324

Text command, Folder Type submenu,
342
Text files, 105
Text touchup, 379
Text touch-ups, 79, 80, 299
Text Touch-Ups command, 79, 80, 299
Text, sending with Shooter, 346, 348
Three-month sidebar display, 22
Thumbnails

three months in sidebar, 22
viewing Calendar by year, 20

Tickler section, 379
show on top, 332
switching to, 290

Ticklers
adding, 31, 33, 328
alarms for, 36
changing, 34
command, Tools menu, 31, 317
creating, 31, 33
described, 31, 379
marking as done, 33, 34, 297
options, 23
removing, 34
section described, 31
show on top, 23
showing item in Tickler section,
177, 317
sorting, 88
summary display, 21
Tickler section described, 17

Time
(See also Appointments, Dates), 25

billing for, 213, 214, 215, 217
date/time stamp, 290
keeping available, 353
logging, 216, 319
zone (options), 23

Time & Expenses command, 213, 217
Time Logger

command, 216
dialog box, 216

Time Logger command, 319
Time, Date, Alarm, etc. command, 25,
331
Timelines (See Gantt columns), 324
Timex® Data Link™, 313
Timex® Data Link™ watch, 119
Today, returning to, 17, 19
To-do's

(See also Ticklers), 31
default folders, 167
described, 31

Toolbar
adding buttons, 92
adding submenus, 93
command, Tools menu, 92, 93, 319
customizing, 91, 92, 319
described, 13, 91
described, 379
dialog box, 92, 319
hiding, 91
reorganizing, 93
Shooter, 348

Tools menu, 303
Top pane, 290
Top-level item, 379
Top-level items, 88, 181
Totals, 191
Tracking projects

(See Gantt columns, Related dates),
48
(See Related dates), 48
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Tracking time & expenses (See Billing),
213
Tutorial, 5
Typing items into a view, 169
Underline style, 299
Undo command, 286
Uninviting attendees, 240
Untitled files, 259
Up command, Move Items submenu,
297
Use with Calendar command,
PhoneBook menu, 339, 340, 341
Use with PhoneBook command,
Calendar menu, 28, 332, 333
User database, 379
User identification, 379
User's Guide, 5
Users

choosing, 225, 235, 236, 237
name for reports (preference), 320

Vacations
(See also Holidays), 23
multi-day appointments, 28

Value edit box
described, 380
editing values, 186
entering values, 186

Values
calculating, 191
deleting, 186
described, 379
editing, 186
entering, 183, 186
finding, 86
list of (See Pop-up list columns or
folders), 342
sets of (See Forms), 307
showing item info, 179, 180, 295
sorting by, 88, 193

Version of ECCO, 341
View By Form dialog box, 201, 310
View Folder's Items command, 346
View Item by Form command, 201,
217, 310
View menu, 292
View tabs, 13, 14
Viewing

(See also Switching between), 14
alarms, 316
Calendar, 14, 17, 19, 20, 292
folder contents, 173, 179
folder in Scratch Notepad, 165,
173, 346
folder window, 165, 294
items by form, 201, 217, 310
Notepads, 14, 292, 293
PhoneBook, 14, 292
related dates, 51

Views
(See also Calendar, Notepads,
PhoneBook), 1
adding to window, 294
defined, 163
described, 1, 14, 380
Help on, 340
Make Public, 230, 295
removing from window, 294
switching between, 14
typing items in, 169

Week
button, 17, 20
start of (options), 23
viewing Calendar by, 17, 20

Weekday events (See Recurring events),
353
Width

column, 187
command, Column menu, 187
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Width command, Column menu, 326
Width, column, 324, 326
Windows

adding views to, 294
Calendar, 17
ECCO program window, 13
Meeting Mail, 242, 293
panes, 290
removing views from, 294
splitting, 290

Windows programs (See Other
programs), 348
Workgroup Directory, ECCO (See
ECCO Workgroup Directory), 221
Workgroup Settings

command, 222
wizard, 221, 222

Working copy of file (See Replica), 251
Working online, 254
World Wide Web browsers, 218, 313
Year

button, 17, 20
moving to, 19
viewing Calendar by, 17, 20

Yearly events (See Recurring events),
353
Zoom button, 166
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Easy Acrobat Reader Instructions
These instructions provide simple help in using Adobe Acrobat to read PDF files. For more
detailed information, consult the help file that comes with the reader. You access this file
from the help menu (the question mark) on a Macintosh or from the Acrobat Help menu on
a PC. This guide addresses three topics:

• What’s on your desktop
• Managing your view of a document
• Navigating around your document

Click on one of these topics to get more information.

The fastest, easiest way to improve the legibility of any PDF file is to enlarge

your view of the file. The magnification icon, , in the status bar at
the bottom of the window, displays the current magnification. Click the icon
to select a greater magnification or enter a desired magnification amount.



What’s on your desktop

Click Here To Do This

See only the document’s page without Bookmarks or Thumbnails. Use this
button to use the maximum screen area to read pages.

See the bookmarks (the document’s table of contents) and the document’s
page. Use this button to jump from one chapter or section to another. To
adjust the screen areas used for the bookmarks and the page, position the
cursor over the vertical line between the areas and drag to the left or the
right.



Managing your view of a document

Click Here To Do This

See each page at 100% magnification.

See all of each page. The magnification changes to get all of the page,
including all margins, on the screen.

See all of the page’s width, including left and right margins. Use the Option
key (Macintosh) or Control key (Windows) to eliminate the margins. This is
the easiest way to get the most magnification that will still show all of the
text or graphics across a page.

Zoom in on a page by doubling the magnification.

Zoom out on a page by halving the magnification.

Choose the magnification from 50% to 800% or enter an amount.

Move the page around so you can see a different part of it, with scrolling or
changing the magnification.



Navigating around your document

Click Here To Do This

Go to the top of the page that has the text next to the bookmark. Note that
you first must be displaying bookmarks.

Go to the first page of the document.

Go to the previous page of the document.

Go to the next page of the document.

Go to the last page of the document.

Find the first page that has specified text on it.
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